Introduction

Thank you for purchasing SoftBank 840N.
@ For proper handset use, read this guide.
@ Accessible SoftBank services may vary by service area, subscription, etc.

SoftBank 840N is compatible with 3G network technology.

Notes
- Copying this guide in whole or part without authorization is prohibited.
- Content of this guide is subject to change without prior notice.

- Efforts have been made to ensure the accuracy and clarity of this guide. Please contact SoftBank Mobile Customer Center, General
Information (P. 15-51) about unclear or missing information.



@ SoftBank 840N is referred to as "handset” in this guide.

@ Most operation descriptions are based on default settings and begin in Standby.

@ Sample screenshots* are provided for reference only. Actual handset windows, menus, etc. may differ
in appearance.

@ Key illustrations are simplified and differ in appearance from actual handset keys.

@ "(Japanese)” appears next to functions or services which require Japanese ability to use.

* Standby Display used in this guide is based on SoftBank 840N Petal Pink model. Design theme of Main
Menu and windows is based on default setting Vesper.
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Basic Operations

Learn basic menu navigation
and key operations.

P.2-2

Search Guide

Mobile Internet
Use Yahoo! Keitai to access

Mobile Internet sites tailored for
SoftBank customers.

Text Entry

Enter text for composing
messages, creating Phone Book
entries, etc.

Messaging Services

Use SMS and S! Mail to send
text messages. Attach and send
files via S! Mail.

P. 6-2

P. 2-10 P. 5-2

My Phone Number

Check your phone number on
handset.

P. 1-21

Customize E-mail Address

Change the account name (part
before @) of your e-mail address.

Exchange Information Wirelessly

My Account Details

Save your contact information
to Account Details to send it to
your friends.

Send your e-mail address to
compatible devices via infrared.

P. 1-21 P. 14-16 P. 13-2

Download Music
Download songs from
Chaku-Uta® sites and set as

ringtones or play back on Music
Player. P.9-4

Add Shortcuts

Add frequently used functions
to Desktop Icons.

Set Ringtones

Set your favorite songs as
ringtones.

Wallpaper
Set your favorite image to appear
in Standby with clock or calendar.

P. 14-8 P. 14-3 P.2-3

Music Player

Download songs and play them
on handset.

P. 9-2

Schedule

Manage your schedule on
handset calendar.

Camera & Video Camera
Shoot still images and videos.

Handset supports One Seg
Digital TV.
P.7-2

P. 8-2 P. 11-4

Yahoo! Keitai Sites
A special portal site for SoftBank
handsets enhances your Internet

browsing experience.
P. 6-3

Graphic Mail
Create HTML messages by
changing font and background

colors, inserting images, etc.
P.5-3 P.9-7

S! Quick News
Subscribe to News and receive
automatic updates regularly.

Gaming Device

Play S! Appli games downloaded
from Yahoo! Keitai sites.

P. 10-2
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Before Using This Guide

IPackage Contents

The following items are included in the
package with handset.

For additional information on accessories,
contact SoftBank Mobile Customer Center,
General Information (P. 15-51).

M Battery (NEBAH1)

M Quick Start Guide (Japanese)
H Safety Precautions (Japanese)
M Warranty (Handset)

+ SoftBank 840N supports microSD™ memory
cards. Purchase a memory card to use related
functions.

+ Use only specified AC charger (sold separately)
to charge handset.

ISafety Precautions

@ To ensure proper use of your handset, read
these safety precautions carefully before use.
Keep this guide for future reference.

@ Observe these safety precautions to prevent
injuries and damages to property.

@ SoftBank accepts no liability for any loss or
damages incurred by you or a third party as a
result of missed calls, etc., due to malfunction,

erroneous operation or failure of this product.

M Labels

Risks of injury or damage from improper use are
categorized by levels. Understand these labels
before reading this guide.

conditions requiring hospitalization or long-
term treatment.

2 Injury includes: Physical burns (high-
temperature and low-temperature), electric
shock, and other conditions not requiring
hospitalization or long-term treatment.

3 Damage to property includes: Incidental
damage to structures and household property
and/or to pets and livestock.

H Symbols

Make sure you understand the following symbols
and precautions before reading this guide.

%,

Action is prohibited.

Great risk of death or
serious injury' from
improper use

/A\DANGER

Disassembly is prohibited.

Risk of death or serious
injury’ from improper
use

/A WARNING

‘.‘
A
2

{

Exposure to liquids is prohibited.

Risk of injury? or
damage to property?

/N\CAUTION

from improper use

Handling with wet hands is
prohibited.

1 Serious injury includes: Loss of eyesight,
physical injury, high temperature burns, low
temperature burns (blisters or reddening
caused by prolonged contact with a heat
source higher than body temperature), electric
shock, fractures, poisoning and other

Action is compulsory.

e

Unplug power cord.




M Handset, Battery, USIM Card, AC
Charger (Sold Separately),
Desktop Holder (Sold Separately),
Memory Card (Not Included), and
Stereo Earphone Conversion
Cable (Sold Separately)

/A\DANGER

Use SoftBank specified
devices (Battery, AC Charger
or Desktop Holder) only.

Use of non-specified devices may
cause Battery to leak, overheat,
rupture or ignite; or may cause
Charger to overheat, ignite or
malfunction.

N

Do not charge, use or leave
handset in places subject to
high temperatures (near an
open flame or heating
equipment, in direct sunlight
or inside a car on a hot day).

May cause deformation or
malfunction; or may cause Battery
to leak, overheat, ignite or rupture.
Also, the outer housing may
become hot resulting in burns.

Before Using This Guide

/AN\WARNING

®

Do not disassemble/modify/
solder handset.

May cause fire, injury, electric shock
or malfunction. Also, Battery may
leak, overheat, rupture or ignite.
Modifying handset is a violation of
the Radio Law and subject to
penalty.

Do not use excessive force to
attach Battery, AC Charger or
Stereo Earphone Conversion
Cable to handset. Battery or
AC Charger may be the
wrong way around.

Battery may leak, overheat, rupture
or ignite.

Do not place handset,
Battery, AC Charger, Desktop
Holder or Stereo Earphone
Conversion Cable in a
microwave oven or pressure
cooker, or on an induction
cooktop.

May cause Battery to leak,
overheat, rupture or ignite; or may
cause handset, AC Charger or
Desktop Holder to overheat, emit
smoke, ignite or malfunction.

&)
()

Keep liquids away from
handset.

If handset and/or battery is not
dried after exposure to fluids
(water, pet urine etc.), overheating,
electric shock, fire, malfunction,
etc. may occur.

Turn off handset when
entering gas stations or other
places where flammable
gases (propane gas, gasoline,
etc.) generate. Do not charge
battery in such places.

Gases may ignite.

Using handset near petrochemicals
or other flammables may cause fire
or explosion.

Do not drop/throw handset
or expose it to excessive
shock.

May cause battery to leak,
overheat, rupture or ignite; or may
cause fire, electric shock or

malfunction.
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If you notice an unusual
sound, odor, smoke, etc.
while using, charging or

1. Unplug AC Charger from outlet.

2. Turn handset power off.

3. Remove Battery from handset,
being careful of burn or injury.

Continued use may cause fire or

electric shock.

storing handset, immediately:

Keep handset out of reach of
infants.

Failing to do so may result in small
parts being accidentally swallowed
or may cause injury.

Keep liquids (water, pet
urine, etc.) and conductive
materials (e.g. pencil lead,
metal fragments, metal
necklaces, hairpins, etc.)
away from Charger Terminals,
External Device Port or
Memory Card Slot.

May cause short circuit, resulting in
fire or malfunction.

When a child uses handset,
parent supervision is advised.
Provide child with proper
instructions.

Failing to do so may cause injury,
etc.

M Handling Battery

/N\DANGER

Check battery type on Battery label. Properly
use and dispose of Battery according to type.

Label

Battery type

Li-ion00

Lithium-ion

Do not store handset in
humid or dusty places or in
places subject to high
temperatures.

May cause malfunction.

N

Do not throw Battery into a
fire.

May cause Battery to leak, rupture
or ignite.

A\ CAUTION

e 0 © @O

Be careful not to pinch your
fingers in the hinge when
opening handset.

Failing to do so may cause injury.

Do not place handset on an
uneven or unstable surface.

Handset may fall, leading to injuries
or handset malfunction. Be
particularly careful while charging
or when vibrator is activated.

N

Do not puncture Battery with
a nail, hit it with a hammer,
step on it or subject it to
strong impact.

May cause Battery to leak, overheat,
rupture or ignite.

N

Keep metal objects (pins, etc.)
away from Battery Terminals.
Do not carry or store
conductive materials (e.g.
pencil lead, metal fragments,
metal necklaces, hairpins,
etc.) together with Battery.
May cause Battery to leak, overheat,
rupture or ignite.




If battery fluid gets into eyes,
immediately rinse with clean
water and consult a doctor.
Do not rub eyes.

Failing to do so may result in loss of

eyesight.

If Battery leaks, immediately
stop using it and keep it
away from fire.

Battery fluid is flammable and
could ignite, causing fire or Battery
to rupture.

Before Using This Guide

M Handling Handset

/AN\WARNING

/A\WARNING

If battery fluid gets on your
skin or clothing, immediately
stop handset use and rinse
with clean water.

Battery fluid may harm your skin.

If any abnormalities
(deformation, scratches, etc.)
are visible on Battery,
immediately discontinue use.
May cause Battery to leak, overheat,
rupture, ignite; may cause handset
malfunction or fire.

N

Do not use while operating a
vehicle (car, motorcycle,
bicycle, etc.)

May cause a traffic accident. Use of
a mobile phone while driving is
prohibited by law, and is subject to
penalty. Stop vehicle in a safe
location (where parking is allowed)
before using handset.

If Battery is not fully charged
even after specified charging
time, stop charging.

Battery may leak, overheat, rupture
or ignite.

Do not allow pets to bite
Battery.

May cause Battery to leak, overheat,
rupture, ignite; may cause handset
malfunction or fire.

If you notice an unusual odor,
overheating, discoloration,
deformation, etc. while
using, charging or storing
Battery, remove it from
handset and keep it away
from fire. Be careful not to
burn or injure yourself.
Battery may leak, overheat, rupture
or ignite.

/N\CAUTION

Do not dispose of batteries as
municipal waste.

Bring used batteries to a SoftBank
Shop or recycling center after
insulating the terminals with tape.
Be sure to observe local regulations
on battery disposal.

Keep handset power off near
high precision electronic
devices or devices using weak
signals.

Handset may cause these devices to
malfunction.

Devices that may be affected:
Hearing aids, implanted cardiac
pacemakers, implanted
defibrillators and other electronic
medical equipment; fire alarms,
automatic doors and other
automatic control devices.

Keep handset power off
aboard an aircraft.

Handset signal may interfere with
aircraft operation. Handset use
aboard an aircraft may be subject
to penalty. When in-flight use is
permitted, observe airline
instructions.
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If you have a weak heart, be
careful with incoming call
vibrator and ringtone volume
settings.

These may affect your heart.

Do not place handset on the
dashboard near airbags.

In case of airbag inflation, handset
may hit passengers resulting in
injury, malfunction or breakage.

If thunder is heard while
outside, immediately turn
handset power off and seek
shelter.

Failing to do so may attract
lightning and cause electric shock.

Do not point infrared beam
at a person’s eyes.

May cause eye injury.

If Display or Camera Lens is
damaged, be careful of
broken glass pieces or

exposed internal components.

Shatter-proof film prevents Display
and Camera lens from shattering;
however glass fragments and
components may cause injury.

%,

Keep magnetic cards away
from handset and make sure
that a magnetic card is not
trapped when closing
handset.

Failing to do so may cause
magnetic data on a cash card,
credit card, telephone card or
floppy disk to be lost.

0l @

If you use electronic medical
equipment, do not place or
use handset near the
equipment.

Using handset near electronic
medical equipment may cause the
equipment to malfunction.

Do not allow fluids, metal
pieces or flammable materials
to enter USIM Card Slot or
Memory Card Slot.

May cause fire, electric shock or
malfunction.

Do not swing handset by its
strap, etc.

Handset may strike you or other
people; Strap may break causing
injury, handset malfunction or
breakage.

Handset may become hot
during prolonged use.

Skin contact for extended period
may cause low-temperature burns.

When using Earphone-
Microphone while playing
games or music, adjust
volume accordingly.

Sound at high volume may impair
hearing; or surrounding sounds
may become inaudible over
playback volume, resulting in an
accident.

A\ CAUTION

If skin abnormality occurs
with use of handset,
immediately discontinue use
and consult a doctor.

Handset contains metals.
Depending on your physical
condition, you may experience
itchiness, rash, etc.

Do not bring speaker close to
the ear when making calls in
handsfree mode or when ring
tone/melody is playing.

May impair your hearing.

e 0 e O

Be careful when opening/
closing handset.

May pinch fingers/Strap, causing
injury or damage.




Watch TV with adequate
lighting and distance from
Display.

Failing to do so may impair
eyesight.

M Handling USIM Card

A\ CAUTION

Before Using This Guide

Do not turn volume up too
high when using earphones.
Using earphones for extended
periods at high volume may impair
hearing or harm your ears.

Be careful handling the Notch
when removing USIM Card.

May injure your hands or fingers.

outlet before extended
periods of handset disuse.
Failing to do so may cause electric
shock, fire or malfunction.

% Unplug AC Charger from

If Display breaks, do not
inhale or touch liquid crystal
fluid. If fluid enters your eyes
or mouth, immediately rinse
with clean water and consult
a doctor. If fluid adheres to
your skin or clothing,
immediately wipe off with
alcohol and wash with soap
and water.

May result in loss of eyesight or
skin damage.

M Handling AC Charger and
Desktop Holder

/A\WARNING

If liquid (water, pet urine,
etc.) gets into AC Charger,
immediately unplug AC
Charger from outlet.

Failing to do so may cause electric
shock, smoke emission or fire.

N

Do not cover with clothing or
bedding during charging.
Heat may build up resulting in fire
or malfunction.

Charger plug, unplug
Charger from outlet and
wipe with a dry cloth.

Failing to do so may cause fire.

Keep magnetized objects
away from handset.
May cause operation errors.

N

Use the specified power
supply and voltage.

Failing to do so may cause fire or

malfunction.

AC Charger: 100 to 240 V AC
(for household AC
outlets only)

Also, do not use commercially

available voltage converters. May

cause fire, electric shock or
malfunction.

When plugging AC Charger
into outlet, keep conductive
materials (pencil lead, metal
parts, necklaces, hair pins,
etc.) away from Desktop
Holder terminals, AC Charger
plug/terminals and plug
Charger firmly into outlet.
Failing to do so may cause electric
shock, short circuit, fire, etc.

o If dust accumulates on AC

- Do not touch AC Charger
Q\,gi with wet hands.

May cause electric shock or
malfunction.
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If thunder is heard, do not
touch AC Charger.

May cause electric shock.

Do not use AC Charger if the
cord is damaged.

May cause electric shock,
overheating or fire.

Firmly hold plug and unplug
AC Charger from outlet
before cleaning.

Failing to do so may cause electric
shock.

Do not use AC Charger and
Desktop Holder in humid
places such as in bathrooms.
May cause electric shock.

Do not unplug AC Charger by
pulling the cord. Firmly hold
plug and unplug AC Charger.
Pulling the cord may damage the
cord resulting in electric shock or
fire.

O © @0

Do not short-circuit Charger
Terminals when Charger is
plugged into an outlet. Do
not touch Charger Terminals
with your fingers, etc.

May cause fire, malfunction,
electric shock or injury.

Do not charge a wet battery.

May cause battery to overheat,
ignite or rupture.

Unplug Charger from outlet
when charging is complete.

Failing to do so may cause fire or
malfunction.

%,

Do not place heavy objects
on the cord of AC Charger.

May cause electric shock or fire.

/\CAUTION

O VO © &

Do not touch Charger
Terminals of Desktop Holder
when plugged into an AC
outlet.

May cause low-temperature burns.

When AC Charger is
connected to an outlet, do
not pull on cord or otherwise
subject Charger to strong
shock.

May cause injury or malfunction.

B Near Electronic Medical Equipment

This section is based on “Guidelines on
Safeguarding Medical Equipment from
Electromagnetic Waves from Mobile Phones and
Other Devices” (Electromagnetic Compatibility
Conference Japan, April 1997), and “Research
Report on the Influence of Electromagnetic
Waves on Medical Equipment” (Association of
Radio Industries and Businesses, March 2001).

/A\WARNING

Keep handset a minimum of
22 centimeters from
implanted cardiac pacemaker
or implanted defibrillator.
Radio waves may interfere with the
operation of implanted cardiac
pacemakers or implanted
defibrillators.




When using electronic
medical equipment other
than implanted cardiac
pacemakers/defibrillators
outside of medical
institutions, consult device
manufacturer about the
influence of radio waves.
Radio waves may interfere with the
operation of electronic medical
equipment.

Observe the following in
medical institutions. Radio
waves from handset may
affect electronic medical
equipment.

+ Do not bring mobile phones into
an operating room, ICU (Intensive
Care Unit) or CCU (Coronary
Care Unit).

Turn off mobile phones in
hospital wards. Disable auto
power-on functions (alarm, etc.)

before turning off mobile phones.

Turn off mobile phones even in
lobbies or areas where use is
permitted if there is electronic
medical equipment nearby.

- Observe the instructions of
individual medical institutions
and do not use or bring mobile
phones into prohibited areas.

Keep handset power off in
crowded places such as rush
hour trains; a person with an
implanted cardiac pacemaker
or implanted defibrillator
may be nearby. Disable auto
power-on functions (alarm,
etc.) before turning off
mobile phones.

Radio waves may interfere with the
operation of implanted cardiac
pacemakers or implanted
defibrillators.

Before Using This Guide

IGeneraI Notes

Usage Basics

@ Handset use may be disrupted when out of
range or signal is weak. Calls/TV image may be
suddenly cut off when moving to a place with
poor signal reception (e.g. inside/next to a tall
building, in a tunnel, underground or in
mountainous areas).

@ Take care not to disturb other people when
using handset in public places.

@ If you receive a call while walking, move to a
safe place before answering.

@ Back up important data. SoftBank accepts no
liability for damages arising from loss/
alteration of handset/memory card data
(Phone Book, image/sound files, etc.) due to
accident or malfunction.

@ Handset is a wireless station under Japanese
Radio Law. You may be requested to submit
your handset for inspection based on this law.

@ Handset use near landlines, TVs or radios may
cause interference. Move away from devices
to avoid interference.

@ Beware of eavesdropping. Handset employs a
digital signal that provides a high level of
privacy protection. However, the possibility of
eavesdropping by a third party using special
means cannot be ruled out.
<Eavesdropping>
Interception of radio signals by a third party
during communication, either intentionally or
accidentally
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@ Do not trap Strap or other objects when
opening and closing handset. Doing so may
cause malfunction or damage handset.

@ Using handset on trains or other public
transportation may affect their electronic
devices.

@ A call may not be connected or you may hear
noises:

+ In an extremely cold place (e.g. freezer
storehouse) where handset may not operate
normally

+ Near metal furniture which may interfere
with signal transmission

- Near electromagnetic sources or magnetized
items, including electric products, audio-
visual equipment and office appliances (e.g.
computer, microwave oven, speaker, TV set,
radio, fax machine, fluorescent lamp, word
processor, electric kotatsu, inverter-driven
air conditioner, electromagnetic cooker)

@ If Battery appears deformed or scratched from

external impact, contact Customer Assistance.

@ When using handset for the first time or after
an extended period of disuse, charge Battery
beforehand.

@ Battery operating time varies by the usage
environment and Battery condition.

@ Do not charge Battery:

- In a humid/dusty place or near sources of
vibration
- Near landlines, TVs or radios

@ Although AC Charger may become warm

while charging, it is not a malfunction.

@ Do not subject handset to excessive shock. Do
not deform Charger Terminals. Doing so may
cause malfunction.

@ When Battery life nears its end, it may expand
slightly. This is not a malfunction.

@ Keep handset away from strong magnetic
force. May cause malfunction.

@ Do not scratch Display with metal objects, etc.
Doing so may damage Display resulting in
malfunction or breakage.

@ Do not use handset while driving. Doing so
may compromise safe driving and cause an
accident. Handset operation in a car may be
punishable by law.

@ Before using handset, stop the car in a safe
place.

@ Handset use may affect electronics in some car
models. Confirm with your car dealer whether
sufficient magnetic protection measures are
implemented in your car. Failing to do so may
compromise safe driving.

@ Keep away from liquids and moisture.

Handset, Battery, AC Charger, Desktop
Holder, Stereo Earphone Conversion Cable
and USIM Card are not waterproof. Do not
use these devices in the rain or in other
humid places (e.g. bathrooms). When
carrying handset near your body (pockets,
etc.), moisture from sweat may corrode
internal parts and cause malfunction.
Damage caused by exposure to liquids or
moisture is not covered by the warranty and
may be irreparable.

Handset's color LCD may be treated with
special coating for enhanced visibility. To avoid
scratching Display, clean handset carefully
using a dry, soft cloth (e.g. eyeglass cloth). If
moisture or soil is left on Display, the coating
may stain or peel off. Do not use alcohol,
thinner, benzene or detergent, as it may cause
discoloration and remove printed logos.

@ Clean Terminals with a dry cotton swab. Soiled

Terminals may cause poor contact, resulting in
insufficient charging or handset to turn off.

@ Do not place handset near an air conditioner

vent. Condensation may form due to abrupt
temperature changes, leading to internal
corrosion and malfunction.

@ Do not apply excessive force to handset and

Battery. Placing handset in an overpacked bag
or sitting down with handset in your pocket
may damage Display, Internal Circuit Board or



Battery, and cause malfunction. Doing so with
external device connected to External Device
Port may damage connector, leading to
malfunction.

@ Although handset becomes warm during use
or charging, it is not a malfunction.

@ Do not leave the Camera Lens exposed to
direct sunlight. Doing so may discolor or burn
Optical Element.

@ Do not affix thick stickers or labels to the
Display or Keypad side. Doing so may result in
malfunction.

@ Do not leave Battery uninstalled or uncharged
for an extended period of time; may alter or
erase saved settings and data. SoftBank
accepts no liability for any damages resulting
from such loss or alteration.

@ Do not store depleted Battery; may degrade
performance and shorten Battery life.

@ Keep the covers of External Device Port and
Memory Card Slot closed. Dust or water inside
handset may cause malfunction.

@ When removing Stereo Earphone Conversion
Cable or AC Charger from External Device
Port, do not pull the cord, hold the connector.
Pulling the cord may result in wire breakage or
malfunction.

@ If you use an outlet with pullout prevention
feature, refer to the instruction manual of the
outlet.

@ Avoid extremely cold and high temperatures.
Use handset at an ambient temperature of 5 to
35 °C, and humidity of 45 to 85 %. If handset
is left in an extremely hot place, handset may
power off automatically.

@ Battery time varies by conditions of use;
however when operation time becomes
extremely short even after a full charge,
purchase a new Battery. Use only specified
battery.

@ Charge Battery at an ambient temperature of
5to 35 °C.

@ Do notinsert USIM Card with labels or stickers
affixed to it. May cause malfunction.

@ When connecting an external device, do not
insert connector into External Device Port at an
angle. When external device is connected, do
not pull the cord.

@ Do not use handset without Battery Cover.
Battery may dislodge and result in malfunction
or breakage.

Creating public disturbances from using handset
may be subject to penalties based on applicable
laws and regulations (e.g. nuisance prevention
ordinance by municipal governments).

Before Using This Guide

Copy

Copyrighted materials, such as music, images,
computer programs and databases, and their
respective copyright holders are protected by
copyright laws. Duplication of copyrighted
materials is permitted only for individual or home
use. Duplications (including data conversion),
modifications, transfers or network distributions
of copyrighted materials for purposes other than
stated above without permission of the copyright
holders constitute an infringement of copyrights
and violation of copyright holders’ rights,
potentially causing claims for reparations or
criminal punishment.

Always observe applicable copyright laws when
making copies using handset and recording
materials using handset camera.

The software installed in this handset is a
copyrighted material and involves copyrights and
human rights of copyright holders which are
protected by copyright laws. Do not duplicate,
modify, alter, detach from the hardware,
disassemble, decompile or reverse-engineer the
software in whole or in part by yourself, nor allow
any third party to do the same, either.

Functional Limitations

After handset upgrade, subscription cancellation
or long periods of handset disuse, TV becomes
unavailable.
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Do not use handset if it has been altered. Using an
altered device is a violation of the Radio Law.
This handset is certified to conform to the
technical standards for specific radio equipment
based on the Radio Law, and Technical
Conformity Mark @ is printed on the model
name seal as certification. If you remove screws
and make alterations inside of handset, the
technical standards conformity certification
becomes invalid. Do not use handset with the
certification invalid, as it is a violation of the Radio
Law.

SAR Certification Information

840N meets the technical standards set by the
Ministry of Internal Affairs and Communications
(MIC) regarding radio wave absorption by a
human body.

These technical standards have been established
on a scientific basis to prevent radio waves
emitted from wireless devices such as mobile
phones from affecting human health. These
standards require that the SAR (Specific
Absorption Rate), an indicator of the amount of
average radio frequency energy absorbed in the
side of a human head, must not exceed 2 W/kg*.
This value includes a substantial safety margin to
assure the safety of all persons, regardless of age
and physical size. The value is equal to the
international guideline recommended by the
International Commission on Non-lonizing
Radiation Protection (ICNIRP) that has a

cooperative relationship with the World Health

Organization (WHO).

* The technical standards are stipulated in the
Radio Law (Article 14-2 of Ordinance
Regulating Radio Equipment).

The highest SAR value is 0.552 W/kg for 840N.

This value was obtained in accordance with the

MIC testing procedure with handset transmitting

at its highest permitted power level. While there

may be differences in SAR levels for various
handsets, they all meet the MIC’s permissible
value. Because mobile phones are designed to
operate at their minimum power level required to
communicate with base stations, the actual SAR
of handset during a call is usually below the
highest value.

For more information about SAR, see the

following websites:

+ Ministry of Internal Affairs and
Communications (MIC)
http://www.tele.soumu.go.jp/e/sys/ele/index.htm

+ Association of Radio Industries and Businesses
(ARIB)
http:/Awww.arib-emf.org/

(Japanese)

SoftBank’s Body SAR Policy

- Body SAR: Value obtained from continuously
talking with handset placed on the body using
earphone-microphone at maximum
transmission power.

+ Specific Absorption Rate (SAR): Value obtained
from talking continuously for six minutes.

+ Placement on the body: Measurements are
taken with the rear of handset facing the body
at a distance of 1.5 cm as the standard handset
position. In order to comply with radio
frequency exposure requirements, use an
accessory (e.g. belt clip, holster) that does not
contain metallic parts to maintain a 1.5 cm
separation between the body and handset.

For more information, see SOFTBANK MOBILE
Corp. Website (Japanese):
http://Awww.softbankmobile.co.jp/ja/info/public/
emf/emf02.html

European RF Exposure Information

840N is a radio transmitter and receiver. This
product has been confirmed not to exceed the
limits recommended by international guidelines
for radio frequency.

These guidelines were developed by the
independent scientific organization International
Commission on Non-lonizing Radiation
Protection (ICNIRP) and include a substantial
safety margin to assure the safety of all persons,
regardless of age and health.

The influence on the human body of radio waves
emitted from mobile phones is measured
employing a unit known as the Specific
Absorption Rate (SAR). The SAR limit for mobile
devices is 2 W/kg. The maximum SAR value for
this model handset, when placed on the ear, is
0.544W/kg. As mobile devices offer a range of
functions, they can be used in other positions,
such as on the body as described in SoftBank’s


http://www.softbankmobile.co.jp/ja/info/public/emf/emf02.html

Body SAR Policy. In this case, the maximum SAR
value is 0.281W/kg*.
Since the SAR is measured at the highest
transmitting power level, the actual SAR during a
call is usually much lower. This is because mobile
phones are designed to operate at their minimum
power levels necessary to communicate with base
stations.
The World Health Organization (WHO) has stated
that present scientific information about mobile
phone use does not indicate any adverse effects
on the human body. They recommend limiting
talk time or using a handsfree device to keep the
mobile phone away from the head and body to
reduce influence of exposure to radio waves.
Additional information can be found at the WHO
website:
http://Awww.who.int/emf
* Measurements with handset placed on the
body are carried out in accordance with the
FCC standards. The values are based on
European requirements.

C€0168

840N is declared to conform with the essential
requirements of European Union Directive
1999/5/EC Radio and Telecommunications
Terminal Equipment Directive 3.1(a), 3.1(b) and
3.2

The Declaration of Conformity can be found on
the following website:
http:/Awww.n-keitai.com/

Minding Mobile Manners

Use your handset responsibly. Inappropriate

handset use can be both dangerous and

bothersome. Take care not to disturb others

when using your handset. Adjust handset use

according to your surroundings.

@ Turn handset power off in theaters, museums
and other places where silence is the norm.

@ Refrain from use in restaurants, lobbies,
elevators, etc.

@ Observe signs and instructions regarding
handset use aboard trains, etc.

@ Refrain from use that interrupts the flow of
pedestrian or vehicle traffic.

Before Using This Guide

Ilntellectual Property Rights

@ Duplicating, modifying or publicly transmitting
copyright-protected contents (e.g. text,
images, music, software) photographed or
downloaded from websites without the
permission of the copyright holders is
prohibited by copyright laws, with the
exception that the duplication or quotation of
those is made only for personal use.

Shooting or recording a demonstration,
performance or exhibition may be prohibited
in some cases even if it is for personal use.
Shooting a photo of a person using this
product without his or her permission, or
posting a photo of a person you shot on
websites without his or her permission may
constitute an infringement of portrait rights.

@ S! Appli, S! Mail and Graphic Mail are
registered trademarks or trademarks of
SOFTBANK MOBILE Corp.

@ SOFTBANK, SOFTBANK's equivalent in
Japanese and the SOFTBANK logo are
registered trademarks or trademarks of
SOFTBANK CORP. in Japan and other
countries.

@ Yahoo! and the “Yahoo!" or “Y!" logos are
trademarks and/or registered trademarks of
Yahoo! Inc. in the U.S.

@ T9° is trademarks and/or
registered trademarks of Nuance @M
Communications, Inc. and/or its

affiliates in the United States and/or other

countries.
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@ microSD™ is a trademark of

o
the SD Card Association. mg‘;
@ This product is licensed g

complying with MPEG-4 Visual Patent

Portfolio License, and you are permitted to use

personally and for the nonprofit purpose in the

following situations:

- To record a movie based on the standard of
MPEG-4 Visual (MPEG-4 Video)

+ To play MPEG-4 Video recorded by the
consumer engaged in the nonprofit activities

+ To play MPEG-4 Video provided by the

provider licensed by MPEG-LA

When you use it for other purposes, such as

promotion, in-house information and profit
activity, contact the U.S. corporation MPEG
LA, LLC.

@ This product contains ADOBE'
Adobe® Flash® Lite™ FLASH'
technology by Adobe ENABLED
Systems Incorporated.

Copyright®© 1996-2010 Adobe Systems
Incorporated. All rights reserved.

Adobe, Flash and Flash Lite are either
registered trademarks or trademarks of Adobe
Systems Incorporated in the United States and/
or other countries.

@ QR code is a registered trademark of Denso
Wave Inc.

@ Powered by JBlend™ Copyright
2002 -2010 Aplix Corporation. All ’
rights reserved. \~
JBlend and JBlend-related N

trademarks are trademarks or JBlend

registered trademarks of Aplix Corporation in
Japan and other countries.

@ Java and Java-based trademarks and ((
logos are trademarks or registered =
trademarks of Sun Microsystems Inc. ~ 1——
in the U.S. and other countries. JQ,){%

@ Chaku-Uta® and Chaku-Uta Full® are
trademarks and/or registered trademarks of
Sony Music Entertainment (Japan) Inc. in Japan
and/or other countries.

@ This product contains NetFront

o
Browser and NetFront AC@ESS
Messaging Client software of

ACCESS CO., LTD SR e

Copyright® 2004-2010 ACCESS CO., LTD.
ACCESS and NetFront are trademarks or
registered trademarks of ACCESS CO., LTD. in
Japan and other countries.

This software is based in part on the work of the
Independent JPEG Group.

@ This product is equipped with
IrFront by ACCESS CO., LTD.
©2008 ACCESS CO., LTD. All
rights reserved.

ACCESS and IrFront are trademarks or
registered trademarks of ACCESS CO., LTD. in
Japan and other countries.

@ MULTITASK, Privacy angle and NEC SUPER
TOWN are trademarks or registered
trademarks of NEC CASIO Mobile
Communications, Ltd. in Japan.

@ This product is equipped with the font
FontAvenue product by NEC Corporation.

IrFront

@ Powered By Mascot Capsule®/Micro3D Edition™
MASCOT CAPSULE® are registered trademarks
of HI CORPORATION.

@ G-GUIDE, G-GUIDE MOBILE and their logos
are trademarks or registered trademarks in
Japan of U.S. Gemstar-TV Guide International,
Inc. and/or its affiliates.

@ IrSimple™, IrSS™ or IrSimpleShot™
are trademarks of Infrared Data m,m
Association®.

@ Hyper Clear Voice is commercially available
based on the license for SRS VIP+ technology
from SRS Labs, Inc. SRS, VIP+, and the @
symbol are trademarks of SRS Labs, Inc.

@ Dialog Clarity and WOW
technologies are Srs @
industrialized based on the ~ Dialog Clarity
license from SRS Labs, Inc.

Dialog Clarity, SRS, WOW and the @ symbol
are trademarks of SRS Labs, Inc.

@ This product contains software licensed
complying with GNU General Public License
(GPL), GNU Lesser General Public License
(LGPL), etc.

For more details, visit “GPL-LGPLZ(ICDWT”
at
http://www.n-keitai.com/guide/download/

@ FrameSolid™ by Morpho, Inc. is used for the
frame interpolation function.

FrameSolid™ is a registered trademark of
Morpho, Inc.

@ PhotoSolid®, MovieSolid® and their logos are
trademarks or registered trademarks of
Morpho, Inc. in Japan and other countries.



@ Microsoft, Windows and Windows Vista are
trademarks or registered trademarks in the
United States or other countries of Microsoft
Corporation (USA).

@ Microsoft Windows Operating System is
indicated in its abbreviated form as Windows.

@ OS (Japanese) are abbreviated as follows in this
guide.

- Windows 7 is an abbreviation of Microsoft®
Windows® 7 (Starter, Home Basic, Home

Premium, Professional, Enterprise, Ultimate).

+ Windows Vista is an abbreviation of
Windows Vista® (Home Basic, Home
Premium, Business, Enterprise, Ultimate).

+ Windows XP is an abbreviation of
Microsoft® Windows® XP Professional
operating system or Microsoft® Windows®
XP Home Edition operating system.

@ The names of the companies, products and
services used in this guide are registered
trademarks or trademarks of the respective
companies.

Before Using This Guide
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- Handset Parts
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Infrared Port
Earpiece
Display

Light Sensor
Multi Selector
Center Key
Mail Key

WNOUVI A WN =

9 Shortcut Key
10 Camera Key
11 Send Key

12 Clear/Back Key
13 Power/End Key

14 Keypad
15 *Key

16 #/Manner Key

17 Microphone

18 Charger Terminals
19 Volume up/Manner Key
20 Volume down/Music Key

21 Sub-display

Yahoo! Keitai Key

HEEDENeReees

-
E]Music

22 Charging Indicator/Illumination

23 Internal Antenna

24 Strap Eyelet
25 Camera
26 Speaker

27 Memory Card Slot

28 Battery Cover



29 External Device Port

Tip

« TV antenna is built into handset. For optimal signal
reception, do not cover Internal Antenna with hands or
anything else. Do not affix stickers over Internal
Antenna.

« Key illustrations are simplified and differ in appearance
from actual handset keys.

Handset Parts

IBasic Key Operations

In Standby
No. Key/Operations Description
5 (©) Access Desktop Icons/Indicators.
Press and hold @ |Open S! Quick News List.
®@ Open Phone Book Search menu.
O Open Received Calls window.
Press and hold ©) | Open Received Address List.
© Open Redial window.
Press and hold @ |Open Sent Address List.
6 ® Open Main Menu.
7 Open Mail menu.
Press and hold Compose a new S! Mail.
8 ® Access Yahoo! Keitai portal.
Press and hold & |Open Yahoo! menu.
9 ® Activate function assigned to key
(Iftsumono-Mail is set by default).
Press and hold ® | Assign a function to key.
10 ® Activate Camera (Photo Mode).

papels buiyan P
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Handset Parts

During Voice Calls

No. Key/Operations Description
11 Open Tomo-Den Window. No. Key/Operations Description
12 Play messages on Answering Machine. 5 ©) Open Phone Book Search Group menu.
Press and hold Set/cancel Answering Machine. Press and hold @ | Continuously increase earpiece volume.
13 | Press and hold (=] | Turn power on/off. (@) Open Phone Book Search Column menu.
14 | Press and hold (5] |Set/cancel ECO Mode. Press and hold @ | Continuously decrease earpiece volume.
Press and hold Set font type, thickness and size. o) Open Received Calls window.
Press and hold Set Privacy Angle on/off. G Open Redial window.
Press and hold (0 | Enter “+" (international access code). 7 Turn handsfree on/off.
16 | Press and hold (#] |Set/cancel Manner Mode. 8 ® Toggle Hyper Clear Voice modes (High,
19 Js- Increase earpiece volume. OFF or Low).
View clock (handset closed). 9 ® Open Task Switch window.
Press and hold [+ | Set/cancel Manner Mode. 12 Hold call.
20 Whusic Decrease earpiece volume. 13 = End call.
Press and hold [ | Activate Music Player (unavailable when Press and hold (=) | Turn power off.
battery is low). 16 Press and hold Set/cancel Manner Mode.
19 Hes- Increase earpiece volume.
20 sic Decrease earpiece volume.

Press and hold Husic

Record other party’s voice.




During Text Entry

Handset Parts

No. Key/Operations Description

5 @ Insert line feed 4 (when cursor is at the

end of text).
© Add a space (when cursor is at the end of
text).

7 Toggle character entry modes (in 5-touch
or T9 input mode). Toggle double-byte
and single-byte characters (in 2-touch
mode).

Press and hold Toggle text input methods (in 5-touch,
2-touch or T9 input mode).

8 ® Open pictograph, symbol or emoticon
lists.

Press and hold & | Convert S! Mail to Graphic Mail.
1" Cycle characters in reverse order (in

5-touch mode).

No. Key/Operations Description
12 Delete one character to right of cursor.
When cursor is at end of text, a character
to left is deleted.
Press and hold Delete all text to right of cursor.
When cursor is at end of text, delete all
text.
15 Enter dakuten () or handakuten ()
(in 5-touch, 2-touch or T9 input mode).
Toggle case (in 5-touch or 2-touch mode).
Insert line feed 4 .
Press and hold Select area.
16 Toggle Shift, Caps Lock and lower case

modes (when entering alphanumerics in
T9 input mode).

Press and hold (#)

Paste copied or cut text.

Press and hold

Undo last operation (conversion, pasting,

cut, etc.) and return to the previous state.
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Display

Display Indicators

E

@ 4@9

1‘ ) ( T‘
EfleEm E8IFESL
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@ 3 (9 (9 (o 17 1a 15

payels bunyan

(1 |8l Battery Level

@ Tl Signal Strength

“ Out of Range

E. Emission OFF Mode

FE USIM Lock Active

@ & Packet Transmission Available
(Yahoo! Keitai)

& Packet Transmission in Progress
(Yahoo! Keitai)

Packet Transmission Available
(Dial-up Connection)

Packet Transmission in Progress

(Dial-up Connection)

&/
(Sending/Receiving Data)

@ & ssL Secured Site Connected

16

Packet Transmission in Progress

@

@

FEoe fRfwfoly =B BEQI

Q

Unread S! Mail/SMS

Handset S! Mail/SMS Memory Full

USIM SMS Memory Full (5 when there
are unread S! Mail/SMS Messages)
Handset S! Mail/SMS & USIM SMS
Memory Full

Dial Lock Active

Original Lock Active

Secret Mode/Secret Data Only Mode
Original Lock Active in Secret Mode/Secret
Data Only Mode

Software Updated

iy Side Key Guard On

Q] /B USB Cable Connected

(Communication/microSD Mode)

microSD Mode

5 5 Handsfree Device Connected
(Communication/microSD Mode)

H/E UsB Cable/Handsfree Device

Connected
(Communication/microSD Mode)

® ﬁ? Infrared Transmission
@ S! Addressbook Back-up Sync in Progress

1 B Memory Card Inserted

@ Invalid Memory Card Inserted
B Memory Card Reader/Writer in Use
] Accessing Memory Card

1) & Voice Call

Bi video Call
%‘ Maximum Call Cost Limit Reached

@ @ Vibration Set for Incoming Calls &

Messages
@/% Vibration Set for Incoming
Calls/Messages

ﬁfiﬂ% No Ringtone for Incoming Calls &

Messages
3’3/3@ No Ringtone for Incoming
Calls/Messages

@ € Manner Mode
j’s}@ Alarm Set
& Alarm Set for Today (appears prior to set

time.)

® ‘ One Seg Timer Recording in Progress




a % New Messages at Voice Mail Center
= Answering Machine On
=3 New Voice Calls
B9 New Video Calls
% New Voice & Video Calls
@ € ECO Mode
Privacy Angle On (‘@’ when Backlight is
Off)
19 5 Keypad Lock Active (After Closed or
Timer is ON)
Tip
* To see indicator descriptions:
® = Settings = ® = Display => @ =>
Icons = @
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Display

_n Sub-display

E] Battery Level

[¥] unread Messages

B Handset Message Memory Full
B usiM sMs Memory Full

paje3s bunyan

(Fé when there are unread messages)

& Handset & USIM SMS Memory Full

"? Manner Mode

(g-j Voice Call

Eu Video Call

@ﬁ Packet Transmission Available
(Yahoo! Keitai)

¢ Packet Transmission in Progress
(Yahoo! Keitai)

-/ % packet Transmission in Progress

(Sending/Receiving Data)

T||| Signal Strength

E!J}' Out of Range

i Emission OFF Mode

18

Handset status and new information appear
on Sub-display.

2010.07.01THU

5:30

Clock (Digital 1)

Missed Call/
New Mail (S! Mail/SMS)

Mow 15234

TV Timer Recording

Incoming Call

On hold

Emotion-Expressing
Mail

Music Player

Tip
+ Sub-display may be hard to see when
outdoors or under strong light.

. Customize

Style Mode Settings
Set Display Design Collectively
Check Style Mode Settings
Edit Title of a Style
Save Current Style Mode Settings as Favorite
Change Each Item for Favorites
Clear All Favorite Settings
(> P. 14-3)
Display Settings
Wallpaper
Show Calendar in Standby
Set Wallpaper Image to Change When Handset
Returns to Standby
Display Color Scheme
Battery Level Indicator/Signal Strength Indicator
Design
Interface Language
Guard from Prying Eyes
Set Effect for Screen Change
(> P. 14-3)
Backlight
Set Backlight & Power Saving
llluminate Display Only or Display and Keys
Set Brightness of Backlight
(> P. 14-5)



Standby Indicators
@ Enable Indicator Selector
(»P.14-7)
Sub-display
@ Notifications/Animation
@ Set Clock Pattern
® Set Messages to Appear
® Set Time Signal
® Set Viewable Time
(> P. 14-8)
Closed Illumination
@ Set Flashing Color for Handset Close

@ Set Flashing Pattern for Handset Close
(> P. 14-27)

papels buiyan F
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USIM Card

_n IBefore Using USIM Card

payels bunyan

Universal Subscriber Identity Module (USIM) Card is an IC card that

contains customer information (phone number, etc.). A USIM Card

must be inserted to use your handset.

@ Store Phone Book entries and SMS on USIM Card.

@ Insert USIM Card into other USIM-compatible SoftBank handsets to use
information on Card.

@ Do not apply excessive force when inserting/removing USIM Card.

@ SoftBank is not liable for any damage caused by inserting USIM Card into
other IC card readers/writers.

@ USIM Card may become warm during use. This is not a malfunction.

@ Keep IC chip clean.

@ For details, refer to the manual supplied with your USIM Card.

@ Do not drop USIM Card or subject to excessive shock. Doing so may cause
malfunction.

@ Do not bend USIM Card or place heavy objects on it. Doing so may cause
malfunction.

@ Avoid extreme temperatures.

@ Do not scratch, carelessly touch or short-circuit the IC chip.
Doing so may result in data loss or malfunction.

@ Clean USIM Card with a dry soft cloth (such as is used for eyeglasses).

@ Use a SoftBank-designated USIM Card. Using a non-designated card may
result in handset malfunction.

1-10

IOther Notes on USIM Cards

@ USIM Cards are the property of SoftBank.

@ USIM Cards will be reissued for a fee if lost or damaged.

@ Return USIM Cards to SoftBank upon cancellation or suspension of
service.

@ Returned USIM Cards are recycled.

@ USIM Card specifications and performance may change without prior
notice.

@ Keep a separate copy of data saved on your USIM Card.

SoftBank is not liable for lost data.

@ If USIM Card or handset (with USIM Card inserted) is lost or stolen,
suspend service immediately. For details, contact SoftBank Mobile
Customer Center, General Information (P. 15-51).

@ Downloaded files (S! Appli, videos, Saved Pages, etc.) saved to handset or
memory card may be inaccessible after USIM Card replacement, handset
upgrade or service subscription cancellation. If a different USIM Card is
inserted, the cookies and cache are cleared to protect personal
information.

— IC Chip




| usIM PINs
There are two security codes for USIM Cards: PIN1 and PIN2.

PIN1 is a four- to eight-digit code to prevent unauthorized handset

use by a third party.

@ Default PINT is 9999.

@ PIN1 can be changed (P. 4-2).

@ When PINT Code Entry Setis set to ON, PIN1 must be entered each time
handset is turned on to be used.

PIN2 is required to reset total call cost or to set a maximum limit to call
costs.

@ Default PIN2 is 9999.

@ PIN2 can be changed (P. 4-2).

PIN Lock & Cancellation (PUK)

If PIN1 or PIN2 is incorrectly entered three times consecutively, PIN

Lock is activated, limiting handset use to specific functions. Enter

Personal Unblocking Key (PUK1/PUK2) to cancel PIN Lock.

@ For information on PUK, contact SoftBank Mobile Customer Center,
General Information (P. 15-51).

USIM Card

Note

« If PIN1 is incorrectly entered three times, and then PUK is incorrectly
entered 10 times, USIM Card locks and handset cannot be used.

« If PIN2 is incorrectly entered three times, and then PUK is incorrectly
entered 10 times, operations that require PIN2 will become unusable.

+ Write down your PUK.

+ To cancel USIM Card lock, contact SoftBank Mobile Customer Center,
General Information (P. 15-51).
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USIM Card

E Push USIM Card in completely

_n IUSIM Card Installation

@ Remove Battery (P. 1-14) before inserting or removing USIM Card.
@ Be careful of notch when handling USIM Card. May injure your hands or
fingers.

n Slide in USIM Card (IC chip facing down)

USIM Card slot Notch

payels bunyan

Removal

n Slide USIM Card out gently

Slide in USIM
(IC Chip down)

112




INotes on Charging Battery

@ Charge battery at least once every six months. If battery is left uncharged
for a long period, it may become unusable or its operation time may
decrease.

@ Avoid connecting too many things to one AC outlet. Doing so may cause
the AC outlet to overheat and cause a fire.

@ Battery and AC Charger may become warm during charging, but this is
not a malfunction. If they become too hot, however, stop charging and
contact SoftBank Mobile Customer Center, Customer Assistance
(P. 15-51).

@ If Charging Indicator flashes red during charging, battery may be faulty.
Contact SoftBank Mobile Customer Center, Customer Assistance
(P. 15-51).

@ Depending on the conditions of usage, the battery may expand as it nears
the end of its life. However, this presents no safety problems.

@ Check the battery type on its label:

Mark Type

Lithium-ion battery

Lithium-ion batteries are a recyclable resource. Do
not dispose of them as municipal waste. Bring used
batteries to your nearest SoftBank Shop or
recycling center after insulating the terminals with
tape. Observe local regulations on battery disposal.

€5

Li-ion00

Battery & Charger

IBattery Installation

@ When installing Battery, make sure Battery is oriented correctly.

Insertion

EN Press and slide Battery cover off

B Insert Battery
Align @ A © marks on Battery and handset then slide Battery into
place.

papels buiyan P
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Battery & Charger

Replace cover
_n El Rep Removal

@ Turn off handset before removing battery.

Q

]

.':_t. n Remove Battery cover

=]

Q P Press (D) and lift out (®)
=2

g B

g S

Align tabs with handset grooves
and slide the cover shut.

Note
« Do not force Battery Cover shut. Tab may be misaligned and cause
breakage.
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Battery & Charger

ICharging Battery

Using AC Charger
Use only SoftBank-specified AC Charger (ZTDAA1, sold separately).

Blades

=

External D\eice Port Pc;rt Cover
W/
[ S e

~

Charger

Z
P
i

Release Tabs

Connector

Open Port Cover
Insert Charger connector into External Device Port

Extend Charger blades and plug into an AC Outlet
Charging Indicator lights red while charging. When charging is
complete, Indicator goes out.

Disconnect connector from handset
Press and hold Release Tabs to remove connector.

Unplug Charger from AC Outlet

Close Port Cover

Note

+ Battery can only be charged while inserted in handset.

* When both Charging Indicator and Display Indicator [H go out and
Charge Unusual Stop Charge appears, disconnect handset from AC
Charger and remove battery. Set up handset and Charger and start
charging again. If the same error occurs, AC Charger may be faulty or a
non-specified charger is being used. Contact SoftBank Mobile Customer
Center, Customer Assistance (P. 15-51).

+ When Battery is fully depleted, etc., it may take time for Charging
Indicator to illuminate.

papels buiyan P
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Battery & Charger

Using Desktop Holder

Desktop Holder is sold separately.

Arrows up

Connector

AC Outlet

Desktop
Holder

harger

1-16

n Insert Charger connector into Desktop Holder
ﬂ Plug Charger into an AC Outlet

B Place handset in Desktop Holder
Charging Indicator lights red while charging. When charging is
complete, Indicator goes out.

3 Lift out

0 More Features

Backlight
o Set Backlight during Charging
(> P. 14-5)

Sounds
@ Set to Play Charging Start/End Tones
(> P. 14-10)



IPower On

@ Make sure USIM Card is correctly inserted
before turning power on.

EN Press and hold (=)
EINil

070 Y

15330

Tip

+ Power-on message (WELCOME) may appear
on Display for a while when turning on
handset immediately after turning power off
or inserting battery.

+ After USIM Card is replaced, Security Code is
required when powering handset on for the
first time. If Security Code is incorrectly
entered five times, handset shuts down.
Turn handset on again.

Initial Setup

Power On/Off

Retrieving Network Information

Setup prompt appears in Japanese the first time
handset is turned on. Select NO and press @ to
exit. Change interface language to English

(P. 14-5) and restart handset to perform setup as
follows.

n [Initial Settings Window] => YES

= @®

P To Automatically Enter Date & Time
Auto => @ => Select a time zone =>
®

P> To Manually Enter Date & Time
Manual (Date Time Set) => @ =>
Select a time zone = @® = Enter
date and time => @

1 Enter Security Code (9999) = @
=> Enter new Security Code = @
= YES = @®

E] select a font size => @
Select Separate Setting to customize
font per window (P. 14-4).

ﬂ [Keypad Sound Setting Window]
=> ON or OFF => ®
Tip
» Setup prompt no longer appears after setup is

complete.
* The default Security Code is 9999.

When ®, ® , ® or @ is pressed after initial
setup, a prompt appears. Select YES to update
network settings.

Tip

* Retrieve network information to use network-
related services, such as mail and the Internet.

* To manually update network settings:
(® = Settings = ® => Connection
Settings = (® => Retrieve NW Info => @
= YES => ®

IPower off
EN Press and hold (=)

Handset shuts down.

pajiels bunyan P
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Clock

o Hide Clock

o Clock Size

@ Clock Color

o Set Auto Time Adjustment
© Manually Adjust Time

o Summer Time

@ Time Zone (Sub Clock)

® Hide Sub Clock

@ Summer Time (Sub Clock)

Auto Power On/Off
® Set Auto Power On/Off

Display Settings

o Set a Wake-up Image

o Set a Wake-up Message
o Set Font Type

o Set Font Thickness

o Set Font Sizes Collectively

Power On/Off

A araEm

Resetting Handset
® Reset All Settings to Default
o Initialize Handset to Default Status
(> P. 14-28)

(»P.14-2)

(»P.14-3)

@ Set Font Size for Each Function Window

Sounds
o Set Key Sound Off

1-18

(> P. 14-4)

(» P. 14-10)




IMinding Mobile Manners

Use your handset responsibly. Inappropriate

handset use can be both dangerous and

bothersome. Take care not to disturb others

when using your handset. Adjust handset use

according to your surroundings.

@ Turn handset power off in theaters, museums
and other places where silence is the norm.

@ Refrain from use in restaurants, lobbies,
elevators, etc.

@ Observe signs and instructions regarding
handset use aboard trains, etc.

@ Refrain from use that interrupts the flow of
pedestrian or vehicle traffic.

IActivating Manner Mode
Mute handset sound.

EN Press and hold
Note

* When handset is set to vibrate for incoming
calls, be careful as handset may slide off, slide
into a stove, etc.

Tip

* Press and hold again to cancel Manner
Mode.

+ Shutter click sounds even in Manner Mode.

* Press and hold to set or cancel Manner
Mode during a call. Short beeps sound
through the earpiece when Manner Mode is
set or canceled during a call.

» Set or cancel Manner Mode by pressing and
holding -

Mobile Manners

0 More Features

Manner Mode
@ Set Manner Mode Type
o Configure Original Manner Mode

(> P. 14-10)

papels buiyan P

1-19



Codes

_n IAbout Codes

payels bunyan

Security Code, Center Access Code and
Network Password are required to use
handset.
@ Do not reveal these codes to others.
Write down your codes.
@ SoftBank is not liable for any damage due to
handset misuse.

ISecurity Code

Security Code, 9999 by default, is required to
use some handset functions. The code can be
changed.

@ If Security Code is entered incorrectly or
nothing is entered for 15 seconds, a tone
sounds and a message appears. Enter correct
Security Code.

Note
* The warning tone does not sound in Manner
Mode or when Keypad Sound is set to OFF.

1-20

Changing Security Code

n ® = Settings — ® = Security
=> (@ => Change Security Code
=@®

ﬂ Enter current Security Code = ®

B Enter new Security Code = @® =
YES > @

ICenter Access Code

Center Access Code, a four-digit code
assigned at initial subscription, is required to
access Optional Services via landlines or to
subscribe to fee-based information.

INetwork Password

Network Password, a four-digit code
assigned at initial subscription, is required to
use Call Barring.

@ If Network Password is incorrectly entered
three times, Call Barring settings are locked.
Network Password and Center Access Code
must be changed.




Other Basic Information

When Battery Is Empty

IChECkII‘Ig Battery Level Recharge battery appears, the battery alarm IUsmg Earphone

Use Battery Level meters as a guide only. sounds for about 10 seconds, and handset Use Stereo Earphone Conversion Cable (sold
powers off in about 60 seconds. Charge battery. separately) to connect earphones.

Battery Level Indicator
o IMy Phone Number Note

Appears at top of Display or on Sub-display. * When ringtone volume (P. 14-8) is set to

papels buiyan P

[B)/[E Near full charge Check handset phone number. Silent, no sound is output to earphones. Set
/E| Sufficient charge n @ = (@) volume to Level 1 or higher.
[E/[2] Almost depleted; charge battery Account Details appear. )
M Add Other Information Tip
=> ® => Enter Security Code => @ => * When sound source is monaural (calls, etc.),

Battery Level Beeper & Large Indicator Select an item = @ = Enter stereo earphones output monaural sound to

left and right earphones; when sound source

Check battery level by number of beeps and information > @ > is stereo, only the left channel is output to
large indicator. H View All Information —— earphones.
. => @) => Display All Data > ® => Enter

n ® E:> Settings - © = Other Security Code => @ =>

Settings = ® => Battery Level S to switch tabs (=> @)

= @ H Reset Account Details

Battery Level indicator appears. Beeps => @ => Reset => @® (= Enter Security

sound according to the battery level. Code => @ )=> YES = @

Three beeps: Near full charge

Two beeps: Sufficient charge

One beep: Almost depleted;
charge battery

Note
« The battery level beeper does not sound in
Manner Mode or when Keypad Sound is set
to OFF.
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Other Basic Information

_n ISide Key Guard

Disable Side Keys ;- and [y while handset
is closed.

Ell ®-> Press and hold
Repeat to cancel setting.
Tip
+ Alternatively, set Side Key Guard by:

@ = Settings => @ => Other Settings =
® = Side Key Guard => ® => ON or OFF
=@

payels bunyan
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IUsing ECO Mode

Setting ECO Mode will dim Display and
modify settings to decrease battery
consumption.

EN Press and hold (5]
ECO Mode is set, and @ appears.

Tip

* Press and hold (5] again to cancel ECO
Mode.

* Press and hold (5] to set or cancel ECO
Mode during a call.

0 More Features

Earphone-Microphone
® Audio Output
@ Microphone Setting
@ Answer Calls Automatically
® Save a Phone Number for One-touch Dialing
from Earphone-Microphone
(> P. 14-11)
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Menu Operations

Accessing Handset Using Softkeys & Multi Selector Keyword Search

Functions Press Softkeys or use Multi Selector in Enter a keyword to search function/menu
—ﬂ @ In this guide, most operations start from Main Standby to access assigned functions. items.
g Menu. Softkeys fle=-e
]
n . ®: Open Mail menu E Enter a keyword => ®
[o) From Main Menu ®): Press and hold to compose new S! Mail Example> Enter “mail*
L] : . e <Ex > i
] Press @® to open Main Menu. Use € to select ®: Access Yahoo! Keitai portal | e - -
S an item and press @ to open sub menus. ®: Pre_c?s and holq to open Yahoo! menu i earch Vor = ai
- ®: Activate function assigned to key %(I)D[t)g;x
g = (Itsumono-Mail is set by default) HDraft
7] o l;w” ®: Press and hold to assign a function to key ;ggglgog ﬂﬁeage
!2" = ﬂ @): Activate Camera (Photo Mode) (ES i
S (7} f
Eliffent  camea  Music Multi Selector B¥%Sel. Area
bt 4 ‘ @: Access Desktop Icons/Indicators
= Ow:m'a @: Press and hold to open S! Quick News List EElEE
-' r&l = @: Open Phone Book Search window
TV PhoneBook  Settings ©): Open Received Calls window Corresponding items are underlined.
Main Menu €©): Press and hold to open Received Address List B @ or @ to select an item = @

©: Open Redial window
©: Press and hold to open Sent Address List
Tip
* Handset returns to Standby after 15 seconds
of inactivity.



Menu Operations

From Original Menu Enter Menu Item Number

Assign often-used functions to Original Enter these numbers for direct menu access.

Menu for quick access. Note that Main Menu Theme must be set to
Basic.

n @ = @ @ See P. 15-20 for menu item numbers.

@ See P. 2-26 for details on changing Main

I Icons/Notifications

Add functions to Icon Window and use them
as shortcuts. Notifications appear to inform

you of missed calls, new messages, etc. Select
a notification to check the information. The

suonesadQ diseg P

Original Menu following shortcuts are set by default.
[Account Details Menu Theme. + SI Quick News* C TV
Receive Ir Data R -
Calculator <Example> Access Select Ring Tone * Quick Search + Bar Code Reader
?g’;?d'u‘;o (menu no. 13) * Links to Japanese page. Requires network
Alarm n ® connection.
Bar Code Reader
Dictionary
My Picture E )=
Secret Mode
= Incoming Cal |
Wenu13
Select Ring Tone
Press &) to toggle between Main Menu h
and Original Menu. »> x;f?" el
Menu  1_
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Menu Operations

Icons Icon Function Icon Function
Icon Function Show Image Text Reader
B
S! Quick News

Play Video

Music Player

Quick Search

S! Appli

Life History Viewer

Bar Code Reader

Call Phone Number

maE ¢

Compose S! Mail

Compose SMS

Access Webpage (Yahoo! Keitai)

Access Webpage (PC Site
Browser)

Play Melody

vy

@E Inbox Folder Calculator
@ Photo Mode Dictionary
I:E):] Movie Mode @oo Receive IR Transmission
%S Voice Mode B@J Original Menu
Eﬁ Schedule B PC Site Browser
?E To Do List
Text Memo




Menu Operations

Notifications Voice Mail notifications disappear after message

Icon Function/Information !
. — is played back.
Icon Function/Information @) Maximum Call Cost Limit Reached * Content key icon disappears after content keys
i are checked or deleted.
’»Q Missed Calls MRAX

@Q’" Software Update

Answering Machine
Play/delete messages.

0 New S! Info Channel
o

Answering Machine (Video
Message)
Play/delete Video Messages.

S!'Info Channel Reception Failure

suonesadQ diseg P

Voice Mail

New Weather Info.

New Message(s)

Ak | B | B | G

Missed Alarms

UPDATE
pae]
Miss]
&)
Em
{:}O Weather Info. Reception Failure
Miss]
(19
(7]

()

Special Template
i& Missed TV Programs

[ L ARM] View Content Keys*
2.z | Timer Recording Finished

(=]

FINISH]

Notifications disappear after accessing the
functions/information. Answering Machine and




Menu Operations

Addlng Icons INavigating through Menus Selecting Menu Items Using Keypad

Add up to 15 icons. Use keypad to enter number corresponding
. A to menu item.
From a function => @ => Add Scrolling Pages
Desktop Icon > @ (->YES=> ®)  Use G or © (@u or B to scroll A Settings__1/2

. er Clear Voice
next/previous pages. 1 |Style Mode Setting
BNoise Reduction
BQuality Alarm
Reconnect Signal
Illumination in Talk
Set Hold Tone
Setting when Folded

Tip

+ Alternatively,
O =>@=> Create Icon => @=> Select
function => @ => Select a Theme => @

Accessing Icons & Notifications
0o

A, Settings  1/2 A, Settings 2/2

1 Style Mode Setting

¥

suonesadQ diseg h

Menu Numbers

Return to Previous Window or
Standby

087 O STHU! 15.30

Press to cancel operation and return to
previous window.

Press (=] to return to Standby.

@ May not apply to all functions/windows.

Icon Window

Pl & => select anicon => @

M Scrolling Icons
= Q

26



'9 More Features

Main Menu

e Change Main Menu Theme

® Switch to Simple Menu

@ Temporarily Change Design Theme of Main
Menu

(> P. 2-26)

Desktop Icons

o Delete Notifications

o Edit Title of a Desktop Icon

o Change Icon Image

® Check Icon Information

® Change Order of Desktop Icons
o Delete Desktop Icons

@ Reset Desktop Icons

® Change Theme of Desktop Icons
@ Show/Hide Desktop Icons

Display Settings
® Set Softkey Color

(> P. 2-26)

(> P. 14-4)

Desktop Icons
@ Set Desktop Theme
@ Change Icon Design of a Theme
@ Change Order of Icons of a Theme
@ Copy Icons to Another Theme
® Move Icons to Another Theme
o Delete Icons of a Theme
@ Show New Message Indicator in 3D
(> P. 14-6)

Menu Display Settings
o List View and Details View
® Set Main Menu Theme
@ Change Icon Design (Original Theme)
e Change Background (Original Theme)
® Reset Original Theme Settings
@ Save Last Selected Menu Item to Memory
® Add a Menu Item to Original Menu
® Change Order of Original Menu Items
o Cancel Original Menu Items
@ Reset Original Menu
(> P. 14-7)

Shortcut Key
@ Change Function Assigned to Shortcut Key
(> P. 14-27)

Menu Operations
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Multitask

suonesadQ diseg h

Activate one function per group at one time.

Function Group Function
Mail Group Mail
Yahoo! Group Yahoo!
S! Appli Group S! Appli
Settings Group Settings

Tools Group

Data Folder, Tools, Phone
Book, Own Data, Camera

TV & Music Group

TV, Music

@ See P. 15-2 for available combinations of
functions that can be activated at the same
time.

@ Confirm currently active tasks in Tasks Bar.

Tools Data Folder ~ Own Data
- Y o

™v F Settings
N |
Ta

sks Bar

@ Transmission fees are incurred while accessing
functions during a voice call.

IActivating Another Function

Activate another function without exiting
current function.

EN while using a function => ®
P> To Activate Function from Main
Menu
@ =» Select another function => @
P Mail Function

P> To Access Yahoo! Keitai Portal

P> To Activate Camera (Photo Mode)
®



Multitask

IToginng Functions

n When multiple functions are
active => @

Incoming Call
G| ¢~ : Stand-by display

| — : Quit function
8| 4> : Select function

Music
B
Task Switch Window

To go to Standby, press (/).
Press ® to reopen Task Switch window.

Pl S > select a task indicator => @

Tip

+ To End Multitask:
[Task Switch Window] => (=) => Quit
Selected or Quit All Function => (®

« Alternatively, press and hold ® to return to
Standby while current functions remain
active.
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Text Entry

Handset has three text input methods: Guide Pane Status Pane
5-touch, 2-touch and T9 Input.
@ This guide mainly explains Japanese text entry [A][¥] cHG @ to convert characters 2 Text input method
in 5-touch mode. Al [¥] Al © 1o search Phone Book (2-touch/T9 Input mode) (No
& ¥ Search indicator for 5-touch mode)
IOverwew EI & to specify a text range to s Insert/Overwrite mode
(4] 7] Area copy/eut @ @ £ [@ |Character entry mode

Ed

Text Entry Window i i
E R D30 to nsert lne feed = uten code input mode

A text entry window consists of Character Aa to switch case of each (P. 2-28)
Entry Pane, Guide Pane and Status Pane. character. or to add dakuten
Indicator and key descriptions are as follows: (¢ Yhandakuten (* )

=
&

Double-byte/Single-byte mode

suonesadQ diseg h

- [{# AA —aa |(F]to cancel Caps Lock mode En Lower case input mode
Character Entry [ aa — Aa (# to set Shift mode & Shift/Caps Lock mode
| Pane [ Aa — AA to set Caps Lock mode R Bytes remaining for text entry
¥ Sel. Press and hold to select [n Number of entered characters
BER Guide P Area area of text to copy (cut). (appears when entering text to
— Guide Pane
[H ¥ Paste |Pressand hold to paste iSeli\glaPZ)one Book/SMS
B B512 — Status Pane copied or cut text. 9
Text Entry Window < Back to cycle characters on a
key in reverse order (e.g. X —
Character Entry Pane 3)
| Cursor
4 End mark (end of text)

2-10



Split Windows

In some instances, a second window opens
with text entry window.

Dlately;recently . .
| Function window

—_—
rlhank you for everythin,

|__Text entry
window

B EEE @487

Referring to Dictionary
from a text entry window

Switching Windows

Press @ and select Change Window to switch
windows.

Changing Text Input Methods

EJ [TextEntry Window] = @ => CHG
Input Method > ® => Select a
text input method = @
Alternatively, press and hold ®.

Toggling Character Entry Modes

n [Text Entry Window] =>
Press ® to toggle entry modes.
Kanji/hiragana—Katakana—
Alphanumerics—Numbers

Tip
* In 2-touch mode, press &) to toggle
single-byte and double-byte modes.

Interruptions during Text Entry

When Battery Runs Out

Battery alarm sounds and Recharge battery
appears. Text is automatically saved. Access the
same function to continue text entry.

Text may not be saved depending on the function.

When (—] is Pressed

A message appears asking whether to end text
entry. Select YES and press ® to end text entry
without saving the text. To continue text entry,
select NO and press @®.

When a Voice Call Arrives

Answer the call. After call ends, text entry
window returns.

Text Entry

Entering Characters in
5-touch Mode

Press a key multiple times to cycle through
letters assigned to that key.
@ For key assignment, see P. 15-10.

Kanji, Hiragana & Katakana

Enter a reading (in hiragana) and convert to
kanji, katakana, etc.

Using Word Prediction

Enter a character and Word Prediction suggests
words starting with that character. Word
Prediction also suggests word selection for words
to follow. Switch to kanji/hiragana mode to use
Word Prediction.
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Text Entry

<Example> Entering "5 &EE "
n [Text Entry Window] => (2]
(four times)

“[J " is entered in Character Entry Pane.
Suggestion list shows predictions for
words beginning with “[3" in Guide
Pane.

[

suonesddQ diseg h

LT
BE % ) &8 &8
#R U225 wm _#
B85 B _J-F %
RUT % ONC @
F BR B8 87K &8

F1 @ = select “igg& = ®

el

[¥iSel . MClose 60|
FE A-L PRL2 ES
Y1h BB AXS
2hSvT @R FLE §
EX LT L&Y & D
& (2 93 LR

" appears in Character Entry Pane.
A suggestion list of words that follow

"% appears in Guide Pane.

2-12

Bl When Required Word Does Not Appear
=
Continue hiragana (reading) entry in
Character Entry Pane to narrow down
selection.

El @ = select“®mzE" ~ ®

k¢ Edit Memorandums
Tl

[ViSel. [RCIose 56
#S LT g% <EsL
£ B5L5EL BUKFES
BB

) >
L @ € o B

H To Exit Suggestion List
= or@®
Tip
Handset has a learning feature that adds
entered words to the suggestion list. Press

and hold to delete an added word from
the suggestion list.

Converting Hiragana

If the required suggestion does not appear or
word prediction is set to off, convert to Kaniji as
shown below:

<Example> Entering “{£@7AK"

EN [Text Entry Window] = (once)
=0 = (once) => (2] (twice)

k¢ Edit Memorandums
s

[ViSel. 8
A EBA A BT
’EWE<H il s

H To Determine Entered Hiragana without
Converting It

= @
E] select aword => ®

B To Change Conversion Range
= O



Text Entry

. - Select an item = @ .
Dakuten (* ) & Handakuten (° ) 2 Press ® or ® to toggle IEd|t|ng Text

<Example> Entering “hi” pictograph/symbol/emoticon lists.

EN [Text Entry Window] => (2] (once) 'TE‘; 5(:)"“‘“ Pages within a List Deletion & Correction

¥
= =@ EN [Text Entry Window] => Move

B cursor to the left of the character

Switching to Lower Case List closes. to delete >

<Example> Change “D” to “> * e RRFEEER erpIEteE) H To Delete All Characters to the Right of
H C
EJ [Text Entry Window] => (4 (three E‘;’:‘:ss and hold
times) => O EN [Text Entry Window] => @ =

H To Delete Entire Text
Common Phrases -
® => Move cursor to the end of text =

suonesadQ diseg P

Pictographs, Symbols & F1 select a folder => @ = Select a Press and hold
Emoticons phrase = @ (twice) 1 position cursor => Enter correct
EN [Text Entry Window] = ® characters

Alphanumerics, Numbers &
Katakana

Enter alphanumerics, numbers or katakana in
kanji/hiragana input mode.

n [Text Entry Window] => Enter

o hiragana => ® = Select a
B2099890808990 character => @
[Sleelaaizll e

SECBPVVYYIVVP 1

1220 n i % BYL DS

213



Text Entry

El Move cursor to end of characters L.
Copy & Paste =@ IEdltmg Templates

@ Only one entry can be stored on clipboard. If
y g b [l ® - own pata > @®
[Thank you for everything

0OU Copy or cut new text, the previously copied
you copy P yeop Common Phrases => ®

b

or cut text is overwritten. .

W
Q . @ Common Phrases
2. EN [Text Entry Window] = @ => -
o Copy or Cut => ® Eg:gg: §
K] & EITE Newerandms | Folder 8
3 Tlhank you for everything [E$Paste
= i )
a- ons Templates (Common phrases) Window
=
n . Select a folder => @
7 Position cursor = @ = Paste = H
e () Folder 3
. [ikNot Stored>
Repeat to paste same text multiple Not Stored>
times. <Not Stored>
BE7s <Not Stored>
- <Not Stored>
E beginni ¢ Tip <:l‘ot gtored>
) ) ) ) < >
Move cursor to beginning o + Copied text is saved until new text is <N3} s}gﬁ:&
characters <> ® copied/cut or handset is turned off. <Not Stored>

<Not Stored>

Templates List

El Select an entry = => Enter text
=@
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IUsing Dictionaries

Using Downloaded Dictionaries

Download dictionaries from Yahoo! Keitai

Saving Words to Own Dictionary sites. Dictionary must be enabled in advance.

Save frequently used words to Own
Dictionary. For each word, save a reading (in
hiragana). When the reading is entered in a
text entry window, the word appears among
the suggestions.

El ® => own Data => ® => Own
Dictionary => ®

@® Own Dictionary
{New>

Own Dictionary Window

Pl <New> > ® = Enter word => @
=> Enter reading = ®
Tip
* To check saved words:
Select a word => (@

El ® > own Data = ® = DL
Dictionary => ®

@ Download Dictionary

[1Dictionaryl
BDictionary2

BDictionary3
@<Not Stored>
B<Not Stored>

Downloaded Dictionary Window

F1 select a dictionary => @

% appears next to the enabled
dictionary.

Tip

+ To disable a dictionary:
[Downloaded Dictionary Window] => Select a
dictionary with % => @

« If an emoticon dictionary is enabled, its
content is reflected in the emoticon list when
entering emoticons.

Text Entry

Entering Characters in
2-touch Mode

Each hiragana character is entered by

combining two key presses.

@ For combinations of character input keys, see
P. 15-11.

@ Procedures for selecting predicted words and
for converting entered hiragana are the same
as those used in 5-touch mode (P. 2-11).

<Example> Entering “F+> 7"

@ The following example is in Japanese text entry
mode.

EN [Text Entry Window] = (21 2)
(%) = (8J0](change to lower
case mode) => (B 1) (») =
(8]0 (change to upper case
mode) => (0 (3] () =
(3) = [(0J5I( )

Pl ® => select aword => ®
Tip
* Pressing also adds dakuten (" ) and
handakuten (* ) or toggles upper case and
lower case.

* Press ©) to toggle double-byte and
single-byte modes.

suonesadQ diseg P
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Text Entry

Entering Characters in T9
Input Mode

Press a key once for each character, and select
the word from the suggestion list.

@ For key assignment, see P. 15-12.

@ When character entry mode is “Number,”

5-touch input method is automatically applied.

<Example> Entering “&"
@ The following example is in Japanese text entry
mode.

ER [Text Entry Window] = (6] (row

&)= (8] (row 5)
Word predictions for the key
combination appear.

& Edit Wemorandums |
(0=

[fKana %N 3
B ®h #2 JIL & &
/Y & B5 MM EN
B §% B8 #® ¥ @n
%g K 8 B EL

B To Change Conversion Range

= O

2-16

M Toggle Kanji and Hiragana Suggestion
Lists
=

H Toggle English and Japanese
Suggestion Lists

= ®
2 JoEe)

Select word from among the suggestions
in Guide Pane.

H To Show Converted Words on
Suggestion List
= @
For example, if you specify “(&%,” then
"5k%," "BE%" and other words that have
the same reading appear on the
suggestion list.

B To Show Predicted Words on
Suggestion List
=
For example, if you specify “13%,” then
“&RH,” "3 " and other words that
begin with the same reading appear on
the suggestion list.

H To Exit Suggestion List and Continue
Character Entry
>

3O

Re-entering Words

Re-enter as shown below if the desired word

does not appear.

<Example> Entering “Sh5h &

@ The following example is in Japanese text entry
mode.

EN [Text Entry Window] => (8 (row
5) => (0] (row D) => (8] (row 5)
= (0] (row D) => (4] (row fz)

"SR5k E " does not appear in
suggestion list.

o Edit Memoranduns |
S—5—C

oni_edit
L5 2@v @ @n 55

Cursor is on the first character of the
word. The edit window opens in Guide
Pane, where hiragana characters of row
“5" appear.



Text Entry

El OO(5) = 3)(h) > O3(5) =
(8(wh) = [E](&)

«¢ Edit Memorandums |
55|

ana SATEN 1
[ 44

B If No Correction is Necessary
=> © to move cursor to the next
character

B To End Re-entering a Word
= @
The words predicted/converted from the
re-entered word appear on the
suggestion list.

14O

'9 More Features

Text Entry

o Switch between Lower Case & Upper Case
o Switch between Single-byte & Double-byte

@ Cycle Characters in Reverse Order
@ Undo Last Operation

@ Move Cursor to Top/End of Text
® Overwrite & Insert Modes

o Insert Line Feed

o Input a Space

@ Use Dictionary

® Quote Text

@ Use Kuten Codes

Templates

o Edit a Folder Name
® Reset a Folder Name
o Edit Templates

® Reset Templates

Dictionaries

o Edit Entries

o Delete Entries

o Edit Title

® View Information
@ Delete Dictionaries

(»P.2-27)

(> P. 2-28)

(> P. 2-28)

Text Entry

o Set Text Input Method

@ Set Word Prediction

@ Set to Show T9 Suggestion Words in Kanji or
Hiragana

o Clear Learning History

e Change Font Size

® Set Auto Cursor Movement in 5-Touch Mode

(> P. 14-27)
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Phone Book

IOverview
_ﬂ Save phone numbers, e-mail addresses and other contact information to Phone Book.

1 . .
b Contacts & Settings ——— p—— Handy FUNCTIONS s—
=
_UO Entry Items Speed Dial
] (i - -EName & Reading Birthday Abbreviated dialing for numbers in Phone Book
9 EGroup Memo (P. 3-12).
o E4 Phone Numbers [ still Image
2 (£33 E-mail Addresses [ Entry Number
EIAddress QIO EN
. — Save frequently accessed Phone Book entries to
Custom Settings Tomo-Den (P. 3-12).
Incoming Ringtone Vibration
Incoming Image Outgoing Message Reject Calls
lllumination

Reject calls from phone numbers not saved in

m Phone Book (P. 4-5).

Secret Data

@ Back Up Important Information
Keep a separate copy of Phone Book entry information. When battery is exhausted or removed for extended periods, Phone Book data may be lost or
altered. Damage to handset may also affect data recovery. SoftBank is not liable for damages from lost/altered Phone Book data.

218



Creating Phone Book
Entries
<Example> Enter a name, phone number,

e-mail address and specify a
group

El ® = Phone Book > ® => @ =
Add to Phone Book => ® =>
Phone = ®

Pl & = @ = Enter family name =
® => Check reading => @ = [ =
@® = Enter first name => @ =>
Check reading => @®
Reading is entered automatically. Edit as
necessary.

M Add to Phone Book |

[EKNot Stored>
[EKNot Stored>
[®a10

Phone Book Entry Window
El @ > ® = selecta group = ®

] B => ® = Enter phone number
= (@ => Select an icon => ®
To save additional numbers, select
E <Not Stored> and repeat the same
step.

B = @ = Enter e-mail address
=> (@ => Select an icon => @

To save additional addresses, select

E] <Not Stored> and repeat the same
step.

a
Setting Incoming Image

EN [Phone Book Entry Window] => [
= @

P> To Capture an Image with Camera
Photo Mode => @ => Capture image
= @

P> To Select an Image in Data Folder
Select Image ~> ® = Select a folder
=> @ = Select a still image => @

Tip
* To cancel selected image, select Release This
and press ®.

Phone Book

Creating Entries from Other
Functions

Create entries from:
- Received calls
+ Redial
- Bar Code Reader
+ Receive/Sent Address List
- Yahoo! Keitai
+ Phone Number Entry window

- Dialed Calls
- Text Reader

<Example> Create an entry from Received
Calls

n © = Select a record => @ => Add
to Phone Book => ® =>Phone =>
®
P> To Save as New Entry
New => @

P> To Add to Existing Entry
Add => @ =>Search Phone Book =
Select an entry => @ (twice)

Phone number is entered.

P Enter other items => ® (= YES =>
@)

suonesadQ diseg P
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Phone Book

F1 ® or ® to switch tabs = @ =
Select an entry => ®

Resuming Phone Book Edit

Operati
If battery is empty or if another function was AkimaMasami
activated while editing an entry, resume o101
operation as follows: Pkinablasani

No Group
El ® = pPhone Book > ® = ® 8= e

Add to Phone Book > ® =>
Phone = ® = Recall —> ®

E Enter each item => &) (=> YES —>
@) Entry Details

Tip El © = select a number = (7]

« Save entry before you exit Phone Book. Press & for video calls.
Otherwise, all changes will be lost.

090392%%¥%0

Tip

« Alternatively, select a phone number from
Phone Book Entry List and press to make
a call. If there are multiple entries, the first
number is called.

IUsing Phone Book

Dialing from Phone Book

El ® => Phone Book => ®

Phone Book

OzawaEi suke

Phone Book Entry List

2-20

Specifying a Search Method
11 K@)

W Search Phone Book

[11Search Reading
Search Name
Search Phone No.
Search E-mail
Search Memory No.
Search Group
Search Column
Search All

Phone Book Search Window

1 select a search method = @
Search Reading:
Enter a reading and press @.
Search Name:
Enter a name and press @.
Search Phone No.:
Enter a phone number and press @.
Search E-mail:
Enter an e-mail address and press @.
Search Memory No.:
Enter three-digit entry number.
Search Group:
Select a group to view saved entries.
Search Column:
Press a key (7 - (0] or (3¢)) to access
the tab corresponding to that key.



Search All:
Phone Book is organized by tabs
(Japanese syllabary order).

Phone Boo

rrrr_rfmu

|
Ak imal

H 090392
OzawaEi suke

Phone Book Entry List

Tip
+ Phone Book entries saved on USIM Card are
indicated by ==/.

Accessing Entries from Other
Functions

Access Phone Book entries from Received
Calls, Dialed Calls, Redial and Received/Sent
Address List.

Access Entries from Received Calls

El © => select an item = @ =
Look-up Phone Book => ®

Access Entries from Dialed Calls

El ® = own Data => ® = Dialed
Calls => ® => Select an item => @
=> Look-up Phone Book > ®

Access Entries from Redial

El G = select an item = @ =
Look-up Phone Book —> ®

Access Entries from Received
Address List

n Press and hold ©) => Select an item
=> @ => Look-up Phone Book =

®

Access Entries from Sent Address List

EN Pressand hold @ = Select an item
=> @ => Look-up Phone Book =>

®

IPhone Book Settings

Customizing Handset Response

Set different ringtones, images, etc. per entry
item or Group.

Indicators

The following indicators appear for set items.

Ak imaMasami

010!
|AkimaMasami

No Group

1= &

090392%%¥*0

[REETEI=] 5=

E‘r Ringtone (Incoming Calls)

Hf Ringtone (Mail)

E‘:) lllumination (Incoming Calls)

B4 lllumination (Mail)

2% Vibrator (Incoming Calls)

B4 Vibrator (Mail)

EE Incoming Image (Calls)

B8 Outgoing Message (Incoming Calls)

Phone Book

suonesadQ diseg P
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Phone Book

To Customize by Phone
Number/E-mail Address

<Example> Set a ringtone for incoming voice
calls

EN [Entry Details] = & = Select a
phone number => @ => Ring
Tonellmage = ®

E Voice Call (Recv.) = ®

E] Ring Tone => ® => Select a
ringtone type => ® (=> Select a
folder => @ )(=> Select a ringtone

= @)

To Customize by Group

<Example> Set illumination for incoming
messages

EN [Phone Book Entry List] = @ =
Group Setting => ®

] selectagroup => @ => Ring Tonel
Image = @®

El mail (Recv.) = ®

I tiumination => ® = Selecta
pattern => @

222

Note

+ Custom Settings are unavailable for secret
Phone Book entries.

+ Custom Settings are canceled when entry is
set as secret.

Tip
* To cancel Custom Settings, select an item
with % and press ®.

Restricting Calls to/from Specific
Phone Numbers

Restrict calls to/from specific numbers in
Phone Book. This can help manage personal
calls and prevent nuisance calls.

n [Entry Details] = O = Select a
phone number => @ =>
Restrictions > ®

P Enter Security Code => @

B Select a restriction type => @
Restrict Dialing:
Permit outgoing calls to only one
number. Note that the number can only
be dialed from Phone Book.

Call Rejection:

Restrict incoming calls from a specified
number.

Call Acceptation:

Receive incoming calls only from a
specified number.

Tip
+ % indicates currently set restriction; to cancel,
select the setting and press (®).

When Restrict Dialing is Set

The following operations are disabled:
- Dialing by Keypad
+ Dialing from Received Calls
+ Calling from Phone Book
(except to the permitted number)
+ Creating Phone Book entries
+ Editing/deleting Phone Book entries
+ Copying Phone Book entries to/from USIM Card

Tip

* When Restrict Dialing is set, all records on
Redial, Dialed Calls and Sent Address List are
deleted.

* Emergency calls (110, 119 and 118) are
available even when Restrict Dialing is set.

« If you change or delete the specified number,
the set restriction is canceled.
Cancel Restrict Dialing to edit or delete.



Setting Secret Entries

Prevent others from accessing certain Phone
Book entries.
@ Phone Book entries set as secret only appear in
Secret Mode or Secret Data Only Mode
(P. 4-6).

EN [Entry Details] = @ => Set Secret
= @®

Tip
» To cancel Secret Setting:
[Entry Details] => @) => Release Secret =

* Entries saved while Secret Mode or Secret
Data Only Mode is active are saved as secret
entries.

» When a Tomo-Den entry is set as a secret
entry, the entry’s Tomo-Den setting is
canceled.

Managing USIM Phone Book

Phone Book entries can be copied between
handset and USIM Card.

El ® = rools = @ = usim
Operation => ® => Enter Security
Code = ®

F1 copy -> ® => Phone— USIM or
USIM—Phone > ® => Phone
Book —> ®

B Search Phone Book

7 select an entry => @
Repeat this step to specify other entries.

He®>yves>®
Note

* Items that cannot be saved to USIM Phone
Book are not copied.

* Phone Book entries set as secret cannot be
copied.

+ All handset transmissions are unavailable
while copying entries.

0 More Features

Saving Additional Information
@ Save an Address or Memo
@ Save Birthday
@ Change Entry Number
(> P. 2-29)

Phone Book

Phone Book Search

® Sort Phone Book Search Results

@ Change Index Tab of Phone Book Entry List

@ Change Font Size

@ Change Phone Number/E-mail Address Order

@ Compose an S! Mail from Phone Book

@ Compose an SMS Message from Phone Book
(> P. 2-29)

Managing Phone Book

@ Check Custom Ringtone/Image Settings by Item

@ Cancel Custom Ringtone/Image Settings by
Item

@ Check Restriction Settings by Restriction Type

@ Cancel Restriction Settings by Restriction Type

® Check Number of Phone Book Entries

o Edit a Phone Book Entry

@ Copy a Phone Book Entry

o Send Entries by S! Mail

o Delete Entries

o Delete Items from an Entry

o Delete an Entry from USIM Card

suonesadQ diseg P

(> P. 2-30)
Customize
Phone Book
o Set Preferred Search Method
@ Change Group Name
(> P. 14-12)
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S! Addressbook Back-up

IOverview

Back up handset Phone Book to server.

@ Separate subscription required.

@ See SOFTBANK MOBILE Corp. Website
(http://www.softbank.jp) for details.

@ Service subscription sets Auto Sync Settings
to ON during network information retrieval
(Cycle Settings: After Editing Ph.Book, Sync
Type: Synchronize).

Synchronization will automatically begin 10
minutes after you edit Phone Book.

@ Even if Auto Sync Settings is set to OFF,
setting returns to ON after network
information is retrieved again.

@ After unsubscribing, make sure that Auto
Sync Settings is set to OFF.

224

Note

« Fully charge battery beforehand.

* When Auto Sync Settings is ON, editing
entries automatically synchronizes, backs up
or downloads updated entries. Packet
transmission fees are incurred.

All data in the server Phone Book will be
deleted if Synchronize, Sync from Client or
Backup is performed after deleting all data in
handset Phone Book.

All data in handset Phone Book will be deleted
if Synchronize, Sync from Server or Restore
is performed after deleting all data in the
server Phone Book.

The following Phone Book items are not
synchronized.

=Still Image

—Entry Number

-Ring Tone

—lllumination

-Vibrator

-Incoming Call Image

-Outgoing Message

Using S! Addressbook
Back-up

Synchronizing Phone Book

Connect to Phone Book backed up on server
and bring it up to date with handset's Phone
Book.

@ The first time you synchronize will be in
Synchronize regardless of the setting.

@ Synchronization can be any of the following
types.

Synchronize Synchronize handset
Phone Book and server
Phone Book. Both Phone
Books are synchronized

with the newest

information.

Sync From Copy updated

Client information to server
Phone Book.

Sync From Copy update information

Server to handset Phone Book.

Backup Back up handset Phone
Book to server (note that
Server Phone Book is
deleted).

Restore Restore server Phone Book

to handset (note that
handset Phone Book is
deleted).




S! Addressbook Back-up

El ® = rools = @ =
S! Addressbook Back-up > ®) 0 More Features

[1IStart Sync
BAuto Sync Settings S! Addressbook Back-up W
8ync Log o Delete Synchronize Log -
(»P.2-31) n
g
S! Addressbook Back-up "E
@ Set Auto Synchronize g
@ Set Auto Synchronize Off [}
S! Addressbook Back-up Window ® Check Auto Synchronize Settings 3
(> P. 14-12)

F1 start Sync => @ => Enter Security
Code > @®

B Select type of synchronization =
® = YES > ®
Synchronization starts. Synchronization
results appear after completion.

4]
Checking Synchronize Log

n [S! Addressbook Back-up Window]
=> Sync Log => ® = Select an
item = @
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E Advanced Features

IMain Menu

Change Main Menu Theme

®=> ® = Select a pattern => @ (= YES
or NO => @)

Edit Title of a Desktop Icon

@ => Select an icon => @ => Edit Title =>
® => Enter title => @

Switch to Simple Menu

@®@=> @ => Simple Menu => ® (= YES

or NO => @)

[Z11n Simple Menu, font size is larger and menu
options are limited to basic ones.

Change Icon Image

© => Select an icon => @ = CHG Icon

Image > ® => Select Icon Image —> ® =>

Select a folder = @ => Select a file => @

[Z1To reset icon image, select Default Icon
Image and press ®).

Delete Desktop Icons

© => select an icon => @ = Delete => @
® To Delete the Selected Icon
=> Delete This => @ => YES => @
® To Delete Multiple Icons
=> Delete Selected = @ = Select icons =
@©@=>@=>YEs—>®
@ To Delete All
=> Delete All = @ => YES => @

Temporarily Change Design Theme of Main
Menu

@®> ® = select a theme =
[Z]Next time you open Main Menu, default
Main Menu returns.

Check Icon Information

@ = select an icon => @ = Icon Info
Setting > ®

Reset Desktop Icons

@ => @ => Reset Desktop => ® => YES
=@

IDesktop Icons

Delete Notifications

@ => Press and hold

Change Order of Desktop Icons

@ =>Select an icon => @ => Sort => @ >
YES => @ => € = Select a position => @

Change Theme of Desktop Icons

® => ® => Change Desktop ~> ® =
Select a theme => @ => YES => @

2-26

Show/Hide Desktop Icons

© => ® = Display Setting => @ =

Display always or Display at Use => @ (>

®)

[ElWhen Display at Use is set, Desktop lcons
only appear when you press @ in Standby.




IText Entry

Start Here
[Text Entry Window].......cccoeerreennrnnenas P. 2-10

Functions Before Entering Text

Switch between Lower Case & Upper Case

[Text Entry Window] => @ = Lower Case
or Upper Case => @

Switch between Single-byte & Double-byte

[Text Entry Window]=> @ => Single-byte
or Double-byte => @

Functions While Entering Text

Cycle Characters in Reverse Order

[Text Entry Window] = Input a character
=
£ This procedure is available in 5-touch mode.

Move Cursor to Top/End of Text

[Text Entry Window] => @ => Jump => ®
=> To Beginning or To End => ®

Overwrite & Insert Modes

[Text Entry Window] => @ = Overwrite or

Insert => ®

[Z] Text entry windows always open in Insert
mode.

Insert Line Feed

[Text Entry Window] =>

[Z)Press @ to insert line feed at the end of text.

Input a Space

[Text Entry Window] => @ => Space => @
[Z)Press @ to add a space at the end of text.

Advanced Features

Use Dictionary

[Text Entry Window] => @ => Refer Dic. =>

®

® To Enter a Word
=> Enter Word => @ => Enter word => @
=> Select a dictionary = @ => Select a word
=> (® => Read descriptions of the word

® To Select Area
=> Select Area => ® => Move cursor to
beginning of word => @ => Move cursor to
end of word = @ => Select a dictionary =>
® = Select a word = @ => Read
descriptions of the word

@ To Enter a Word from Search History
=> Reference History = @ = Select a
word => @ => Select a dictionary => @ =>
Select a word = @ => Read descriptions of
the word

[ )
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Undo Last Operation

[Text Entry Window] = Press and hold
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E Advanced Features

Quote Text

[Text Entry Window] = @ => Quote Data
= ®
@ To Quote from a Phone Book Entry
=> Quote Phonebook = ® = Search
Phone Book = Select a data item to quote
text from => @ =>
@ To Quote from Account Details
=> Account Details => ® = Enter Security
Code => @ = Select a data item => @ =>
@ To Scan Text by Text Reader
=> Text Reader = ® => Scan text with
camera => ®
@ To Scan Bar Code by Bar Code Reader
=> Bar Code Reader => ® = Scan a bar
code with camera => @

Use Kuten Codes

[Text Entry Window] => @ = Kuten Code
=> (@ => Enter kuten codes (P. 15-13)

I Templates

Start Here

[Templates (Common phrases) Window]
P.2-14

[Templates List]......cccocrvereriernnsencnesannnns P. 2-14

Edit a Folder Name

[Templates (Common phrases) Window] =>
Select a folder => @) => Edit Folder Name
=> (@ = Enter folder name => @

Reset a Folder Name

[Templates (Common phrases) Window] =>
Select a folder => @ = Reset Name —> ®
=> YES => @

Edit Templates

[Templates List] = Select a template = @
=> Edit => @ => Edit phrase => @

Reset Templates

[Templates List] = Select a template => @
® To Delete the Selected Template
=> Delete This => @ => YES => @
@ To Delete All
=> Delete All => @ => Enter Security Code
= @ => YES > @
5] User entries are deleted, and preinstalled
templates return to default.

IDictionaries

Start Here
[Own Dictionary Window]................... P. 2-15
[Downloaded Dictionary Window]...... P. 2-15

Own Dictionary

Edit Entries

[Own Dictionary Window] = Select an
entry => ® = Edit word => @ => Edit
reading => @




Delete Entries

[Own Dictionary Window] => Select an
entry => @ = Delete => @
o To Delete the Selected Entry
=> Delete This => @ => YES => @
® To Delete Multiple Entries
=> Delete Selected = ® => Select entries
2@ =>0® > YES=> @
@ To Delete All
=> Delete All => @ => Enter Security Code
= @ => YES > @

Downloaded Dictionaries

Edit Title

[Downloaded Dictionary Window] => Select
a dictionary => @ = Edit Title => @ >
Edit title => @

View Information

[Downloaded Dictionary Window] => Select
a dictionary => @ => Dictionary Info —> ®

Delete Dictionaries

[Downloaded Dictionary Window] => Select
a dictionary => @
@ To Delete the Selected Dictionary
=> Delete This => @ => YES => @
® To Delete All
=> Delete All => @ => Enter Security Code
> @ > YES > @®

IPhone Book

Start Here

[Phone Book Entry Window] ............... P.2-19
[Phone Book Entry List]... ....P. 2-20
[Entry Details] ....P. 2-20

Saving Additional Information

Save an Address or Memo

[Phone Book Entry Window] => E or
=> (@ => Enter content => @ (> &>
Select an icon => @)

Advanced Features

Save Birthday

[Phone Book Entry Window] => =@
=> Enter date of birth => @

Change Entry Number

[Phone Book Entry Window] = [l => @
=> Change entry number => @

Phone Book Search

Sort Phone Book Search Results

[Phone Book Entry List] => @ => Sort = @
=> Select a criterion => @
[ZINot available for all search methods.

Change Index Tab of Phone Book Entry List

[Phone Book Entry List] = @ = Change
Display => ® = Alphabet, Memory No. or
Group => @®

[ )
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Change Font Size

[Phone Book Entry List]/[Entry Details] =
@ => Font Setting —> ® => Standard
Font, Big Font (or Small Font) => ®
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E Advanced Features

Change Phone Number/E-mail Address
Order

[Entry Details] = Select a phone

number/e-mail address = @ => Move to

Top => @

[Z1 This procedure is available when more than
one phone number/e-mail address is saved to
a Phone Book entry.

Compose an S! Mail from Phone Book

[Entry Details] => € => Select an e-mail
address = @ => Compose S! Mail

Compose an SMS Message from Phone
Book

[Entry Details] => € = Select a phone
number => @ => Compose SMS ~> ® =
Compose SMS message

Managing Phone Book

Check Custom Ringtone/Image Settings by
Item

[Phone Book Entry List] => @ => Ring Tone/
Image => ® = Select an item with % =>

[Z] Select another item with % to view that
setting.

Cancel Restriction Settings by Restriction
Type

[Phone Book Entry List] => @ =>
Restrictions —> ® = Enter Security Code

=> @ => Select a restriction type with % =>
@ => Release Settings > @ => YES => @

Cancel Custom Ringtone/Image Settings by
Item

[Phone Book Entry List] = @ = Ring Tone/

Image => ® => Select an item with % =

® => Select an item with % => @ =

Release Settings => @ = YES => ®

[Z]When the same ringtone/image is set for
multiple entries, canceling the setting for one
entry cancels setting for all entries.

Check Number of Phone Book Entries

[Phone Book Entry List] => @ => No. of
Phone Book => ®

Edit a Phone Book Entry

[Entry Details] <> @ => Edit Phone Book >

@® => Edit each item => ® (= YES => @)

[Z)select [[f and edit the entry number. The
edited entry is saved as a new entry and the
original entry remains as before.

Check Restriction Settings by Restriction
Type
[Phone Book Entry List] => @ =>

Restrictions —> ® = Enter Security Code

=> (@ => Select a restriction type with % =
® = Check Settings —> @

Copy a Phone Book Entry

[Entry Details] => @ => Copy to USIM or
Copy from USIM => @ => YES => @

Send Entries by S! Mail

[Phone Book Entry List] = @ = Attach to
Mail => @ => Compose S! Mail =>




Delete Entries

[Phone Book Entry List] = Select an entry

=> @ => Delete Data > ®

o To Delete the Selected Entry
=> Delete This => @ => YES => @

® To Delete Multiple Entries
=> Delete Selected = ® => Select entries
2@ =>0® > YES=> @

@ To Delete All
=> Delete All => @ => Enter Security Code
> @ > YES=> @ > YES = ®

[Z)1f an entry is also saved to Tomo-Den,
confirmation appears. Select YES to delete.

Delete Items from an Entry

[Entry Details] = € = Select an item => @
=> Delete Data = ® = Delete Phone No.,
Delete Mail Add., Delete Address, Delete
Birthday, Delete Memorandums or Delete
Image => @ => YES => @

Delete an Entry from USIM Card

® => Tools => ® => USIM Operation =>
® => Enter Security Code = @ => Delete
=> @ => USIM => ® => Phone Book => ®
=> Search Phone Book = Select an entry
2@ =>® >YES=> @

IS! Addressbook Back-up

Start Here
[S! Addressbook Back-up Window].....P. 2-25

Delete Synchronize Log

[S! Addressbook Back-up Window] => Sync
Log => @ => Select Log => @
@ To Delete the Selected Log
=> Delete This => @ => YES => @
@ To Delete Multiple Logs
=> Delete Selected = ® => Select Log =>
@©@=>@>YEs—>®
@ To Delete Al
=> Delete All => @ => Enter Security Code
> @ > YES > @®

Advanced Features
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E Overview

Voice call and video call are available on handset.

Voice Cal| m—
Make Calls to:

]
i

SoftBank
Handsets

Non-SoftBank
Mobile Phones

it

Landlines

Video Call m——
Make Calls to:

%Qﬁ

SoftBank Non-SoftBank Landlines
Handsets Mobile Phones

Other party must use a video call
compatible phone

| .

Calling Abroad
from Japan
Make/receive voice and

Int @ al
video calls.

* International phone service available without
separate application.

-

Using Handset Abroad
Handset is Global Roaming
Service eligible. (Prior application
may be required.)

* For details, see:
http://mb.softbank jp/en/global_services/global_roaming/
or contact SoftBank Mobile Customer Center,
General Information (P. 15-51).

Emergency Calls

Your location is automatically reported to the
corresponding agency (police, etc.) when you
place emergency calls (110, 119 or 118) with
SoftBank 3G handsets.

(Emergency Location Report)

@ Registration and transmission fees do not apply.

@ Positioning accuracy is affected by location and
signal conditions. Always provide your location
and purpose on the phone.

@ Location Information is not reported when:

- The call is placed without Caller ID (e.g.
prefixed by 184). However, the corresponding
agency may obtain your Location Information
in a life threatening situation.

- Abroad (International Roaming)

Emergency calls are possible even while
some handset restrictions are active.

« Restrict Dialing (P. 2-22)

+ Keypad Lock (P. 4-4)

+ Set Max Cost Limit (P. 14-14)
+ Emission OFF Mode (P. 4-5)

+ PIN1 Code Entry Set (P. 4-2)




IMaking Voice Calls
n Enter phone number

PHONE NUMBER

Phone Number Entry Window

H Correcting Misentries
=> € to scroll cursor => to delete
(press and hold to delete all numbers to
the left) => Reenter number(s)

M Deleting Phone Number
= (=]

Voice Call Window

E]l = toend call

Note

* The other party may hear a short beep when
(0Jto (9], or are pressed during a
call.

Tip

+ Always include the area code even when
dialing from the same area.

» When you hear a busy tone, the other party is
on another line.

* When you hear a message saying that the
other party cannot be reached, the other
party’s mobile phone is off or is out of signal
range.

» When you hear a message asking for your
caller ID, call again with your number
revealed.

» 15 seconds into a voice call, Display backlight
becomes dim. If no keys are pressed for 15
seconds, Display turns off and handset enters
Power Save Mode. Calls are not disconnected
and handset operations are available even in
Power Save Mode.

» Connect stereo earphone-microphone to
make or take calls with handset closed.

Voice Call E

Adjust Earpiece Press and hold @

Volume
Elw- or E]Musm
Hold Call

Ilnternational Calls
Application not required.

n Enter phone number => @ = Int’l
Call > ®

P select a country code => @=>
Select an international prefix
number => @ =>

El (=toend call

6u!||23P
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E Voice Call

IAnswering Voice Calls
EN when a call arrives =

ﬂ Pl (= to end call

A Tip

Q » When receiving calls from abroad, mobile
= phone numbers appear as "country code +
g phone number (initial 0 is omitted)."

Recording the Other
Party’s Voice

n Press and hold [y during a call
A short beep sounds through the
earpiece and recording starts. When
remaining recording time reaches five
seconds, a short beep sounds. When
recording is finished, two short beeps
sound.

To stop recording, press @® or press and
hold Buusic-

IAnswering Machine

Record caller’'s messages on handset when
you are unable to answer voice or video calls.

Setting Answering Machine

El ® = settings > @ = Incoming
Call => ® => Answering
Machine = @®

Fl on => ® = select an outgoing
message => @

B Enter ring time

Tip

* When Voice Mail or Call Forwarding is
activated, set a shorter ring time for
Answering Machine.

* Alternatively, press and hold to set/cancel
Answering Machine from Standby.

+ Answering Machine is unavailable when
handset is off, out-of-range or in Emission
OFF Mode; use Voice Mail (P. 3-14).

When a Call Arrives

Outgoing message plays after the set ring time.
When caller’s voice/video message is recorded,
Missed Call and Answering Machine Indicators
appear in Standby.

RECORDING
MESSAGE

Recording Messagel

B To Answer Call during Recording
=(Jor®

Activate When a Call Arrives

Activate Answering Machine when unable to
answer an incoming call. Answering Machine
setting returns, after message is recorded.

n When a call arrives = Hyusic
Answering Machine is activated and
starts recording.



Note

« Answering Machine cannot be activated when
memory is full.

Tip
« Alternatively, press (#) when a call arrives.

When answering with (], handset enters
Manner Mode.

IPIaying Messages

El © = select notification & or &,
=@®

¢ Play/Erase Msg.
[TAnswering Machinel
B Answering Machine2
B Answer ing Machine3

@ Answering Machined
B Answer ing Machine5
BVoice Memo

Play/Delete Voice Message Window

Items with a message recorded are
indicated by *.

F1 select a message => @
Tip
+ To delete a message while playing it:
@) = Erase => @ = YES => (®)

Operations during Playback

Play Next Message s
Stop ®or
Return a Voice Call
Return a Video Call

Tip

* Pressing in Standby also plays recorded
voice messages. When there is a voice memo
but no voice message, the voice memo plays.

« To play voice messages from Main Menu:

(® = Tools => @ = Play/Erase Msg. =
®

Operations during
Message Playback

Voice Call E

Play Previous/Next (C)
Message

Adjust Volume ()

vi— or BMusic

Pause/Play ®

Stop
Return a Voice Call
Return a Video Call

Tip

* To play video messages from Main Menu:

® = Tools => @ => Play/Erase V/C Msg.

=@®

ﬁu!"e;)P
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E Voice Call

0 More Features

Outgoing Call Functions

® Show/Hide Caller ID

® Add Area Code and Country Code (Prefix Numbers)
(> P. 3-16)

International Calls
o Enter “+" to Call Abroad
(> P. 3-16)

Handling Incoming Calls
@ Reject Calls
® Place Calls on Hold
o Forward Calls
o Forward Calls to Voice Mail Center
(> P. 3-16)
Engaged Call Operations
® Handsfree
© Make Other Party Clearer to Hear (Hyper Clear Voice)
® Send Touch Tones
(»P.3-17)
Answering Machine
o Delete Recorded Messages
(> P. 3-18)

Display Settings
@ Set an Outgoing Call Image
@ Set Image or Video for Incoming Call
(> P. 14-4)

Incoming Call Alerts

o Adjust Ringtone Volume

@ Set a Ringtone

® Set Random Playback of Melodies as Ringtones

® Set Vibration

o Set lllumination Color

o Set lllumination Pattern

@ Set lllumination to Flash for Missed Calls

@ Set Handset Action When Handset Opened

@ Set an Incoming Call Image

@ Show Phone Book Entry Images for Incoming Calls
(> P. 14-8)

Answering Incoming Calls
o Set to Answer Calls by Pressing Any Key
@ Set to Mute Ringtone by Pressing Any Key

(> P. 14-9)
Sounds
® Record Sound to Set as Ringtone or Outgoing
Message
o Play Recorded Sound
® Delete Recorded Sound
(> P. 14-10)

Earphone-Microphone
e Audio Output

@ Microphone Setting
® Answer Calls Automatically
@ Save a Phone Number for One-touch Dialing
from Earphone-Microphone
(»P. 14-11)

Outgoing Calls
@ Save Area Code and Country Code as Prefix Numbers
@ Save Touch Tones
® Set Numbers after “ %" as Sub Address
(> P. 14-12)

International Calls
@ Change International Access Code
Automatically Dialed with "+
@ Change a Country Code
@ Save an International Access Code
(> P. 14-13)

Call Settings
® Set Reconnection Tone
® Set Noise Reduction
® Set Weak Signal Alarm
o Set Clarity of Other Party Voice
® Change Color of lllumination While Calling
@ Set Outgoing Message while Call is on Hold
o Set Closing Sound Off
e End Call By Closing Handset
(> P. 14-13)




IVideo Call Window

Main
window
Call time

Video call
indicators

Video Call Indicators

[V Mute

Call in progress.

Press (= to place call on hold.
Callis on hold.

Press to return to call.

& Hyper Clear Voice High
Hyper Clear Voice Low

Transmitting Audio
Transmission Failed

Transmitting Video
Transmission Failed

Sending Outgoing Image via Rear Camera
Sending Alternative Image

Handsfree ON
Handsfree OFF

Photo Mode Portrait
Photo Mode Scenery
Photo Mode Close-up

IH 44 BREE 28|06

€l

Video Call

IMaking Video Calls
n Enter phone number

PHONE NUMBER

6ug||e:)P

Phone Number Entry Window

Ml Correcting Misentries
=> € to scroll cursor=> to delete
(press and hold to delete all numbers to
the left)=> Reenter number(s)

H Deleting Phone Number
= (=)



E Video Call

2 §©)

(CieaA]
[AlVISEd
AkimaMasanmi
090392%¥¥x0
Video Call Window
El (=toend call
Note

* The other party may hear a short beep when
(0Jto (9], or are pressed during a
call.

Tip

» Always include the area code even when
dialing from the same area.

+ Emergency calls (110, 119 and 118)
automatically switch to voice calls.

+ An error message appears when connection

fails.

Front Camera is unavailable on 840N. Use

Rear Camera image or Alternative Image for

outgoing image.

If recording a TV program during a video call,

charging handset may cause Camera to

switch off. This depends on handset

temperature and usage condition.

Connect stereo earphone-microphone to talk

with handset closed.

Operations during Video Calls

Adjust Earpiece
Volume

@ or press and hold @

Her- or Hhuse

Hold Call

Toggle Main and | Press and hold @ to toggle
Sub Window Main window image as
Images follows: Other party’s

image — Your image —
Other party’s image (sub
window off) = Your image
(sub window off)

Toggle Camera/
Alternative
Images

®

Zoom In/Out
Outgoing
Camera Image

o

Mute Audio

Press and hold -
To cancel mute, press
again.

IAnswering Video Calls

EN when a video call arrives =>
Alternative Image is sent.

Pl (= to end call



0 More Features

Outgoing Call Functions

® Show/Hide Caller ID

® Add Area Code and Country Code (Prefix
Numbers)

(> P. 3-16)
Handling Incoming Calls
® Reject Calls
o Place Calls on Hold
o Forward Calls
(> P. 3-16)

Engaged Call Operations
® Handsfree
® Make Other Party Clearer to Hear (Hyper Clear
Voice)
@ Set Image Quality
o Adjust Brightness
@ Change White Balance
@ Change Color Tone
e Change Photo Mode
@ Backlight lllumination Time
(> P. 3-17)

Display Settings
@ Set an Outgoing Call Image
@ Set Image or Video for Incoming Call
(> P. 14-4)

Incoming Call Alerts
o Adjust Ringtone Volume
@ Set a Ringtone
® Set Random Playback of Melodies as Ringtones
® Set Vibration
o Set lllumination Color
o Set lllumination Pattern
@ Set lllumination to Flash for Missed Calls
@ Set Handset Action When Handset Opened
@ Set an Incoming Call Image
@ Show Phone Book Entry Images for Incoming
Calls
(> P. 14-8)
Answering Incoming Calls
® Set to Answer Calls by Pressing Any Key
@ Set to Mute Ringtone by Pressing Any Key

(> P. 14-9)
Earphone-Microphone
® Audio Output
o Answer Calls Automatically
(»P. 14-11)

Outgoing Calls
@ Save Area Code and Country Code as Prefix
Numbers

o Set Numbers after “ %" as Sub Address
(> P. 14-12)

Call Settings
@ Set Reconnection Tone
® Set Noise Reduction
o Set Weak Signal Alarm
@ Set Clarity of Other Party Voice
@ Change Color of lllumination While Calling
@ Set Outgoing Message while Call is on Hold
@ Set Closing Sound Off
e End Call By Closing Handset
(> P. 14-13)

Video Calls

@ Set Outgoing Image for Video Calls

® Redial Automatically as Voice Call When Video
Call Connection Fails

@ Set an Image to Appear in Main Window

@ Automatically Switch to Handsfree Mode in
Video Calls

(> P. 14-14)

Video Call E

ﬁu!"e;)P

39



Bu!ueah

3-10

E Call Logs

IDiaIing from Call Logs

Phone numbers and dates and times of
incoming and outgoing calls are saved on
handset as call logs. Access call logs to return

calls quickly.

Call Log Indicators

The following indicators appear in Redial,
Dialed Calls and Received Calls windows.

Voice Calls

Outgoing & Incoming
Missed

2 Unchecked Missed

International Calls
Outgoing & Incoming
=] Missed

@ Unchecked Missed

Video Calls

Outgoing & Incoming
Missed

2 Unchecked Missed

International Video Calls
Outgoing & Incoming
%] Missed

Unchecked Missed

Answering Machine
Voice Messages
Video Messages

Packet Transmission

[ﬁl Outgoing & Incoming Calls
Appears when outside the GMT+09 time
zone.

Redial/Received Calls

El Gor©

(G o

6/28 20:21
ZKitagawaRikio

6/27 11:56
ZNakayamaTaro

0 6/26 21:13

090392%kkk7
6/25 10:32

B

B

0903924048
6/15 14:26
0zawaE isuke
@ 6/11 8:53

B

S0zawak i suke
6/20 19:56

B

090392446

[ AkimaMasami
Redial Window Received Calls Window

3 select arecord => ® > or

Dialed Calls

El ® => own Data -> ® => Dialed
Calls => ®

Dialed Calls 1/2

[y o

TKi tagawaRikio |
6/27 11:56

TNakayamaTaro
@ 6/26 21:13

090392%kkk7
6/25 10:32

ZS0zawaEi suke
@ 6/20 19:56

0903924kkk6

/G

Dialed Calls Window

A selectarecord => @ <> (ZJor

Checking Number of Missed Calls

El ® = ownpata = ® =
Received Calls > ®
The total number of incoming calls,
number of missed calls, and number of
unchecked missed calls appear.

F1 Al calis or Missed Calls > ®



Missed Calls

lllumination flashes.

Select the “Missed Call” icon to check details or
select the icon and press and hold to turn off
illumination.

ICaII Time & Cost

Check the total and last call times and costs.

Call cost and cost limit may be unavailable

depending on your subscription.

El ® = settings = ® => Call Timel
Charge => ® => Call Data > ®

Tip

* Use indicated call times and costs only as a
guide. The actual call time and cost may be
different. Your handset may not indicate call
costs depending on the service you subscribe.
Indicated costs do not include consumption
tax.

» When the last or total call time exceeds 199
hours 59 minutes 59 seconds, counting
restarts from zero seconds.

0 More Features

Redial, Dialed Calls & Received Calls
e Change Font Size

® Show Ring Time (Missed Calls)

@ Delete Records

(> P. 3-18)
Call Time & Cost
® Reset Total Call Time
@ Reset Total Call Cost

(> P. 3-18)

Pd Customize

Incoming Call Alerts
o Set lllumination to Flash for Missed Calls
@ Set Handset Action When Handset Opened
(> P. 14-9)

Checking Call Logs

o Notify Missed Calls with Tone (When s
Pressed)

@ Change Colors of Names, Phone Numbers and
E-mail Addresses in Call and Message Log
Windows

(» P. 14-10)

Call Costs
® Set Auto Reset of Total Call Cost
@ Set a Maximum Call Cost Limit

Call Logs E

(> P. 14-14)

5ug||e:)P



E Speed Dialing

ISpeed Dial

Enter Phone Book entry number (000 to 009)
and press for direct access to that entry.
@ If a Phone Book entry has more than one

Fl @te@=Dor®

ITomo-Den

Save up to 10 Phone Book entries to

Tomo-Den for quick access.

@ Tomo-Den is unavailable in Secret Data Only
Mode.

@ Tomo-Den is available in Secret Mode,
however secret entries cannot be saved to
Tomo-Den.

312

phone number, handset dials the first number.

Saving Entries to Tomo-Den Using Tomo-Den

1 v

no photo

<Not Stored>
Pl
Gl
ST

= SMS.

Tomo-Den Window

Fl © = select a tab =
P> To Search from Phone Book
View Phone Book ~> ® = Search
Phone Book = Select an entry => @
P> To Enter the Information
Direct input => ® = Enter items =>

B Select a phone number or e-mail
address = @®
When a checkbox is selected, other
numbers/addresses become grayed and
cannot be selected. To select another
number/address, first cancel the
currently selected checkbox.

ae

1 v

Pl © => Select an entry => CALL,
S! Mail or SMS > ®
Tip
« Alternatively, press (1 -0 Jin Step 2 to
select a recipient.

@ More Features

Speed Dial

o Cancel Entries from Tomo-Den

@ Change Tomo-Den Entry Image

® To Send an S! Mail to All Tomo-Den Entries
(> P. 3-18)



Make calls while overseas.

@ Global Roaming Service may require prior
application. Details are available online at
http://mb.softbank jo/en/global_services/global_roaming/
or contact SoftBank Mobile Customer Center,
General Information (P. 15-51).

@ 840N is compatible with 3G network only.

Countries
EN Press and hold (T0)

“+" is entered.

ICaIIing Japan and Other

1 Enter country code and phone
number (omit first “0” from area
code) =>

Tip
+ Do not omit the first “0” from area code
when calling Italy.

Calling within the Same
Country

n Enter phone number with area
code =>
Do not omit “0” from area code.
Country code not required.

Calling While Abroad (Global Roaming)

0 More Features

Global Roaming
® Set Operator
® Search Available Operator
@ Set Priority for Operators
® Show Operator Name While Roaming
(» P. 14-15)

6u!||e3P
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E Optional Services

IOverview
The following services are available with your
handset.
_ﬂ Call Forward calls to a preset phone
9 Forwarding | number.
— Voice Mail |Forward calls to Voice Mail Center
=] when unable to answer a call.
© Missed Call Notification
Notification (SMS) arrives for
missed calls while handset was
off, out of range or engaged, etc.
Call . Place the current call on hold to
Waiting”  |answer another incoming call.
Talk with two parties alternately.
Group Call others during a call and talk
Calling* with multiple parties
simultaneously.
Call Select whether to restrict
Barring incoming and outgoing calls and
SMS.
Caller ID Select whether to show or hide
your number when making calls.

* Separate application is required.

3-14

Activating Call Forwarding

<Example> Forward calls to a specified
number after a set ring time

El ® = settings > ® >
Optional Services > @® =>
Voice MaillDivert => ®

Tip

« If No Answer is set, press to answer
incoming call before the call is forwarded. If
Always is set, handset does not ring/vibrate
and all calls are forwarded to the preset
number.

Call Forwarding and Voice Mail cannot be set
simultaneously. Call Forwarding for video
calls is only available with Voice Mail.

If you activate Call Forwarding when Voice
Mail has already been set, Voice Mail is
canceled.

Activating Voice Mail

<Example> Forward calls to Voice Mail
Center after a set ring time

n [Voice Mail/Divert Window] =
Voice Mail ON => ® => YES = ®

Pl No Answer => ® => Select a ring
time = @
To forward calls to Voice Mail Center
immediately, select Always and press @®).

% Voice Mail/Divert |
[1IPlay Messages

BVoice Mail ON

BDivert ON

@Voice Mail/Divert OFF
B6et Status
@Erase Icon

Voice Mail/Divert Window

F] Divert oN > ® > YES > @ =>
VoicelVideo Calls, Voice Calls or
Video Calls > ®
P To Enter Phone Number
Enter phone number => @

P To Search from Phone Book
@ =>Search Phone Book = Select an
entry = @ =>Select a phone number
=> (@ (twice)

B No Answer > ® > Select a ring
time => @
To forward calls immediately, select
Always and press @®.



Tip

« If No Answer is set, press to answer
incoming call before the call is forwarded to
Voice Mail Center. If Always is set, handset
does not ring or vibrate and all calls are
forwarded to Voice Mail Center.

* Voice Mail and Call Forwarding cannot be set
simultaneously. Voice Mail is only available
with Call Forwarding for video calls.

« If you activate Voice Mail when Call
Forwarding has already been set, Call
Forwarding is canceled.

Missed Call Notification

SMS notification informs you of missed calls while
handset was off, out of range, engaged, etc.

1 jan]rsanir:sive

Follow voice guidance.

To Play Messages

n [Voice Mail/Divert Window] =
Play Messages => ® => YES => (®
Tip
« Alternatively, dial 1416 to play messages.

Canceling Call Forwarding &
Voice Mail

n [Voice Mail/Divert Window] =
Voice MaillDivert OFF > ® =>
YES => ®

0 More Features

Call Forwarding & Voice Mail
@ Delete Icons for Notifying Recorded Messages
@ Check Current Setting Status

(»P.3-19)

Call Waiting
o Set Call Waiting
@ Answer Incoming Calls during Calls
@ Check Current Setting Status
(» P. 3-19)

Group Calling
o Hold Current Call to Make Another Call
® Switch Parties
o Talk with Multiple Parties Simultaneously
o Talk with a Specific Party
@ End Call with a Specific Party
(> P. 3-19)
Call Barring
@ Restrict Incoming/Outgoing Calls & SMS
o Cancel Call Barring

Optional Services

@ Change Network Password
@ Check Current Setting Status
(> P. 3-20)
Caller ID
® Show/Hide Phone Number
@ Check Current Setting Status
(> P. 3-20)

6ug||e;)P
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n Advanced Features

IOutgoing Call Functions

Show/Hide Caller ID

Enter phone number => @ => Notify Caller

ID => ® => OFF, ON or Cancel Prefix => ®

= or

[Z] Alternatively, enter “186" before the phone
number to show your number, or “184" to
hide your number.

[Z1 Show/hide Caller ID each time you dial from
Phone Book or call logs (Redial, Dialed Calls
or Received Calls).

ﬁu!ueah

Add Area Code and Country Code (Prefix
Numbers)

Enter phone number => @ => Prefix

Numbers => ® => Select an item => @ =>

or

|1 Save area codes and country codes
beforehand for quick access to prefixes.

[£] Add prefix from Phone Book entry, Redial,
Dialed Calls or Received Calls windows.

[2) EB#45 (International Dialing Code,
0046010) is set by default.

3-16

Ilnternational Calls

Enter “+” to Call Abroad

Press and hold (07 = Enter country code

=> Enter area code = Enter phone number

= => Dial => @

[21“+" appears when you press and hold (0],
indicating that the international code set in
Auto Int’l Call Set. is entered.

IHandIing Incoming Calls

Voice & Video Calls

Reject Calls

When a call arrives => @ = Call Rejection

= @®

Place Calls on Hold

When a call arrives = (—] => To answer
call =
[Z3Press (=) again to end the call on hold.

Forward Calls

When a call arrives => @ = Call
Forwarding => @
[E1 This procedure is available when Call

Forwarding has been activated from Voice
Mail/Divert window.

Voice Calls

Forward Calls to Voice Mail Center

When a call arrives=> @ = Call

Forwarding => @

£ This procedure is available when Voice Mail
has been activated from Voice Mail/Divert
window.




IEngaged Call Operations

Start Here
[Voice Call Window]
[Video Call Window]....

Voice & Video Calls

Handsfree

e P.3-3
w... P. 3-8

[Voice Call Window]/[Video Call Window]
=
£ Press ® again to cancel handsfree mode.

Make Other Party Clearer to Hear (Hyper
Clear Voice)

[Voice Call Window]/[Video Call Window]

= ®

[Z)Press ® to toggle setting High,
OFF or Low.

[Z] Unavailable when handsfree is On or when
an external device (ex. stereo
earphone-microphone) is connected.

Voice Calls

Send Touch Tones

[Voice Call Window] => @ (twice) =

Settings => ® => Dialing = @ => Pause

Dial => @® (three times)

@ To send touch tones all at once:
=> Press and hold @ = Send at one time
= @®

[Z)Each time you press (/7), a touch tone
sequence until “p” (pause) is sent.

[Z1 Save touch tones in advance (P. 14-12).

Video Calls

Set Image Quality

[Video Call Window] => @ => V. Call

Settings = ® = Visual Prefer. => @ =>

Select an item => @

[£1Only available when sending outgoing image
via Rear Camera.

Advanced Features

Change White Balance

[Video Call Window] => @ => V., Call

Settings = ® => White Balance > @ >

Select an item => @

[Z1Only available when sending outgoing image
via Rear Camera.

[ )

Change Color Tone

[Video Call Window] => @ => V. Call

Settings = ® => Color Mode Set => ® =>

Select an item => @

[£] Only available when sending outgoing image
via Rear Camera.

ﬁu!"e;)P

Change Photo Mode

[Video Call Window] => @ => V. Call

Settings => @® => Photo Mode => ® =>

Select a mode => @

[Z1Only available when sending outgoing image
via Rear Camera.

Adjust Brightness

[Video Call Window] => @ => V. Call

Settings = ® = Brightness => @ >

Select a level => @

[Z1Only available when sending outgoing image
via Rear Camera.

Backlight lllumination Time

[Video Call Window] => @ => Display Light
=> @ => All Time ON or 10 Seconds ON >
®

3.17
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E Advanced Features

IAnswering Machine

Start Here
[Play/Delete Voice Message Window]

Delete Recorded Messages

[Play/Delete Voice Message Window] =>

Select a message = @) => Delete This,

Delete Rec. Msg. or Delete All > ® => YES

= @®

[Z]Selecting Delete All also deletes a voice
memo if it has been saved.

P.3-5

ICaII Logs

Start Here

[Redial Window] ...P.3-10
[Dialed Calls Window] ...P.3-10
[Received Calls Window] .........ccceeeueeee P.3-10

Redial, Dialed Calls & Received Calls

Change Font Size

[Redial Window], [Dialed Calls Window] or
[Received Calls Window] = @ = Font
Setting = ® => Standard Font or Big Font

=@

Show Ring Time (Missed Calls)

[Received Calls Window] = @ = Ring
Time => @

Delete Records

[Redial Window], [Dialed Calls Window] or
[Received Calls Window] => @ => Delete
=@
® To Delete the Selected Record
=> Delete This => @ => YES => @
® To Delete Multiple Records
=> Delete Selected = ® = Select records
=@ =>® = YES > @
® To Delete All
=> Delete All => @ => Enter Security Code
> @ > YES > @®
[Z]Selecting Delete All in Redial window or
Dialed Calls window deletes all records from
both Redial and Dialed Calls.

Call Time & Cost

Reset Total Call Time

® <> Settings > ® => Call Time/Charge
=> (® = Reset Total => ® => Enter
Security Code = ® = Reset Total
Duration => @ => YES => ®

318

Reset Total Call Cost

® => Settings = ® => Call Time/Charge
=> (® = Reset Total => @ => Enter
Security Code = @ = Reset Total Cost =
® => YES => ® = Enter PIN2 = ®

ISpeed Dial

Start Here
[Tomo-Den Window]..........ccoveerenunncne P.3-12

Cancel Entries from Tomo-Den

[Tomo-Den Window] => €3 => Select a tab
=@
® To Release the Selected Entry
=> Release This => @ => YES => ®
® To Release All
=> Release All => ® = Enter Security Code
= @ = YES => @

Change Tomo-Den Entry Image

[Tomo-Den Window] => € => Select a tab
=> @ => Image => ® =>Select a folder =
® => Select an image => @




To Send an S! Mail to All Tomo-Den Entries

[Tomo-Den Window] = @ => Broadcast
Mail => ® = Create S! Mail =>

IOptionaI Services

Start Here
[Voice Call Window]
[Voice Mail/Divert Window]

Call Forwarding & Voice Mail

Delete Icons for Notifying Recorded
Messages

w. P.3-3
P.3-14

[Voice Mail/Divert Window] = Erase Icon
= @ => YES => @

Check Current Setting Status

[Voice Mail/Divert Window] => Get Status

= @®

Call Waiting

Set Call Waiting

@® => Settings —> ® > Optional Services
=> (@ = Call Waiting => ® => ON or OFF
=@ =>YES > @

Answer Incoming Calls during Calls

[Voice Call Window] => Call waiting tone
sounds =>
[Z)Press @ to toggle between two parties.

Check Current Setting Status

@® => Settings —> ® => Optional Services
=> (@ => Call Waiting => ® => Get Status
=@

Advanced Features

Group Calling

Hold Current Call to Make Another Call

[Voice Call Window] => => Enter phone

number =>

2370 dial from Phone Book, press @ or @,
search Phone Book, select a number and
then press (7.

2170 dial from Dialed/Received Calls, press @
or €, select a phone number or name and
then press (7.

Switch Parties

[Voice Call Window] => @
[Z)Press @ to toggle parties.

Talk with Multiple Parties Simultaneously

[Voice Call Window] => While talking with
one party => @ = Join Multi Party => ®

Talk with a Specific Party

[Voice Call Window] => While talking with

multiple parties = @ = Select Ans. Call

=> @ => Select a party => @

[Z1 The other parties are placed on hold while
talking with the selected party.

)
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n Advanced Features

End Call with a Specific Party

[Voice Call Window] => While talking with
multiple parties = @ = Select Disc Call =>
® => Select a party => @

Call Barring

Restrict Incoming/Outgoing Calls & SMS

@® => Settings => @ => Optional Services

=> (® = Call Barring > ® => Outgoing

Calls or Incoming Calls => ® => Select an

item => @ => YES => @® => Enter Network

Password = @

[Z1Emergency calls (110, 119 and 118) are
available even when Call Barring is set.

[Z1When Bar All Outgoing Calls or Bar All
Incoming Calls is set, Call Forwarding and
Voice Mail become unavailable.

[EIWhen Call Forwarding or Voice Mail is set,
Call Barring is unavailable.

[Z)1f Network Password is incorrectly entered
three times consecutively, Call Barring
settings are locked. Network Password and
Center Access Code must be changed. For
details, contact SoftBank Mobile Customer
Center, General Information (P. 15-51).

3-20

Cancel Call Barring

® => Settings —> ® => Optional Services
=> (@ = Call Barring => ® => Cancel All
Barring => @ = YES => @ => Enter
Network Password = @

Check Current Setting Status

® => Settings = ® => Optional Services
=> (® => Caller ID Notification => @ =>
Get Status > @

Change Network Password

® => Settings —> ® => Optional Services
=> (® = Call Barring => ® => Set NW
Password => ® = YES > @ = Enter
current Network Password => @ = Enter
new Network Password = @ => Enter new
Network Password again for confirmation

= @®

Check Current Setting Status

® <> Settings > @® = Optional Services
=> @ => Call Barring => ® => Get Status
=> @ => Select an item => @

Caller ID

Show/Hide Phone Number

@® => Settings > ® = Optional Services
=> (® => Caller ID Notification => @ =>
Activate/Deactivate => ® => ON or OFF =>
® =>YES=> @




Securlty

PIN Settings........cccvemrrersserssnisesssanssessennans
Setting PINT ENtry .....cocoeviiiiiiiiieeeceeee
Changing PINT/PIN2 ........ccccceienenieiienenieienne

Prohibiting Unauthorized Handset Use
Dial LOCK ..cveuiiuieiieieieieietete e .
Original LOCK .......cccouviieiienieiieiiiese e
Disabling Keypad .........ccccceieriirieiienienceceneee
Secure Remote Lock ......ccceeeriveiiieicinincnnne

Prohibiting Outgoing/Incoming Calls..
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Delaying RINgtone .........cccccoceiinencnincncccieene
Emission OFF Mode ..

Secret Modes .............
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Hiding Handset Data.........ccccccevieiiesiceneeseeeee
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- PIN Settings

| Setting PIN1 Entry | Changing PIN1/PIN2
Set to require PIN1 entry each time handset is @ PINT Code Entry Set must be set to ON
turned on. before changing PINT.
El ® = settings > ® => Security [l ® => Settings => @ > Security
=> (@ => PIN Setting > ® => (@ = PIN Setting -> ®
_nm E Enter Security Code => ® E Enter Security Code => ®
2 B PIN1 Code Entry Set => ® => ON B Change PIN1 Code or Change
£ = @ > Enter PIN1 => ® PIN2 Code > ®
~,
<

I3 Enter current PIN1/PIN2 => @

H Enter new PIN1/PIN2 => @ =
Enter new PIN1/PIN2 again for
confirmation => @®



IDiaI Lock

Prevent others from operating handset.

El ® = settings > @ > Security
=> (@ => Function Lock => ®

1 Enter Security Code => @

E] pial Lock => ®
Tip
» The following operations are available even in
Dial Lock.
- Power on/off

- Making emergency calls (110, 119 and 118)
- Answering incoming voice/video calls

Prohibiting Unauthorized Handset Use

Canceling Dial Lock Bl Enter Security Code = @

n Enter Security Code => @
If incorrect Security Code is entered,
press (—] and enter correct Security
Code.

Tip
« If Security Code is incorrectly entered five

times, handset powers off. Turn handset
power on and enter correct Security Code.

IOriginaI Lock

Prevent others from accessing handset
functions/data (e.g. Phone Book, Mail, etc).
Select from three locks (1, 2 or 3) and
customize as required.

Activating Original Lock

El ® = settings = ® = Security =
® = Function Lock > ®

Dial Lock
BOriginal Lock 1
B0riginal Lock 2
@0riginal Lock 3
S[0FF

Reset Lock

Lock Window

Aandas P

E] select an Original Lock => @
Functions/data specified under the
selected lock type are locked.

Tip

+ To edit title:

[Lock Window] => Select an Original Lock =>
® = Edit Title = @ = Edit title = @

« Security Code entry is requested when
accessing a locked function or data. Enter
Security Code to unlock and access function/
data. Original Lock setting returns when
handset returns to Standby.

+ Dial/Sending Mail and Incoming/Mail
Disp. cannot be unlocked temporarily.



ﬁ Prohibiting Unauthorized Handset Use

Kundag h

Customizing Original Lock

Set lock per function, group or category.
B= Some functions/groups are locked.
ML All functions in Group/Category are locked.

Customize by Function/Data

n [Lock Window] => Select an
Original Lock =>

F1 select a category = @
E] selecta group = ®

] select an item = @
Checked items are locked. To uncheck an
item, select the item and press ®.
H To Select All Functions
=> @ <> Select All => @

M To Deselect All Functions
=> @ = Release All => ®

[ ® (three times)

Customize by Category or Group

n [Lock Window] => Select an
Original Lock =~

P select a category (=> @ = Selecta
group)

El ® = select = ®

To deselect, press @), select Release and
then press @®).

M To Select Lock for Category or Group
= @ = Select All => ®

M To Cancel Lock for Category or Group
=> @ = Release All => ®

A e« e

IDisainng Keypad

Set Keypad Lock to automatically lock
handset keys. Customize Lock settings as
required.

Setting Keypad Lock

El ® => settings > ® => Security
=> (@ => Keypad Lock => ®

1 Enter Security Code => @
P> To Lock When Handset Closed
After Closed => @ => ON => @
P> To Lock After Handset Closed a
Certain Time
Timer => @ => Select time until lock
activates => @

He

Tip

+ All keypad operations are disabled, except for
answering incoming calls and turning power
on/off.

. appears at bottom of Display when
keypad operation is available in Keypad Lock.

+ Emergency calls (110, 119 and 118) are
available even when Keypad Lock is set.

Temporarily Unlocking Keypad Lock

EN Enter Security Code => @

ISecure Remote Lock

If your handset is lost, lock handset functions
remotely from a PC or other mobile phones.
All key operations are disabled except Power
Key. For details, visit SOFTBANK MOBILE
Corp. Website (http://www.softbank.jp), or
access My SoftBank from your handset:

&) => X=2—1X ;(Menu List) => @ => My
SoftBank —> ®



Rejecting Calls without
Caller ID

Incoming calls from hidden and/or
unidentified numbers can be rejected.

El ® = settings = ® => Security
=> (@ => Call Setting WIO ID >

®
1 Enter Security Code => @

E] Unknown, Payphone or User
Unset => ®

] Reject > ®
Tip

* To allow incoming calls, after Step 3:
Accept => (® => Select Ring Tone or Select
Calling Disp. => ® =>Select type = @ (=>
Select a folder = @) =>Select a ringtone or
image = @

Unsaved Numbers

El ® => settings > ® => Security
=> (@ => Reject Unknown => ®

1 Enter Security Code => @

IRejecting Calls from

Prohibiting Outgoing/Incoming Calls

E] Reject = @
Note

« This procedure is unavailable when Set Mute
Seconds under Ring Time (sec.) is set to ON
(P. 4-5).

Tip
* To allow incoming calls, after Step 2:
Accept => @

IDeIaying Ringtone

Delay ringtone, for callers not saved in Phone
Book (including Secret Phone Book). In
addition, set Missed Calls Display to Not
Display so missed calls with a short ring time
do not appear in Received Calls. This can
prevent you from accidentally returning calls
from nuisance calls.

El ® = settings > ® => Incoming
Call => ® => Ring Time (sec.) =

®

F1 set Mute Seconds => ® => ON =>
® = Enter time before ringtone

plays

E] missed calls Display = ® =
Display or Not Display > ®

Note

* This setting is unavailable when Reject
Unknown is set to Reject (P. 4-5).

Tip

* Setting Set Mute Seconds to OFF cancels
function and ringtone sounds immediately for
incoming calls.

IEmission OFF Mode

Activate Emission OFF Mode to suspend all
transmissions. Incoming and outgoing
calls/messages, Yahoo! Keitai, etc. become
unavailable.

El ® => settings > @ => Security
=> (@ => Emission OFF Mode >
® > YES > ®
Repeat procedure to cancel Emission OFF
Mode.

Tip
+ Emergency calls (110, 119 and 118) are
available even in Emission OFF Mode.

Aandas P
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ﬁ Secret Modes

Secret Mode & Secret Data
Only Mode

Activate Secret Mode/Secret Data Only Mode
to view secret Phone Book entries, secret
Schedule events and secret files.

Secret Mode: View all data and secret data.
Secret Data Only Mode: For Phone Book and
Schedule, only secret entries appear. For
image files, messages and bookmarks, all
saved data appear.

Activating Secret Mode & Secret
Data Only Mode

El ® => settings > ® => Security
=> (@ => Secret Mode or Secret
Data Only Mode > ®

1 Enter Security Code => @

Canceling Secret Mode & Secret
Data Only Mode

EX In standby, =)

IHiding Handset Data

Files stored in Secret Folders are accessible
only when Secret Mode or Secret Data Only
Mode is activated.

@ Storable file types: Images, videos, received
and sent messages and bookmarks (Yahoo!
Keitai and PC Browser).

@ Data saved on memory card or USIM Card
cannot be stored in Secret Folders.

@ Each Secret Folder of Data Folder has a fixed
storage capacity as follows:

+ My Picture: Approx. 2 MB
- Videos: Approx. 10 MB

Moving Data to Secret Folders

n Set handset to Secret Mode or
Secret Data Only Mode

F1 From a folder, select an item = @
=> Keep in Secret => ®

Moving Data from Secret Folders

n Set handset to Secret Mode or
Secret Data Only Mode

F1 n a folder list => Secret => @
E] select anitem = @ = Put Out >

®
ﬂ Select a destination folder = @®
Tip
* Functions available with Secret Folder data
are limited.
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.:‘ Overview

Handset supports SMS and S! Mail.
e Available Mail Services

\
D Exchange short text messages with other
SMS SoftBank handsets.
" — J
+* C \
_ﬂ X SoftBank .. Exchange long text messages with S! Mail
Ho dan S! Mail compatible SoftBank handsets and other
= andsets | (Separate e-mail compatible mobile phones and
&_' Q‘ contract PCs. Images and melodies can also be

D “‘ required) attached to S! Mail.
nnp — Customize Handset E-mail Address.
Effective for blocking spam.

Handset Non-SoftBank

Mobile Phones Use HTML mail to change font size/color, background, etc.

%
"A Special Template
Graphic Mail templates are awarded based on the number
of sent or received Graphic Mail.

A

[ ]

]

[ |
JEVSELS

Server

@If recipient’s handset is turned off or
out of range, sent message is stored

on the server up to 30 days until the
recipient’s handset becomes available. PCs Itsumono-Mail
Save custom-created message templates.
L J

5-2



ISending S! Mail
EJ Press and hold

S! Mail Composition Window

A => (@ => Enter Address =>
® => Enter address => ®
To add more recipients, Select ,
press @ and repeat the same step.

B => (@ => Enter subject = @
A => (@ => Enter text = @

|Add Art
LSel. Area
[ Auto

E#s R 30646
S! Mail Text Entry Window

5]
H To Cancel Transmission
=> When Start Packet Connection
appears = ®
Alternatively, press & during
transmission.
M If Resend mail? Appears
= YES = @®
Tip
+ Add up to 20 recipients total between To, Cc
and Bcc fields.

IGraphic Mail
Create html messages to change font
color/size and background color. Add
scrolling text, paste images, etc.
<Example> Change font size, background
color, insert an image and set
flashing text.
n [S! Mail Text Entry Window] =
<> [#A:| => @ => Select a font
size => (® => Enter text => @

F1 &= @ =& > Selecta
background color => ®
Press © to toggle between 25-color and
256-color palettes.

Sending Messages

3] => (@ => Select a folder = @®
=> Select an image = @

M Inserting Images with Large File Size
=> Insert Mail or SubQCIF Scale Down
=> @ (=> Check an image => @)

] A o> @ > i o @) <> Enter
text > @ > AL > @ > Bies| >
®

Hoe-®

new F
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Sending Messages

Entering My Pictograms
n [S! Mail Text Entry Window] => ®
Pl ® or ® to select [iF tab

k

i s |
H

My Pictograms Entry Window

E] & to select a pictogram => ®
4]

Handset returns to S! Mail Text Entry
window.

54

Using Predictions

Categories

Use predictions to quickly enter My Pictograms.

<Example> Entering “[&/&U“ (fireworks)
@ The following example is in Japanese text entry
mode.

n [S! Mail Text Entry Window] =
Enter “[FEU" =

P2 © to select a pictogram => @
Use ® or & to toggle prediction
candidates for My Pictograms and Mail
Art.

Note

+ Downloaded My Pictograms do not appear in
predictions.

Tip

+ Enter a My Pictograms category name and
press & to open a list of matching My
Pictograms.

My Pictograms are categorized for quick entry of
target items.

<Example> Entering “/\— k" (heart)
@ The following example is in Japanese text entry
mode.

n [My Pictograms Entry Window] =>

®@

A category appears in a list.

B Message

=]

Ple=i#x—¢=®
Use ® or ® to toggle page or category.

H To Enter From History
=> @ => History => ®

E] select a pictogram => @



Special Template

Access to a Special Template (original Graphic
Mail template) is awarded, based on the
number of sent/received Graphic Mail (see
chart below).

Sent Message
Count

3, 30, 60, 90, 120, 150,
200, 250, 300, 350

1, 25,75, 100, 150, 250,
400, 500

Received
Message Count

A notification appears when a Special
Template is awarded.

<Example> When three Graphic Mail
messages are sent

Ell © = select notification &, = @

An animation appears.

Fl ® orc=

Template

w*Download Templates
if SIS >

BBRSA-N0Y1Y
0 BRS A7
HBRSA-BIER
BR-ERBAHT D

Template List

Special Template files are saved in
Templates. ([J appears for Special
Template.

Note

* Special Template files not yet available also
appear in Templates. Once the required
sent/received count is achieved these
templates become accessible.

Initializing handset resets sent/received
message count and Special Template access
becomes unavailable again.

Tip
+ To access Graphic Mail templates:
= Templates = @)

Sending Messages

IAttaching Files

Attach the following files to S! Mail:

+ Images

+ Melodies

+ Phone Book entries
+ Schedule (To Do List)

+ Videos

+ Music (Songs)

+ Account Details

- Bookmarks

@ For information about image, video, melody
and music files, see P. 12-2.

n [S! Mail Composition Window]
= ®

P select a file type => @ (=> Enter
Security Code => @) => Select a file
= @

M Images with Large File Size
=> Attach Mail or QVGA Scale Down —>
@® (=> Check an image => @)

Note

+ Copy protected files cannot be sent as
attachments or output to external devices.

new P

Tip
* To open or play an attached file:
Select the file => @
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Sending Messages

Saving Addresses to
Mail Member
Use Mail Member to group mail addresses
together. Create up to 20 groups; save up to 20
addresses per group.
El ® -> own Data > ® =>
Mail Member => ®

o Mail Member  1/2

[(ail Member 1
BMail Member 2

BMail Member 3
@Mail Member 4
BMail Member 5
BMail Member 6

Mail Member List

1 select a Mail Member list => @

@®  Mail Member 1 1/2
[1]xxx-xxx@sof tbank.ne. jp|

Mail Member Window

B <Not Stored>
P> To Enter an Address
=> Enter address > @

56

P> To Save an Address From Phone Book
or Sent/Received Address List
©@ > Look-up address > @ >
Phone Book, Sent Address or
Received Address —> ® = Select an
address => @ (<> @)

IUsing Itsumono-Mail

Create and save message templates to
Itsumono-Mail. Save up to three templates.

Saving Itsumono-Mail
11 NG

= Itsumono-Mail
[i[KNot Recorded>

B<Not Recorded>
B<Not Recorded>

—-—-END----

Itsumono-Mail Window

Pl <Not Recorded> —> ®
B Enter address, subject and text

Aae

The message is saved.
Press &) to save and send the message.

Note

* Itsumono-Mail is assigned to Shortcut Key by
default. If you change Shortcut-key Setting
(P. 14-27), access via Shortcut Key (®)
becomes unavailable.

Tip
* Alternatively, to access templates:
=> ltsumono-Mail = @

+ To delete:
[Itsumono-Mail Window] => Select a template

= @) = Delete = ® => Delete This or
Delete All => ® (=>Enter Security Code =>
®) = YES => @

Default Itsumono-Mail
Set one message as the default message.
n [Itsumono-Mail Window] = Select
target message => @
P2 priority set. = ®
% appears for default template.
Tip
« If the default template is deleted, another
message is automatically set as default

template.




Sending Messages

1 JG)

Default template is selected. To send a
different template, manually select the

template.
= Jtsumono-Mail
u
come_home . @

=lAkimaMasani
I got there.

<Not Recorded>

I"T1 come home.

Meet me in front of the

station.
---END----

| sending SMS Messages

Send short text messages to SoftBank
handsets, using recipient’s phone number.

El ® = compose sMS => ®

SMS Composition Window

A => (@ => Enter Address >
@® => Enter phone number => @
E => @ = Enter text = @

Aae

'9 More Features

Composing Messages
® Enter Address from Phone Book
o Enter Address from Sent/Received Address List
o Enter Address from Mail Member List
® Set To, Cc or Bcc
o Delete an Address
o Insert Header/Signature
o Set Default Input Language for SMS
o Delete Text
@ Change SMS Message to S! Mail
(»P.5-17)

Sending Messages
@ Set Priority (S! Mail)
@ Server Storage Period (SMS)
@ Request Delivery Report
@ Save Messages to Draft
@ Quit Composing and Delete Message
(> P.5-18)
Attaching Files
o Capture and Attach Still Image/Video
o Delete S! Mail Attachments
(> P. 5-18)

new F
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Sending Messages

Mail Member
o Edit an Address
o Delete Addresses from a Mail Member List
o Edit a Mail Member List Name
® Reset a Mail Member List Name
(» P.5-18)
Graphic Mail
o Add/Edit Text Decoration
e Undo
@ Preview Graphic Mail
o Cancel All Decoration
o Instantly Convert S! Mail to Graphic Mail
® Save Graphic Mail as a Template
e Download Templates
o Create Graphic Mail from a Template
o Edit a Template
o Edit Title of a Template
o Delete Templates

(> P. 5-19)
Display Settings
@ Set an Outgoing Message Image

(> P. 14-9)

S! Mail Settings
o Edit Header/Signature
o Insert Header/Signature Automatically
® Request Delivery Report
(> P. 14-16)

SMS Settings
® Request Delivery Report
o Set Server Storage Period of SMS Messages
@ Set SMS Input Language
(> P. 14-16)



Receiving & Opening Messages

@ Pictograms

IOpening New Messages

i@ |Hury & |Advice Bib :
Received Result wind p + Alternatively open new messages from
eceived Result window opens for new . like _.q: Cheer desktop notification.
messages. il — ' » When Mail under Sub-display Setting is set
. . . Wy |Dislike Q’f Join to ON, press [J+- with handset closed to check
Emotion-Expressing Mail v I - the subject of new messages.
When a message is received, a pictogram B appy @ |Impression + Indicator may not always correspond to
matching the message content appears in ﬁ Angry @ Request message cont_ent
Received Result Window and Message List. s - : n;tc?wpa’\):agflihrgesgggs rc]:ngotzzto(:oes et n_
Set the Keyword setting on, to show Keyword 7 |Sad £ |Notice informatign
indicators when messages include user-set @ Fun @1 oK : g
keywords (P. 14-16). 9
PP |surprise & |Reply - =
: IOpenmg Inbox Messages
“? | Question (D |Other
COMPLETED n = Inbox '_:>©
EJ [Received Result Window] => Mail
— ndicator =@ ;
i B IFolder1
[©lew nail FA select a message = ® BciFolderz
@ CoFolder3
B1fiTrash Box
Note
« By default, complete S! Mail messages Folder List
Received Result Window (including attachments) are automatically

retrieved. Transmission fees apply, depending
on your subscription plan. While traveling
abroad, message retrieval may incur high
transmission fees.

59



Receiving & Opening Messages

F1 select a folder => @

£ 8:23 OzawaEisuke
29 6/30 NakayamaTarg
27 6/30 H AkinaMasam|
265 6/30 OzawaEisuke
£ 6/29 KitagawaRiki
The pasta we ate yesterd|
ay was delicious!

Search for a good restau

rant again!
o,

Message List

E] select a message => ®

010/ 7/ 1 10:05
EoAkimaMasami
Dyesterday

[The pasta we ate yesterd|
lay was delicious!
Search for a good restau
rant again!
----END----

Message Window

To check previous/next message, press

Tip

+ Some attachments may require content keys

to open/play the file.

5-10

IRepIying to Messages

n [Inbox Message List] = Select a
message => @ =
B When Original Message Has Multiple
Recipients
=> To Sender or To All => ®

FJ Edit subject/text =>

Replying (Quote Message)

n [Inbox Message List] = Select a
message > @ = ®
Bl When Original Message Has Multiple
Recipients
=> To Sender or To All => ®

F1 Edit subject/text =
Note

« If To All'is selected, your address is also
included in the reply. Save your address to
Account Details (P. 1-21) to exclude your
address as a destination.

Tip

» Attachments are automatically deleted from
reply messages.

* Quoting text is available only for S! Mail replies.

IUsing Mail List

Retrieve Mail List and select messages to
download or forward.

El ® = server Mail => ® => Mail
List => @ (=> YES => ®)

= Mail List

[1[= 15:28 AkimaMasani
B= 15:25 NakayamaTaro|
D= 15:23 KitagawaRiki

Mail List

B Select a message = @ =>

Message Receive => ®

P> To Receive a Message
Receive This => ®

P> To Receive Multiple Messages
Receive Selected —> ® = Select
messages = @ =>

P> To Receive All Messages
Receive All => ®



Tip

« If download fails while retrieving all
messages, download is canceled.

* When there is only one message, message
opens upon retrieval.

0 More Features

Receiving Messages
© Manually Retrieve Messages (S! Mail)
(» P. 5-20)

Checking Messages
@ Retrieve Complete S! Mail Manually
® Delete S! Mail from Server
@ Read Out Messages
® Check Message Information
(» P. 5-20)

Server Message Operations
@ Update Mail List
@ Switch Mail List Views
@ Check Server Message Information (S! Mail)
o Forward a Server Message (S! Mail)
o Delete Server Messages (S! Mail)
@ Check Server Memory Status
(> P. 5-20)

Receiving & Opening Messages

Pd Customize

Display Settings
@ Set Image or Video for Incoming Message
o Set Image for New Message/Received Result
Window
@ Show New Message Info While Viewing TV
(> P. 14-49)

Incoming Message Alerts
o Adjust Ringtone Volume
@ Set a Ringtone
® Set Random Playback of Melodies as Ringtones
@ Set Ringtone Duration for Incoming Message
® Set Vibration
o Set lllumination Color
o Set lllumination Pattern
@ Set lllumination to Flash for New Messages
@ Set Handset Action When Handset Opened
@ Set an Incoming Message Image
(> P. 14-8)

Incoming Message Settings

o Customize E-mail Address

® Do Not Show Emotion Indicators

® Show Keyword Indicators

@ Delete Keywords

® Set Priority When Receiving Messages during
Operation

® Read Out Received Mail (Text to Speech) Setting

@ Set Voice to Read Out Messages

® Manually Retrieve Complete Messages n
(> P. 14-16) g

Reply Settings o

@ Quote Message Marks —
(PP. 14-17)



Handling Messages

E] select a message => ®

IMessage Folders Opening Sent & Received —
Press &) to open Mail Menu. Messages Lo 12010/ 7/ 1 13:49

lakayamaTaro
el lo

N
Sent, received and draft messages are saved <Example> Open a Sent Message H
in the locations below.

Hello, long time no see!
. n = Outbox = @ How about having a meal
e ggether again sometime?
1 Inbox ———— Received messages 2 ----END----
2 Qutbox B “iFoldert
_ﬂ 3 Draft —LL Sent messages _lFoIderg
4 Compose Message CiFolder:
5 Compose SMS -— Draft messages
6 Server Mail "
S ; Message Window
7 Retrieve New il
g. 8 Templates Folder List
= 8 Itsumono-Mail To check previous/next message, press
0 Mail Setting E Select a folder = @ o p ge, p
- = Qutbox 1/2
Mail Men = A
atMenu 1113 49 Nakayamalaro Tip
=10: i i
@1 g/gﬁ %‘:‘,’?Egg,”,‘;;,k, + When Outbox/Inbox is full, old messages are
= 6/30 NakayamaTaro deleted in order of Trash Box then Outbox/
= gﬁg 3‘;;’3:!?:3’;; Inbox when a new message is sent or
ello, long time no see! received. Unread and protected messages
How about having a meal and Secret Folder messages are not deleted.
together again sometime?)
---—-END----

Message List

512



Windows & Indicators

Check message status, attachment type, etc.
by indicators.

Folder Lists

Folder Type

1 General Folder
[ Trash Box

T Secret Folder

1}
B JFoldert

0
BSecret

B “IFolder2 B “IFoldert
@ IFolder3 @ “IFolder2
BMTrash Box “IFolder3
Inbox Folder Outbox Folder
List List

Message Lists

029 6/30 NakayamaTaro
027 6/30 HAkimaMasa
Becd 6/30 (|zawaEisuke
B 6/29 IitagawaRiki|

Inbox Message
List

Message Windows

@ —
(L= 12010/ 6/30 13:10
(From | A:AK imaMasami

[suiea] 7 Meet ing Spot

Qutbox 1
3:40 Nakaya

0:02 OzawaElsuke
6/30 HKitagawaRiki

0= 6/30 |akayamaTaro
8= 6/30 J|kimaMasami
B= 6/29 (|zawaEisuke

Outbox Message
List

®

i
(o 12010/ 7/ 1 13:49
INakayamaTaro
[suieaHe | |0

Letts meet at the ticket|
ate

o
11 send a video about
ithe restaurant >

Elmov ie_3zpl
i} 181KBytes|

Hello, long time no see!
How about having a meal
together again sometime?

----END----

Received Message
Window

Sent Message
Window

Message Status

4 Unread

£ Read

=4 Protected (Unread)

o= Protected (Read)

¥ Forwarded

“3 Replied

=l Sent to a Single Recipient
=} Sent to Multiple Recipients

Message Type
& SMS on Handset
=/ SMS on USIM Card
2= S! Mail Notification
Attachment Type
£l Image
B Video
43 Melody (Tones/Ringtones)
ﬂ Music
& Copy-protected File

{2] Phone Book Entry, Account Details,

Schedule Event or Bookmark
E Forwarded Server Mail
f2] Others
&% Multiple Files

Handling Messages

The following marks appear on indicators to
inform you:
[ Folder Contains Unread Messages
B Locked Folder
* Folder with Auto Sort Set
=2 Protected Message
<~ Delivery failed to Some Recipients or Some
Attachments Deleted
# Delivery Failed/All Attachments Deleted
'ﬂ' Attachment Deleted
& High Priority S! Mail
Tip
+ To open/play copy-protected files, save files to
Data Folder.

. appears in field when Delivery
Report is received.

B _
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Handling Messages

Canceling Auto Sort

n [Folder List] => Select a folder =
@ => Auto-sort > ®

1 select a criterion => @ => Release

Prohibiting Access to
Messages

Setting Mail Box Lock

ISorting Messages

Automatically sort incoming/outgoing
messages into folders.

n [Folder List] => Select a folder =>

i s |
H

® => Auto-sort > ®

P> To Sort by Address
Address Sort => ® => Look-up
Address, Look-up Group, Look-up
Member or Enter Address => ®

P> To Sort by Subject
Subject Sort => ® = Enter subject
= @

= @
P> To Cancel a Criterion
Release This => @ => YES => ®
P> To Cancel Multiple Criteria
Release Selected —> @ => Select
criteria => @ <> ® => YES => @
P> To Cancel All Criteria
Release All => ® => YES => ®

El ® = mail setting > ®

A mail Box Lock => ® => Enter
Security Code => ®

E] select a mail box => @®
Repeat Step 3 to specify other boxes.

Aae

P> To Sort by Reply Failed, Send Failed
or Unregistered Address
Reply Impossible, Send Impossible or
Unregistered Add. => ®

Setting Folder Lock

n [Folder List] => Select a folder =
. ® => Folder Lock => ® => Enter
Tip Security Code => @ => YES => @

+ Only one Inbox folder can be specified for |4 appears for locked folders.
sorting Reply Impossible messages.

+ Only one Outbox folder can be specified for Tip
sorting Send Impossible messages.

+ Only one Inbox/Outbox folder can be
specified for sorting Unregistered Add.
messages.

+ Search addresses from Phone Book,
Received/Sent Address List in Look-up
address.

* Repeat the same procedure to cancel mail box
and folder lock.

* Lock Trash Box to require password for
access.

« Security Code entry is required to view
messages in locked mail boxes and folders.
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T M Els t P> To Return Multiple Messages

oringiiviessagesiini>ecre Put Out Selected => ® => Select a
[ [T folder => @ => Select a message >

@ Set handset to Secret Mode or Secret Data ® (repeat to select another message)

= ® = YES =
Only Mode beforehand (P. 4-6). YES > @

L P> To Return All Messages
u dM , S! Mail with Text
® Unread Messages attwith fex Put Out All => @ => Select a folder =
Unreceived or delivery reports cannot be

=> YES =
stored in Secret Folders. ® ®

[l [Message List] > Select amessage ISaving S! Mail Attachments
= @ => Keep in Secret => ®

> To Store a ill;%age Saving Image, Video, Melody,
Keep This Music and Flash® Files

P> To Store Multiple Messages

Keep Selected > ® => Select a <Example> Save an image

message = @ (repeat to select n [Message Window] => Select a file

another message) = ® = YES => @ = @ => Save Data => ® => YES
P> To Store All Messages in a Folder = @

Keep All => @ => YES => @

F1 select a folder => @
Returning Messages in Secret

Folders to Ordinary Messages El YESorNO <> @ (= Selectanitem
- = @ ( => Select a view => @ =
EX IFolder List] => Secret = ® Check an image = @)
E Select a message = @ = Put Out
= @

P> To Return a Message
Put Out This => @ => Select a folder

54C)

Handling Messages

Saving an Image Inserted in Text

n [Message Window] => @ = Save
Insert Image —> ®

FJ select an image => ® = YES =
@® => Select a folder => @®

E] YESorNO => @ (=>Selectan item

= @ ( = Select a view => @ => n_
Check an image => @®))

Saving a Phone Book Entry -

n [Message Window] = Select
contact information (a phone
number, etc.) => @ (twice) =
Phone or USIM => ® => New =>

®
F1 Edit each item =

Saving a Schedule Event

n [Message Window] => Select
Schedule events => @ (twice)
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Handling Messages

Saving a Bookmark

n [Message Window] => Select a link
(URL, etc.) => @ (twice) = Select a
destination = ® = Select a folder

E30)
Note

* Mail-attached phone book entries, schedule
events or bookmarks cannot be saved to
microSD.
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'9 More Features

Managing Messages

o Protect a Message

@ Move Messages to a Different Folder

@ Move Messages to Trash Box

o Delete Messages

o Delete All Read Messages

o Delete All Delivery Reports

® Report as Spam

o Delete Attached Files

® Copy SMS Messages between Handset and
USIM Card

o Delete SMS Messages on USIM Card

@ Change Message Color

® Add a Folder

e Edit a Folder Name

@ Change Order of Folders

o Delete a Folder

@ Check Number of Saved Messages

@ Check Sent/Received Addresses

(»P.5-21)

Using Messages

o Edit a Sent Message

o Edit & Send a Draft Message

o Forward a Message

@ Save Sender, Recipient's E-mail Address or
Phone Number to Phone Book

o Call a Phone Number in Text

@ Send an S! Mail to an E-mail Address in Text

® Access the Internet from a URL in Text

@ Save Number/Address in Text to Phone Book
@ Search Information by Keyword

@ Switch Subject Field Views

@ Change Message Font Size

@ Search for Messages in a Folder

@ Sort Messages

o Filter Messages

@ Return Message List View to Default

o Switch All Unread Messages to Read Messages
@ Open S! Mail Delivery Report

@ Check Attachment Properties (Image File)

(> P. 5-23)

Message Window/Messaging Settings
o Set Message List View
@ Set Auto-Play for Melody Attachments
® Set Scroll Unit
® Set Font Size
e Change Address for Reporting Spam
® Check Mail Settings
@ Restore to Default Settings
(> P. 14-17)

SMS Server Settings
@ Change SMS Center Address
® Reset to SoftBank SMS Center Address
(> P. 14-18)



ISending Messages

Start Here
[S! Mail Composition Window].
[S! Mail Text Entry Window]..
[Mail Member List]............
[Mail Member Window] ..
[SMS Composition Window] ..

e P.5-3
.P.5-3
..P.5-6
..P.5-6

... P.5-7

Composing Messages

Enter Address from Phone Book

[S! Mail Composition Window]/[SMS
Composition Window] => => @ =
Phonebook = ® = Search Phone Book =
Select Phone Book = @® = Select an
e-mail address or phone number => ®

Enter Address from Sent/Received Address
List

[S! Mail Composition Window]/[SMS
Composition Window] = =@ =>
Sent Address or Received Address => @ =
Select an e-mail address/phone number =>
@ (twice)

[Z) Alternatively, select and press € to

open Sent/Received Address List.

Enter Address from Mail Member List

[S! Mail Composition Window] = =

® => Mail Member > ® => Select a

Mail Member list => @

[Z] All addresses in the selected Mail Member list
are entered in the Address field.

5] You must save addresses to a Mail Member
list in advance.

Advanced Features

Insert Header/Signature

[S! Mail Composition Window] => @ =>
Add Header or Add Signature => ®
[£] Save header/signature in advance.

Set To, Cc or Bcc

[S! Mail Composition Window] => =

® <> Select an address => @ = Change

Rcv. Type => @ => To, Cc or Bcc => @

[Z1 Cc (Carbon copy): S! Mail copies are sent to
other addresses. Addresses in the Cc field are
revealed to the other recipients.

[Z1Bcc (Blind carbon copy): S! Mail copies are
sent to other addresses. Addresses in the Bcc
field are hidden to the other recipients.

[Z]When there is no address in the To field, the
message cannot be sent.

Set Default Input Language for SMS

[SMS Composition Window] => @ = SMS
Input Char. => ® => Japanese or English
=@

Delete Text

new F

[S! Mail Composition Window]/[SMS
Composition Window] = @) => Erase
Message => @ => YES => @

Change SMS Message to S! Mail

[SMS Composition Window] => @ =>
S! Mail Conversion => @®

Delete an Address

[S! Mail Composition Window] => =
® => Select an address => @ = Delete
Receiver => ® => YES => @

517



i s |
H

n Advanced Features

S ng Messages

Set Priority (S! Mail)

[S! Mail Composition Window] => @ =>
Priority => ® => High, Normal or Low => ®

Server Storage Period (SMS)

[SMS Composition Window] => @ => SMS

Valid. Per. => ® = Select a period => ®

[£] Specify a period the SMS message is stored in
the server in case it fails to reach the recipient
because the recipient’s handset is out of
range, etc.

[E1When None is set, the SMS message is
deleted from the server after it is resent once
in a certain period of time.

Request Delivery Report

[S! Mail Composition Window]/[SMS

Composition Window] = @ = Delivery

Report or SMS Report Req. = @® => ON or

OFF => ®

[Z1When ON is set, handset receives a delivery
report.

5-18

Save Messages to Draft

[S! Mail Composition Window]/[SMS

Composition Window] => @ = Save = @

2] The message is saved to Draft. Messages
saved in Draft can be edited and sent at a
later time.

Quit Composing and Delete Message

[S! Mail Composition Window]/[SMS
Composition Window] = @ = Delete =
® =>YES=> @

Attaching Files

Capture and Attach Still Image/Video

[S! Mail Composition Window] => @ =>
Activate Camera —> ® => Photo Mode or
Movie Mode > ® = Shoot image/video
= @®

Delete S! Mail Attachments

[S! Mail Composition Window] = Select an
attached file => @ => Delete Att. File or
Del All Att.Files => @ => YES => @

Mail Member

Edit an Address

[Mail Member Window] => Select an
address => ® => Edit address => @

Delete Addresses from a Mail Member List

[Mail Member Window] => Select an address
=@
® To Delete the Selected Address
=> Delete This => @=> YES => @
@ To Delete All
=> Delete All => ® = Enter Security Code
= @ > YES => @

Edit a Mail Member List Name

[Mail Member List] = Select a Mail
Member list => @ => Edit Member Name
=> (® => Edit name => ®

Reset a Mail Member List Name

[Mail Member List] => Select a Mail
Member list => @ => Reset Member Name
=@ > YES => @




Graphic Mail

Add/Edit Text Decoration

[S! Mail Text Entry Window] => (/) = gaest|

=> (@ = Select beginning of characters =>

@® = Select end of characters = @ =

Select effects menu => @ => Apply or

Change effects

[Z)Select taes| , press &), select YES and then
press ® to select the entire text.

Undo

[S! Mail Text Entry Window] = (/7] = Sun|
= @®

Preview Graphic Mail

[S! Mail Text Entry Window] => (7] => 21|
=> @ = [a=d or @) to close preview

Cancel All Decoration

[S! Mail Text Entry Window] = (7] = Rl
=@ = YES > @ (= @)

Instantly Convert S! Mail to Graphic Mail

[S! Mail Text Entry Window] = Enter text
=> Press and hold ® = &) to toggle
selections => @

[Z1Pictographs, graphic items, and effects are
automatically selected, based on content of
entered text (available in Japanese entry
mode).

[Z] Alternatively, press (/7), select [Auts| and
then press @ to convert to Graphic Mail.

[2)In Preview window, press @ to toggle
pictographs and emoticons on/off.

Advanced Features

Create Graphic Mail from a Template

=> Templates => @ => Select a template
= @ =

Edit a Template

=> Templates => @ => Select a template
= @ => @ = Edit > @ = Edit text =>
®) (twice)=> YES or NO => ®

Save Graphic Mail as a Template

[S! Mail Text Entry Window] => Enter text

= @ => @ = Template > ® => Save

Template => @ => YES => @

[Z] Attached files except images inserted in text
are not included in a template.

[Z1Save up to 1,000 templates including
downloads. Delete saved templates as
needed.

Edit Title of a Template

=> Templates => @ = Select a template
=> @ = Edit Title => @ => Edit title => @

new P

Download Templates

=> Templates => @ => Download
Templates => @ => YES => @ => Follow
onscreen instructions

Delete Templates

=> Templates => @ = Select a template
=> @ => Delete => ®
® To Delete the Selected Template
=> Delete This = @ <> YES => @
® To Delete Multiple Templates
=> Delete Selected = ® = Select
templates => @ => @ = YES => @
® To Delete All
=> Delete All => ® => Enter Security Code
> @ > YES > @®
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n Advanced Features

IReceivingIOpening Messages

Start Here

[Message List] P.5-10
[Message Window] ........cccceeereernercnenns P.5-10
[Mail List] P.5-10

Receiving Messages

Manually Retrieve Messages (S! Mail)

=> Retrieve New ~> ® = Received

Result window opens = Mail => @ =>

Select a message => @

[ Press & or press and hold to cancel
message retrieval.

[Z]Retrieve messages that were stored on the
server while handset was off or out of range.

Checking Messages

Retrieve Complete S! Mail Manually

i s |
H

[Message List] = Select an S! Mail

notification => @ =>

[Z]S! Mail notification is deleted when you
retrieve the complete message.

[Z1Manually retrieve complete messages when
Message Download is set to Manual (S!
Mail Settings, P. 14-17).

5-20

Delete S! Mail from Server

[Message List] = Select an S! Mail
notification = @ => @ = Delete => @
=> Notification, Server Mail or
Notifi./Server => @ => YES => @

Read Out Messages

[Message Window] = @ => Read Out
Message > @

[Z) Press ® to stop reading.

[Z)Press @ to end reading.

Check Message Information

[Message List] => Select a message => @ =
Mail Info => @

Server Message Operations

Update Mail List

[Mail List] = @ => Mail List => @

Switch Mail List Views

[Mail List] => @ => List Setting => @ =>
Subject, Name or Address => @

Check Server Message Information
(S! Mail)

[Mail List] => Select a message => @ =
Mail Info => @

Forward a Server Message (S! Mail)

[Mail List] => Select a message => @ =>
Forward => @ => => @ => Enter
address =

Delete Server Messages (S! Mail)

[Mail List] => Select a message => @ =
Delete > ®
® To Delete the Selected Message
=> Delete This => @ => YES => @
® To Delete Multiple Messages
=> Delete Selected = ® = Select
messages = @ => @ = YES => @
@ To Delete All
=> Delete All => @ => Enter Security Code
= @ => YES => @

Check Server Memory Status

=> Server Mail => ® => Server Mail
Memory => @




IManagingIUsing Messages

Start Here

[Folder List] P.5-12
[Message List]... P.5-12
[Message Window] . P.5-12
[Inbox Folder List] ... ...P.5-13
[Inbox M ge List] P.5-13
[Received M ge Window] P.5-13
[Sent M ge Window] P.5-13

Managing Messages

Protect a Message

[Message Window] => @ => Protect

ON/OFF => ®

[Z]1f a message is protected, this procedure
cancels protection.

Move Messages to a Different Folder

[Message List] = Select a message => @ =

Move => ®

@ To Move the Selected Message
=> Move This => @ = Select a destination
folder => @ => YES => @

@ To Move Multiple Messages
=> Move Selected => @ = Select a
destination folder = @ => Select messages
2> @ =>® = YES > @

o To Move All
=> Move All => @ => Select a destination
folder => @ => YES => @

[Z] A message can also be moved to a different

folder from Message window.

Advanced Features

Delete Messages

[Folder List] => @ => Delete All => @ =>
Enter Security Code => @ = YES => @
[Message List] = Select a message > @ =
Delete > ®
@ To Delete the Selected Message
=> Delete This = @ = YES = @
@ To Delete Multiple Messages
=> Delete Selected = ® = Select
messages = @ => @ => YES => @
@ To Delete All
=> Delete All => @ => Enter Security Code
= @ => YES > @
[Z] Protected messages cannot be deleted.

B _

Move Messages to Trash Box

[Message List] = @ => Move to Trash Box

=> @ = Select messages => @ > @ >

YES => @

[Z] Protected messages and delivery reports
cannot be moved to Trash Box.

Delete All Read Messages

[Inbox Folder List] => @ => Delete Read =
® > YES => ®

[Inbox Message List] => @ => Delete > @
=> Delete Read > @ => YES => ®

[Z] Protected messages cannot be deleted.

Delete All Delivery Reports

[Inbox Message List] = @ => Delete = @
=> Delete All Reports => ® => Enter
Security Code => @ => YES => @

[Z] Protected delivery reports cannot be deleted.
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. Advanced Features

Report as Spam

[Message List]/[Received Message Window]

(= Select a message) = @ = Report

Spam => @ =>

[E1Header/signature is not inserted, regardless
of Insert Setting.

Change Message Color

[Message List] = Select a message = Press

and hold

[ZJEach time you press and hold (%), the
message color toggles as follows: Red — Blue
— Default (Black)

ol

Delete Attached Files

[Message Window] = Select attached files
=> @ => Delete Att. File or Del All Att. Files
= @=> YES => @

Copy SMS Messages between Handset and
USIM Card

@® => Tools => ® => USIM Operation =
® => Enter Security Code = @ => Copy
=> (@ => Phone—USIM or USIM—Phone =
® =>SMS => @ => Inbox or Outbox ~> ®
=> Select a folder => @ => Select an SMS
message => @ => @ = YES => @

Add a Folder

[Folder List] = @ => Add Folder => @ =>
Enter folder name => @ = YES or NO =
® (=> Address Sort, Subject Sort, Reply
Impossible, Send Impossible or
Unregistered Add. => @ => Make auto
Sort settings = ®) => YES or NO => @

Delete a Folder

[Folder List] = Select a folder => @ =

Delete Folder => ® => Enter Security Code

= @ => YES => @

[Z]Folders containing protected messages and
preinstalled folders cannot be deleted.

£ This procedure also deletes messages stored
in the folder.

£ Auto Sort settings are also canceled when
you delete a folder with Auto Sort settings.

Edit a Folder Name

[Folder List] = Select a folder => @ = Edit
Folder Name > ® => Edit folder name =

[Z] Preinstalled folders cannot be renamed.

Check Number of Saved Messages

[Folder List]/[Message List] = @ => No. of
Messages => ®
2] Check number of total, unread, protected
and USIM Card SMS Messages.
Folder List: The total of all folders.
Message List: The total of the selected folder.

Delete SMS Messages on USIM Card

@® => Tools => ® => USIM Operation =>
® => Enter Security Code = @ => Delete
= @ => USIM => @ => SMS => @ =>
Inbox or Outbox => @ = Select a folder
=> (@ = Select an SMS message = @ =
= YES = @®

Change Order of Folders

[Folder List] = Select a folder => @ => Sort

Folder => ® => Select a position = ®

[Z] The order of preinstalled folders cannot be
changed.

Check Sent/Received Addresses

Press and hold © or press and hold @ =
Select an entry => @
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Using Messages

Edit a Sent Message

[Sent Message Window] => ®& =» Edit
address, subject and text =>

Edit & Send a Draft Message

=> Draft => @ = Select a message =
® => Edit address, subject and text =

Forward a Message

[Received Message Window] => @ =
Forward => ® (twice) = Enter address =
[Z) Edit subject and text as needed.

[£] Attached files are forwarded.

Save Sender, Recipient’s E-mail Address or
Phone Number to Phone Book

[Message Window] => @ = Address List
=> @ => Select an e-mail address/phone
number => @ = Save Address => @ =>
YES => @
@ To Save to Handset
=> Phone => @ = Select store method =
(® (= Search Phone Book = Select Phone
Book => @ (twice)) => Edit items => @& (=
YES or NO => ®) (= Enter entry number =
®)
@ To Save to USIM Card
=> USIM => @ = Select store method =
(® (= Search Phone Book = Select Phone
Book = @ (twice)) = Edit items => @ (=
Overwrite or Add = @) (= YES or NO =
®)

Advanced Features

Access the Internet from a URL in Text

[Message Window] = Select a URL => @
=> YES => @

Call a Phone Number in Text

[Message Window] = Select a phone
number <> ® => Voice Phone or Video Call
=> @ <> Dial => ®

Save Number/Address in Text to Phone
Book

[Message Window] = Select an

e-mail address/phone number => @ =>

Add to Phonebook => ® = YES => ®

® To Save to Handset
=> Phone = ® = Select store method =
® (= Search Phone Book = Select Phone
Book => @ (twice)) = Edit items => & (=>
YES or NO => @) (= Enter entry number =>
®)

® To Save to USIM Card
=> USIM => @ => Select store method =
(® (= Search Phone Book = Select Phone
Book => @ (twice)) = Edit items => & (=>
Overwrite or Add = @) (= YES or NO =>
®)

Send an S! Mail to an E-mail Address in
Text

[Message Window] = Select an e-mail
address => @ => Compose S! Mail =

Search Information by Keyword

[Message Window] => @ = Quick Search
=> (® => Enter Keyword => @® = Enter
keyword => @ => [MzSearc] => @ = Select
an item from search results => @
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E Advanced Features

Switch Subject Field Views

[Message List] = Press and hold (#]

[ElWhen Mail List Disp. is set to 2 Lines, view
toggles in the order Name — Address.

[ElWhen Mail List Disp. is set to 1 Line, orto 1
Line+Body, the view cycles as follows:
Subject = Name — Address

Filter Messages

[Message List] => @ => Filter => @ =>
Select a criterion => ®

£ This procedure can be combined with Search
Mail or Sort.

Change Message Font Size

[Message Window] = Press and hold [©)

Return Message List View to Default

[Message List] = @ = Display All => ®

Switch All Unread Messages to Read

Search for Messages in a Folder

[Message List] = @ = Search Mail => ®

=> Search Sender, Search Receiver or

Search Subject => @ (= Select a search

criterion => @) = Select an address, enter

address or subject => @

[Z]Narrow down search results by repeating the
search operation.

[Z1 This procedure can be combined with Sort or
Filter.

[Inbox Message List] = @ = Read All =>
® =>YES=> @

Open S! Mail Delivery Report

[Sent Message Window] = @ => Disp.

Report => @

[Z]Only available in Message window of a sent
message with a requested delivery report.

Sort Messages

[Message List] = @ => Sort => @ =>
Select a criterion => ®

£ This procedure can be combined with the
Search Mail or Filter.

Check Attachment Properties (Image File)

[Message Window] = @ => Property =
® => Select image => @
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@ Overview

:IIIIII Ill*

:IIIIII Ill*

PC Websites

Browse PC websites using PC Site Browser
(P.6-5).

Mobile Internet Sites

Press ®) to access the Mobile Internet
via Yahoo! Keitai (P. 6-3 ).

Internet

Transmission & Information Fees
Some web contents automatically connect to
different pages incurring transmission fees.
Information fees may also apply.

About Security

Handset supports SSL/TLS (encryption protocols
for Internet transmissions of important/sensitive
information). Root certificates necessary to use
SSL/TLS are saved on handset by default.

« SSL (Secure Sockets Layer) and TLS (Transport
Layer Security) protocols encrypt data before
transmission. Connect via SSL/TLS to safely
transmit personal information, credit card
numbers and internal corporate information, and
guard against eavesdropping, data manipulation,
impersonation and other Internet risks.

* When a security notice appears, subscribers must
decide for themselves whether or not to open the
page. Opening secure pages constitutes
agreement to the terms of SSL/TLS usage.
SOFTBANK MOBILE Corp., VeriSign Japan K.K.,
Cybertrust Japan Co., Ltd., Entrust Japan Co.,
Ltd., GlobalSign K.K., RSA Security Japan Ltd. and
Secom Trust Systems Co., Ltd. cannot be held
liable for any damages associated with the use of
SSL/TLS.

* When Warning Messages is set to ON, an alert

appears each time handset connects to a website
using PC Site Browser.



Yahoo! Keitai @

Keitai = Hi = + To access X=2—1X / directly:
Kl press and hold ® - History -+ @ Press and hold &) => Menu List = @

* A confirmation for SSL/TLS communication

IConnecting to Yahoo! Tip
1

i appears each time a secure page is opened.
g:}gg appears in SSL/TLS compatible pages.
BSited * Some pages require user authentication. Select
BSites text entry field and enter your user ID or
password.
History List 3.
0
Web Page 1 select a record => ® 5
o
-

F1 select an item = @
Repeat to select more links. Entering URLs

El (= = YES = @ to close browser  [{l] Press and hold & => Enter URL >

Enter URL

URL Entry Window

F1 <NEW> > ® = Enter URL > ®
= OK = ®

6-3
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Yahoo! Keitai

'9 More Features

Yahoo! Keitai
@ Switch to PC Site Browser
@ Open Yahoo! Keitai Main Menu

(> P.6-11)

History

@ Save a URL in History to Bookmark
@ Check a URL in History

@ Delete Records in History

(»P.6-11)

Using URL Log
@ Use Previously Entered URLs
o Edit Previously Entered URLs
@ Send URLs by S! Mail
® Delete URL Records
(»P.6-11)
Root Certificates
o Check Certificate Details
o Switch a Certificate between Valid & Invalid

(»P.6-12)

Internet

o Clear Cache

o Delete Cookies

o Initialize Memory Status of Internet

® Set Whether to Send Manufacture Number

o Set Whether to Send Referer
® Enable/Disable Cookies
@ Check Internet Settings
® Reset Internet Settings
(> P. 14-19)
Providing Location Info

@ Provide/Restrict Location Info When Requested
(» P. 14-20)



IPC Site Browser

View PC websites using PC Site Browser.

Scroll up, down, left or right to view entire

page.

@ You may not be able to view as you want
depending on the site.

@ Note that transmission fees may be expensive
for pages with large amounts of data.

O — TR

0 —EElEREy R — ©
WULTT Pl
J—

PC Site Browser Window

@ | Tabs
One for each title/URL appears when
viewing several pages.

® |Page Toggle
Appears when viewing several pages.

Toggle with ®.

@ | Layout Display
g PC Screen
= Small Screen

@ |New Tab

Open link in a new tab.

About Page Layout

When using PC Site Browser, two page layout
types are available for each of

PC Screen and Small Screen:

PC Screen: Scroll pages vertically and
horizontally.

Small Screen: Scroll pages vertically.

Pages are laid out to fit Display width.

PC Site Browser

IConnecting to PC Websites

EJ Press and hold ® = PC Site
Browser => ®

@  PC Site Browser

0

B Bookmark

BHistory

@Enter URL

BYahoo! Keitai

BPC Site Brw. Settings

PC Site Browser Menu

Pl Home => ® (=> YES or NO => @)
=> Select an item => @
Repeat to select more links.

(Yahoo! JAPAN

Web Page

E]l = = YES = @ to close browser
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PC Site Browser

Using Access History Entering URLs

n [PC Site Browser Menu] => History n [PC Site Browser Menu] => Enter

E30)

BSite2
BSsite3

History List

1 select a record => @ (=> YES or
NO = @)

URL = ®

Enter URL

URL Entry Window

Pl <NEWs => @ = Enter URL => @
=> OK => @ (= YES or NO => @®)

'9 More Features

PC Site Browser
@ Switch Page View
® Return to Home

(»P.6-11)
History
® Save a URL in History to Bookmark
@ Check a URL in History
@ Delete Records in History
(»P.6-11)

Using URL Log

@ Use Previously Entered URLs
o Edit Previously Entered URLs
® Send URLs by S! Mail

® Delete URL Records

Internet

o Clear Cache

o Delete Cookies

e Initialize Memory Status of Internet

o Set Whether to Send Manufacture Number
@ Set Whether to Send Referer

o Enable/Disable Cookies

@ Check Internet Settings

® Reset Internet Settings

(»P.6-11)

(> P. 14-19)
PC Site Browser
@ Do Not Show Alert When Activating PC Site
Browser & Switching Browsers
® Select a Script Setting
(> P. 14-20)
Providing Location Info
@ Provide/Restrict Location Info When Requested
(> P. 14-20)



INavigating Pages

Scrolling Pages

If a page extends beyond view, use € to
scroll page.

Press [{++- or Husic to jump between sections of
the page.

When a page includes multiple frames, select
frames to view.

n & = Select a frame
Fl © = Frame in = ®

Navigate through the frame as you
would a page.

To exit frames, press @), select Frame
Out and then press @.

Open Linked Page in New
Tab

Open up to five pages simultaneously. Press
to toggle pages.

EN (web Page] = Select a link = &
The linked page appears in a new tab.

(Yahoo! JAPAN

BSZIE

UsuEs A-0UsY Wh 2z
=5 22y D3qrva FLE
s £y aax K

ThE _ Gbm  Ave 707
B Ea-scusll B8 =

Yahoo! JAPAN |2k ]

Press ®) to toggle tabs.

Page Operations

Tip
+ To open pages in a new tab other than linked
pages:
[Web Page] = @ => Window Operation =>
® => Open New Window => @ =>
Bookmark, Enter URL (,Yahoo! Keitai or
Home) => ® =>Specify page to open => @
* To close opened pages:
[New Tab] = (=) = YES => @)
e Use to return to previous pages stored in
cache. Return through pages opened in tabs to
close.

Jumping to Next or
Previous Page

Once opened pages are stored in a temporary
storage area (cache). Press @), select History
Back or History Forward and press @ to go
back to the previous page or proceed to the
next page, without connecting to the
network as long as the pages are stored in
the cache.
@ Network connection is made when the cache
is full.

jPoUI9U| P



@ Page Operations
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Selecting Links and Other
Items

Operate as follows when buttons and menus

appear in web pages.

-Online Registration-
Terms of Use ——————— (1)
Nane T

[ Kento T —®

Gender (+)Male OFemale —1 @

Pursuit gSpo‘;ts
Reading l__
[CIMusic ®
N

Ol m
Use € and press @ to select multiple . Customize

items from a range of options. |v] indicates Internet
the item is selected. o Set Scroll Unit/Speed

o Enable/Disable Image Download
@ Set Auto-Play for Melody Attachments
(> P. 14-19)

® | Command Button
Select a command button and press @ to
activate the assigned function.

—®
@ [Link
Select a link and press @ to access the
linked page.
@ | Text Box

Select a text box and press @ to open a
text entry window to enter text.

@® | Pull-down Menu
Select a pull-down menu and press @ to
open a list of options. Use @ to select an
item and press @).

@ | Radio Button
Use € and press @ to select only one item

from a range of options. (® indicates the
item is selected.

Yahoo! Keitai
® Set Font Size

o Set Flash® Sound On/Off
'9 More Features (> P. 12-19)
E Advanced PC Site Browser

Page Operations ® Set Page Layout
® Reload Page

® Save Image/Melody Files

@ Save Background Image of a Page

@ Send URL Links via S! Mail

o Call a Linked Phone Number

o Send S! Mail to a Linked E-mail Address
@ Access URL Link

® Save Numbers/Addresses to Phone Book
@ Search Information by Keyword

e Change Page Font Size

@ Zoom In/Out

® Jump to Top/End of a Page

@ Change Character Code

o Play Flash® from the Beginning

@ Check Title, URL or Certificate of a Page
® Show Key Guidance

(> P. 14-20)

(»P.6-12)



Bookmarks & Saved Pages

- F1 select a folder => @

IUsmg Bookmarks R
] Bookmark

Save URLs to Bookmark for quick access. [IINEC SUPER TOWN

BXZ1-Y2h
EMy SoftBank

. By4y5-
Saving URLs to Bookmark latiacetdall
T

n [Web Page] =~ ©@) => Bookmark = @ Viewable content is page as it was saved.
@® = Add Bookmark => @® =>

YES > ® Saving a Page

E Select a folder => @ Bookmark List n [Web Page] => @ => Saved Pages
eoxmare - = (@ => Add Saved Pages —> ® n_

IUsing Saved Pages

Save a page to Saved Pages to view that page
at a later time without incurring connection
fees.

@ Only Yahoo! Keitai pages can be saved.

I e e rrd  El selectabookmark <> @ (- YES < YES = © 3
n d hold @ or NO => @) o
e 3
P From Yahoo! Keitai Tip Opening Saved Pages o
Bookmark => @ * To access a bookmarked page from another n Press and hold & => Saved Pages
P> From PC Site Browser R/a\lgi: e S0 = a0 > =
i (= = ep Page ookmari -
i;g S(ge Browser => @ => Bookmark Bookmark List = ® = Select a folder = T. S?Vi(: Pages
me tapble
(® => Select a bookmark => @ B Mg K orerast
¥ Bookmark Folder BCoupon

1]
@microSD

Bookmark Folder List

Saved Pages List
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@ Bookmarks & Saved Pages
_—

F3 select a page > @
_ ") More Features
Tip
« To open a saved page from another page: £ Advanced
[Web Page] = @) = Saved Pages => ® => Bookmarks
Saved Pages List = ®) =>Selectapage =  _ tiit 4 Title

O o Edita URL
@ Send a Bookmark by S! Mail
@ Check Number of Bookmarks
o Create a Folder
o Edit a Folder Name
@ Change Order of Folders
® Move Bookmarks to a Different Folder
o Delete a Folder
® Delete Bookmarks

JoUIaU| h

(> P. 6-14)
Saved Pages
o Edit a Title
o Protect Saved Pages
@ Check Number of Saved Pages
o Delete Saved Pages
(> P. 6-15)
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IConnecting to the Internet

Start Here

[Web Page] «ee. P. 6-3, P. 6-5
[History List] .... v P. 6-3, P. 6-6
[URL Entry Window] ........ccceeuvuee. P. 6-3, P. 6-6

Yahoo! Keitai

Switch to PC Site Browser

[Web Page] => @ = Switch to PC => @
=> YES => @ (=> YES or NO => ®)

Open Yahoo! Keitai Main Menu

[Web Page] => @ = Yahoo! Keitai = ®

PC Site Browser

Switch Page View

[Web Page] => @ = Change Disp. Mode

= @

£ Page view toggles between PC screen and
Small screen. Small screen adjusts width to
handset Display.

Return to Home

[Web Page] => @ => Home => @

Save a URL in History to Bookmark

[History List] => Select a record = @ =
Add Bookmark => ® => YES => @ =>
Select a folder => @

Check a URL in History

[History List] = Select a record => @ =
URL => ®

Advanced Features

Delete Records in History

[History List] => Select a record => @ =
Delete —> ®
® To Delete the Selected Record
=> Delete This => @ = YES => @
@ To Delete Multiple Records
=> Delete Selected = @ => Select records
= @ = ©® = YES = @
@ To Delete All
=> Delete All => @ => Enter Security Code
= @ => YES > @

Using URL Log

Use Previously Entered URLs

[URL Entry Window] => Select a record =
® => OK => @ (=> YES or NO => @)

Edit Previously Entered URLs

[URL Entry Window] => Select a record =
® => Select URL entry field = @ => Edit
URL => @ => OK => @ (=> YES or NO
= @)

[ )
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E Advanced Features

Send URLs by S! Mail

[URL Entry Window] => Select a record =>

® => Compose Message —> ® => Enter

address, subject and text =

[Z] Composition (S! Mail) window opens with
the URL inserted in the text.

Delete URL Records

[URL Entry Window] = Select a record =
@ > Delete = @
@ To Delete the Selected Record
=> Delete This => @ => YES => @
@ To Delete Multiple Records
=> Delete Selected = ® = Select records
2@ =>® => YES > @
@ To Delete All
=> Delete All => @ => Enter Security Code
= @ = YES = @

Root Certificates

Check Certificate Details

JoUIaU| h

@® = Settings = @® => Connection
Settings > @ = Certificate => @ >
Select a certificate = @

6-12

Switch a Certificate between Valid &
Invalid

® => Settings —> ® => Connection

Settings => ® => Certificate => @ =>

Select a certificate => @ => Valid/Invalid

= @

[Z1 This procedure switches a valid certificate to
invalid and an invalid one to valid.

Save Background Image of a Page

[Web Page] => @ = Save File => @ (=

Background Image => @) => Save => @

=> YES => (® => YES or NO => ®

Z1To check file properties, select Property and
press @).

IPage Operations

Start Here
[Web Page] .......ccocemmrmrincennnnnnnnd P. 6-3, P. 6-5

Reload Page

[Web Page] => @ = Reload => ®

Save Image/Melody Files

[Web Page] = @ = Save File => @ (=

Object => @) (= Select a file => @) =>

Save => @ => YES => @ (= Select a

folder => @) => YES or NO => ®

2370 play a melody, select Play and press @).

21 To check file properties, select Property and
press ®.

Send URL Links via S! Mail

[Web Page] = @ => Convenient Tools >

@® => Compose Message —> @ => Attach

URL => ® => Enter address, subject and

text =

[£] Composition (S! Mail) window opens with
the URL inserted in the text.

Call a Linked Phone Number

[Web Page] = Select a phone number =>
® => Voice Phone or Video Call => ® =>
Dial => @

[Z] Only available when using Yahoo! Keitai.

Send S! Mail to a Linked E-mail Address

[Web Page] = Select an e-mail address =
® => Compose S! Mail =>

Access URL Link

[Web Page] = Select a URL => @




Save Numbers/Addresses to Phone Book

[Web Page] = Select a phone

number/e-mail address => @ => Add to

Phone Book => @® => YES => ®

@ To Save to Handset
=> Phone = @ = Select store method =3
® (= Search Phone Book = Select an entry
=> @ (twice)) = Edit each item => ® (=>
YES or NO = ®) (= Enter entry number =>
®)

@ To Save to USIM card
=> USIM => @ => Select store method =3
® (= Search Phone Book = Select an entry
=> @ (twice)) => Edit each item => ® (=>
Overwrite or Add => @) (= YES => @)

Change Page Font Size

[Web Page] => @ => Change Font Size =>

® = Select a font size = @

[Z10nly available when the page view is Small
Screen in PC Site Browser.

Advanced Features

Play Flash® from the Beginning

[Web Page] => @ => Convenient Tools >
® <> Replay => ®
[Z1Only available when using Yahoo! Keitai.

Zoom In/Out

[Web Page] => @ => Zoom => @ =>

Select a magnification => @

[Z1Zoom is only available when PC Site Browser
is set to PC Screen.

Check Title, URL or Certificate of a Page

[Web Page] = @ => Convenient Tools =>
@® = Site Info => @ => Title, URL or
Certificate => @

Search Information by Keyword

[Web Page] => @ = Quick Search => ®

@ To Enter a Keyword
=> Enter Keyword => ® => Enter keyword
> @ = => @ = Select an item
from search results => @

@ To Select a Keyword from Previous Entries
=> History => @ => Select a keyword => @
= => @ = Select an item from
search results => @

Jump to Top/End of a Page

[Web Page] = @ => Convenient Tools —>
(® => Head of Sentence or End of Sentence
=@

Show Key Guidance

[Web Page] => @ => Help => ®
[Z1Only available when using PC Site Browser.

Change Character Code

[Web Page] => @ => Convenient Tools =

@® => Change CHR Code —> ® = Selecta

character code => @

[£] Use this procedure when characters of a
page are illegible.

jPoUI9U| P
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E Advanced Features

IBookmarks & Saved Pages

Start Here

[Bookmark Folder List] veee. P. 6-9

[Bookmark List] veee. P. 6-9
[Saved Pages List]........ccocvrrmruernrerursesnnns P. 6-9
Bookmarks

Edit a Title

[Bookmark List] = Select a bookmark =>
© => Edit Title => @ => Edit title => @

Edit a URL

[Bookmark List] = Select a bookmark =>
® = Edit URL => @ => Edit URL => @

Send a Bookmark by S! Mail

[Bookmark List] = Select a bookmark =>
® => Compose Message or Attach to Mail
=> @ => Enter address, subject and text
=
[Z1 Compose Message: URL is inserted in
S! Mail Composition window.
Attach to Mail: Bookmark is attached to
S! Mail.

Check Number of Bookmarks

[Bookmark Folder List]/[Bookmark List]

=> @ <> No. of Bookmarks => ®

£ The total number of bookmarks can be
checked from Bookmark Folder List and the
number of bookmarks in a folder can be
checked from Bookmark List.

Create a Folder

[Bookmark Folder List] = @ => Add
Folder => ® => Enter folder name => @

Edit a Folder Name

[Bookmark Folder List] = Select a folder
=> @ = Edit Folder Name => @ => Edit
folder name => @

Move Bookmarks to a Different Folder

[Bookmark List] => Select a bookmark =>

® <> Move > ®

@ To Move the Selected Bookmark
=> Move This = @ => Select a destination
folder => @ => YES => @

® To Move Multiple Bookmarks
=> Move Selected => @ = Select a
destination folder = @ = Select bookmarks
2@ =>0® > YES=> @

o To Move All
=> Move All => @ => Select a destination
folder => @ => YES => @

Change Order of Folders

[Bookmark Folder List] => Select a folder

=> @ = Sort Folder => ® = Select a

position => @

[Z) The order of Preset folders cannot be
changed.

Delete a Folder

[Bookmark Folder List] = Select a folder

=> @ = Delete Folder => ® => Enter

Security Code => @ = YES => @

[£] This procedure also deletes all the bookmarks
saved in the folder.

6-14



Delete Bookmarks

[Bookmark List] => Select a bookmark =>

®@ <> Delete > @
@ To Delete the Selected Bookmark
=> Delete This => @ => YES => @

@ To Delete Multiple Bookmarks
=> Delete Selected = ® = Select
bookmarks => @ => ® => YES => @

@ To Delete All

=> Delete All => @ => Enter Security Code
= @ => YES > @

[Z) Alternatively, to delete all bookmarks:
[Bookmark Folder List] => @ = Delete All
=> (@ = Enter Security Code = @ = YES
= @®

Saved Pages

Edit a Title

[Saved Pages List] = Select a saved page
=> @ = Edit Title => @ => Edit title =>
®

Check Number of Saved Pages

[Saved Pages List] => @ => No. of Pages
= @

Delete Saved Pages

[Saved Pages List] = Select a saved page
=> @ = Delete > ®
@ To Delete the Selected Saved Page
=> Delete This => @ => YES => @
@ To Delete Multiple Saved Pages
=> Delete Selected = ® = Select saved
pages = @ => ® => YES => @
® To Delete All
=> Delete All => @ => Enter Security Code
= @ => YES => @
&) Protected Saved Pages cannot be deleted.

Protect Saved Pages

[Saved Pages List] = Select a saved page

=> @ => Protect ON/OFF => ®

[] Use this procedure to toggle saved pages
between protected and unprotected.

Advanced Features

[ )

jPoUI9U| P
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Overview

Capture still images and record videos with handset camera.

Capture Still Images/Videos

Wide Range of Image Sizes

Select image size accordingly. Use small
sizes for S! Mail attachments and larger
sizes for saving high resolution images.

Photo Modes

Select a mode suited to the subject/scene

eiowied) h

such as Portrait, Scenery and Sports mode.

Non-SoftBank
Mobile Phones

Various Features

Features include:
Auto Timer
Continuous Shooting
Adding Frames

(P. 7-9, P. 7-10)

Chance Capture

Even when video memory becomes full,
continue recording video (P. 7-10). The
continued portion is saved as a separate
file while memory space is created by
deleting the original video from the
beginning.

SoftBank PCs
Handsets

« Lens' focus sound may be audible when using
Camera. This is normal.

« Still images are saved in JPEG format and

videos in MPEG4 format.

Clean the lens with soft cloth. Fingerprints or

grime on the lens may result in blurred

images.

Handset movement during shooting may

cause image blurring when Shake Correction

is OFF. Setting Shake Correction to Auto is

recommended.

Although Camera is made with high-precision

technology, some pixels may appear brighter

and some darker.

Shooting or saving images when handset is

warm may affect image quality.

Exposing the lens to direct sunlight for an

extended period may result in discoloration of

photo images.

» Shutter click and Auto Timer tone sound at a
fixed volume even in Manner Mode.



Overview

. - . @ | Focus Frame (Still Images) ® |Image Size
IV|ewf|nder Indicators A white frame appears for Auto Focus. - Photo Mode/Continuous Shooting
Focus Frame is green when focus is locked, Bl 5M (1920%X 2560) to B SUbQCIF
and red if focusing failed. (128%96)
® | shake Correction - Movie Mode/Chance Capture
& Auto #gm QVGA (320%240) to B SubQCIF
" " (128%96)
@ | Storage Location (Still Image)
Handset Memory Card ® |Image Quality (Still Image)
Storage Capacity (Still Image)’ Super Fine Normal
White number: 11 or more files Fine
Yellow number: 10 or less files File Size (Video)
Red number: No memory space Mail attachment? Long time
Storage Location (Video) Upto2 MB n_
B Handset Memory Card @ | Photo Mode
® ®@O®e0eO () Storage Capacity (Video)' Auto Sports Mode Q
Photo Viewfinder Blue: 500 KB or more Portrait Night View 3
Yellow: Less than 500 KB
Scenery OFF %

Red: No memory space "
Brightness

@ | Camera Mode 2 210 % +2
9% Movie Mode . .
&4 Chance Capture @ |White Balance
[#] Photo Mode £ Auto & Light Bulb
Fine &= Fluorescent Lam|
&) Auto Continuous Shooting % Cloud = P
(83 Manual Continuous Shooting = i
%, Voice Mode @ [Zoom (16 steps) _
Ll Minimum to £-7] Maximum
@ | Auto Timer

) Auto Timer set

® [ AF Guidance (Still Images)
For AF toggle and focus lock

® ® 6 066

Video Viewfinder

7-3



Overview

@ | AF Mode (Still Image)
AFON

Close-up

AF OFF

@ | Recording Type (Video)
Normal (Video & Sound)

Video only B Sound only
® | Image Quality (Video)

Long time Fine

Normal Super Fine

@® | Recording Status (Video)
SEHDBY Recording ready
epEC  Recording

1 Approximate value

2 Available when Select Size is QCIF(176x144)
or SubQCIF(128x96).

3 Auvailable only when Photo Mode is set to OFF
(in normal and continuous shooting modes).

eiowied) h

Captured still images and videos are
automatically saved to handset.

Tip
» Toset so that a preview window appears after
recording:

[Photo Viewfinder)/[Video Viewfinder] = @)
=> Auto Save Set => @ => OFF => ®

Shake Correction

Camera is equipped with Shake Correction.
This function reduces camera shake in 6 axial
directions for still images and 2 axial
directions for videos.

Set Shake Correction off when not needed.




ICapturing Still Images
e

E Frame image in Viewfinder = O}
When the focus locks, Focus Frame turns
green and shutter is released.

Image is automatically saved.

Tip
» To activate Camera (Photo Mode):
® => Camera => ® => Photo Mode =>

» Shutter clicks even if focusing fails and Focus
Frame turns red.

* Focus Frame appears only when Auto Focus is
set.

Capturing Still Images

Photo Preview Window

Appears when Auto Save Set is set to OFF. Press
@ to save image.

“Photo Preview
Window

M To Discard Image and Return to
Viewfinder
= => YES => @

Tip

« Attach still images to S! Mail or set as
wallpaper (P. 7-12, P. 7-13).

« Still images are saved to My Picture in Data
Folder. The storage location can be changed
to memory card (P. 14-23).

Operations ewfind

AF Change

€]

AF Lock

Zoom In'

Zoom Out'

Open Menu

Toggle Camera Mode

Select Size

Quality Setting

Photo Mode

Adjust Brightness

White Balance?

S| Bl G| B & | H] e 2@
e.lawe;)F

Help

1 Zoom is unavailable when Select Size is set to
5M(1920x2560).
2 Available when Photo Mode is set to OFF.



Capturing Still Images

'9 More Features

During Shooting
® Use Camera Menu
o Set Image Quality
@ Switch Color Modes
® Reduce Flicker
@ Check Storage Capacity
o Set Shake Correction
(»P.7-12)
After Shooting
® Send Still Image with Graphic Mail
@ Send Still Image by S! Mail
® Show Mirror Image of Shot Still Image
@ Save Mirror Image of Shot Still Image
@ Capture Image and Set as Wallpaper

eiowied) h

(»P.7-12)

Customize
Camera Settings
o Set Shutter Sound

(> P. 14-23)
File Storage
@ Set Storage Location for Still Images

(> P. 14-23)



Recording Videos

Video Preview Window

IRecording Videos

Appears when Auto Save Set is set to OFF. Press

n ® > Camera —> ® > Movie ® to save video. Zoom In ©
Mode => ® Zoom Out )
Open Menu
Toggle Camera Mode |1
Select Size 2]
File Size Setting
Photo Mode
Video Preview Window Adijust Brightness 5) n_
Video Viewfinder M To Discard the Recording and Return to White Balance 8) Q
E1 Famsimage Vit < ® I = :

ﬂ© 1:/'5 i d to Videos in Data Folder. Th Tip
Recording ends. 10€0 15 saved to Videos In Jata Folder. Tne * Key operation tones may be recorded if you

Video is automatically saved. zta?rda(gpe I1o§_azt|3c;n LA adjust zoom, etc. while recording a video.

77



Recording Videos

'9 More Features

During Shooting
® Use Camera Menu
® Set Image Quality
@ Switch Color Modes
® Reduce Flicker
@ Check Storage Capacity
@ Change Video Type
o Set Shake Correction
(»P.7-12)
After Shooting
@ Send Video by S! Mail
® Show Recorded Video in Standby
o Edit Title of Video

Video Settings
@ Set Shutter Sound

eiowied) h

(»P.7-12)

(» P. 14-23)

File Storage
@ Set Storage Location for Videos
(> P. 14-23)



IContinuous Shooting

Shoot up to 20 still images continuously.

Automatic continuous shooting mode:

Automatically shoots a set number of images

at set intervals after you release the shutter.

Manual continuous shooting mode:

Shoots a set number of images, each of which

is shot by releasing the shutter manually.

@ See P. 14-23 for details on setting interval/
number of shots for Continuous Shooting.

n [Photo Viewfinder]/[Video
Viewfinder] => (1) = &} or (&) =>

Continuous Shooting
Viewfinder (Manual)

E Frame image in Viewfinder = @
Image is automatically saved.

Thumbnail Preview Window

Appears when Auto Save Set is set to OFF.
Press and hold &), Save or Mirror Save and press
@ to save all still images.

Picture

A

mimage 1/ 5

Thumbnail Preview Window

M To Discard Shot Images and Return to
Viewfinder
= => YES => @

Tip

* Image size can only be set to CIF(352x288),
WQVGA(240x427), QVGA V.(240x320),
QCIF(176x144) or SubQCIF(128x96).

Various Features

IAdd Frames to Images

EJ [photo Viewfinder] = @ =
Select Frame > ® => Select a
folder => @ = Select a frame =

®

FJ compose image in the frame => @
Image is automatically saved.

Framed Image Preview Window

Appears when Auto Save Set is set to OFF. Press
@ to save image.

Framed Imae Preview Window

H To Discard Shot Images and Return to
Viewfinder
=> (@) => YES => @

esawe) F
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Various Features

IAuto Timer IChance Capture

@ Auto Timer returns to OFF after shooting. Continue recording video even when

memory is full.

[Photo Viewfinder]/[Video
Viewfinder] > @ > Auto Timer [}l [Photo Viewfinder]/[Video
= @ Viewfinder] => (1) => = @

ON => ® = Enter time = @® E Frame image in Viewfinder => @
Recording starts.

When the available recording time is
over, the remaining time indication

Frame image in Viewfinder = ®
Auto Timer starts countdown, and

lllumination flashes blue. About five flashes.

seconds before shooting, a countdown

tone sounds and Illlumination flashes B @

rapidly. Recording ends.

To stop Auto Timer, press ® or [ceq), Video is automatically saved.

P> For Still Images
Images are automatically saved.
P For Videos

Note

* When recorded video exceeds available
memory, handset saves the maximum

. . recordable time from the end of recording.
Recording ends. Videos are Initial portion is deleted.

automatically saved.

Tip
* To shoot manually during Auto Timer
countdown, press (®).

IRecording Only Sound

Record only audio in Movie Mode (Voice
Mode).

n [Photo Viewfinder]/[Video
Viewfinder] => (1) = %, => @

Ae

Recording starts.

He®

Recording ends.
Video is automatically saved.

Tip
» To activate Voice Mode from Main Menu:
(® => Camera = ® => Voice Mode => @®



'9 More Features

After Shooting

o View Images

@ Save One Frame

@ Save Only Selected Images

@ Save as Animation

@ Open an Image as Mirror Image

@ Send Still Image with Graphic Mail
® Attach to S! Mail

@ Change Frame before Saving Image

(»P.7-13)

Camera Settings
@ Set Interval for Continuous Shooting
@ Set Number of Shots for Continuous Shooting

(> P. 14-23)
File Storage
@ Set Storage Location for Still Images/Videos
(> P. 14-23)

Various Features
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. Advanced Features

IDuring Shooting

Start Here
[Photo Viewfinder] .... e P.7-5
[Video Viewfinder] .... v P.7-7

Use Camera Menu

[Photo Viewfinder]/[Video Viewfinder] =
=> Select an item => @

Set Image Quality

[Photo Viewfinder)/[Video Viewfinder] =>
® <> Quality Setting => @ => Select an
item => @

Switch Color Modes

[Photo Viewfinder]/[Video Viewfinder] =>
® => Camera Settings —> @ => Effect =>
® => Full Color, Sepia or Monochrome =>

®

Reduce Flicker

[Photo Viewfinder]/[Video Viewfinder] =>
® => Camera Settings —> ® <> Flicker =>
® => Auto, Mode 1(50Hz) or Mode 2(60Hz)
= @®

Check Storage Capacity

[Photo Viewfinder]/[Video Viewfinder] =>
® => Memory Info => @

Change Video Type

[Video Viewfinder] => @ => Movie Type
Set => ® => Normal, Video or Voice => ®

Set Shake Correction

[Photo Viewfinder]/[Video Viewfinder] =>
© => Shake Correction => ® = Auto or
OFF=>®

Send Still Image/Video by S! Mail

@ To Send Still Image by S! Mail
[Photo Preview Window] => & => Attach
Image => @ (=> Attach Mail, QVGA Scale
Down or VGA Scale Down => @)=
Compose S! Mail =>

® To Send Video by S! Mail
[Video Preview Window] => & => Compose
S Mail =>

[£] Video files exceeding the size limit are not
attached.

IAfter Shooting

Start Here

[Photo Preview Window].
[Video Preview Window] .
[Thumbnail Preview Window]...
[Framed Image Preview Window]....

.P.7-9
..P.7-9

Send Still Image with Graphic Mail

[Photo Preview Window] => & = Insert
Image —> ® <> Insert Mail or SubQCIF
Scale Down => @® => Create Graphic Mail
=

Show Mirror Image of Shot Still Image

[Photo Preview Window] => @ => Mirror
Display => ®
2] To return image to its original state:
[Photo Preview Window] = @ => Normal
Display => @

Save Mirror Image of Shot Still Image

[Photo Preview Window] => @ => Mirror
Save => @




Capture Image and Set as Wallpaper

[Photo Preview Window] => @ = Set as

Display => ® => Stand-by Display => @

=> Select a layout = @ = Check preview

= @®

[£] Set image to other function windows
(Dialing, Mail Sending, etc.).

Save Only Selected Images

[Thumbnail Preview Window] = Select an

image = @ => Repeat the same step =

& => Save or Mirror Save => @®

[Z)select a checked image and press @ to
cancel the selection.

Advanced Features

Attach to S! Mail

[Thumbnail Preview Window] = Select an
image => @ (twice) = Attach Image —> ®
(=> Attach Mail or QVGA Scale Down —>
®) => Compose S! Mail =>

Show Recorded Video in Standby

[Video Preview Window] => @) => Set as
Stand-by => @

Save as Animation

[Thumbnail Preview Window] => @) =>
Store All&Anime => ® => Save or Mirror
Save => ® = Select a destination => @

Change Frame before Saving Image

[Framed Image Preview Window] => @ =
Change Frame —> ® => Select a folder =
® => Select a frame = @ (twice)

Edit Title of Video

[Video Preview Window] => @ => Edit Title
=> @ => Edit title => @

View Images

[Thumbnail Preview Window] = Select an

image =

[Z]Press © to switch to the previous/next
image.

Open an Image as Mirror Image

[Thumbnail Preview Window] => @ =>

Mirror Display => ®

[Z1To return image to its original state:
[Thumbnail Preview Window] => @ =>
Normal Display => @

Save One Frame

[Thumbnail Preview Window] = Select an
image => @ => &) = Save or Mirror Save

=@

Send Still Image with Graphic Mail

[Thumbnail Preview Window] = Select an
image => ® (twice) => Insert Image —> ®
=> Insert Mail or SubQCIF Scale Down —>
® => Compose Graphic Mail =

esawie) F
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About TV

Handset supports One Seg Digital TV for cellular phones.

@ One Seg is available only in Japan.

One Seg ——
One Segq is a digital TV broadcasting service
for mobile devices. It uses one segment of
the terrestrial digital band for TV and data
broadcasts that you enjoy at home, on your

handset.
kD

Watch TV in
Widescreen

7

Data Broadcasts

Enjoy data broadcasts while watching
TV. Access program-related information
and even participate in the program

(P. 8-6).

Record Programs

Record a program on memory card
while viewing it and enjoy it again at a
later time (P. 8-8).

View and Record Timer

Book programs you want to
view/record. Program Guide can be
used for booking programs

(P. 8-10).

Quick Info

Sender and subject information appears
for new message while TV is active

(P. 14-5).

\

J

Precautions

@ Never watch TV while riding a bicycle,
motorcycle or driving a car. You may not hear
the sounds around you clearly, or TV
image/sound may distract you creating the risk
of accident. Even while walking, pay attention
to the traffic around you. Be especially careful
at railway crossings and pedestrian crosswalks.

@ TV image/sound may be affected if a call or
message is received while watching TV.

@ TV information (TV links or data you entered in
Data Broadcast Mode) saved on handset
cannot be transferred to another handset
when you change your handset to another
model or when it is repaired. Keep a memo of
necessary information.

@ TV is available when USIM Card is inserted and
with a valid SoftBank contract.

@ TV antenna is built into handset. If image
quality does not improve, move handset away
from body or change locations.




About TV

@ TV image/sound may deteriorate or signal

reception may become impossible in the OPeratmg in Landscape View

following areas: Multi Selector for selecting channels or

+ Areas far from signal towers adjusting the volume is operated the same

+ Mountain areas or places beside tall way in both Portrait and Landscape View.
buildings

+ In tunnels, underground malls or buildings I P
with a lot of signal obstructions Initial Setup

@ For more information on One Seg services, visit Configure channel settings for your area and
the following website: save stations to a channel list.
The Association for Promotion of Digital
- ’ El ® > v = ® = Channel
Broadcasting B ®
From PC: http:/Awww.dpa.or.jp/ Settings =

From handset: http://www.dpa.or.jp/1seg/k/ E Select Area = @ = Select area
Uapanese) => (@ = Select prefecture/city =
® > YES > ®

When You First Activate TV Stations for the area are saved to a

The first time you activate TV, the following channel list.

information appears.

+ How to switch between Portrait and Landscape
View

+ Functions unavailable in Landscape View

Read information then press @), select YES,

and press @®. If NO is selected, information

no longer appears when activating TV.

P

Tip

« If signals from stations of the selected area are
difficult to receive, search for stations using
the Automatic option.



About TV

ITV Windows

Quick Info
Ticker scrolls across top of Display for new
messages (P. 14-5).

Channel

Program Title

Subtitles

9 ||

Signal Strength

Strong
£S5 Moderate

Weak
B2 Out of Broadcasting Area

Subtitle Data
&) subtitles Available

Volume

TV Power Saving
@ TV Power Saving Active

Recording Status

@HEC Recording

@MEEC Timer Recording Activated
IIFRIEE Recording Paused

Portrait View

Data Broadcast

TV View Mode
Image Mode
Data Broadcast Mode

0 More Features

Channel Settings

@ Save Stations to a Channel List Automatically

® Save Stations of a Different Area to a Channel
List

® Switch Channel Lists

Channel List

® Change Title of Channel List

@ Delete a Channel List

® Assign Channels to Remote Control Numbers
o Delete a Channel

(> P.8-12)

(> P. 14-21)
Other Settings
@ Check TV Settings
® Reset Channel Settings
o Clear Data Broadcast Memory
® Reset TV Settings
(> P. 14-22)




IWatching TV
(l@®=1v= ® = watchTv = @

TV Window

E Use Keypad to select a channel
Press for channel 10, (0] for channel
11, and for channel 12.

B (=) or press and hold to end
TV => YES > @®
Follow the same step to end TV in
Portrait view.

Tip
+ TV volume is 0" when Manner Mode is active
and no earphone is connected. Adjust with

TV Operations

Change Channel in
Order

&

Automatically
Search for
Receivable
Channels

Press and hold &
+ Press & or [@d to

stop search

Adjust Volume

@ or press and hold @

Bw- or BMusic

Press and hold [H+-or
press and hold Hyse

Mute

Toggle Portrait and | ® or press and hold (9
Landscape

Show/Hide Press and hold
Subtitles’

Toggle Windows?

Press and hold
Windows toggle as
follows:

Data Broadcast — Image
& Data Broadcast —
Image & Subtitles & Data
Broadcast

Switch to Data
Broadcast Mode?

Watching TV

1 Available in Landscape View.
2 Available in Portrait View.

Taking Calls While Watching TV

When a call arrives or when Alarm or
Schedule Alarm is activated while watching
TV, TV is interrupted to receive the call, etc.
TV resumes after call or function ends.

P



Watching TV
Data Broadcasts IProgram Guide

(Japanese) Select a Link ©) @ Use Program Guide to set timer to
Data broadcasts are available while watching Confirm record/activate programs.

i it vi i i Selection of a ;
TV in Portrait view. Access v.arlous k|r.1ds .of Lk ® n @ o TV e @ = Program Guide
program-related and other information in n - ®
Data Broadcast Mode. Switch P.

Lo PR © See Program Guide help for further
n [TV Window] = Previous Page* operations.
Toggle Windows | Press and hold Before first using Program Guide,
Windows toggle as follows: configure initial settings and agree to
Data Broadcast — Image & 'the terrT15 of use. Follow the onscreen
g Data Broadcast — Image & instructions.
— DIRFENT Subtitles & Data Broadcast
cE ‘ :
Switch to TV

Mode

=R
SEOEFHULVRE(TIE
SHOXS

* Available when connected to a data broadcast

= website.
Data Broadcast Mode Window

Note
Data Broadcast Mode is activated. « Viewing data broadcast information requires
. no fees. However, accessing Internet links will

E Select a link <> @ incur transmission fees.
If a confirmation for Internet access + Data broadcasts are unavailable in Landscape
appears, select YES and press @ to view.

access the Internet. Select YES (By
default) and confirmation no longer
appears.



'9 More Features

Watching TV
@ Show Program Information
® Adjust Brightness
@ Switch Main & Sub Audio
o Switch Audio Channels
@ Show Current Channel List Information
® Add Current Station to Channel List
o Select a Program
(> P.8-12)
Data Broadcasts
® Reload Page Accessed from Data Broadcast
@ Check Certificate for SSL Page
o Exit Page and Return to Data Broadcast
(> P.8-12)
TV Link
@ Save TV Links
@ Access Pages/Information from TV Links
® Show Details of a TV Link
@ Show Number of Saved TV Links
o Delete TV Links
(> P. 8-13)

Image & Sound
@ Set Subtitle Display
@ Show/Hide Icons in Landscape View
® Save Battery by Dimming Backlight
@ Set Sound On While Handset Closed
® Keep Backlight On When Viewing TV
® Set Backlight Duration for Viewing TV
(> P. 14-21)
Data Broadcasts
o Set Whether to Show Images in Pages Accessed
from Data Broadcasts
® Enable/Disable Sound Effects of Data
Broadcasts
@ Show Confirmation Window Again
(> P. 14-22)

Watching TV

P
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E Recording/Playing Programs

IRecording Programs

TV programs can be recorded on memory

card while you are watching them.

@ Data broadcast information does not appear
when playing recorded programs.

n [TV Window] => Press and hold
Recording starts.
M To Capture a Screenshot
=
Captured screenshots are saved to TV in
Data Folder.

2]
Recording ends.
Bl When Memory Becomes Full
Recording ends and the recorded
portion is saved.

Note

* The channel remains fixed during recording.
Recording certain programs is restricted. If a
restriction is activated while recording a
program, recording automatically ends, and
the part that has been recorded so far is saved.
When £ appears to indicate handset is out of
the broadcasting area, recording is paused.
When the signal strength recovers to weak or
better, recording automatically resumes.
Recording continues even if handset is closed.
However, this may affect signal reception.
Recordings that you make are for personal use
only. Other uses require the permission of the
copyright holder.

IPIaying Recorded Programs

El ® => Data Folder > ® = TV =
®

F1 video => ® => microsD => ®

microSD
[11=201007011530001
T2201007011530002
=2201007011531003

Recorded Program List

B To View Captured Screenshots
=> Image => @ => Select a folder => @

E] selectafile = @

& CORIEENTOE

Recorded Program Playback Window

H To Stop Playback
=



Tip

« If a program was stopped partway through,
resume playback from that point. Select YES
and press ®).

Playback Operations

Pause/Play

Adjust Volume @ or press and hold @

Hes- or Buusic

Press and hold - or
press and hold s

Mute ®

Fast Play’ (C)

Frame Forward © during pause
Skip Ahead 30 Press and hold @
Seconds?

Skip Back 30 Press and hold ©
Seconds?

Toggle Portrait and |(® or press and hold
Landscape View 9)

Show/Hide Subtitles | Press and hold

1 Toggle normal and fast play.

Recording/Playing Programs

2 Available when recorded program is 30
seconds or more.

0 More Features

Recording Programs
e Edit Title of a Recorded Program
o Reset Title of a Recorded Program
@ Switch Views of Recorded Program List
® Check Information on a Recorded Program
@ Check Volume of Recorded Programs
o Delete Recorded Programs
(> P. 8-13)

Playing Programs
@ Specify Point to Start Playback

Recording Programs
o Continue/End Recording at Low Battery
(> P. 14-22)

(> P.8-14)

P
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View/Record Timer

ISetting View Timer

El ® = 1v = @ => Booking
Program List = ®

caBooking Program List

ariety show
010/ 7/ 5(Mon) 16:15|
ATV AA

View Timer Setting Window

Ho-®
P> To Enter Date Manually
Enter Date —> ® => Enter date and
time => @
P> To Select a Date from Calendar
Choose Date => ® => Select a date
=> @ = Enter time => @

1 B = ® = Select a channel => @®

EH O = ® = on, oniset Time or
OFF => ® ( = Select a time = @)
a
Tip
» When the set time arrives, alarm sounds for
about five minutes and information (start
date/time, channel, program title and

animation) appears. Press any key to stop
alarm tone.

ISetting Record Timer

Fl ®=1v=® = Timer
Recording List = ®

calimer Recording List
/- 1(Thu)

82010/ 7/ 2(Fri)
2010/ 7/ 2(Fri)
v XX
DESports

Timer Recording List

Fl @ = New > ®

tq  Edit Program
B e ]
@2010/ 7/ 1.15:30

[&Recording

Record Timer Setting Window



EO0~®

Enter date and time to start/end

recording.

P> To Enter Date Manually
Enter Date —> ® => Enter date and
time to start and end recording => @

P> To Select a Date from Calendar
Choose Date => ® => Select a date
=> @ = Enter time => @

] B => @ => Select a channel => ®
H B-~®-=o0oNoroFF+®

[ © (> YES or YES (Confirm
Once) > @)

Note

« If multiple recordings are set back-to-back
(same end and start times), the first recording
ends ahead of its set end time.

Tip

+ One minute before recording starts, alarm
sounds for about two seconds. Information
appears on Display (start and end dates and
times, channel, program title and animation)
and TV activates. Recording starts at the set
start time.

'9 More Features

View/Record Timer

® Select a Timer Alarm Tone

o Enter Title of Booked Program

@ Set Regular Activation of View or Record Timer

o Set Timer Alarm Volume

o Activate TV Directly from Timer Alarm
Notification Window

@ Set Priority at Recording Start Time When a TV
& Music Group Function is Active

o Edit View/Record Timer Settings

@ Change Order of Booked Programs

® Delete Booked Programs

® Check Volume of Recorded Programs

@ Check Result of Timer Recording

(> P. 8-14)

View/Record Timer

P



. Advanced Features

IChanneI Settings

Save Stations to a Channel List
Automatically

® => TV => @ => Channel Settings —> ®

=> Automatic => @ => YES => ® => YES

=> (® = Enter title => @

[Z)When a Remote Control Number applies to
two or more channels, select an area
manually.

IWatching TV

Start Here

[TV Window] P. 8-5

Show Program Information

[TV Window] => @ = Program Info => ®

Save Stations of a Different Area to a
Channel List

® => TV => @ => Channel List => ® =>
Not Stored => @ => Channel Settings >
® => Select Area —> ® = Select area =
® = Select prefecture/city => @ => YES
=@

“h

Adjust Brightness

[TV Window] = @ => Display Setting =
® <> Brightness => @ => Select a level =>

®

Switch Main & Sub Audio

[TV Window] => @ => Sound => @ =>
Main/Sub Sound => ® = Select an audio
output option => @

Show Current Channel List Information

[TV Window] => @ => Channel => @ =>
Channel Info > ®

Add Current Station to Channel List

[TV Window] => @ => Channel => @ =>

Add Channel => @ => YES => @

[E1 This function is useful when you find new
stations via auto-search (press and hold ).

Select a Program

[TV Window] => @ => Channel => @ =

Tune Service => ® => Select a service

(program) => @

5] Tune Service is available when more than
one service (program) is broadcast from the
same station.

Switch Channel Lists

® => TV => @ => Channel List => @ >
Select a channel list => @

8-12

Switch Audio Channels

[TV Window] => @ = Sound => @ =>
Sound Switch => @ => Select an audio
channel => @

[Z1Sound Switch is available when there is
more than one audio channel.

IData Broadcasts

Start Here
[Data Broadcast Mode Windowl]..........cccc..... P. 8-6

Reload Page Accessed from Data Broadcast

[Data Broadcast Mode Window] => @ =>
Data Broadcast = @ => Reload Contents

= ®




Check Certificate for SSL Page

[Data Broadcast Mode Window] = @ =
Data Broadcast = ® = Show Certificate

= @®

Exit Page and Return to Data Broadcast

[Data Broadcast Mode Window] => @ =»

Data Broadcast = ® => Back to Data BC
=@

Access Pages/Information from TV Links

@ =>TV=> @ = TVLink~> ®
[Z1 Types of TV links are indicated by the
following icons:
Memo information
Data broadcast site
Internet content

ITV Link

Start Here

[Data Broadcast Mode Window].. ..P. 8-6

Save TV Links

[Data Broadcast Mode Window] = Select
an item = @ (= YES or YES (By default)
= @)

[Z1Some TV links may have expiration dates.

Show Details of a TV Link

® => TV => @ => TV Link => @ = Select
aTV link => @ => Display detail => ®

Advanced Features

IRecording Programs

Start Here
[Recorded Program List].........coceererucnene P. 8-8

Edit Title of a Recorded Program

[Recorded Program List] = Select a
program => @ = Edit Title => @ => Edit
title => @

Show Number of Saved TV Links

® > TV @ => TVLink => @ => @ =
No. of TVIink => ®

Reset Title of a Recorded Program

[Recorded Program List] = Select a
program => @ <> Initialize Title => @ =>
YES => @

Delete TV Links

® => TV = @ => TV Link => ® => Select
aTVlink => @
@ To Delete the Selected TV Link
=> Delete This => @ => YES => @
@ To Delete Multiple TV Links
= Delete selected => @ = Selecta TV link
=> (@ = Repeat step of selecting TV link =
> YES > @
@ To Delete All
=> Delete All => @ => Enter Security Code
= @ => YES => @

Switch Views of Recorded Program List E'

[Recorded Program List] => @ => Switch
List => @ => Title or Title+Image => @

Check Information on a Recorded Program

[Recorded Program List] = Select a
program => @ => Show Info => ®

Check Volume of Recorded Programs

[Recorded Program List] = @) => Check
Memory => ®

813



. Advanced Features

Delete Recorded Programs

[Recorded Program List] = Select a
program => @
@ To Delete the Selected Program
=> Delete This => @ => YES => @
@ To Delete Multiple Programs
=> Multiple-choice => @ => Select a file =>
® (repeat to select another file) => @ =
Delete => @ => YES => @
o To Delete All
=> Delete All => @ = Enter Security Code
> @® > YES > @®

IViewIRecord Timer

Start Here

[Booking Program List]
[View Timer Setting Window]
[Timer Recording List] .........cceu...
[Record Timer Setting Window] ...

Select a Timer Alarm Tone

[View Timer Setting Window] => =@
=> Select a folder => @ (=> Select a sub
folder =>> @) => Select an alarm tone => @

B IPIaying Programs

-
<

Start Here
[Recorded Program Playback Window]
P.8-8

Specify Point to Start Playback

[Recorded Program Playback Window] =>
=> @ => Location => @ => © to
specify point => @

8-14

Enter Title of Booked Program

[View Timer Setting Window]/[Record
Timer Setting Window] => = @ =
Enter program title => @

Set Regular Activation of View or Record
Timer

[View Timer Setting Window]/[Record
Timer Setting Window] = & => @ =>
1 Time, Daily or Select Day —> ®

[Z]When Select Day is specified, select days of
the week and press ®).

Set Timer Alarm Volume

[View Timer Setting Window]/[Record
Timer Setting Window] = B => @ => @
to adjust volume => @

Activate TV Directly from Timer Alarm
Notification Window

[View Timer Setting Window] = [&] => @

=> ON or OFF => ®

[ZWhen ON is set, press @ twice, select YES
and press ® from Alarm Notification
window to activate TV and watch the booked
program.

Set Priority at Recording Start Time When a
TV & Music Group Function is Active

[Record Timer Setting Window] => =
® => Recording or Operation Preferred =>

®

[Z]When Recording is set, the function in
operation is interrupted/ended, and
recording starts. When Operation
Preferred is set, a confirmation asking to
start recording appears.

Edit View/Record Timer Settings

[Booking Program List]/[Timer Recording
List] = Select a booked program => & =>
Edit each item =>




Change Order of Booked Programs

[Booking Program List]/[Timer Recording
List] => @ => Sort => @ => Select a
criterion => @

Delete Booked Programs

[Booking Program List]/[Timer Recording
List] => Select a program => @ => Delete
=@
@ To Delete the Selected Program
=> Delete This => @ => YES => @
@ To Delete Multiple Programs
=> Delete Selected = ® = Select
programs = (® = Repeat step of selecting
programs => @ => YES => @
@ To Delete All
=> Delete All => @ = Enter Security Code
> @® >YES > @®
[EZ] Select Delete Past to delete old bookings.

Check Volume of Recorded Programs

[Timer Recording List] => @ => Memory
Info => @

Check Result of Timer Recording

® => TV => @ => Result Timer Rec => ®
=> Select an entry => @
[Z1Press @ to play the recorded program.

Advanced Features

[ )
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About Music Player

Use Music Player to play and organize songs on handset.

@ Access the Internet to download music. @ Fully charge battery beforehand. Playback unavailable on low charge.
@ Also play videos with Music Player. @ Alarm notifications, incoming calls, etc. will pause playback. For videos,
@ Some files are unplayable depending on their format. select the same video to resume watching.
Play & Organize Songs/Videos on Handset
Save Music

Inbox
Save downloaded music, or music transferred or copied from
Memory Card.

N
N
Sy

Handset .

E +m| Transfer to e

microSD

Save music moved/copied from handset or transferred from PC.

h 11ddy s 78 19fe|d d1snA

[ €3

Memory Card
o Save Videos
PC »* Inbox
Save downloaded videos, videos attached to messages and videos
Download moved/copied from Memory Card.
Download and play music/videos .
V7 | \N o) (packet transmission fees are Camera microSD
* 7| charged). Save recorded videos. Save videos moved/copied from
= = == handset.
A\ | /4
Internet



IPIayback Windows

gl I
® 20QODOB®OG®O® ®
Full Screen Mode (For Video Playback)

Artist Name <Creator>"

Title

Playback Image <Video>"

®|e|ee

Playback Status
>AUR Play MFENEE Pause

PMRF  Fast Forward <dA8 Rewind
PELEW Slow Play? @AM Fast Play?

Current Track/Total Tracks in Folder
(Current File Number/Total Files in
Folder)

Equalizer
OFF
eSS Bass
Tredifla Treble
Treble Reducer
Mp Jeem [k
Tzdlinw @it For each genre of music
Sp=adh For audio playback

Sound Effect

W oFF

? Bass correction (+1 to +3)
usu Surround

%ERE Bass correction

(+1 to +3)/surround

MBS User settings

Repeat Mode
OFF @ Repeat All3
@) Repeat One3

About Music Player

Shuffle Mode
38 oN3 OFF

8| ©®

To Web
Connect to the URL in the song.

Song/file Selection

Volume

®|®|e

Elapsed Playback Time/Total Playback
Time

®

Playback Position

Use € to move playback position during
pause.

11 indicates the current playback position.

1
2

Descriptions in < > apply to video playback.

Available during video playback.

3 Available during music playback.

P 1ddy is 1 19feld d1snin
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9.4

About Music Player

IDownIoading Music

@ Check the fees, expiration date, etc. on the
download site.

n ® => Music => ® => Download
Music => @ => YES => @®

E Follow onscreen instructions

Transferring Music from
PC

Save music from PC to memory card for

playback.

@ Music Player plays AAC-format music (file
extension mp4 or 3gp). Use software to
convert file format as needed.

El ® = settings - ® = External
Connection => ® => USB Mode
Setting => ® => microSD Mode
= @

ﬂ Connect handset to your PC with a
USB cable
This enables memory card data to be
accessed from your PC.

B Copy music to memory card folder
Copy to the following folder:
¥PRIVATE ¥MYFOLDER ¥ My Items ¥ Music

ﬂ Remove USB cable from your PC
and handset
Follow appropriate procedure for your
PC's OS when removing cable.

Note

« See software providers' websites for
specifications and usage of file format
conversion software. SoftBank provides no
guarantees regarding operation of any specific
software.

* Music is for personal use only.

* Files created with PC software, etc. may not
play.

» Do not infringe on third party/intellectual
property rights.

Tip

+ After saving music, return USB Mode
Setting to Communication Mode.



IPIaying Music
El ® = mMusic=>®

F1 select a folder => @
H To Play Music in Memory Card
=> microSD => @ => Music => @ =>
Select a folder = @

@Musicl3

Song List

E] selectasong = ®

JIRACK] /

I & P
Music Playback Window
(Video Playback Window)

Tip

+ Alternatively, play music from Ring Songs -
Music in Data Folder.

Alternatively, in Standby, press and hold Jusic
to start Music Player. Play resumes from
where it was paused last.

If files were saved to memory card via another
handset, those files may be saved to
Sound&Ringtones. To play:

® => Music => @ => microSD => @ =>
Ring Songs => ® => Select a folder => ®
=> Specify music to play

To play videos downloaded or recorded with
camera:

(® => Data Folder => ® = Videos => @ =>
Select a folder => (@) => Specify a video to play
When video is about to be played the first
time, a confirmation appears asking whether
to play video in Full Screen Mode all the time.
Select YES or NO and press ®. Confirmation
no longer appears.

While Handset is Open

Music Playback

Play from Beginning
Play Previous Song or
Video

©) or press and hold
Ber-

Play Next Song/Video

@ or press and hold
BMusic

Rewind

Press and hold ©

Fast Forward

Press and hold @

Move Playback Position

€ during pause

Open/Close Menu

Pause/Play ®

Select a Song/File ® or(8)
Equalizer! )
Sound Effect’ =
Repeat Mode'
Shuffle Mode'
Access the Internet  |(5)
Toggle Normal Screen | (8]

and Full Screen?

End Playback

@ or press and hold
@

Adjust Volume

Bw» or E]Music

1 Press key to toggle on/off.
2 Available when playing videos.

P 1ddy is 1 19feld d1snin
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Music Playback

While Handset is Closed

Hor- or HDuusi

Adjust Volume

Playing from Beginning |Press and hold -
Play Previous Song or

Video

Press and hold [usic

Play Next Song/Video

IUsing Playlists

Use playlists to play songs by genre or by

artist, or gather your favorite songs and

arrange them in your favorite order.

@ Songs saved on memory card can also be
added to playlists.

Creating a Playlist

El ® = Music = ® = Playlist =
®

Playlist
1@
B@Playlistl
B®Playlist2

B ®Playlist3

Playlists Window
Fl1 @ => create Playlist -> ®

E] select a folder => @ = Select a
song = @
Repeat this step to add other songs.

[ when all songs are selected => @ =
Enter playlist name = @

Playing Songs from Playlist

n [Playlists Window] => Select a
playlist => ®
To play all songs in the playlist, press ®.

Playlistl
[i{@Musicol

@Musico2
@Musice3

Playlist

F] select asong => @
Songs play back in the listed order.

Tip
+ To play all songs, select All Tracks (Phone) in
Playlists window and press @ (twice).

'9 More Features

Playing Music/Video
® Resume Playback
® Use Menu
o File Information
® Repeat
o Set Preferred Sound Effect
@ Change Playback Window Appearance
o Set Image Display Size
@ Change Video Playback Speed
® Use a Different Function While Playing Music
@ Check Operation Methods
(> P.9-9)

Organizing Songs
® Set a Song as Ringtone
@ Search for Songs
@ Change Order of Songs
® Check Volume of Saved Music

(» P. 9-10)

Playlists
@ Add Songs to Playlist
@ Change Order of Playlist Songs
o Cancel Playlist Songs
o Edit a Playlist Name
@ Copy a Playlist
@ Check Playlist Information
o Delete Playlists
(> P. 9-10)



IAbout S! Appli

S! Appli are applications designed for
SoftBank handsets. Download games and
other applications.

About Network S! Appli

Since network S! Appli require network (Internet)
connection, transmission fees are incurred. A
confirmation may appear when an application is
connecting to the network. Follow onscreen
instructions.

Tip

» For information on transmission fees, contact
SoftBank Mobile Customer Center, General
Information (P. 15-51).

About License Information

To check Java™ and JBlend™ license information:

El ® =>s! Appli > ® =>
Information —

IDownIoading S! Appli

El ® = s! Appli = ® => s! Appli
List => ® => Download S! App
= @ => YES => @

Follow onscreen instructions.

Note

+ Check the battery level before downloading

S! Appli. If the battery level is low, download

may fail.

If you replace USIM Card due to damage or

loss, downloaded S! Appli are no longer

available.

If you initialize handset when using an S! Appli

moved to Memory Card, the S! Appli will no

longer be usable.

You will need to download it again.

When using an S! Appli moved to Memory

Card, using the procedures below will resave

the S! Appli to your handset and the S! Appli

in Memory Card will no longer be usable.

— Download the same S! Appli with no
Memory Card inserted

— Download the same S! Appli with different
Memory Card inserted

Use an S! Appli resaved to handset as it is in

handset, or again move it to Memory Card.

S! Appli

Tip
+ See S! Appli's Help menu or the download
site for operational information.

IActivating S! Appli

El ® = s! Appli => ® => s1 Appli
List => ®

S! Appli List 1/2

Download S! App

W SIEBRTL 1=
L [}
3] N

‘ﬁﬁhémjj;%

ﬂﬁur\“-v Pt

au\ommjﬁ
S =]

S! Appli List
F1 select an application => @

Tip

+ S! Appli is paused when a call arrives. When
the call ends, a prompt appears. Select
Resume to resume the S! Appli.

+ To end S! Appli:
While running, (=) => End = ®

P 1ddy js 13 19he|d J1sni
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'9 More Features

S! Appli

@ Check S! Appli Information

@ Check Volume of Saved S! Appli
o Delete an S! Appli

(»P.9-11)

When Running S! Appli

® Set Sound Volume

@ Set Vibration

@ Set Backlight

@ Set Blinking of Backlight

o Allow/Prohibit S! Appli to Connect to Network

@ Allow/Prohibit S! Appli to Write Personal
Information

@ Reset Security Settings of S! Appli

(> P. 14-24)
S! Appli
® Reset S! Appli Settings
o Delete All S! Appli

(> P. 14-24)



IMusic Player

Start Here
[Music Playback Window] ...P.9-5

...P.9-5

[Video Playback Window]

[Song List] P.9-5
[Playlists Window] ........ccccceveenerenrenanrnene P.9-6
[Playlist] P. 9-6

Playing Music/Video

Resume Playback

® => Music => @ => Resume Play > ®

Use Menu

[Music Playback Window]/[Video Playback
Window] => ®& => Select an item => @*
*Press to toggle.

File Information

[Music Playback Window]/[Video Playback
Window] => @ => File Property or Video
Info => @

Repeat

[Music Playback Window] = @ = Action
Setting —> ® => Repeat Setting > @ >
All Repeat or Single Repeat —> ®

Advanced Features

Change Video Playback Speed

[Video Playback Window] => @ => Play
Menu => @=> Fast or Slow = ®
[Z1Press @ to return to normal speed.

Set Preferred Sound Effect

[Music Playback Window]/[Video Playback
Window] = @ = Action Setting => @ =
Sound Effect => @ => SRS_WOW => @ =>
Select user setting 1 to 3 =~ & = Set level
for each effect=> @
@ To return sound effect to initial state

=> Select user setting 1 to 3 = @) (twice) =

®

Use a Different Function While Playing
Music

[Music Playback Window] => (=] => Switch

to BGM => ® => Activate another function

[21n Standby, press and hold s during BGM
playback to end Music Player.

Change Playback Window Appearance

[Music Playback Window] = @ => Action
Setting —> ® => Change Skin => @ =>
Select a design => @

Check Operation Methods

[Video Playback Window] => @ => Help >

®

Set Image Display Size

[Video Playback Window] = @ = Action

Setting —> ® => Set Image Disp. > @ >

Normal or Fit in Display => @

[Z] Available when playing in Normal Screen
mode.

P 1ddy s 1 19he|d d1sniy
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n Advanced Features

Organizing Songs Playlists

Set a Song as Ringtone

[Song List] => Select a song = @ = Select
Ring Tone => ® => Select ringtone item =

®

Search for Songs

[Song List], [Playlists Window] or [Playlist]

=> @ = Search => @ = Title => @) =

Enter condition = @

[Z] Select a song from search results and press
® to play it.

Add Songs to Playlist

[Playlist] => @ => Edit Playlist => @ >

Add Music => @ => Select a folder => @

=> Select songs => @ => ® = YES => @

[Z1 The songs you selected are added at the end
of the playlist.

Edit a Playlist Name

[Playlists Window] = Select a playlist => @
=> Edit Playlist Name => @ => Edit playlist
name => @

Change Order of Playlist Songs

[Playlist] = Select a song => @ = Edit
Playlist => ® = Sort Playlist = @ =>
Select a position = @

Copy a Playlist

[Playlists Window] = Select a playlist => @
=> Copy to Playlist => @

Check Playlist Information

[Playlists Window] = Select a playlist => @
=> Playlist Info => ®

Change Order of Songs

[Song List)/[Playlist] = @ => Sort => @ =>
Select a criterion => @

Check Volume of Saved Music

[Song List] => @ => Memory Info => @

9.10

Cancel Playlist Songs

[Playlist] => Select a song => @ => Edit
Playlist => @ = Release Settings => ®
® To Release the Selected Song
=> Release This => @ => YES => @
® To Release Multiple Songs
=> Release Selected = (® = Select songs
@@ PYES>@®
@ To Release All
=> Release All => @ => Enter Security Code
= @ => YES => @

Delete Playlists

[Playlists Window] = Select a playlist => @
=> Delete Playlist => @)
® To Delete the Selected Playlist
=> Delete This => @ => YES => @
@ To Delete Multiple Playlists
=> Delete Selected = ® = Select playlists
2@ =>® > YES—> @
@ To Delete All
=> Delete All => @ => YES => @




Advanced Features

[ )

IS! Appli

Start Here
[S! Appli List] P.9-7

Check S! Appli Information

[S! Appli List] => Select an S! Appli => @ =>
Properties => ®

Check Volume of Saved S! Appli
[S! Appli List] => @ => Memory Info => ®

Delete an S! Appli

[S! Appli List] = Select an S! Appli => @ =>
Delete => @ => YES => @

P 1ddy s 1 19he|d d1sniy






Entertainment

S! QUICK NEWS.....cccceennnnnnnneeenereeeeeeeeeeeeees
Using S! Quick News (Japanese)........c..cccceeueunene
S! Info Channel ...........c...cc.........
Using S! Info Channel (Japanese)...
S! Contents Store.......cccccecmmmeeeeeees
Downloading Contents (Japanese)
Advanced Features........c.ccccveeerreseerenaeenas
S! Quick News
Sl Info Channel.........ccoceeeieciecieece s
Weather Indicators........ccccceeeeeieeieciecieeiee s
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S! Quick News

Using S! Quick News Checking Updated Information ,9 More Features

(Japanese) EN [s! Quick News List] = Select an Bl Advanced
Registered news can be updated item <> @® s Quick N
- ! Quick News
aomatly s chces on Suriy B electinformaton - ©
$1 Quick News To check next updated information, ® View Descriptions of Registered News
' ’ press &. o Delete Registered News/ltems
(> P. 10-6)

Registering News

<Example> Register news on S! Quick News

List S! Quick News
@ Set Automatic Updates for S! Quick News
n Press and hold @ @ Hide S! Quick News in Standby

o Set Ticker Speed
o Set Information to Appear in S! Quick News
o Hide S! Quick News Images
® Reset S! Quick News Registered Contents
(> P. 14-25)

b juswuIe}Ig)UT

S! Quick News List

F1 Add News = ® => YES = ®
E] select an item = @

Follow onscreen instructions.

10-2



Using S! Info Channel
(Japanese)

This information service automatically

receives the latest news, weather and other

information.

@ Packet transmission fees are incurred for using
S! Info Channel/Weather Indicators.

Subscribing for Service

Subscribe by registering to receive service.

El ® = Entertainment > ® = S!
Info Ch./Weather —> @®

&1 §! Info Ch./Weather

History
Register/Cancel

Get Latest Contents
Settings

VWeather Indicator

S! Info Channel Menu

F1 Register/Cancel > ® => YES =

®

Follow onscreen instructions.

S! Info Channel

Checking Latest Information Weather Indicators

A Desktop Icon notifies you when new
information is received.

El © => Desktop Icons & = @

] AUKSArza—R
YRHOO! ~vk5=a.

XXXXXXXXXKXXKXXXXKXRKXX
XXXXXXXXXKXXXXXXXXKXX
XXXXXXXXXXXXXXXXXXXX
XXXXXXXXXXX

Web Page
Follow onscreen instructions.

Tip
* To check from a menu:
[S! Info Channel Menu] = What's New =>

* To check previous information:
[S! Info Channel Menu] => History => @ =>
Select a date => ® => Unread or read
backnumbers are indicated with &1 or Za.

After subscribing, weather indicators
showing current weather appear in Standby.

Weather Indicators

-@: |Clear (Daytime) | [> |Later

J Clear (Night) / |Partial

@ |Cloudy @ Pollen (Low)
* Rain @ Pollen (High)
@- Snow @ UV Rays (Low)
4 |Thunder @] UV Rays (High)

<Example> Cloudy, partial rain « 7/ 4
@ For a complete list of indicators, see Appendix
(P. 15-19).

Checking Weather Report

n [S! Info Channel Menu] => Weather
Indicator => ® => Weather > ®

JusWIUIeId)UT
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S! Info Channel

b juswuIe}Ig)UT

'9 More Features

S!'Info Channel
@ Receive Previous Unreceivable Information
o Store Images/Melodies from Web Pages
© Add Phone Numbers/Mail Addresses from Web
Pages
(> P. 10-6)
Weather Indicators
® Manually Update Weather Information

(> P. 10-6)

S!'Info Channel
@ Set Whether to Display Desktop Icon For New
Received Information
o Set Font Size for Web Pages
(> P. 14-25)

Weather Indicators

o Set Whether to Automatically Update Weather
Information

@ Set Whether to Display Weather Indicators in
Standby

@ Set Whether to Display Desktop Icon For New
Received Information

(> P. 14-26)

104



S! Contents Store .

Downloading Contents
(Japanese)

Download contents via Yahoo! Keitai.

® => Entertainment => ®

EB. Entertainment

1 §!Info Ch./Weather

F1 s! contents Store > ®
Follow onscreen instructions.

F JusWIUIeId)UT
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Advanced Features

L]

IS! Quick News

Start Here
[S! Quick News List] .....ccccceevverreerenennns P. 10-2

Manually Update List

[S! Quick News List] = Select an item =>
@ => Refresh this or Refresh all => @ =>
YES => @®

IS! Info Channel

Start Here
[S! Info Channel Menu] ........cc.cceeeeneeen P. 10-3
[Web Page] P. 10-3

Receive Previous Unreceivable Information

[S! Info Channel Menu] => Get Latest
Contents => @ => YES => @®

View Descriptions of Registered News

[S! Quick News List] => Select an item =>
® <> Outline => @

Delete Registered News/Items

[S! Quick News List] => Select an item =>
®
@ To Delete the Selected Item
=> Delete this => @ = YES => ®
o To Delete All
=> Delete all => @ => YES => @ (twice) =
Enter Security Code = @ (twice)

b jJusWUIeIdUY
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Store Images/Melodies from Web Pages

[Web Page] => @ = Save File => @ (=

Select a file => @) => Save => @ => YES

> @ (= Select a folder = @) (= YES or

NO => @)

[Z)Select Play and press @® to play melody file.

[Z)Select Property and press @ to check file
information.

Add Phone Numbers/Mail Addresses from
Web Pages

[Web Page] => @ = Add to Phone Book —>

® > YES > ®

@ To Save to Handset
=> Phone => @ = Select store method =
(® (= Search Phone Book = Select Phone
Book => @ (twice)) => Edit items => @ (=
YES or NO = ®) (= Enter entry number =
®)

@ To Save to USIM Card
=> USIM => @ => Select store method =
(® (= Search Phone Book = Select Phone
Book => @ (twice)) => Edit items => & (=
YES => @)

IWeather Indicators

Start Here
[S! Info Channel Menu]............ccocceuuee. P.10-3

Manually Update Weather Information

[S! Info Channel Menu] => Weather
Indicator = ® => Manual Update => @ =>
YES => @
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View activities in chronological order.

ILife History Viewer Window

2o010/07/01

®

Life History Viewer Window

e ¥

= 10/07/01

b sjoo1

morning

10/0701  08:05
2070/07/01 08:

112

Time Axis

CliE

Time Axis Zoom

Zoom in or out to adjust time span. Select
Axis unit between one-minute and one-
month.

B2 -2 - P -vice

Data Type

El Still image, Image data
Video

E@ Schedule

K3 Received

g Sent

@ Received & sent messages

Data properties

No Title: Image files and movie files
Title: Schedule events
Sender/Receiver Name: Messages

Icon

Thumbnail: Image files

' Movie files

8 etc. Schedule events

"=, ~, &= , @ etc. Messages

Date and time

Title

Title/Name: Image files, movie files and
schedule events

Sender/Receiver Name: Messages

Tip
« Stillimages and images in JPEG format can be
browsed.

Viewing Data in
Chronological Order

El ® = Tools = ® = Life History
Viewer > ®

Life History Viewer Window

To reduce/enlarge scale of time axis,

press or @



F1 select a data item = @

H
The function corresponding to the data
type is activated and the data is opened.

'9 More Features

Life History Viewer
@ Hide Some Items in Life History Viewer
@ Update Life History Viewer
(»P.11-19)

Life History Viewer

P sjoo1
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Schedule

Save future events to Schedule. Set alarm to
be activated at a specified time with message
and animation appearing to remind you of
the event. Saved events can be checked from
Schedule window.

IScheduIe Window

¢ 2018/ 7/ 1(Thu)
SIMTW|TIF|S|
o 23
—4l5/6/7(8/9]10
11112[13114[15116/17
18]19/20(21(22/2324
25/26/27/28[29/30/31

UT) O 8:00 Slmorning
@ | 1(T) £ 13:00 Gmeeting
1(T) 2 16:30 dgoing out

Schedule Window

b sjool

114

Calendar

Blue date: Saturdays

Red date: Sundays, public and other
holidays

Pink date: Anniversary

Date with gray background: Today

Information Panel

Date, day of the week, content type icon,

time and saved content

« Content Type Icon
( (or a user icon) Event
# Holiday
i+ Anniversary
1 To Do list

+ Event Repetition Icon
& Alarm Notification
[E] Daily event
Weekly event
Annual event
Event for over a day

ISaving Events to Schedule

El ® = Tools = ® => Schedule =
®

2] => Schedule => ®

Edit Schedule
=<Not Recorded>
C32010/ 7/ 1 15:30
C32010/ 7/ 1 15:30
&) Time
30!

N
E3CIock Alarm Tone

[EXNot Recorded>

Event Edit Window

E]l B = ® = Enter details = @ =>
Select an icon => @®

1 [ => ® = Enter start/end date
and time => @

E B8 = ® = 1 Time, Daily ([]) or
Select Day ({T]) = ® (= Put
checkmarks to days of the week =

®)



E [ => @ = Select an alarm
notification option => @ (=> Enter
time)

=> (@ => Select an alarm tone
type => @ (=> Select a folder => @
=> Select an alarm tone => @)
Folders are unavailable when Clock
Alarm Tone, Voice Announce or OFF is
selected.

=> (@ => Enter summary => @
=

Entered content appears when alarm
sounds or vibrates.

Alarm Notification

When the set time arrives, alarm sounds and
animation appears (on Display or Sub-display) for
approximately five minutes.

Press any key to stop alarm. Press any key again to
end notification message.

Tip

« If the set alarm time arrives during a call,
alarm tone sounds through earpiece.

« If a call arrives while alarm is sounding, alarm
stops.

Schedule

Adding Holidays & Anniversaries IChecking Saved Events

El ® = 1ools = ® = Schedule =
®

EN [schedule Window] = ® =
Holiday or Anniversary => ®

Fl (] = ® = Enter year, month and
date => @

B => @ => 1 Time or Annually
@-~®

1 & = ® = Enter content => ®
5

Setting Secret Entries

Set private events as secret entries.

@ Activate Secret Mode or Secret Data Only
Mode beforehand (P. 4-6).

@ Events set as secret entries are viewable only in
Secret Mode or Secret Data Only Mode
(P. 4-6).

n [Event Edit Window] => Enter
items =>

Tip

* To cancel setting in Secret Mode or Secret
Data Only Mode:
[Event List}/[Event Details] = @ => Release
Secret = (@ => YES => ®

2
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© 8:00 Glmorning
£213:00 &meeting
2 16:38 Glgoing out

Sch

edule Window

Press &) to toggle between weekly and

monthly view.

F1 & = select a date with events =

®

T

2010/ 7/ 1(Thy) |

P sjoo1

@neeting

Glgoing out
nne;

Event List
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Schedule

E] select an event => ®

5o Schedule

Date (from):
7/ 1(Thu) 8:00

Date (t0):

7/ 1(Thu) 8:30
[Th
IAlarm:ON
Summary :

Plan:®
morning assembly

Event Details

IDeIeting Events

To Delete One Event

n In [Event List], select an event or
[Event Details] => @

Pl Delete => ® => Delete This -> ®
= YES => ®

h sjooy

To Delete Multiple Events

n In [Schedule Window], select date,
[Event List] or [Event Details] => @

Pl Delete => ® => Delete Selected
= @®

116

E] select an event => ®
Repeat this step to specify other events.

[(A®=vEs=>®

To Delete All Events Prior to a
Specified Date

n In [Schedule Window], select date,
[Event List] or [Event Details] => @

F1 Delete => ® => Delete Past > ®
=> Select an item = ® => YES =

®

'9 More Features

Schedule

o Sort Events by Icon

® Save Image/Animation to User Icon List
@ Cancel User Icons

® Check Number of Saved Events

o Edit an Event

o Copy an Event

o Delete All Events

® Reset Holidays

@ Search Information by Keyword

Alarm
@ Set Priority at Alarm Notification Time
@ Change Alarm Tone

(»P. 11-19)

(> P.14-2)



To Do List

Save tasks to To Do List. Set Alarm to remind P> To Cancel a Due Date .
you of deadlines. No Date => @ ICheckmg Saved Tasks
N k H E = @ = select a priority level [l ® = Tools => ® = To Do List >
ISavmg Tasks N0O) ®
n %E>Toolsc>© = To Do List = E B = @ => Select a category = ® Tg.Do ListAll
[nner
e ® [ = @ = Select an alarm eI
= New = notification option = @® (= Enter
M To Edit a Saved Task time)
=> Select a task => @ => Edit => @ Task List
ST T st [ B = @ = select an alarm tone P2 select a task = @
Edinner — type => @ (=> Select a folder => ®
o . => Select an alarm tone => @) =
inner
Egersonal bue Date:
EXC| ock Alarm Tone Folders are una\{ailable when Clock . gg;g{ezfol(gggim 08
Alarm Tone, Voice Announce or OFF is gotDate " |
Task Edit Window selected. pfiﬁﬁ?géuﬁﬁ?’"a -
|Alarm: OFF (o)
B B => @ = Enter task = @ Alarm Notification [Status : P1aA o
) ) @
Task appears when alarm time arrives. When the set time arrives, alarm sounds and
animation appears (on Display or Sub-display) for m_
ﬂ E] - @ Task Details

approximately five minutes.

P> To Enter Date Manually )
Press any key to stop alarm. Press any key again to

Enter Date = ® = Enter due date

and time => @ end notification message. Tip
» To Enter Due Date from Calendar Tip ° Qverd(ue tasks are indicated by red status
icons (e.g. b
Choose Date = @ = Select a date  If the set alarm time arrives during a call,
on Calendar => @ => Enter date/time alarm tone sounds through earpiece.
=@ + If a call arrives while alarm is sounding, alarm

stops.

11~
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To Do List

IDeIeting Tasks
To Delete One Task

n In [Task List], select a task or [Task
Details] => @

Pl Delete => ® = Delete This -> ®
= YES => @

To Delete Multiple Tasks

EN [Task List] = @

Pl Delete -> ® => Delete Selected
= @®

E] select atask = @
Repeat this step to specify other tasks.

l®-=>YEs=>®
To Delete All Completed Tasks

EN [Task List] = @

Pl Delete => ® = Delete
Completed > @® => YES => ®

118

'9 More Features

To Do List

o Sort Tasks by Category
@ Change Order of Tasks
o Set Task Status

o Delete All Tasks

Alarm
@ Set Priority at Alarm Notification Time
e Change Alarm Tone

(> P. 11-20)

(»P.14-2)



Text Memo

Save short notes or messages as text memos.

@ Saved text memos can be inserted in Schedule IDeIeting Text Memos 0 More Features
or in messages.
To Delete One Text Memo K3 Advanced

ISaving Text Memos ED [(Text Memo List] > Select atext ~ TextMemo
memo = @ ® Save a Text Memo to Schedule
fl @ = Tools > ® = Text Memo o Sort Text Memos by Category
= @® E Delete => ® => Delete This =>® e Check Text Memo Information
EogEETe e = YES = @ o Delete All Text Memos

[Thank you for everyth (» P. 11-20)

Hello, How are you?
<Not Recorded>
<Not Recorded>
<Not Recorded>
<Not Recorded>
<Not Recorded>
<Not Recorded>
<Not Recorded>
<Not Recorded>

To Delete Multiple Text Memos
EN [Text Memo List] = @

Pl Delete -> ® => Delete Selected
= @®

E] select a text memo => @
Repeat this step to specify other text
memos.

F1 <not Recorded> = ® => Enter [(e-ves—®
content => @®
M To Edit a Saved Text Memo
=> Select a text memo => ® => Edit
content => @

Text Memo List

P sjoo1
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Voice Memo

Record voice for up to 20 seconds. Handset

makes single recording and overwrites each

time.

@ SeeP. 3-5and P. 3-18 for playing and deleting
a recorded voice memo.

IRecording Your Voice

El ® = Tools => ® => Voice Memo
= @

Pl YEs => ® = Record your voice
Speak into microphone after short beep
sounds through earpiece.

When remaining recording time reaches
five seconds, a short beep sounds. When
recording is finished, two short beeps
sound. To stop recording, press @®.

Tip

* Recording stops automatically when a call
arrives, alarm goes off or another function is
activated.

« See P. 3-4 for details on recording the other

party’s voice.

h sjooy
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Calculator

IUsing Calculator Tip
« If the calculation result exceeds 10 digits, .E
El ® = T1ools > ® = Calculator - "
®

E Enter numbers with Keypad =
Enter +, —, X or + with Multi
Selector

M To Calculate Negative Numbers
=> @) => Enter numbers with keypad =
Enter +, —, X or + with Multi Selector

13O

Result appears.

Enter Number

c

+ (Add)

— (Subtract)
X (Multiply)

P sjoo1

-+ (Divide)

= (Equal)

Decimal Point

Cancel Calculation

(EO)
(D)

ANEEEEEEE

Clear Number

1111
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Alarm

ISetting Alarm
El ® = rools = ® => Alarm = ®

00
larm2
BAlarm3  OFF |
OAlarmd — OFF |
BAlarm5  OFF |
Alarm List

F1 select an alarm =

EdAuto Power OFF

Alarm Setting Window

El B = ® = Enter title => @

Title appear in Alarm message.

1 @ => ® = Enter time = ®

1112

EH 8 = ® = 1 Time, Daily ([) or
Select Day ({T]) = @ (=> Put
checkmarks to days of the week =

®)

[ B = ® = Select an alarm tone
type => @ (=> Select a folder => @®
=> Select an alarm tone => @)
Folders are unavailable when Clock
Alarm Tone, Voice Announce or OFF is
selected.

= @ = @ to adjust volume =

BEa-~-®
P> To Set Snooze
ON => ® => Enter number of
activation times = Enter time
interval
P> To Cancel Snooze
OFF => ® => Enter ringing duration

El Bl = ® = ONorOFF = ® = ®

H To View Alarm Entries
=> Select an entry => @

k¢ Alarm
A larml

6:00

N Time

Clock Alarm Tone
Level 4

Snooze 5times/5min
lAuto Power OFF

Alarm Details

Alarm Operations

When the set time arrives, alarm activates and
animation appears (on Display or Sub-display).
When Auto Power is set to ON (Alarm Setting
window), handset automatically turns on for
alarm.

Press any key to stop alarm tone with handset
open.

When Snooze is set to OFF, press any key again
to cancel alarm and return to previous window.
When Snooze is set to ON, alarm tone repeats at
the set interval. Press (—] to cancel Snooze.



Alarm

Note ") More Features

* When Keypad Sound is set to ON, two short

beeps sound if you: n Advanced

— Press a key, after canceling alarm (Snooze

Alarm
not set). c | AL AL
— Press (—J while snooze is still set. ¢ Lance arms
« Set the auto power-on function to OFF in o Edit Alarm Settings
Alarm Setting window and turn off handset, (> P. 11-21)
when you are near high-precision electronic .
devices or devices using weak signals, on an Customize
aircraft or in a hospital where handset use is Alarm
;;roh|b”|ted: hile alarm i I ® Set Priority at Alarm Notification Time
° Ltgpcsa arrives while alarm is sounding, alarm o Change Alarm Tone

(»P.14-2)

If the alarm activation time comes during a
call, alarm sounds from Earpiece. Snooze does
not work even if it is set to ON.

ICanceIing Alarm

n [Alarm List] => Select an alarm =

®

Each time you press &), alarm toggles
between ON and OFF.

P sjoo1

Tip
« Alarm settings are retained even if alarm is
canceled.
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Bar Code Reader

About JAN & QR Codes

Scan JAN and QR codes with Bar Code
Reader.

JAN Code

JAN codes are linear (1-dimensional) barcodes
consisting of parallel bars of varying width. Scan
JANS (8-digit) and JAN13 (13-digit) codes.

QR Code

QR codes are matrix (2-dimensional) barcodes

which can store information including kanji, kana
and pictographs. Some data may require multiple
QR codes to store the complete data (split data).

IScanning Bar Codes

@ Position handset camera at a distance of 10 cm
from the bar code.

El ® = Tools => ® => Bar Code
Reader > ®

1114

E Frame barcode in Scan Viewfinder

— Scan Viewfinder

Sl

SETRIR)

Scanning

Scan Window

Scanning starts automatically.
Use © to zoom in/out.

H To Cancel
= @ => 0K = @®

H To Scan Split Data
=> OK => @ (twice) = Scan a QR code
Repeat to scan another QR code. Scan all
split data to access and save information
on handset.

EJ check scanned data
M To Discard Scanned Data
= => YES => @

] ® = store > ® = YES > ® =
OK > ©®

Tip

+ Make sure to zoom in and focus JAN/QR code
in Scan Viewfinder.

+ Scanning may take a while.

* Some bar codes may not be scanned.

IChecking Scanned Data

EN [Scan Window] => @ => Reading
Data List > ®

120100701 1326 0000
B20100701_1225_0000

£120100701_0915_0000

Saved Scan Results List

F1 select an entry => @

Scanned Information

Tip
+ Characters that are not supported by Bar

Code Reader are replaced with spaces
(blanks).



0 More Features

Using Scanned Data

© Make a Call

® Compose S! Mail

® Access the Internet

@ Save to Phone Book

® Save a Bookmark

o Copy Text

© Edit Title of Scanned Data
@ Delete Scanned Data

(»P.11-21)

Bar Code Reader

P sjoo1
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Text Reader

Abo t Reade

Use Text Reader to scan printed text.

Scan Modes

Card read

Scan name, phone number,
e-mail address, postal code,
address and memo printed
on business cards, and save
all scanned data collectively
as a Phone Book entry.

Compose
message

Scan address, subject or
message text, and open
Composition (S! Mail)
window with the address,
subject or message text
entered.

URL

Scan URL, and access the page
or save the URL to Bookmark.

h sjooy

Mail address

Scan e-mail address, and
compose an S! Mail to the
address.

Phone number

Scan phone number, and
make a call to the number.

Free memo

Scan Japanese or English
text, and save the text to
Text Memo.

11-16

k¢ Card Read
hen not fitting in a Frame
Read again _([4[»|: ITen Changey—— O

B e ey e el
O——  Akima-Masami
e e )
®—|:|_|
N &G EEIEEIEE
kimaMasani
®_
®—— ateral Bl 20Nega | ©
——0®

Scan Window

Scan Viewfinder

Category Icons
[Z] Name

f&l Phone number
[& E-mail address
[# Postal code
@ Address

[El Memo

[Tol Address

Kbl Subject

= Message text

Scanned Text

Scan Mode

Remaining Number of Characters That
Can be Scanned

Negative Mode
Nega appears when NEGA/POSI Mode is
set to Negative Fix.

Key Guidance




IScanning Text

@ Position handset camera at a distance of 10 cm
from the text.

<Example> Scanning in Card Read mode
El ® = Tools > ® => Text Reader
=@

Pl New => ® = Card Read => ®

75 Card Read

|2 [GIEICIENE]

Please read
a_Name

B 32

Lateral

Scan Window

E] S => select a category icon =
Frame text in the Scan Viewfinder
Use @ to zoom in/out.

®
n The scanned text appears.
B To Rescan the Same Text
= (@) => YES => @
Bl When Text Extends Beyond View
=> & to scroll the field

M To Scan Following Text
=> (@ => Frame text in the Scan
Viewfinder (include several scanned
characters of the preceding text) = @
H To Scan Another Item
=> @ => € = Select a category icon =
Frame text in the Scan Viewfinder => @

H®

Tip

*+ Make sure to zoom in and focus text in Scan
Viewfinder.

* When Processing ...
handset.

+ Handwritten text is not recognized.

+ Text may not be recognized correctly when:
— Faxed or copied text is scanned.
- Decorated characters are scanned.
- Spaces between characters are uneven.
— Text is indistinguishable from the

background.

- Ambient lighting is inappropriate.

appears, do not move

Text Reader

IChecking Scanned Text

El ® = Tools => @ => Text Reader
=> (@ => Reading Data List => @®

k¢ Text Reader
501 tBank

Scanned Text List

B Select an entry => ®

5 Text Reader

emo

Scanned Text Details

P sjoo1
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Text Reader

0 More Features

Scanning Text
® Correct Scanned Text
® Edit Scanned Text
@ Set Printing Status of Text
@ Set Guidance ON/OFF
® Set Vertical/Lateral Scan
(»P. 11-21)

Using Scanned Data

© Make a Call

® Compose S! Mail

® Access the Internet

@ Save to Phone Book

® Save a Bookmark

@ Search Phone Book

® Save a Text Memo

o Copy Text

® Delete Scanned Data
(»P.11-21)

h sjooy
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ILife History Viewer

Start Here

[Life History Viewer Windowl]............. P.11-2
[Life History Viewer Closeup Window]
P.11-3

Hide Some Items in Life History Viewer

[Life History Viewer Window]/[Life History
Viewer Closeup Window] => @ => Display
Setting => ® = Select a data item => ®
=> Select an item => @ =

[Z10nly checked items appear in Life History
Viewer window.

Update Life History Viewer

[Life History Viewer Window]/[Life History
Viewer Closeup Window] = @) => Reload
= @®

IScheduIe

Start Here

[Schedule Window] .... ..P.11-4
[Event Edit Window] .. ..P.11-4
[Event List] P.11-5

[Event Details]... ...P.11-6

Sort Events by Icon

[Schedule Window], [Event List] or [Event
Details] = @ = Icon Display => @ =>
Select an icon => @

Save Image/Animation to User Icon List

[Schedule Window], [Event List] or [Event

Details] = @ = User Icon setting => @

=> Select item = @ => Select folder => @

=> Select item => @

£ User Icons are available when saving events
to Schedule. The selected image/animation
appears in alarm notification.

Cancel User Icons

[Schedule Window], [Event List] or [Event
Details] = @ => User Icon setting => @
=> Select item = ® = Release this => @
(=> YES => @)

[Z]Select Release All to cancel all icons.

Advanced Features

Check Number of Saved Events

[Schedule Window] = @ = No. of
Schedules => ®

Edit an Event

[Event List]/[Event Details] (= Select an
event) = ® = Edit each item =>

Copy an Event

[Event List]/[Event Details] => @ => Copy

=> @ => Enter start/end date and time =

@® => Edit each item =>

[Z]Repetition setting of an event is canceled
when it is copied.

Delete All Events

[Schedule Window], [Event List] or [Event

Details] = @ = Delete => @ => Delete

All => ® => Enter Security Code => @ =>
Select an item => @ => YES => @

P sjoo1

Reset Holidays

[Schedule Window] =>> @ = Reset Holiday
= @ = YES > @

11-19
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E Advanced Features

Search Information by Keyword

[Event Details] => @ => Quick Search => @®

@ To Enter a Keyword
=> Enter Keyword => @ = Enter keyword
=@ = => @ = Select an item
from search results <> @

@ To Enter a Keyword with Quote Keyword
=> Quote Keyword = @® => Schedule or
Summary => ® => Move cursor to head of
keyword to search = @ => Move cursor to
last character of keyword to search = @ =>
=> @ => Select item from results
= @®

@ To Select a Keyword from Previous Searches
=> History => @ => Select keyword => @
= = Select item from results =
®

ITo Do List

Start Here
[Task List] P. 11-7
[Task Details] P. 11-7

Sort Tasks by Category

[Task List] => @ = Category Display > ®
=> Select a category => @

IText Memo

Start Here
[Text Memo List].....cccceeceereeereerrceervennens P.11-9

Save a Text Memo to Schedule

[Text Memo List] = Select a text memo =>
® <> Edit Schedule > @® = Enter each
item =>

Change Order of Tasks

[Task List] => @ => Sort/Filter => @ =>
Select a criterion => @

11-20

Set Task Status

[Task List]/[Task Details] (= Select a task) =

® => Change Status —> ® = Select a

status => @

[Z] The set status is indicated by the status icon
in Task List and in Task Details.

[ZlWhen Completion is set as status, enter the
completion date.

Delete All Tasks

[Task List] => @ => Delete => @® = Delete
All => @ => Enter Security Code = @ =>
YES => ®

Sort Text Memos by Category

[Text Memo List] = Select a text memo =
@) => Category => ® = Select a category
=@

Check Text Memo Information

[Text Memo List] = Select a text memo =>
® <> Text Memo Info => ®

Delete All Text Memos

[Text Memo List] => @ = Delete => @ =>
Delete All => ® => Enter Security Code >
® > YES > @




IAIarm

Start Here
[Alarm List]
[Alarm Details]..

P.11-12

Cancel All Alarms

[Alarm List]/[Alarm Details] => @ =>
Release All => ® => YES => ®

Edit Alarm Settings

[Alarm List]/[Alarm Details](=> Select an
alarm) = & => Edit each item =

IBar Code Reader & Text Reader

Start Here
[Saved Scan Results List] ..
[Scanned Information]
[Scan Window].........
[Scanned Text List]..
[Scanned Text Details]...

.P.11-14
.P.11-14
.P.11-17
.P. 11-17
.P. 11-17

Scanning Text

Correct Scanned Text

[Scan Window] = Scan text = € to move
cursor to the character you want to correct
=> Press the number key corresponding to
the correct character on the suggestion list

51 Press to toggle upper case and lower
case.

Edit Scanned Text

[Scan Window] = Scan text = @ = Edit

=> (@ = Edit text using keypad

£ To cancel editing and return to scanned text,
press @), select Select Recog. Data and
then press @®.

Advanced Features

Set Printing Status of Text

[Scan Window] => @ => NEGA/POSI Mode

=> (@ = Auto setting, Positive Fix or

Negative Fix => ®

[Z]Set to Positive Fix when dark-colored text is
printed on a light-colored background.

[51Set to Negative Fix when light-colored text
is printed on a dark-colored background.

Set Guidance ON/OFF

[Scan Window] => @ = Guidance OFF or
Guidance ON => ®

Set Vertical/Lateral Scan

[Scan Window] => @ => Vertical Writing or
Lateral Writing => @

Using Scanned Data

Make a Call

P sjoo1

[Scanned Information]/[Scanned Text
Details] = Select a phone number => @ =
Dialing = ® => Voice Phone or Video Call
=> @ => Dial => @ => Talk => (=) to end
call

11-21
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E Advanced Features

Compose S! Mail

[Scanned Information]/[Scanned Text
Details] = Select an e-mail address = @
=> Create S! Mail => ® => Compose and
send S! Mail

Save a Bookmark

[Scanned Information]/[Scanned Text
Details] = Select a URL => @ => Add
Bookmark => @ (twice) > Select a folder

=@

Access the Internet

[Scanned Information]/[Scanned Text
Details] = Select a URL => @ = Internet
=@ => YES > @

Search Phone Book

[Scanned Text Details] = Select an item =>
© = Search Phone Book => ® = Search
Phone Book

Delete Scanned Data

[Saved Scan Results List]/[Scanned Text List]
=> Select an entry => @
® To Delete the Selected Entry
=> Delete This => @) => YES => @
® To Delete All
=> Delete All => @ => Enter Security Code
=@ <> YES <> @

Save to Phone Book

[Scanned Information]/[Scanned Text

Details] = Select an item => @ => Add to

Phone Book => ®

@ To Save to Handset
=> Phone = @ => Select store method =
® (= Search Phone Book = Select an entry
=> @ (twice)) = Edit each item = ® (=>
YES or NO => @) (=> Enter entry number =>
®)

@ To Save to USIM Card
=> USIM => @ = Select store method =
® (= Search Phone Book = Select an entry
=> @ (twice)) = Edit each item = ® (=
Overwrite or Add => @) (=> YES => @)

Save a Text Memo

[Scanned Text Details] = Select an item =>
® => Add to Memo => ®

Copy Text

[Scanned Information]/[Scanned Text
Details] = @ => Copy = @® = Select
beginning of characters = @ = Select
end of characters => @

Edit Title of Scanned Data

[Saved Scan Results List] = Select an entry
=> @ => Edit Title => @ => Edit title => @

1122



Data Management

About Data Folder...........ccoovservuernrsnnnnnnns 12-2 Advanced Features........c..ccoorservuersersaenaens 12-14
Accessing Files .......cocooeiirimnecccieicees 12-3 ACCesSING FIles ...
Opening Files.........ccooiiiiiiiiiiiceceeecee 12-3 Editing Files ...........
Creating Animations.........ccccceveeieeierieesiescenes 12-4 Managing Folders .
Using Playlist (Melodi€s) ........ccoceeerereeiieiinnienns 12-5 Managing Files...... .
Using Playlists (Vid€os).......c.ccoverereririencniennenne 12-5 Memory Card........ccceeeiiiieiiiiiieeee e
Editing Files........ccccoiiimniiniiins e
Editing Still Images...
Editing VIdeOs .......ccccevuiriieniiiiecineeeeies
File & Folder Management...............cceucee. 12-9
Creating a Folder.........cocooiiiiiiiiiiice, 12-9
Moving Files to a Different Folder.................... 12-9
About Memory Card
Inserting & Removing a Memory Card............ 12-10
Managing Memory Cards ........cccoeeernines
Formatting a Memory Card.......

Accessing Memory Card Data
Copying Data between Handset &

Memory Card.......ccceeeeieeieeeeeeee e 12-12
Configuring Print Settings of Images.............. 12-13
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About Data Folder

Use Data Folder to manage data on handset. Files are automatically saved to folders by file format.
@ Some folders contain links. Use the links to access download sites in Yahoo! Keitai.

Folders & Files in Data Folder

My Picture Melody S! Appli
Image files (Camera images and downloaded Melodies and audio files recorded by Voice Downloaded S! Appli
files such as My Pictograms) Announce
Ring Songs-Music Videos TV
Chaku-Uta®, Chaku-Uta Full® and Video files (captured/downloaded video files) Recorded programs' and captured screenshots?

downloaded music files

1 Save to memory card only.
2 Save to handset only.

When Data Folder memory is full or number of files savable is reached, a message asks whether to delete unnecessary data (note, however, this message
may not appear depending on the data type). Follow the steps below to delete data:

YES => @ => Select a folder = @ = Select a data item => @ => ®& => YES => @

@ You may need to select a data type before selecting a folder if the data you want to delete has multiple storage areas.

@ You may need to select more than one data item to delete depending on the degree of insufficient memory.

b juswabeue eyeq
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Accessing Files

IOpening Files Opening Files on Memory Card Using Picture Files

<Example> Open Video File n ® = Data Folder => ® Open a picture file from My Picture folder.
! ® > Dpata Folder > ® = FA select a folder = ® => microSD

Videos = ® = @®
FJ select a folder > ® E] select a folder = ®

Canera 7 select afile = @

(1201007011530
Indicators in File List

= i i

Indicators show file type and available Picture indow o
File List operation. Operations in Picture Windo [
[Tl QVGA movie perations in Fictu fndow o
E] select afile > ® IEN VGA movie Switch Files ) 2
& Attach to mail Toggle Normal ®) o
[iL Insertin Graphic Mail Screen and Full « In full screen mode, g
g Set as wallpaper, etc. Screen view vertical images
pap 9 Q
g4 Setasaringtone in Portrait View; []
1r Infrared transmission horizontal Images in %
4 Copy/move to memory card Landscape View. 3
% Edit Zoom In/Zoom Out* |@® => ®) or -
— Over 10 MB et @) = m_
Opened File Window B Aopli M Card fil Show at Actual Size* | @ ®
. (Applies to Memory Card files) Scroll Large-sized or |
Tip Zoomed-in Image*
« Select files in S! Appli to activate S! Appli. For . .
information about S! Appli, see P. 9-7. * Press ® to return to the original size.

» Select files in Ring Songs-Music or Videos to
activate Music Player. For details, see P. 9-3.
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Accessing Files

Open a file from Melody folder.

NOW PLAYING

Melody Window

Playback Operations

Switch Files O
Adjust Volume (@)
Bw- or Ellllusic
Stop ®
End

b juswabeue eyeq
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Note
+ Only images in JPEG format can be used for
creating animations.
+ Some images may be unavailable depending on
the image size or file size.
* Images saved on memory card cannot be used.

ICreating Animations

Create animations each of which is made of
up to 20 frames using still images in My
Picture folder.

El ® => Data Folder => ® => My
Picture => ® => Original
Animation => ® .

Tip
+ Select an animation you created in Original
Animation List and press @ to play the
animation.

M= QOriginal Animationi/2
[1[KNew>
<New>
<New>
@<New>
<New>
<New>
<New>
<New>
New>
New>
New>
New>

Original Animation List

Fl <New> = ®

B Select a frame => @ = Select a
folder => ® => Select a still image
= @®
Repeat this step to assign a series of
images to their respective frames.

M To Cancel an Assigned Image
=> Select a frame = @® = Release This

= @®



Accessing Files

IUsing Playlist (Melodies) IUsing Playlists (Videos) Tip
Save melodies to Playlist to play back in the Save videos to a playlist to play them in the : S@electalplayhst fromiaplaylistioldenandlpress
saved order. playlist order. @ kY.
El ® = Data Folder > ® = El ® => Data Folder > ® =
Melody => ® => Playlist Videos => @ => Playlist => ®
F1 ® = Edit Playlist > ® Playiist
M To Clear Playlist y
i Playl ist3
=> @ = Release Playlist => ® => YES ] jplgzl it
=@ B Playlists
B Select a number => @ => Select a o
folder => @ => Select a melody = o
@ -,
Q
Repeat this step to assign other melodies <
to different numbers. Playlists Window g
B To Cancel an Assigned Melody ) ; []
=> Select a number => ® => Release A select a playlist > @ = Edit ‘g
This = ® Playlist -> ® 3
[0}
4 E] select a number => @ => Select a 3
. folder => @ => Select a video > @
T|p Repeat this step to assign other videos to m_
+ Select Playlist folder in Melody and press ® different numbers.
tcohplay‘ Pla¥!||st. o T M To Cancel an Assigned Video
anging file names of melodies on Playlist, > Select a number = @ > Release

or deleting melody files clears Playlist.
V2 ITESy T U This => @ = YES > @

4]
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Accessing Files

'9 More Features

Opening Files
® Check File Information
@ Change Order of Files
@ Set an Image to Appear in Standby
@ Set a Video to Appear in Standby
o Set a Melody/Video as Ringtone
(> P. 12-14)
Viewing Images
® Play Animation from the Beginning
® Compose Four Images to Make One
o Set Display Size of an Image
e Edit Title of an Original Animation
@ Cancel an Original Animation
(> P. 12-14)
Playing Melodies
o Play All Melodies in the Same Folder Repeatedly
(» P. 12-15)
Playing Videos
® Switch Display Format of File List
o Clear a Playlist

(> P. 12-15)
Customize
Display Settings
@ Set Image List View
(> P. 14-5)
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Note

+ Only images with “§ in File List can be edited.

* Repeated editing may cause deterioration of
image quality or increased file size.

+ For images larger than VGA, some edit
options are unavailable. File size is
automatically reduced to VGA or smaller
when saved.

Adding a Frame

EN [Picture Window] => @ => Edit
Image => ® => Frame = ®

F1 select a frame => ®
M To Change Frame
=
H To Rotate Frame 180 Degrees
=
M To Cancel Frame
=> @ => Cancel => ®

E®

] ® = YESorNO = @®

| Editing Still Images

Basic Flow of Operations

El ® => Data Folder => ® => My
Picture > ® => Select a folder =
@® = Select an image = ®

Picture Window

Fl1 ©® -> Edit Image => ® => Select
an editing option => @® => Edit
image

E] ® to end editing

[l ® = YESornO = ®
Select YES to overwrite original image.
Select NO to save as a new file.

Editing Files

Adding Stamps

n [Picture Window] => @ => Edit
Image = ® => Marker Stamp =

®

ﬂ Select a marker stamp => @
B To Rotate Marker Stamp
=> @ = 90° to Right, 90° to Left or
180° => ®
B To Enlarge/Reduce Marker Stamp
=> @ => Scale Up or Scale Down => ®

B To Cancel Marker Stamp
=

El & = select a position => @
B To Paste Another Marker Stamp
=> @ = Select a marker stamp => @

4 JO)

H ® - YESornO > @®

Pasting a Text Stamp

EN [Picture Window] => @ => Edit
Image => ® => Character Stamp

=@
F1 Enter text => ®

F juswabeuely ereq
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Editing Files

M To Edit Text L. N
=>@ => Character Input => @ =>Enter I Editing Videos 0 More Features

text = @ . .
B To Change Text Color Sid(;:::ﬁpk_eep only the needed portion of a
=> @ = Character Color > ® = Select Editing Files
acolor => @ n ® => Data Folder => ® => ® Retouch an Image
Press ® to toggle color palettes. Videos => ® > Select a folder =>  ® Adjust Image Brightness
HTo Change Font Type @® => Select a video => @) => Edit  © Rotate an Image
=> @ => Font Type => ® => Gothic or Video —> ® ® Change Image Size
Ming-Cho => @ o Correct Backlight
M To Change Font Size E @ = Trim Videos => ® => Any ® Refresh Skin Tone
=> @ = Font Size => @ = Select a font Size or 500KB = ® (> P. 12-15)
size => @ Specify portion to save.
B & - select a position = @ P> To Start from Beginning of Clip
ne P To Start Partway Through Clip
® => @ at start point=>
H ®-=vYEsorno=® Clip plays.

@ to specify end point and select ®.
" The specified portion plays.
Cropplng an Image If 500KB is selected, playback stops when
EN [Picture Window] => @ => Edit 500KB is reached.
m Image => ® => Trim away —> ® El ® (twice) = YES = @

Select a size => @ => &3 to select
an area > @

juswabeue eyeq

Note
+ Available only for QCIF (176 x 144) or smaller
B ® format clips (indicated by % in File List).

] ® => YESorNO =>®
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ICreating a Folder

El ® = Data Folder > ® = Select
a folder type => @

<Example>When My Picture is Selected

[ My Picture

0 @Download Pictures
w¥Download My Pict

CiCamera

CiMail Art

CiMy Pictograms
ZiAuto Graphic Mail
CIPreset Screen
Ci0riginal Animation
ZimicroSD

CiFrame

CiStamp

Folder List

Fl1 ® = Add Folder => ® => Enter
folder name => @®
Tip
+ Folders can only be created in handset Data
Folder.

File & Folder Management

Moving Files to a
Different Folder

EX [File List] => Select a file => @ =

Move => ®

P> To Move Selected File
Move This => @ => Select a
destination folder => @ => YES => @

P To Move Multiple Files
Move Selected > @ = Select a
destination folder = @ = Select a
file => @ (repeat to select another
file) => ® => YES => @

P To Move All Files in a Folder
Move All => ® => Select a
destination folder => @ => YES => @

0 More Features

Managing Folders

o Edit a Folder Name

o Delete a Folder

o Delete All Files in My Picture, Melody or Video
Folder

(» P. 12-15)
Managing Files
o Edit a Title in My Picture File List
@ Check Volume of Saved Files
o Edit a File Name
o Delete Files
(> P. 12-16)

F juswabeuely ereq
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About Memory Card

Save files to memory cards. Still images and
videos shot with handset camera can be |n5el'tin9 & ReITIOViI‘Ig a
saved directly to memory card. Data can be Memory Card n Press and release
copied and moved between handset and Gently pull out memory card.
memory card. Data on memory card can also
be accessed from Data Folder.
@ Handset supports memory cards of up to

2 GB. Insertion
@ Do not insert or remove memory cards when

handset power is on. n Open Slot Cover
@ Insert memory cards properly. Otherwise, they E Insert memory card into Memory

cannot be used on handset. Card Slot until it locks
@ Do not affix stickers or labels to memory cards. . .
Insert gently with the printed logo

Turn handset power off before inserting or
removing a memory card.

Note

@ Do not remove a memory card or power off
handset while writing and reading data with
that memory card. It may cause data loss or
malfunction.

@ Access to memory cards may be unavailable
when the battery level is low.

] As memory cards are very thin and precise facing u « Memory card may spring out.
2 mechanisms, even a thin sticker or label on a 9 up. » Memory card may break if inserted or
2 memory card may cause contact failure or removed with force.
2 destruction of data. Memory Card
eep memory cards out of reach of infants Slot Cover
2 e« ds out of reach of infant |
[ who may accidentally swallow them or be
"g injured.
[]
2
=

B

ﬂ Close Slot Cover
Tip
« If § appears in Display, there may be a contact
failure. Remove and reinsert memory card.

12-10



Formatting a Memory
Card

@ Format memory cards on handset only.
Memory cards formatted on another device or
PC may not work.

@ Formatting a memory card deletes all the data
on it.

El ® = Tools => ® => microsD
Manager => ®

Fl1 ©® => microSD Format > ® =>
Enter Security Code => @ => YES
=@

Note
« Do not remove memory card while
formatting. Handset/memory card
malfunction may occur.
« Make sure that there is no important data left
on the memory card before formatting it.

Accessing Memory Card

Data

El ® = Tools => ® => microsD

Manager => ®

e Categories
Phone Book
Schedule

To Do List
Inbox

Outbox

Draft

Text Memo
Bookmark
Content Key

microSD Manager Window

F3 select a category = ®

To Do List
118910070100
1510062800
1510062600

File List

Managing Memory Cards

E] selectafile = @

Data List

7 select a data item = @

Contents

dinner

Category

Personal

Completion Date
____/__/,_

Period
2010/ 7/ 1 21:00
Change Status
Plan
Priority
None

Data Details

P juswabeuely ereq
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Managing Memory Cards

- P To Copy Multiple Data -
Copylng Data between Copy Selected => ® (=> Select copy Copying Memory Card Data to
Handset & Memory Card destination folder => @) => Select a Handset

data item => @ (repeat to select
ing i i To Copy Images or Other Data to
Following items can be copied to/from another data) = @ = YES = @ HandsF;){ g

handset and memory card:
P> To Copy All Data

PIM Data Ehﬁng ?OOTk eDntrifs:[ ot Copy All => @ => Enter Security Code n ® => Data Folder => ® => Select
chedule, To Do List, tex L :
memos. Inbox. Outbox => (@ (= Select copy destination a folder type => @® => microSD =
Draft, bookmarks, content folder = @) = YES => @ ® => Select a folder and sub-folder
keys Tip = @ =>Select a data item => @ =
Files in Data Still images, My Pictograms,
Folder Flash® rgnelodigs videgos + When one Phone Book entry or Schedule Copy to Phone -> ®
songs event that is set as secret is copied to memory P> To Copy Selected Data
card, its secret setting is canceled. Copy This => ®
» Files attached to messages may be deleted. » To Copy Multiple Data

Copying Handset Data t o gt et ™ s g
Memory Card « Data saved in Pre-installed folders of Data item => @ (repeat to select another
data) => ® => YES > @

Copy Phone Book entries, Schedule, Folder cannot be copied.

messages, images, videos, etc. . Cpntent keys are copied collectively at one P> To Copy All Data
) time. Copy All => ® = Enter Security Code
<Example> Copy data in Data Folder to = @ = YES = @

memory card

E] Ipata List] = @ = Copy to
microSD > ®
P> To Copy Selected Data
Copy This => @ (= Select destination
folder => @)

b juswabeue eyeq
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To Copy PIM Data to Handset

El ® = rools => ® => microsD
Manager => ® => Select a PIM
data type => @ => Select a data
item => @ => Copy/OW to Phone
= @

P> To Copy Selected Files
Copy & OW this —> ®

P> To Copy Multiple Files
Copy & OW select => @ => Select a
file => @ (repeat to select another
file) =>

P> To Copy All Files
Copy/OW All to Ph => @

Enter Security Code => @® => YES
= (@ => YES => ® (=> YES or NO
= @)

Note

* When copying memory card data to handset
in overwrite mode, the corresponding data on
handset is overwritten by the copied data.

« If the maximum storable number of items is
reached when copying all items, copying stops
at that point.

Managing Memory Cards

Configuring Print Settings
of Images

Specify which images on memory card to be
printed and the number of prints, etc. in
DPOF (Digital Print Order Format) settings so
that the images can be printed by DPOF
compatible printers or print service shops.

El ® => Data Folder => ® = My
Picture = ® => microSD = ® =
DCIM => ®

F1 select a folder => @ = Select a
stillimage => @ => DPOF Setting
= @®
P> To Specify Selected Images

DPOF set One => ®

P> To Specify Multiple Images
DPOF set Choice = ® = Select a still
image > @ (repeat to select another

image) =

E] Print => ® = Print Sheets -> ®
=> Enter number of prints => @

1 a Date => ® => ON or OFF => ®
Heé

0 More Features

Memory Card

@ Check Available Memory Space of Memory
Card

@ Check & Repair Memory Card

® Delete Data on Memory Card

@ Cancel Print Settings of Images

(» P. 12-16)

F juswabeuely ereq
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E Advanced Features

IAccessing Files

Start Here
[File List]
[Opened File Window]..
[Picture Window] ....
[Melody Window] ...
[Original Animation List] ..
[Playlists Window] .....

Opening Files

Check File Information

[File List]/[Opened File Window] (=
Select a file) = @ => Image Info, Melody
Info or Properties —> ®

Change Order of Files

[File List] => @ => Sort => @ => Select a
criterion => @

Set an Image to Appear in Standby

[File List]/[Opened File Window] (=

Select a file) => @ = Set as Display —> @

=> Stand-by Display => ® (> Select a

layout => @ => Confirm preview => @)

[£] Set image to other function windows
(Dialing, Mail Sending, etc.).

12-14

Set a Video to Appear in Standby

[File List] = Select a file => @ =>
Stand-by Display => ® <> YES => @

Set a Melody/Video as Ringtone

[File List]/[Opened File Window] (=

Select a file) => @ = Ring Tone => @ =>

Select an item => ®

[Z10nly melodies can be set as ringtones from
Opened File window.

Viewing Images

Play Animation from the Beginning

[Picture Window] => @ => Retry => @

Compose Four Images to Make One

[File List] => @ => Composite Image > ®

=> Select a position => @ = Select a folder

=> @ => Select an image = @® => Repeat

the same step to assign three other images

to their respective positions => ® => @

[Z1Only images in JPEG format can be used for
creating composite images.

[5] Copyright-protected images are unavailable.

[Z]images saved on memory card cannot be
used.

[5] Some images cannot be used depending on
their size.

Set Display Size of an Image

[Picture Window] => @ => Set Image Disp.
=> (® => Normal or Fit in Display => ®

Edit Title of an Original Animation

[Original Animation List] = Select an
animation => @ => Edit Title => @ = Edit
title => @

Cancel an Original Animation

[Original Animation List] = Select an
animation => @ => Release Animation —>
® > YES => ®




Playing Melodies IEditing Files

Start Here
[Picture Window] .......ccceecerveerecerrcecrennn P.12-7

Play All Melodies in the Same Folder
Repeatedly

[Melody Window] => @ => Set Repeat Play
= @ => ON => @®

Playing Videos

Retouch an Image

[Picture Window] => @ = Edit Image =>
® => Retouch => ® = Select an effect =>
@ (three times) => YES or NO => @

Switch Display Format of File List . .
play Adjust Image Brightness

[File List] => @ = List Setting => ® =>

i i => @) = Edii =
Title or Title+Image ~> @® [Picture Window] = @ = Edit Image

@® => Brightness => ® => © to adjust
brightness = @ (twice) = YES or NO =>
O]

Clear a Playlist

[Playlists Window] = Select a playlist => @
=> Release Playlist => @ => YES => @

Rotate an Image

[Picture Window] => @ = Edit Image =

® => Rotate => @® => 90° to Right, 90° to
Left or 180° => @® (three times) = YES or

NO => ®

Change Image Size

[Picture Window] => @ = Edit Image =
® => Change Size => @ = Select a size =
@) (three times) = YES or NO => ®

Advanced Features

Correct Backlight

[Picture Window] => @ => Edit Image ~>
® => Correct Backlight => ®) (three times)
=> YES or NO => @

Refresh Skin Tone

[Picture Window] => @ = Edit Image =>
® => Refresh Skin Tone —> ® (three times)
=> YES or NO => @

IManaging Folders

Start Here

[Folder List] P.12-9

Edit a Folder Name

[Folder List] = Select a folder = @) => Edit

Folder Name = @ => Edit folder name =

®

[Z]Only names of user-created folders and
folders in My Pictograms can be edited.

@

F juswabeuely ereq
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. Advanced Features

Delete a Folder

[Folder List] = Select a folder => @ =>
Delete Folder => ® => Enter Security Code
=> @ (=> YES => @) => YES => @
@ To Select Ring Songs-Music
[Folder List] = Select a folder => @ =
Delete Folder = ® => Enter Security Code
=> (@ => Delete This, Delete Selected or
Delete All => @)( => Select a folder = @ =>
Repeat to select another folder => @)( =
YES or NO => @) => YES => @
[Z1Only user-created folders can be deleted.
[ZIFiles in the selected folder are also deleted.
[Z]When files that are set as wallpaper,
ringtone, alarm tone, etc. are deleted, their
settings are reset to default.

Delete All Files in My Picture, Melody or
Video Folder

[Folder List] = @ => Delete all Image or

Delete All => ® = Enter Security Code =

® > YES—>®

[Z]When files that are set as wallpaper,
ringtone, alarm tone, etc. are deleted, their
settings are reset to default.

12-16

IManaging Files

Start Here

[File List] P.12-3

Edit a Title in My Picture File List

[File List] = Select an image file = @ =

Edit Title => @ = Edit title => @

[E1 Titles of files saved in Pre-installed folders
cannot be edited.

Check Volume of Saved Files

[File List] => @ => Memory Info => ®

Edit a File Name

[File List] => Select a file => @ => Edit File

Name => @ => Edit file name => @

[Z1Names of files saved in Pre-installed folders
cannot be edited.

Delete Files

[File List] => Select a file => @ => Delete
=@
® To Delete the Selected File
=> Delete This = @ => YES = @
® To Delete Multiple Files
=> Delete Selected => ® => Select file =
@ (repeat to select another file) => & =>
YES = @
@ To Delete All
=> Delete All => ® => Enter Security Code
= @ => YES => @

IMemory Card

Start Here

[microSD Manager Window]............. P. 12-11
[File List] P. 12-11
[Data List] P. 12-11
[Data Details].. e P.12-11

Check Available Memory Space of Memory
Card

[microSD Manager Window], [File List],
[Data List] or [Data Details] => @ =>
microSD Info => ®




Check & Repair Memory Card

[microSD Manager Window] = @ =

Check microSD => ® => YES => @

£ To cancel checking and repairing a memory
card, press & or (=].

[ Some memory cards may not be repairable.

Delete Data on Memory Card

[File List] = Select a data item => @ =>
Delete => ®
@ To Delete the Selected Item
=> Delete This => @ => YES => @
o To Delete Multiple Items
=> Delete Selected = ® => Select file =
@ (repeat to select another file) => ®& =>
YES => @
@ To Delete All
=> Delete All => @ = Enter Security Code
= @ => YES => @

Cancel Print Settings of Images

® => Data Folder => ® => My Picture =
® => microSD => @ => DCIM => @ =>
Select a folder = @ = Select a still image
=> @ => DPOF Setting = @® = DPOF set
One or DPOF set Choice => @ (= Select an
image = @ (repeat to select another
image) => &) = Print OFF or All Print OFF
=@

Advanced Features

F juswabeuely ereq

1217






Connectivity

Infrared......cccoveeiisniinnieere e
Getting Started.........ccceeeveieninecenee e
Transferring Data via Infrared..

Connecting to PC....
B ST G ———
Data Transfer.......ccovereierneneeeeee e
Setting USB MOdEe .....c.ooueveirieniirinienceeeeeceee
Accessing Memory Card Data from a PC ..
Using Handset as Modem.........c.cccccoveeeeiinnnene

131



b Kyandsuuo)

E Infrared

IGetting Started

Wirelessly exchange files with infrared
compatible devices. Handset supports
IrSimple™-standard high-speed infrared

transmission. Transfer large-size data quickly

with compatible devices (mobile phone,
printer, etc.).

The following files are transferable:

- Still images

+ Melodies

+ Videos

+ My Pictograms

- Songs

+ Phone Book entries, Account Details

+ Schedule events

+ To Do List tasks

+ Received/sent messages

+ Draft messages

+ Text memos

+ Common Phrases (Templates)

+ Own Dictionary data

- Bookmarks (Yahoo! Keitai/PC Site Browser)

132

" @ Align Infrared Ports of both sending and
receiving devices, as shown below.
@ File transfer may not start depending on
receiving device status. Some settings or
content may be lost depending on the
receiving handset model. &
@ Handset is out of range during infrared

transmission, so such functions as voice and

video calls, the Internet access and

sending/receiving S! Mails are unavailable. This Infrared Port
may continue even after infrared transmission Within +15°
is finished. s 2

@ Transferring data may take a while depending
on the amount of data. Some data may not be
received by handset.

@ During transmission, progress bar shows
approximate number of files transferred. Note
that actual progress may be faster.

@ Some pictographs and symbols in messages
and Phone Book entries may not be received
by handset correctly.

Within 20 cm

@ Do not move either device until a message
appears indicating completion of data
transmission. Do not place any objects
between the devices. Do not obstruct Infrared
Ports.

@ Infrared transmission may be disrupted by
direct sunlight, directly under fluorescent
lighting or near other infrared devices.



Authentication Password

To transfer multiple files at once, the same
authentication password must be entered on
both sending and receiving devices.

ITransferring Data via Infrared

Sending One File

Send one file at a time.

El select afile > @ => Send Ir Data
=@

E Set the receiving device to receive
data

E] Align Infrared Ports => YES => @
Transfer starts.
Message appears when file transfer is
complete.
B To Cancel Transfer

=
Note

« File transfer is unavailable for Phone Book
entries saved on USIM Card.

Tip

* In a data list window, press &) to send a JPEG
image via high-speed transmission (IrSS™
function).

* In the case of high-speed transmission (IrSS™
function) of JPEG images, the receiving device
may fail to receive images, even when the
image transmission is successfully completed
by the sending device.

Receiving One File

El ® => Tools => ® => Receive Ir
Data > ® => Receive —> ®

ﬂ Align Infrared Ports
Transfer starts.
H To Cancel Transfer

= ®

ﬂ When file is received => YES => @
File is saved to handset.
File is discarded if no operation is
performed within 30 seconds of transfer.

Sending All Files

Send all files at one time from a data list
window/data details window.

ET In a data list window/data details
window => @ =>Send All Ir Data
= @®

1 Enter Security Code => ® => Enter
authentication password

B Set the receiving device to receive
data

1 Align Infrared Ports => YES => ®
Transfer starts.
When all files are sent, a message
appears indicating completion of
transfer.
B To Cancel Transfer

=
Note

« All file transfer is unavailable for still image,
melody, video, My Pictogram and song files.

« File transfer is unavailable for Phone Book
entries saved on USIM Card.

P fandauuo)
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E Infrared

Receiving All Files

El ® = Tools => ® => Receive Ir
Data => ® => Receive All => ®

E Enter Security Code = @ => Enter
authentication password

E] Align Infrared Ports => YES => @
Transfer starts.

ﬂ When an overwrite confirmation
appears — YES = ®
Transfer starts.
Message appears when files are saved to
handset.

H To Cancel Transfer

=
Note

« Existing handset files are overwritten (e.g.
When all messages are transferred, existing
messages, including protected messages are
overwritten. When all Phone Book/Schedule
entries are transferred, all data including
secret data is overwritten).

« File transfer stops when maximum storable
capacity is reached.

Kyandsuuo)
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'9 More Features

Phone Book
@ Do Not Send Phone Book Entry Images via
Infrared
(> P. 14-12)




IBasics

Connect handset to a PC via USB cable to use
the following functions.
@ USB cable is sold separately.

Transfer Phone Book,
Schedule and To Do List
data between handset and
a PC (P 13-5).

Data transfer*

USB memory Use memory card inserted
in handset as an external
drive of a PC to read and
write data with memory

card (P. 13-5).

* USB driver must be installed in advance.

USB Driver

Install USB Driver to connect handset to a PC.
Download USB Driver from the following site
(Japanese).
http://www.n-keitai.com/guide/download/

IData Transfer

Use Data Transfer Tool to transfer data

between handset and a PC. Download Data

Transfer Tool from the following site

(Japanese).

http://www.n-keitai.com/guide/download/

@ Install USB Driver before using Data Transfer
Tool.

ISetting USB Mode

Set USB mode before connecting handset to
your PC via USB cable.

El ® => settings -> @ => External
Connection => ® => USB Mode
Setting > ®

ﬂ Communication Mode or
microSD Mode > ®
Select Communication Mode for
Internet tethering (packet transmission)
or using Data Transfer Tool.
Use microSD Mode for accessing
memory card data from a PC.

Accessing Memory Card
Data from a PC

Connect handset to your PC using a USB

cable, and access memory card data from the

PC.

@ Set USB Mode Setting to microSD Mode in
advance.

n Connect handset to your PC using
a USB cable
This enables memory card data to be
accessed from your PC.

B When you are finished, disconnect
handset from the PC
Follow the procedure for safely
removing external devices (which differs
slightly according to the operating
system), when disconnecting handset
from the PC.

Connecting to PC H

P fandauuo)
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E Connecting to PC

Note

* Make sure handset and the PC are properly
connected. Otherwise, data cannot be transferred,
and may even be lost.

If handset's battery is almost or completely
empty, data cannot be transferred, and may
even be lost. Check handset's battery level and
the power of your PC.

Do not remove the USB cable while copying
data from your PC to handset. If the USB cable
is removed during data transfer, data cannot
be transferred, and may even be lost.

IUsing Handset as Modem

Use handset as an external modem for packet

transmission.

@ Refer to the instructions of your Internet
service provider or the manual of your PC for
the network connection settings on your PC.

@ To use "Access Internet” for data
communication, you do not have to sign up
with a service provider. For information about
the service overview, access points and setting
procedures, contact SoftBank Mobile
Customer Center, General Information
(P. 15-51).
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ICIock

Clock, Display & Sounds

@® = Settings => @ => Clock = @

Hide Clock => Clock Display => @® => Display => @ =>
OFF => ®

Clock Size => Clock Display => ® => Size => @ =>
Select a size => @

Clock Color => Clock Display => @® => Color => @ =>

Black or White => @

Set Auto Time
Adjustment

=> Set Main Time => ® => Time Adjustment

=> (@ => Auto => @ => Select a time zone

= @®

+ Press ® to change city/area name in Time Zone
Selection field.

+ If auto time adjustment is still not performed,
open Yahoo! Keitai top page again and perform
Reload before returning to Standby.

Manually Adjust
Time

=> Set Main Time > ® => Time Adjustment
=> (@ => Manual(Date Time Set) => @® =>
Select a time zone => @ = Enter date
and time = @

Time Zone (Sub
Clock)

=> Set Sub Clock => ® => Display Method
= @ => Always = @ (=> YES => @)=>
Select a time zone => @

Hide Sub Clock

=> Set Sub Clock => ® => Display Method
=> @ => OFF => @

Summer Time (Sub
Clock)

=> Set Sub Clock => ® => Summer Time
=> @ => ON => @®

IAIarm

® = Settings => @ => Clock = @

Set Priority at
Alarm Notification
Time

=> Alarm Setting —> (® => Operation
Preferred or Alarm Preferred > ®

Change Alarm
Tone

=> Clock Alarm Tone Set => ® => Select
an item => ® => Set an alarm tone

Summer Time

=> Set Main Time => @ => Summer Time
= @ = ON = @®

b uoneziwolsn)
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IAuto Power On/Off

Set Auto Power
On/Off*

@® => Settings => @ => Clock => @ =
Auto Power ON or Auto Power OFF => ®
=> ON => @ => Enter time => @ => 1 Time
or Daily => ®

* When near high precision electronic devices or devices using weak signals,
or in areas where handset use is forbidden (aboard aircraft, in hospitals,
etc.), set Auto Power ON to OFF and turn handset power off.

ISter Mode Settings

@ => Settings => ® => Style Mode Setting => ®

Clock, Display & Sounds

Change Each Item
for Favorites

=> B5ICA D (Favorites) => & = Select an
item => @ => Set an image

Clear All Favorite
Settings

=> B%ICA D (Favorites) = @) => Reset
Setting Info => ® => YES => @®

IDispIay Settings
@® = Settings = ® => Display = ®

Wallpaper

=> Display Setting => ® => Stand-by
Display => ® => My Picture or Videos =
@® => Set an image/video (> Select a
layout => @ (twice))

Set Display Design
Collectively

=> Select a style => @ => YES => @ (=>
YES or NO => ®)

Check Style Mode
Settings

=> Select a style =>

Edit Title of a Style

=> Select a style = @ = Edit Title => ®
= Edit title => @

Save Current Style
Mode Settings as
Favorite

=> B%ICA D (Favorites) = ® = @) =>
Take Setting Info => ® => YES => ®
+ The current style mode settings can later be

recalled collectively from SXICAD when they
are changed.

Show Calendar in
Standby

=> Display Setting => ® => Stand-by

Display => ® => Calendar => @ =>

Background => ® => Set an image =

Select a layout => @ (twice)

Select No Background if you do not want any
image in the background of the calendar.

+ Press @), use @ to select the calendar and press
® to operate it. Use @ to switch to the
previous/next month. Press @ to activate
Schedule.
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Clock, Display & Sounds

Set Wallpaper
Image to Change
When Handset
Returns to
Standby

=> Display Setting => ® => Stand-by
Display = ® => Random Display => ® =>
Select a folder => @ = Select a layout =>

®

+ Each time handset returns to Standby, a different
wallpaper image appears. Images are randomly
selected from the set folder.

Battery Level
Indicator/Signal
Strength Indicator
Design

=> Display Design => ® => Icon Pattern
=> (@ => Battery Icon or Antenna Icon =>
@ => Select a pattern => @

Set Softkey Color

=> Display Design => ® => Soft Key => ®
=> Select a color => @

Set a Wake-up
Image

=> Display Setting => ® => Wake-up
Display => ® => My Picture => ® => Set
an image

Set a Wake-up
Message

=> Display Setting => ® => Wake-up
Display => ® => Message => ® => Enter
message = @

Set Font Type

=> Font => ® => Font Type => @ =>

Gothic or Ming-cho => ®

+ Alternatively, press and hold in Standby to
make font settings.

Set an Outgoing
Call/Message
Image

=> Display Setting => ® => Dialing, Video
Call Dialing or Mail Sending > ® => Set
an image

Set Font Thickness

=> Font => (® = Thickness => ® => Thin

or Bold => @®

+ Alternatively, press and hold in Standby to
make font settings.

Set Image or Video
for Incoming
Call/Message

=> Display Setting => @ => Calling, Video
Call Calling or Mail Receiving => ® =>
Select Calling Disp. or Select Receiving
Disp. => @ (=> My Picture or Videos =
@®) => Set an image/video

Set Font Sizes
Collectively

=> Font => @ => Character Size => @) =>

Standard or X-large => ®

+ Items settable with Separate Setting for
Character Size can be set collectively.

+ Alternatively, press and hold in Standby to
make font settings.

Set Image for New
Message/Received
Result Window

=> Display Setting —> ® => Retrieve New
or Mail Rec’d Result => ® => Set an image

Display Color
Scheme

=> Display Design => ® => Color Theme
=> (@ => Select a color => @

Set Font Size for
Each Function
Window

=> Font = ® => Character Size > ® >

Separate Setting => ® => Select a

window = @ => Select a size => @ =

+ Alternatively, press and hold in Standby to
make font settings.

+ In PC Site Browser, only available in Small Screen
View.
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Interface
Language

=> SEZER > @ <> 7 (or English) =>

®

+ To change interface language from Japanese to
English:
@ > BED@® > Fr XTI > @ >
Language => ® = English => @

Set Image List
View

=> Viewer Settings = ® => Picture or
Title => @

Guard from Prying
Eyes

=> Privacy Angle => @ => ON => ®
+ Alternatively, press and hold (87 in Standby to
toggle on and off.

+ When Privacy Angle is set, Display is whitish
and the viewing angle is narrower.

+ Turn power off then on again to cancel Privacy
Angle.

Clock, Display & Sounds

| Backlight

® = Settings > ® = Display = @ =>
Backlight = ®

Set Backlight &
Power Saving

=> Lighting => @ => ON or OFF => @ =>
ON or OFF => ® (=> Enter a time before
the Power Saver Mode is activated)

+ When the Power Saver Mode is activated,

nothing appears in Standby. Pressing any key
cancels the Power Saver Mode.

Set Backlight
during Charging

=> Charging => @ => Standard or All Time
ON=>®

Show New
Message Info
While Viewing TV

=> Quick Info Setting => @® => Display
Sender or Display Sender/Subject => ®

llluminate Display
Only or Display
and Keys

=> Area => ® => LCD+Keys or LCD => ®

Set Effect for
Screen Change

=> Screen Effect => ® => Select an item
= @®

+ Select an item and press ®) to check details.

Set Brightness of
Backlight

<> Brightness => ® => ON or OFF => ®

=> Select a Level => @®

+ When set to ON, Display Backlight automatically
adjusts to surrounding brightness.

+ Middle is set by default. Setting to Bright
decreases battery time.
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Clock, Display & Sounds

IDesktop Icons
® = Settings => ® = Display = ®

Set Desktop

=> Desktop Icon => @ => Select a theme

Delete Icons of a
Theme

=> Desktop Icon => ® => Select a theme
=> ® = Select an icon => @ => Delete =
(® => Delete This, Delete Selected or
Delete All => @® (=> Select icons => @ =>
®) = YES > @

Theme = @ = YES => ®
- Press &) to see details of the selected theme.
Change Icon => Desktop Icon => ® => Select a theme

Design of a Theme

=> ® => Select an icon => @ => CHG Icon
Image => ® => Select Icon Image or
Default Icon Image —> @® (= Set and icon)

Show New
Message Indicator
in 3D

=> 3D Display Setting => @ => ON > ®

Change Order of
Icons of a Theme

=> Desktop Icon => ® => Select a theme
= ® = Select an icon => @ => Sort =>
® => Select a position => @®

Copy Icons to
Another Theme

=> Desktop Icon => @ => Select a theme
=> ® = Select an icon => @ => Copy =>
® => Copy This, Copy Selected or Copy
All => ® => Select a destination theme =>
@ (= Select icons => @ = ®@)(=> YES =
®)

Move Icons to
Another Theme

=> Desktop Icon => ® = Select a theme
= ® => Select an icon = @ => Move =>
(® => Move This, Move Selected or Move
All => ® => Select a destination theme =>
® (=> Select icons => @) => ®) = YES =>
O]
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IMenu Display Settings

® => Settings = ® => Display > ® => Menu
Display Set > ®

List View and
Details View

=> Menu Display => ® => List or Detail >

®

- Select View for menus from @<= Settings =

Set Main Menu
Theme

=> Theme => @ => Select a theme => ®
(=> YES or NO => ®)

Change Icon
Design (Original
Theme)

=> Theme => ® => Original Theme => ®

=> Select a menu item => @ => Set an

image

+ Change Main Menu icons to any preferred
image.

+ Press ®) to check current setting.

Change
Background
(Original Theme)

=> Theme => ® => Original Theme => ®

=> Background Image => ® => Set an

image

+ Change Main Menu background to any
preferred image.

+ Press &) to check current setting.

Reset Original
Theme Settings

=> Theme => ® => Original Theme => ®
=> Select a menu item => @ => Reset or
All reset => ® => YES => @

+ Only available when any Original theme settings
have been changed.

Clock, Display & Sounds

Save Last Selected
Menu Item to
Memory

=> Memory Focus = ® => ON => @

iar ere JORAC

Add a Menu Item
to Original Menu

=> Select an item => ® = Select a
function => @ (=> YES => @)

Change Order of
Original Menu
Items

=> Select an item => @ => Sort = @ =>
Select a position => ®

Cancel Original
Menu Items

=> Select an item => @ => Release or
Release All => ® => YES => ®

Reset Original
Menu

=> @) => Reset Org. Menu => ® => YES =>

®

IStandby Indicators

Enable Indicator
Selector

® => Settings => @ => Display => @ =>
Icons Setting => @ => ON => ®
+ The indicators at the top of Display are enabled
by pressing @ in Standby. Use € to select an
indicator and press @ to access the
corresponding function.
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Clock, Display & Sounds

ISub-dispIay
® = Settings > ® = Display = @ =>

Sub-display Setting > ® => ON => ®

Notifications/

=> Disp. Clock Only => @ => ON => @ =>

Animation

+ Select OFF to set notifications (incoming
messages, etc.) and animation (alarm, etc.) to

Ilncoming Call/Message Alerts

® = Settings => @® => Incoming Call => ®

Adjust Ringtone
Volume

=> Ring Volume => ® => Phone, Video

Call or Mail => ® => @ to adjust volume =>

@

+ When Step is set, the ringtone volume increases
every three seconds. When Silent is set, no
ringtone sounds.

appear.

Set Clock Pattern | => Clock Type = ® => Select a pattern =
Ok

Set Messages to => Called, Mail or Connection => @® => ON

Appear =@ =

Set a Ringtone

=> Select Ring Tone —> @ => Phone, Video
Call or Mail => @ => Select Ring Tone =>
@ => Select an item => @ (=> Select a
folder => @) => Set a ringtone

Set Time Signal

=> Time Signal => @ => ON = @ =>
30 Minutes or 60 Minutes => @ =>

Set Viewable Time

=> Display Time => ® => 15 Seconds, 30
Seconds or 60 Seconds > ® =>

b uoneziwolsn)
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Set Random
Playback of
Melodies as
Ringtones

> Select Ring Tone —> ® => Phone, Video
Call or Mail => @® => Select Ring Tone =>
® => Random Melody => ® => Select a
folder => @

+ Melodies in the selected folder are played at
random as ringtones.

Set Ringtone
Duration for
Incoming Message

= Mail Ring Time = @ = ON = @® =
Enter ringing duration

+ When OFF is set, no ringtone sounds and
handset does not vibrate when receiving
messages.




Clock, Display & Sounds

Set Vibration*

=> Vibrator => ® => Phone, Video Call or
Mail => ® => Select a pattern => @

+ When Melody Linkage is set, handset vibration
is linked to the set ringtone melody. Handset

may not vibrate depending on the set ringtone.

Set lllumination
Color

=> lllumination => @ => Set Color => ®
=> Phone, Video Call or Mail => @® =>
Select a color => @

Set lllumination
Pattern

=> lllumination => @ => Set Pattern —> @

=> Select a pattern => @

+ When Melody Linkage is set, illumination
pattern is linked to the set ringtone melody.
lllumination may not flash depending on the set
ringtone.

Set lllumination to
Flash for Missed

=> lllumination => ® => Missed Info =
® =>ON > ®

Calls/New

Messages

Set Handset Action | = Setting when Opened => ® => Select
When Handset action => @ =>

Opened

Show Phone Book
Entry Images for
Incoming Calls/
Messages

=> Disp. Phone Book Image > ® => ON
=@

* When Vibrator is not set to OFF, be careful not to let handset fall off a
desk or slide too close to a stove, etc. when it vibrates.

IAnswering Incoming Calls

@® = Settings => ® => Incoming Call => ®

Set to Answer
Calls by Pressing

=> Answer Setting => @ => Any Key
Answer => ®

Any Key + Answer incoming voice calls by pressing a key
from (7], @, (0)- (87, 3, ®, ®, - and
€. The any key answer function is disabled for
incoming video calls.

Set to Mute => Answer Setting = ® => Quick Silent

Ringtone by =@

Pressing Any Key

+ Mute the ringtone by pressing a key from
(8- (9], (%3, ® (for voice calls only), &, Jss-
and € or by opening handset.

Set an Incoming
Call/Message
Image

=> Select Ring Tone —> @ => Phone, Video
Call or Mail => @ = Select Calling Disp.
or Select Receiving Disp. => ® (=> My
Picture or Videos => @) => Set an
image/video
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Clock, Display & Sounds

IManner Mode

® => Settings => ® => Incoming Call => ® =>

Manner Mode Set > ®

Set Manner Mode
Type

=> Select a Manner Mode => ®
+ When Super Silent is set, all tones emitted
through the earpiece are also muted.

Configure Original
Manner Mode

=> Original => @ = Set each item =>

IChecking Call Logs

@® = Settings => ® => Incoming Call => ®

ISounds

@ = Settings => ® => Other Settings ~> ®

Set Key Sound Off

=> Keypad Sound => ® => OFF => ®

Set to Play
Charging Start/End
Tones

=> Charge Sound => ® => ON => @®

® => Tools => ® => Voice Announce => ®

Record Sound to
Set as Ringtone or
Outgoing Message

=> Select an item => @ => YES => @ =>
Record sound (for about 15 seconds)
- Press @ to stop recording.

Notify Missed Calls
with Tone
(When [Jy.s. Pressed)

=> Info Notice Setting > ® => ON => @
+ Two short beeps sound twice when there are

missed calls, and three short beeps sound when
there are none.

Play Recorded
Sound

=> Select an item with % => @

Delete Recorded
Sound

=> Select an item with % => @ => Erase
= @ = YES => @

Change Colors of
Names, Phone
Numbers and
E-mail Addresses
in Call and
Message Log
Windows

=> Disp. Call/Receive No. => ® => Select a

color => @

+ Press ® to toggle the color palette between 16
colors and 256 colors.

+ To reset the color settings, press &.
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IEarphone-Microphone
® = Settings > ®

Audio Output

=> External Connection => ® => Headset
Usage Setting => @ => Headset+speaker
or Headset Only => ®

Microphone
Setting

=> External Connection => ® => Headset
Mic. Setting — ® = Built-in Microphone
or Headset Microphone => ®

Answer Calls
Automatically

=> External Connection = @ = Auto
Answer Setting => ® => Phone or Video
Call => @ => ON => @® => Enter ring time

Save a Phone
Number for
One-touch Dialing
from Earphone-
Microphone

=> Dialing => @ => Headset SW to Dial =>
® = Voice Call => ® => Search Phone
Book => Select an entry => @ => Select a
phone number => @

Clock, Display & Sounds
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IPhone Book

Phone Book & Calls

Set Auto
Synchronize Off

=> Auto Sync Settings — @® => ON/OFF =>
® > OFF=>®

Set Preferred
Search Method

[Phone Book Search Window] (P. 2-20) =

Select a search method => & => 0K => @

+ To cancel the preferred search method, press
in Phone Book Search window, select the
search method with %, and then press ®.

Change Group
Name

[Phone Book Entry List] (P. 2-20) => @ =>
Group Setting => ® => Select a group =>
® => Edit group name => @®

+ The name remains the same only for No Group.

Do Not Send
Phone Book Entry
Images via
Infrared

® => Tools => ® => Forwarding Image =>
® > OFF > @

Check Auto
Synchronize
Settings

=> Auto Sync Settings => ® => Confirm
Settings => @

IOutgoing Calls
@® = Settings = ® = Dialing = ®

Save Area Code
and Country Code
as Prefix Numbers

=> Prefix Setting => ® => Select an item
=> ® => Enter name => @ => Enter prefix
numbers => @

IS! Addressbook Back-up

® => Tools > @® => S! Addressbook Back-up

£ 30)

Save Touch Tones

=> Pause Dial => ® => ® => Enter touch
tone numbers => ®
+ Press and hold to enter “p” (Pause).

Set Numbers after
“%" as Sub Address

=> Sub-address Setting => @® => ON => ®

Set Auto
Synchronize

=> Auto Sync Settings => ® => ON/OFF =>
® => ON => @ => Enter Security Code =>
@ => Select synchronize timing => @ (=
Set synchronize cycle and day) = Select
synchronize type => @ => YES => ®
(twice)
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Ilnternational Calls

@ => Settings = ® => Dialing => ® = Int'l
Dial Assistance => ®

Phone Book & Calls

Change
International
Access Code
Automatically
Dialed with "+

=> Auto Int’l Call Set. => ® => ON => ®

=> Select a country code => ® => Select

an international access code => ®

+ When OFF is set, the international access code
is not entered when you press and hold (0.

+ Select an international access code you set in
IDD Prefix Setting.

Set Noise => Noise Reduction => ® => ON => @®
Reduction
Set Weak Signal => Quality Alarm => ® => High Tone or
Alarm Low Tone => ®

+ Alarm may not sound before call is disconnected,

if signal strength drops suddenly.

Set Clarity of => Hyper Clear Voice => ® => High, Low
Other Party Voice |or OFF => ®

Change a Country
Code

=> Country Code Setting => ® => Select
an item = = Enter country name =
® => Enter country code = @®

Change Color of
lllumination While
Calling

=> lllumination in Talk => ® => Select a
pattern => @

Save an
International
Access Code

=> IDD Prefix Setting => ® => Select an
item = => Enter international access

name => @ => Enter international access
code => @®

Set Outgoing
Message while Call
is on Hold

=> Set Hold Tone => ® => On Hold Tone

=> (@ = Select a hold tone => @ (=> @)

+ Select a hold tone and press ®& to check
guidance message.

Set Closing Sound
Off

=> Setting when Folded => ® => No Tone

=@

ICaII Settings
@ => Settings —> ® = Talk —> ®

End Call By Closing
Handset

=> Setting when Folded => ® => End the
Call => @

Set Reconnection
Tone

=> Reconnect Signal => ® => High Tone
or Low Tone => ®
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ICaII Costs

® = Settings => ® => Call Time/Charge => ®

Phone Book & Calls

IVideo Calls

@® = Settings => ® => Video Call => ®

Set Auto Reset of
Total Call Cost

=> Auto Reset Total Cost => @® => Enter

Security Code => @ => Auto Reset => @

=> ON or OFF => @ (=> Enter PIN2 => @®)

+ When ON is set, the total call cost indication is
automatically reset to zero at twelve midnight
on the first day of each month.

Set a Maximum
Call Cost Limit*

=> Set Max Cost Limit => ® => Enter

Security Code => @ => [ = @ = Enter

cost limit => @ => [ => @ => ON => @

= il => @ =>Set alarm tone = [ = @
= @ to adjust volume => @ = @ =>

Enter PIN2 = @

+ A call ends automatically and E appears in
Display when the total call cost exceeds the set
maximum limit.

+ When the set total call cost limit has been
reached, all outgoing calls are disabled. To
enable outgoing calls, set the maximum call cost
limit to O:
=> Set Max Cost Limit => (® => Enter Security
Code = @ => Ed = @ (twice) > @ =
Enter PIN2 => @

Set Outgoing
Image for Video
Calls

=> Select Image > ® => Select an item =>
@ => Pre-installed or Original => ®
To set an image other than the preinstalled
image:
=> Original => @ => Change Setting => @
=> Set an image
+ Press & to check image.

Redial
Automatically as
Voice Call When
Video Call
Connection Fails

=> Auto Redial as Voice => @ => ON => @®

Set an Image to
Appear in Main
Window

=> Display Setting => ® => Main Display
=> (@ => Other Side or My Side => ®

Automatically
Switch to
Handsfree Mode in
Video Calls

=> Hands-free Switch => @ => ON => ®

* Cost display may not be available depending on your subscription. If

unavailable, you will also be unable to set a cost limit.
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IGIobaI Roaming

@ => Settings = ® = Int'l Roaming Set >
®

Set Operator

=> NW Search Mode => ® => Manual =>

@ => Select an operator => @®
+ When Auto is set, an available operator is set
automatically.

+ Use this procedure when handset is out of the
service area of the currently used operator.

Search Available
Operator

=> NW Search Mode => ® => Network
Re-search => ® => Select an operator =

®

+ Available when NW Search Mode is set to
Manual.

Set Priority for
Operators

=> NW Search Mode => ® => PLMIN
Setting —> ® => Select an operator = @
=> Change Priority => @ => Select a
position on the priority list => @ => ®& =
YES => @

+ When Auto is set under NW Search Mode, you

are automatically connected to the highest
priority operator among available operators.

Show Operator
Name While
Roaming

=> Display Operator Name > @ =>
Display ON => ®

Phone Book & Calls
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Mail

IS! Mail Settings
=> Mail Setting > @

Edit Header/
Signature

=> Header/Signature = ® => Edit Header
or Edit Signature => ® (twice) => Edit
header/signature =

Insert Header/
Signature
Automatically

=> Header/Signature => ® => Insert
Setting => ® => Check item(s)=> @ =>

Request Delivery
Report

=> S! Mail Settings ~> @ => Delivery

Report => @ => ON => ®

+ Delivery Report arrives when recipient has
received your S! Mail. S! Mail Report appears
in Subject field of Delivery Report.

Set SMS Input
Language

=> SMS Input Character —> ® = Japanese
(70char.) or English(160char.) => ®

Ilncoming Message Settings
> Mail Setting —> ®

Customize E-mail
Address

=> Custom Mail Address => ® => Follow
onscreen instructions

+ Confirmation message arrives when setup is
complete. Use the information to update
Account Details.

ISMS Settings

=> Mail Setting => ® => SMS Settings —> ®

Request Delivery
Report

=> SMS Report Request > ® => ON => ®

+ Delivery Report arrives when recipient has
received your SMS message. SMS Report
appears in Subject field of Delivery Report.

Set Server Storage
Period of SMS
Messages

=> SMS Validity Period => ® = Select a

period => @

+ When None is set, SMS messages you send are
not stored on the server.

14-16

Do Not Show
Emotion Indicators

=> Emotion/Keyword => ® => Uncheck
Disp. Emotion =>

Show Keyword
Indicators

=> Emotion/Keyword => @® => Put a
checkmark to Disp. Keyword => Select a
keyword entry field => ® => Enter
keyword => @ =>
+ When handset receives an S! Mail containing
the specified keyword, a keyword indicator
9 - 4@ appears.
+ In case a message contains both the content
that matches an emotion indicator (P. 5-9) and

a specified keyword, the keyword indicator
takes priority.




Delete Keywords

=> Emotion/Keyword => ® => Select a
keyword => @ => Delete Keyword or
Delete All Keyword => ® => YES => @ =>

+ To delete all keywords, uncheck Disp. Keyword.

Set Priority When
Receiving
Messages during
Operation

=> Receiving Setting => ® => Alarm
Preferred or Operation Preferred = O

Read Out Received
Mail (Text to
Speech) Setting

=> Read Out Setting => ® => Read Out
Received Mail => ® => ON or OFF => @®

+ Mail is only read out while in Japanese
Language Mode.

IMessage Window/Messaging Settings
=> Mail Setting => ®

Mail

Set Message List
View

=> Mail List Disp. => @ => 2 Lines, 1 Line
or 1 Line+Body => ® => Subject, Name or
Address => @

Set Auto-Play for
Melody
Attachments

=> Start Attachment(auto) => ® => ON =>

®

+ Automatic play only for received mail.

Set Scroll Unit

=> Scroll => @ => 1 Line, 3 Lines or 5 Lines

=@

Set Voice to Read
Out Messages

=> Read Out Setting > ® => Select Voice
=> (@ => Select a voice type = @

+ Mail is only read out while in Japanese
Language Mode.

Set Font Size

=> Font Size => ® = Select a size = @

Manually Retrieve

=> §I Mail Settings = ® => Message

Change Address => Report Spam Setting => ®=> Edit
for Reporting address => @ => YES => @

Spam

Check Mail => Check Mail Settings => ®
Settings

Complete Download => ® => Manual => ®
Messages + Complete messages are retrieved manually.
IRepIy Settings

Restore to Default
Settings

=> Reset Mail Settings > ® => Enter
Security Code => @ => YES => @

Quote Message
Marks

=> Mail Setting => ® => Header/
Signature —> ® = Edit Quotation Marks
=> (@ => Edit quotation mark => @

F uonjeziwoisnd
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Mail

ISMS Server Settings

@ => Settings —> @® => Connection Settings
=> (@ => SMS Center Selection => ®

Change SMS => 819066519300 => @® => Enter SMS
Center Address Center address = ® => International or
Unknown => ®
+ Address is 819066519300 by default. SMS may
become unavailable if Center address is
changed.
Reset to SoftBank |=> Reset => ® => Enter Security Code =>
SMS Center ® = YES => @
Address

b uoijezZIWOolSND
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I Internet

S NN eT) Press and hold & => Browser

Settings = ®

Sl e e e 549 Press and hold & => PC Site

Browser => ® => PC Site
Brw. Settings = @®

Set Scroll => Scroll => @ => Whole Page, Half Page
Unit/Speed or Single Line => ®
Enable/Disable => Downloads > ® => Display Images =

Image Download

@® => ON or OFF => ®

Set Auto-Play for

=> Downloads => @ => Play Sounds => ®

Internet

Set Whether to
Send Referer

=> Security = ® => Send Referer => ®

=> ON or OFF => ®

Enable/Disable
Cookies

=> Security = ® => Cookie Settings =
® <> Select an option => @®

Check Internet
Settings

=> Check Settings or Check PC Site Brw.

Set > @®

Reset Internet
Settings

=> Reset or Reset PC Site Brw. Set —> ®
=> Enter Security Code => @ => YES => @®

IYahoo! Keitai

52500 Press and hold & => Browser Settings => ®

Melody => ON or OFF => @
Attachments Set Font Size => Font Size => @ => Select a size => @®
Clear Cache => Memory Manager => ® => Delete Set Flash® Sound | => Flash Sound Effect => ® => ON or OFF

Cache => ® => Enter Security Code = @
> YES => @

Delete Cookies

=> Memory Manager => @ => Delete
Cookies => @ => YES => @

Initialize Memory
Status of Internet

= Initialized Browser > @ => Enter
Security Code => @ => YES => @

Set Whether to
Send Manufacture
Number

=> Security => @ => Manufacture
Number => @® => ON or OFF => @®

On/Off

=@

F uonjeziwoysn)
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Internet

IPC Site Browser

SERTED Press and hold @ => PC Site Browser => ® =
PC Site Brw. Settings — ®

Do Not Show Alert
When Activating
PC Site Browser &
Switching
Browsers

=> Warning Messages => @ => OFF => ®

Set Page Layout

=> Display Mode Settings => @® => PC
Screen or Small Screen => @® => Select a
size => @

Select a Script
Setting

=> Security => @ => Script Settings —> @®
=> Select an option = @®

IProviding Location Info

Provide/Restrict
Location Info
When Requested

® => Settings > ® = Send Location
Info => ® => Enter Security Code => @® =>
Confirm, Send or Not Send => @®

- Information unretrievable when set to Not
Send.

b uoijezZIWOolSND
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IChanneI List

® = TV = @ => Channel List = ®

TV

Ilmage & Sound
EUTED @ = TV => @ = User Settings > ®

Change Title of
Channel List

=> Select a channel list => @ = Edit Title
=> @ = Edit title => @

Set Subtitle
Display

=> Subtitles => ® => ON(Wide:Bottom),
ON(Wide:Top) or OFF => @

Delete a Channel
List

<> Select a channel list => @ => Delete

This => @ => YES => @

+ The currently used channel list cannot be
deleted.

Show/Hide Icons
in Landscape View

=> Icon Always Show => ® => ON or OFF

=@

Assign Channels to
Remote Control
Numbers

=> Select a channel list => ®& = @ =
Remote Control No. > ® => Select a
remote control number => @ => Select a
channel => @ => Repeat the same step =
=> YES => @

Save Battery by

Dimming Backlight | -

=> TV Power Saving => @ => YES => ®

Following these steps when TV Power Saving
is on will cancel TV Power Saving.

Delete a Channel

=> Select a channel list => & => Select a

channel => @ => Delete This => ® => YES

= @®

+ Delete a channel from any channel list except
for the currently used list.

Set Sound On
While Handset
Closed

=>TV Sound While Closed => @ => ON=>®

+ When set to ON and handset is closed, a page
connected from data broadcast automatically
updates. Packet transmission fees apply.

Keep Backlight On
When Viewing TV

=> Display Light => ® => Constant Light

=@

+ TV Power Saving must be off to set Display
Light.

Set Backlight
Duration for
Viewing TV

=> Display Light => ® => Lighting
Duration => ® => Enter lighting time

+ TV Power Saving must be off to set Display
Light.

F uonjeziwoysn)
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TV

IData Broadcasts

uoneziwolsn)

@® => TV => @ > User Settings - @ = Data
BC Settings = ®

Set Whether to
Show Images in
Pages Accessed
from Data
Broadcasts

=> Set Image Disp. => ® => ON or OFF =>

®

Enable/Disable
Sound Effects of
Data Broadcasts

=> Sound Effect => ® => ON or OFF => ®

IOther Settings
® = TV => @ = User Settings — ®

Check TV Settings

=> Check TV Settings > ®

Reset Channel
Settings

=> Reset Channel Setting > ® => Enter
Security Code => ® => YES => @

Clear Data
Broadcast Memory

= Reset Storage Area — @ => Select an
affiliated station => @ => Delete This or
Delete All => ® (=> Enter Security Code

= @) = YES => ®

Show
Confirmation
Window Again

=> Reset Disp. Set. => ® => YES => ®

+ Once you select YES(By default) in a
confirmation window for accessing a web page
from Data Broadcast, the window no longer
appears. Use this procedure to set the window
to reappear.

Reset TV Settings

=> Reset TV Settings > ® => Enter
Security Code => @ => YES => @

IRecording Programs

Continue/End
Recording at Low
Battery

@ => TV => @ => User Settings > @ =>
Rec. While Low Battery => ® => ON or
OFF => ®
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ICameraN ideo Settings

Set Shutter Sound

[Photo Viewfinder] (P. 7-5)/[Video
Viewfinder] (P. 7-7) => @) => Shutter
Sound => @ =>Select a shutter sound =>

®

Set Interval for
Continuous
Shooting

[Continuous Shooting Viewfinder] (P. 7-9)

=> @) = Interval/Number => ® => Shot

Interval => ® => 0.5 Seconds, 1.0 Seconds

or 2.0 Seconds => @

+ Shot Interval is available when CHG Camera-
mode (P. 7-5) is set to A-Continuous Mode.

Set Number of
Shots for
Continuous
Shooting

[Continuous Shooting Viewfinder] (P. 7-9)
=> @) = Interval/Number => ® => Shot
Number => ® => Enter Shot Number =>

®

IFiIe Storage

Set Storage
Location for Still
Images/Videos

[Photo Viewfinder] (P. 7-5)/[Video
Viewfinder] (P. 7-7) => @ => Select to
Save => ® => Phone or microSD => @ =>
Select a folder => @

+ To save videos on memory card, select a folder
of Inbox.

0
<
7]
-
[}
3
N
o
(=7
o
3
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S! Appli
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B

IWhen Running S! Appli
® => SI Appli = ® => Settings => ®

Set Sound Volume

=> Sound/Vib Settings > ® => Volume
= @ => @ to adjust volume => @®

Set Vibration

=> Sound/Vib Settings => ® => Vibration
=> (@ => ON or OFF => @

Set Backlight

=> Backlight Settings => ® => Switch
ON/OFF => ® => Always ON, Always OFF
or Link To Phone Set. => @®

Reset Security
Settings of
S! Appli

=> Select an S! Appli => @) => Security
Settings > (® => Reset Security Set. =>
® > YES > @®

IS! Appli

@® > S! Appli —> ® > Settings > ® >

Reset-> (®

Reset S! Appli
Settings

=> Set to Default => ® => Enter Security
Code => @ => YES => ®

Set Blinking of
Backlight

=> Backlight Settings —> @ => Blink => ®
=> ON or OFF => @

® = S! Appli = ® = S! Appli List => ®

Allow/Prohibit
S! Appli to
Connect to
Network

=>Select an S! Appli => @ = Security
Settings => ® => Net Access => @ => All
Permit, Prompt at 1st only, Prompt each
time or Disable => ®

+ Available with network-capable S! Appli.

Allow/Prohibit
S! Appli to Write
Personal
Information

=> Select an S! Appli => @ => Security
Settings > @ => Write/Del User Data =
@® => All Permit, Prompt at 1st only,
Prompt each time or Disable => ®

+ Available with S! Appli that can write and delete
user data.

1424

Delete All S! Appli

=> Delete All S! App => ® => Enter
Security Code => @ => YES => @
+ Some S! Appli are not deleted.




IS! Quick News

@® = Entertainment > ® => S! Quick News
= (@ = Settings = ®

Set Automatic

=> Auto Refresh => ® => Select an item

Updates for S! => (@ => Select update interval, ON or OFF
Quick News = @ (twice)
Hide S! Quick => Standby Settings => @® => Standby

News in Standby

Disp. Set. => ® => OFF => ® (twice)

Entertainment

IS! Info Channel

@® = Entertainment => ® => S! Info
Ch./Weather -> ® => Settings —> ®

Set Whether to
Display Desktop
Icon For New
Received
Information

=> S! Information Notif. => ® => ON or
OFF > ®

Set Ticker Speed

=> Standby Settings = ® => Speed
Settings => ® => Fast, Normal or Slow =>
® (twice)

Set Font Size for
Web Pages

=> Font Size => ® => Select font size =

®

Set Information to
Appear in S! Quick
News

=> Standby Settings => @® => Unread &
Read Set. => ® => Unread Only or Unread
& Read => ® (twice)

Hide S! Quick
News Images

=> Set Image Disp. => ® => OFF =>@®
(twice)

Reset S! Quick
News Registered
Contents

=> Del. Quick News => @® => YES > ®
(twice) => Enter Security Code => ®
(three times)

F uonjeziwoysn)
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Entertainment

IWeather Indicators

@® => Entertainment => @ =>
S! Info Ch./Weather => ® => Weather
Indicator => ® => Settings => ®

Set Whether to => Weather Update => @® => ON or OFF
Automatically = @ (=> YES = @)

Update Weather

Information

Set Whether to => Standby Setting => ® => ON or OFF =>
Display Weather |@

Indicators in

Standby

Set Whether to => Weather Notif. => @ => ON or OFF =>

Display Desktop
Icon For New
Received
Information

®
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IText Entry

@® => Settings = ® > Other Settings —> ®
=> Character Input Set —> @®

Set Text Input

=> Input Mode => ® => Select an input

Method method => @
Set Word => Prediction => ® => ON or OFF => ®
Prediction

Set to Show T9
Suggestion Words
in Kanji or
Hiragana

=> T9 Change Mode => ® => T9 Kanji
Change Mode or T9 Kana Change Mode
= @®

Clear Learning
History

=> Clear Learned => ® => Enter Security
Code => @® => T9/Expect Words/Pic. or
Kana/Kanji Change/Face => ®

Change Font Size

=> CHG Input Size => ® => Select a size =

®

Other Settings

IShortcut Key

Change Function
Assigned to
Shortcut Key

@< Settings => ® => Other Settings =
® => Shortcut-key Setting => @ =>
Select a function => @ => YES => @

- Alternatively, press and hold @ in Standby to
access Shortcut-key Setting window.
- To return to original settings, press @), select

Reset Shortcut-key, and press ®.

ICIosed Illumination

® => Settings => ® => Other Settings = ® =>
Closed lllum. => ® => ON = ®

Set Flashing Color
for Handset Close

=> Set lllumination => @ => Select a color

=@

Set Auto Cursor
Movement in
5-Touch Mode

=> Auto Cursor => (® => Fast, Normal,
Slow or OFF => @

Set Flashing
Pattern for
Handset Close

=> Set Pattern —> @ => Select a pattern =

®

F uonjeziwoysn)
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Other Settings

IResetting Handset

@ => Settings —> @® => Other Settings —> ®

Reset All Settings
to Default

=> Reset Settings => ® => Enter Security
Code => @ => YES => ®

Initialize Handset
to Default Status

=> Initialize => @ => Enter Security Code

= @ => YES => @) => YES => @

+ When the initialization is completed, handset
automatically shuts down and restarts.

+ When handset is initialized, all data
downloaded and saved on handset are deleted
and cannot be restored.

+ Your Security Code will also be reset to default.

b uoijezZIWOolSND
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Multitask Combinations

The following table shows combinations of functions that can be used simultaneously to multitask.
@ The following indications may not apply depending on the function status and combination.

S! Appli

q . f Data Phone | Own :
Function| Mail |Yahoo! lmSettlngs Folder Tools Book | Data Camera| TV |Music Original
Group
Menu
Currently
Active Function ] ) ) =, = ® (8] Q ® () ]
Mail =| x O ) O @) O @) O O 0 @) @) O |Mail Group
Yahoo!
Yahoo! | O X (@) O @) O O O (@) O @) (@) (@) Group
. S! Appli
S! Appli &= O @) X X @) O @) O O O O O O Groupppl
) Settings
Settings 0 O @) (@) O X O O O (@) O O @) (@) Group

Data Folder [t3| O @) O @) @) X X X X X @) O O |Data Folder
Tools m| O @) @) @) @) X X X X X O @) @)
-g Phone Book || O O O O O X X X X X O O O
4 Tools Group
g_ OwnData || O e 0 @) e X X X X X e) e 0
3
_ﬂ Camera m|l O O O O O X X X X X O O O
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Multitask Combinations

. . S! Appli .| Data Phone | Own .
Function| Mail |Yahoo! lm Settings Folder Tools Book | Data Camera Music Origina
Group
Menu
Currently
Active Function =] () ) =, [F -} (48] » ¢} &
v O O O O O @) O O X O
(]
TV Active @) @) O @) O @) O 0 O X X O .
TV & Music
Music olo|lol| x|lo|lo|lo|o]olo x | o [Crouwp
&b
Player « « y
Active O O O O @) O O O O
During a .
Voice call | = © o x % x x @) ©) O O X O |Voice Call
During a .
Video Call B| x X X X X X X X X X X x | Video Call
During Packet
Transmission #| o o o o o o o o o o y o External
with a PC Connection
Connected
O Available

X Not Available

-
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Software Update

h xipuaddy

Check if software on handset needs to be
updated, and update it through the network
if necessary.

@ Before updating software, turn off handset
and restart it to make sure that all handset
functions have ended.

@ Disconnect the USB cable from handset. The
software update, if it is done with the USB
cable connected, may not be properly
completed.

@ No transmission fees apply to check or update
software.

@ Updating software may take 30 minutes or so.
Wait for the software update to finish before
using handset.

@ Make sure battery is sufficiently charged
before updating software.

@ Update software in a location of good signal
reception. Do not change locations while
updating software.

@ Other handset functions are available once the
software update is completed.

@ Data saved on handset is retained when you
update software. However, data may be lost
depending on the handset condition (e.g. a
malfunction). We recommend that you make
backups of important data (though it may be
impossible to back up some downloaded data)
before updating software. SoftBank is not
liable for any data loss.

154

@ Never remove battery or USIM Card or turn off

handset while updating software.

@ If software update fails, handset may become
inoperable. If this happens, contact SoftBank
Mobile Customer Center, Customer
Assistance (P. 15-51).

IUpdating Software

n @ => Settings —> @® => Other
Settings —> ® => Software
Update = ®

Pl software Update => ®

= Sof tware Undate
e recomnmend that you
stay in a place with

update. Continue?

B Follow onscreen instructions

After Software is Updated

After update, handset restarts and update status

appears.
< Software Update |
Software has been
successful ly updated.
Update Status
Note

If handset does not restart after updating,
remove and reinsert Battery, and turn handset
on again. If handset still does not restart, call
SoftBank Mobile Customer Center, Customer
Assistance (P. 15-51).



Checking Update Results

El ® = settings > ® => Other
Settings —> ® => Software
Update = ®

F1 update Result > ®

Changing Update Schedule

Notification appears for scheduled updates.
Follow onscreen instructions to change
update schedule. Once schedule is changed,
notification appears at the set time. Press @
to start update. If handset is left untouched,
update starts automatically.

Note
« End all functions to open notification.
Software update is canceled if you continue
using functions for over ten minutes after the
scheduled time.

Tip

« Alternatively, to change update time:
(® = Settings = ® => Other Settings =>
®=> Software Update = @ => Regular
Updates = @ => Follow onscreen
instructions

Software Update

-
e
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Troubleshooting

Problem Possible Cause & Remedy Refer to Problem Possible Cause & Remedy Refer to
Cannot turn on Is battery properly installed? P 1-13 Cannot make calls |Is Keypad Lock active? P 4-4
handset. using Keypad.

Is battery exhausted? P 1-21 9 Reyp Is Dial/Sending Mail specified to be P 4-3
- — locked in Original (Dial) Lock mode?
Handset is slow to | It takes time if there are large amounts -
turn on. of data (e.g., Phone Book entries) saved Is Restrict Dialing set? P 2-22
on handset.
A message Did you include the area code when -
Cannot charge Is battery properly installed? P.1-13 informs you the dialing a phone number?
battery. s AC Ch I qint et P 115 number is not in
Charging Indicator > | 7arger plugged into an outle o service.
does not light up. properly: - -
Busy tone always | Does Network is busy at this moment -
Is the connector of AC Charger . )
) : sounds for Please try again later appear in
correctly inserted into handset? ) )
outgoing call. Display?
ifi ?
Is AC Charger the specified ZTDAA_1 ) Network is busy |Voice call/packet transmission network -
Battery may not charge properly with B L )
ified ch at this moment | may be experiencing heavy traffic or
non-specitied charger. Please try again |technical difficulties. Try again later.
Battery drains too |Battery service life may be over. P 1-13, later appears. Emergency calls (110, 119 and 118) are
fast. Battery lifespan may be shortened by P 14-5 still available.
environmental factors. Cannot receive Is handset in Emission OFF Mode? P.4-5
ion ti i Calls.
Battery operation time will vary o Is handset in Manner Mode? P1-19
depending on handset operations or Incoming ringtone
settings. does not sound.  |Is Ring Volume set to Silent? P 14-8
Cannot make Is handset out of service area or in a -
calls. location with a weak signal?
Is a maximum call cost limit set? P. 14-14
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Troubleshooting

Problem Possible Cause & Remedy Refer to Problem Possible Cause & Remedy Refer to
The other party’s  |Is the earpiece properly placed against - Display is blank. Is Power Saver Mode activated? P 14-5
voice is difficult to |your ear?
hear v If handset is left in a very hot place, it -
' Is anything obstructing the speaker if it - may automatically shut down.
is in handsfree mode? If this happens, move handset to a
- location at an appropriate temperature
Is t,he earpiece volume properly P.3-3, (5 to 35 °C) and wait for a while until
adjusted? P. 3-8 )
the keys become operable again.
Thg ther partys | ls t,he earpiece volume properly P33, Display is hard to |Is Brightness under Backlight set to P 14-5
voice is too loud. |adjusted? P. 3-8
see. lower level?
Handset respohse This may occur when there are large - s ECO Mode activated? P 122
to key pressesis  |amounts of data saved on handset, or
slow. when large amounts of data are being Is Privacy Angle set to ON? P 14-5
transferred between handset and
Display backlight |Is Lighting under Backlight set to P 14-5
memory card.
does not OFF?
Cannot hear key |Is Keypad Sound set to OFF? P 14-10 illuminate. -
. Is ECO Mode activated? P 1-22
operation tones. -
Is handset in Manner Mode? P. 1-19 - - - 5
Display backlight |Is Brightness under Backlight set to P. 14-5
Side Key is Is Keypad Lock active? P. 4-4 is sometimes ON? Light Sensor detects the
inoperable when Is Side Key Guard set to ON? P 122 bright, sometimes |surrounding brightness and

handset is closed.

dim.

automatically adjusts the Display
Backlight brightness.

Nothing appears
in Sub-display.

Is Sub-display Setting set to OFF?

P 14-8
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Troubleshooting

Problem Possible Cause & Remedy Refer to Problem Possible Cause & Remedy Refer to
Message appears | The image, video or song is unavailable - Insert USIM USIM Card is not properly inserted or P.1-12
when opening an [ with the function being used when any appears. may be damaged.
image, video or of the following messages appear. - - -

: . X Insert microSD | Memory card is not properly inserted or | P. 12-10
song file. Not available and No preview data
appears. may be damaged.
appears The image file may be corrupted. -
.IX PP 9 Y P Replace with A | Perform a scan disk on memory card. P.12-17
instead of an
image or preview New One or
) check the Disk
Images shot with [ When shooting images indoors, flicker P 7-12 appears.
handset camera may occur due to fluorescent lighting, -
) y . . .g 9 Function Cannot |End one of the currently active -
flicker. etc. Changing the Flicker setting may : ) )
. Operate Any functions to continue operation.
help reduce flicker.
More appears.
Images/videos Were the still images or videos shot P 7-12 Other functi " h i
shot on handset | with Flicker not set to Auto? lerrunction €€ messages appear when youtry to )
) . active Cannot use an unavailable function when
are too bright. Set Flicker to Auto. L )
start appears. another function is active.
Images/videos Select a Photo Mode suited to the P.7-5, -
) Other function
shot on handset | subject or scene. P 7-7 .
active Cannot
are blurred.
operate appears.
Cannot watch TV. |Is handset out of the digital terrestrial - - -
. . ) Memory This message appears when operation -
broadcast service area or in a location o ) L
. ) shortage appears. |is interrupted due to insufficient
with a weak signal?
memory. Reboot handset.
Are the channel settings done? P 8-3 - - - - -
Connection Is handset in a location where signal is -
Cannot use S! Has different USIM Card been inserted? P 9-7 failed appears. weak?

Appli.

S! Appli becomes unavailable after
inserting a different USIM Card. Initialize
handset and download S! Appli again.

The page you are trying to access is very
busy. Try again after a while.
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Problem

Possible Cause & Remedy

Refer to

B appears.

Inserted memory card may be defective.

P.12-17

Troubleshooting

>
3
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Text Entry Key Assignments

Iln 5-touch Mode

Key | Kanji/hiragana Entry Mode | Katakana Entry Mode Alphanumeric Entry Mode Number Entry Mode
(J BLIZIBBLNS 2B FAOIF7AoTA 1 J@-:7 1 1
2] hELIFT HFo42 abcABC2 2
TLIEZ EPZSE defDEF3 3
4] feb5DTED IFVT R 4 ghiGHI4 4
Z{tA 0] FIXRJS jKIKLS 5
(e} FORNZ J\EI~R6 mnoMNO6 6
FHOHH NZLXET parsPQRS7 7
PIOL® I & ¥13va138 tuwTUV8 8
=) 5b3N3 SujLo9 wxyzZWXYZ9 9
(o} nEA—D PENETEN 0 0+3
456 < < 456 25 "
v ? | - (space)’® w0 ? | - (space)’® ;P -&() ¥ (space) #

Appears as “~ " during double-byte entry.

The lower case of “ 7" can be entered in double-byte mode.

Press and hold (0 to enter “+.”

Can be toggled between upper case and lower case.

to insert line feed *  ."

Before confirming characters, press @ to display “_,” and press again in this state to enter “* “ or ** "
Cannot be entered when entering readings in Own Dictionary.

Only space can be entered when entering readings in USIM Phone Book.

0N U WN =

b xipuaddy
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Text Entry Key Assignments

Iln 2-touch Mode

In Double-byte Mode In Single-byte Mode * When using double-byte mode to
enter reading in USIM Phone Book,
Key [ Press Next Key [ Press Next double-byte katakana are entered
1|2|38|4|5|6|7|8|9]|0 1|2(3|4|5|6|7|8| 9 |0| instead of hiragana.
S[1 |0 5|2 B|AlB|C|D|E S[1(7 4|5t (al8lcl|oD ¢ -Pressafterentermgacharacter
) o s b q ) sl s 4 b d to switch upper and lower case.
@ L2 N e EE a c e @ / I a c € | 1 Can be entered when entering
3 2|0 E||IFIT|FIC|IH|T|J 3 2|0 | % |77 [I|F|C|H ! J pictographs is possible, such as in
~+ flg|lh|il]j - flegh| i@ [ Text Memo and Common Phrases.
3|c|L|F|E|Z|K|LIM|N|O S|y |A[E|Y[K|L|IM] N |0| 2 Press(8)(0]to toggle between
kil|{m|n]|o kil |fm| n 0 upper-case and lower-case modes.
alr=|s5|olclelPlQlRIS|T als|slyvl7rlPlalR| s | 1| 3 Aftercharacters that cannot
> plalr|s]|t y olalr] s |t have ** “or“" ,” a separate " “
5| |1c|®|m|o|Uv]w][x]Y 5[+ || x[#|/|ufv]w[x [vy| o isentered Before
confirming characters, press @ to
ulviwlx]|y Ulvfw] x |y ) W w "
> T display “_,” and press again in this
[SHNESRON NI RN NP 4N B B A el D2 6| N[ | T (N|K|Z]?]! -/ state to enter " or ** "
z z : A space is entered for these key
ZEEEIBEIRIEIRR ! RN = combinations.
8 v| (|w]) |&|=*|# MK 8|7 NERERE: MR
» © & v 3 _°>
9|5|b|d|N|5|1|2|3|4]|5 SQ(I(U|(b|b)O|T|2[3] 4|5 'g
@| /| - | _ | : |nepp|copecip 5™ 5
o|n|=E|w~|S |7 |6]7]8]|9]0 |77 |v|>|"|8]7|8] 9]0 o
o) N ° - ' o . |www. | .com [html | http// |nttpsy/ Ex
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Text Entry Key Assignments

Iln T9 Input Mode

15-12

Kanji/hiragana | Katakana A
Key Entry Mode | Entry Mode Alphanumeric Entry Mode
Rowds, 1 Row 7, 1 J@721(),-_:" & ¥ 1Single-byte
space
(2J|  Rowh, 2 Row73, 2 abcABC2
Row, 3 Rowt, 3 defDEF3
C4J| Rowlz, 4 Row?%, 4 ghiGHI4
(=0 Row’, 5 Row7, 5 jkIKLS
(6J| Rowld, 6 Row/\, 6 mnoMNO6
Rowz, 7 Row ¥, 7 pqrsPQRS7
Row+¥>, 8 Row, 8 tuvTUVS
9) Row5, 9 Row 3, 9 wxyzZWXYZ9
(o) DE R 03I 0
_ 4_
> .0 1) .0
3 12 12 26
g 3 3
2
X

« For key assignments in number entry mode, see the

table in “In 5-touch Mode.”

+ Numbers do not appear when entering reading in

USIM Phone Book or Own Dictionary.

+ Press to toggle the case as follows: Caps-lock

cancel mode — Shift mode — Caps Lock mode

+ Caps Lock mode: All characters are entered in upper

case.
Shift mode: The first characters of words are
capitalized and the rest of characters are entered in
lower case.

Caps-lock cancel mode: All characters are entered in
lower case.

+ Once characters entered in Shift mode have been

determined, the mode is switched to Caps-lock
cancel mode.
When edmng areading, pressing (%] adds/cancels
“or"*
- to |nsert line feed “ J
“rg b and (space)” appear
r|ght after a readlng or character is determined.
The lower case of “ 7" can only be entered in
double-byte mode.
" is entered in double-byte mode.
Pressing before confirming characters enters a
space before confirming.



Kuten Code List

@Actual Display font may differ in appearance from the following.

&= OHIEH RENIER IEMTER SRS

m ~ K LR 1t 4 0 JLHI= BRI o e

geo WEEK e | JORE  DIREERKPEHLE
M5 o IEEHE  _MIRRGER & | HE | EEESSm
< EHRHN —OEHEROE RE ERSERXE
ge HiBRE P HIS A e R S 2 R {HRIR R
SoiD EEPEE  SHEFHHE RSB XBESSE
Colc BEHEK  BENKEE  EEE K
ol RK AR BRHEw R 1 4 R A 3
22 Seece oEewedr ELET NETECR
ol MOF ©s>0 TFF @OXN3E 9EN
g=|x  Xoao s+ L o®Blg HRJ
S~ o we= mos 4 QOB s B8N
folws wol xas 44 @@Sta: 284
Zolss OTT ocd g T @334 Ew
.m,a Ix LST oo3 rhE @QORMMEY BW
To(<® MEXET =TT —L @@H,".28F®-
mz X2 O¥eQ Lsx — |4+ @OR, LY @-
|~k OS> wsxc |[H{4 OO~ a2 @I
olo b SFO Oo¥82 AT ©COXiE @I
PEz2 SSNRIEERE 2233 253335853
olo> BUNPIEH 8Q *ANKRZEAD -+ =
g=| == IRDPMVBCL Q HHRPIRZCHD OW N
S~lEZ wHOPNRY £ HHEMNIYC »0O Io
mslv NV N8 PE DAXINNCHAL NC W
Zw|lx 3 nvin LR DAKANNR2IR WO >
es[—+ SHDLBHO  YHARKNIDOD <nca
Sol—0 3HOOLEE02 YHARININ LZ3 3
Lolce BARNMBEOKLEY NRPARUMMN mSx

Colwo BRNNUDH % ARDPALUEMM <<e

olvanN BIRUDHER RONLVIEAH Y

olc s | . ——VI¥ Il Y &= ©® 00 o
go|- |1+ ——AO® % U m A + & LAND
E~[] Oim=VvV.® b M > ¥ + ~— wWO>o
go|- o %i—=H#.x D U § I A~ o 0OZXa
Zol o Y—mll, I 4 T n = oO==®©
ma C = ok O I a0 oond>

T ov I} ~AAXHROEM— C> ©—38 ~<X¥D

ol ., N oo W@ DL (e © Sk

E-Z, A\: ~1 80061 N -8 o -0

of —v i : ~v+ANBK t U NS < I
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Kuten Code List

o|IRHE KE-RECMEE NSRRI @REN RXED EER
BB RENRESTTMS b,  IIKEIRAKGITIE SRR o A A
Sr|HIRMR ERHBARENN WHIIZMHFTSE QEMRRE  S%HE DT EH
maﬁﬁﬁ EREEMBINGE FEMRRRNEIND  SUko 8 MR ERAYE
o |SRKIN IRBRRIMENE TARTEERER SRRm<m,  SNE R
2 |G I W R R MR M ERI S WAL E R E B U R BIREE  ~ RIR
T o FIPIXERE R R RIS ST R DR E R IR GEED BAHEd T
S o[ RERRIEAEIK R ERSME H T M MK K E RIS R MY BISREREL i
= -2 HE IR E RIS ISR WA T T RO RS R DO i B 8
OB WERREERME HORISERHHITE  SOoomn RERW BRE
o HRZENERRE W IDEEREEE GO TRRERR S KINES
go| BEBUERINEIREN B BEEKECE R0 DEGERE IREMKGED
S| MPEMXBUSRERRER MR RQMRENEHK BEE JOpREES ERREER
ms i icIHCEIEIEE R MHEEHEEER RIMER  HESRE  ERKEER
So| REBEADRIRE BE HERREN SRR, ERERE SRR
2 | DIRIKIRMER TR SRR HERITEERHERE EHRNEEER KIS
So|QSHIENERYNEAME SHHROKREERRE  H{ESJEEROE DR
£ oo Db AT B IRGRII . RARME TS B e RERRNRIE R K
C | QUCHIRHA S ROEASER  XEMEERRNERED RIS K ORISR
o[k MEHEEEIN I Sh#EXERSE B0E SBNEENT IEREE
o REEIE HMEEHERE REE KB HEEZRSEE KER 2 EOEESKER
So[KARXRIEE FERIMIREIRER R B MIRMMTE EEN REEEmS
SR XNHERHBES RE R REKRKE BEE HER0EER
mﬁﬁﬁﬂﬁ% HEEES KR HOEE i SRIMINED EHE ERRHEY
So|iaKiRGE IREIKERANS KR EIN o SRR ER BN | BRI
£ v [EHOEHRREKHMHAEN S SCHRE — EHKERKENKERE S SREEEK
o MNERHMERREIEEE [UENE  RRURRRRNRIER R EX
£ o BB RN KHTEIR S KBTI RO SR MOSE X
- |WEPRAEKSRREEE FREEY ARSI OBESRRY SRy
o[ HORIPIRRINIEK SEKKEMEIL OGRS KR HEREIREEH IEy  SREEN
ol B WE  OREHKEEE CHRBEREEE FHENEEE 6R BEER
3°| N ORE  XEES GHSGRKEDE SRR SRR
Sol ¥ G EEIEHEK INEERHEEE PUEDESE  On SERE
ms HIEEE [EHRREEE RNEEETE SRERERE S8 #SeER
S P R, SKEEEN XREZLHERSR PEREMERE | e ChimkE
oS IOiRRE BRI RN S SR AR A L BB A i o] S R AT XU X
i HERE ERETSOREREENEHITEMM KR RNRITE (R RRER
Eev HHEE  — SESEE R SR TSR TR RIERER
&~ KEBN EZERKEREORRDESHREFTCEREHEIN R (B
° g BH  EREERCE WEMSRROEE SR iR ReR
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Kuten Code List

Appendix

o BINRE  BEE MINKDSE  sRE MR R kERE 8
go| WKER EHE IRRERKKE  HEN Bl O X RBKE &
S| HEWE  EEM IRECRKEE  ERK my e E REm  F
ma IR ol @,ﬁtmwwwh% ERIK K Dy & & kR &
50 R T QRMIREO W WS | SR KK &
< Ry EsmErRsesr e kxS e e’ er Tu
g ENR BERERNARIIEEN B ke ok HE mE 0P
Se HEE  BEHKERRREEERE @sRB K % BE  HERR
- BHfiE  RDEARERKEEE REER K #E ¢ WPRHES

© gegsdcR BT B IBHEIRK  KENE B IR MmE

= BR DR RSEIEESE jekREHE I
8= HERE iR RREARESED  [EREm AK
Sr(RR A HEHRIBINRD INERER  MHXEE SR
ms R ¢E RO WIS _ﬁ”ﬁmm MR RPRHE AR
ol Wil | HMESIIZE HRRIREG 0 MRE IR KHIEE RS
2v(He N KRR EE RN T KERKEIMEEE BRI
Solm  ENE  ECREIECEEERE  HXREIEENER  DEROEERSER
Sollx MRS OEEKEOKESERGE REERESKEE @ KELHERRKRE
SoR ERE SHTERIERXEE UREKBREERSEE  SREEEER

® S R SRCHRE fRnE EBIIEEHE  EEEK SR

ol RER HEE CSRE EXNS  SRRMEY RDLEnD e g
go| WER 0 OHER LU BEE  ROHERE RANEERES 0 SR
S| WUMIE  MENE MR RSP R EIRER LE @
ma WK i bR EEK HRiig:n HEEmER 0 K®E R
So| WHEWEE | ISURER ) HRLY ISRIMER AEREE MEELKE  RE R
v(ERESN RER NRERREE  EHRADERENR g Zwn<
So|HbKEN  BRE RREREKE  MRIHRESEEBREER & | |w
ColEERER  RBRE I HRER-DE SRRLEREREEEEEN X O
Co|REFKEK  WEE DRERSEXE WHERREEEBNIREN RS B

ol efEm it RRE SEE WK EESRE O RE R

o REERNIEE K AHERERE Rl DERCRR AEEE SEKIORE
o[ MNRE=R #EF MORNEEN BEE ERIERGHE BHEER  RREHN
SriBEITETKSK  fHH  CEmEEHEK TERE BNEKEESR WEEN Rk
ms HCimiE TR iz RIPIIEIAISIYY MR SEIXER RORE 0 REMEE
So|BlEEN BE | TREKHNGN BOE SSRGS
2 R ERB IR E L R [ G e o ﬁﬁ%@éRD,EEﬁi_,_a b kel
S o fEE -SRI STHRBIITENE  KEGDESTMEREER &R
£ o[ HHEXTIS RIS  TIRIE RS ER X%ﬁﬁ%ﬁmﬁﬁa_mﬂ_& RiFiHYE
S-S IR MSREREERE  RREOKEISOKRE  RbEE

O|BISHRIMEIRIR B MISHQUENELHER MG SRR SRER  RIWMEEH
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Kuten Code List

Fourth digit of Kuten codes

PIPERURIRER RILGRKEEEE BENSESRERE KRQEERERE
PGP RS EEMRIERKINE  EEMREERAE BRI EEER
MERMGR M SHKEREHKIE EERREERND 8RR K TER
ERDEO R EHERRNEIEE  ERRRREONE SBRoRREEg
BEMREG RN BOSTWSERE SRR IS K EEEH&MWH%
456 R 900 U S0 6 4 K 53 R S R 44 K 1K Q4 34 T W 0 G M T O I BT i S DK e
KA i b s 9K f0 00 A 0 R 1 e S ¢ R AR S R O O i R R RN K TR VR R
K 0 B R R R PGB R IR R K SRR K 25 o R A R K IR R A e
221t T 4 A 0 ¢ X R 2 A1 X 12 0 G R SRR N O R B DR s e [ 32 g
B EMEEIERER RO HKER HEXEERINRE  RKHSHE KRR

5 1 13 15 1A =

I

digit50123458789

1st-3rd

® < 0 ©~ o o~ oo

570

o
=)
)

56
596

Fourth digit of Kuten codes

" {8597

R |56
#1569
g 12| 58
B | 591
T &% | 592
B I | 593
1| 594
k| 595
N

K ifg | 598

ﬂEﬁ

ORI IR I R A N
WO EPHKITEHER R RAmE Egﬁgt DEPEFEEEL ﬁ%ﬁ?ﬁ%@%
B ERKEESRR DRTRERRER RECEGEEERE EmNEEGs
B EEEEHEEHRE SWHEENEND STRESREIN BRENSERH
BE BESHEENROK SEEROHEKS FTTHMREDLE BRI S
] ] 1 5 5 o L 5% 0 {00 2 58 A BRSBTS 4
5 I = ¢ O A O R RO R B R 2R O { B K I E K B R s E R B i IR N E i K
I 5 0 S S R I 2 2 5 A S A L 3 4 i 0 A 2 18 ) B S0
08 =0 S0 R -4 S 205 N £ 0 1 (X 0T 4 i T Y B P MR RO B4 W D T A 3R
BEE SEENEEEOKE HERCER IR MUEERIBEER ERdHKnd

B A | 561
S 17 | 562
;

digit50123456789

1st-3rd

529
530

©
I}
)

Fourth digit of Kuten codes

1’“ 527
22| 552

K {p| 523
{H| 525
1% | 526
@

&1 531
f&| 532
% | 533
| 534
B | 535
R 53
F| 53
| 53
;0% | 551
IR | 554
m‘ 555
F5w

LEESS HiE E ) S 0 S
~HEHIESRE MR REREERR SQETWWW ﬁ mMEﬁE%E
HEEKSHWEEY BRERCKERSR ROMYS MBS o i
A RILPRERE DERCERERR SEEIENSHE SRKSDmE
SHICEBERE MWK TIRE  FELTRNENE @ik
<SSP o 8 HET PN R BT 4D [ X e e i e ) I L [ 2 R A
K 1 R 40 e R DI AT 081 i B¢ 3 (5 R A FE i AR R R R B U R KK Lk &
HPeR 2 R £ 2 4Bl 20 140 8 2 e L) 2 R R 430 4 I R e 60 b B T 0 BT R 55
I  RUH B EEEER BN KERRREREER (SHEXEREERER

digitt [0 1 2 3 4 5 6 7 8 9

1st-3rd

RRISEEEGHE EREN\OReE BEHEDESEIRY HIjixdEEe

&=
umswo O~ msWwo~®
oo oo o CO000000O0O — —— ——— —
ST OO WOWwDWWwo W

477
478
479

Fourth digit of Kuten codes

il
oo~
25>
332

e

HE  OHERR HE

foms Kl K Xfwﬁﬁ% %%F W R

i ﬁ%ﬁ% $2Em HEAMEERE R LK  EE

MR O MR MR HISEERE  EMRR ERE RH
o BRE ﬁﬁ%ﬁ O | EESLSBMEEC PR EIEE AR
4 s @i EBSEKBECBIPRE | UIME | R
HErE  SEKE  KE  HYFUEE KLREE S BN o
GEEER WRET KE KREERER KEREE O BWE o
EREIE PR & REREPRRE BERERE OREE  RBE

digits |0 1 2 3 4 5 6 7 8 9

1st - 3rd

448 | G & ) 3 R B 9 M) | 476
i
f&
#
=]

449 |58
%
#

RUSHHEHE PR [ MMIEIE  ERRGEE HtE &8

O~ ms 0w
© ©© O oo
SSSSTS<
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Kuten Code List

Appendix

Fourth digit of Kuten codes

g o
RGO SRR
BN SRR

o PR B T S R N
ﬁﬁ%#n ﬁﬁﬁm#

GRENR
BES
R RS

IRHERIEHERE  ERENEREEY
BRI BREEE R R S R
ROUSHCIBITIKEE SRS RS
RIS R ERET HRSENRICEE
RIBERRIENG  EEREEREEE  WHSe LyE
KRR RSN b R B B 1 S e R B R B K E N R R B iR TR
240 e 1 A R e 55 L M R Y S B M B R S R B BB i %%%
R R K e R R B R R B R R B M R QR IR R TR B 2R 5

1R 020 T A T 50 5 A 0 OB B EE B BB
IRIRHEHS R RN ERIRRE WHRKETOREY Rl

B S R

digit50123458789

1st-3rd

UM T IDON~DDO —
LD 1D 1O O D 1D 1D © © ©
NSNS NN~ NS

750
751
75

Fourth digit of Kuten codes

D ENRT WIS IR KO
BEMEHERRE K
RO e T SR SR BRI

5| 744
B2 | 746
2 5| 747
Bt 749

§,;§ 742

PHESHRNIE AN e DTSRRI IKBRRR A I ER R332
HIKERR R SPUEEEREE DR K S T
MK RKE AMHERREERY  HEROMEESE 1RHD
WKL Rk SREESAEEE ERENSNSREE SNEEnEane miR
FERMRRE ESEREeRYUn HREMEEIrS SREgiERIRg kil
S R 5K R R KT O S 2 DT S S D B B B EX RIS W s 2 BT R B B O R R i I R
SR 45 O R R 2 2 4 P 2 QL O 0 0 A B L T MK S SR 0 K TR
r%%%%%mﬁ@ﬁ%ﬂfﬁmME?Fiﬁzfﬁ%ﬁgﬁgmmﬁﬁéﬁﬁiﬁﬁﬁg
B LR ek 2 R S 0 T W M KR R 8 B I R 00 R 2 Rl B M M S B BT B R L SR ISR
Mm@ CUEEHRERTE HETMEIRM SR S IrR@Esile K

di97t50123458789

1st-3rd

NTDON VDO — UM IO © M~ 0O
COoO———r——— -~ «
~

688

o ) o~
= =) S oo
© © ~~~ [N N S N S N

23456789

Fourth digit of Kuten codes

o
S
3

24

XD YA B R %ﬁw.%%ﬁ%

;ﬁ 695
%2 | 696
i 3| 697
5| 698
7| 699

fasy

= 35 | 685
& B | 686
}% 689
E_ 691

1&| 684

© ~
@ >
a8 a8
EHEK iR 2

£| 681
481 682

B M O
3 5 B
ERUBIR (XIS B I BB
E ORI KR [ R

b Eﬁ&ﬂf%
S0 B R B SRR
T DS R R R
R IR e

T 5 FRA 4 B B K
RS RKEE
LI E R RN
006 2 OO T o 2

ﬁ R R R
EWEHA%E@ umn
TR T AORR I
@mﬁ Ehﬁxﬁ% ﬁ

§§€§Eéﬁ 721

T S R R i T S A 0 30 2 DO 9 AR BRI BB £ 4 4
m.mun»m%samwmmmﬁ@ﬁE,Egs_ﬁr,%r@ﬁmﬁﬁ%&ﬁﬁ%ﬁﬁ_ﬁﬁ R MR R
e T R 1 0 B B M Y el O 2 4 K e 0 2 OO 8 S (B 4
.,ﬁiikﬁﬁm 5 5 0 50 R 1 20 R U 0 2 e 2 K 0 R Bk e i 5 T A2 4
EREERERIE RMESEhRERE BESR NS KRR ENEERG

digits [ 0 1

1st-3rd
640

645

©
<
©

650
659
660
662
665
666

o
~
©

Fourth digit of Kuten codes

1&& 648
B & | 649

HKiEW
@ﬁﬁ%%ﬁﬁfﬁ
iR 7 U P R
WEEKREESR  PRRHREEITK  RRMREH
BERMUORE  MECER RS EE%@ﬁMmFE

ﬁ@ﬁ@ﬁ%%mgﬁ%ﬁﬁﬂm%%giﬁﬁﬁ‘%%E%~%ﬁﬁ%&MQﬁ EF%@

R s {2 U BRI I U 0 (R R T R D60 SR 0 1 e 0 G R R T M S O R S

EE R QR (R TR B OB K G KD R TN < D Ot I O I R R L 62 B e

SR 5 M A0 0 A 0 5 N e LM PR KT T R i T e R B

E SUSEEREER BRFREEERKE IRESHMRERN SIRERE SR

#|ea
1B | 642
% | 643
2| 644
%
A

ﬁﬁﬁm_ﬁyr,ﬁpmiuﬁ
SR R IRER T R

32 | oo
% % | 660

N | 663
‘éz%;‘

Bl 5% B R
/= % 8 B B | ees

ERmE

g

7

«“[v?;‘ﬂi%fﬁ 667

digits [0 1 2 3 4 65 6 7 8 9

1st-3rd

631
632
633
634
637
638
639

o © ™~ o ~—UOSTWLON®DO w0 ©
OO0 ——— ———— — — QU CU Q) CU QU QU U QU U ™ o™
© © © © © © ©©®©DOD0 D00 © ©

599
600
601
602
603
604
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Kuten Code List

RS BEREREEREN FREESEENNRE RESHRRERR

ERENE PENERREREN CRYSERERECH RERENREnE

HEFRER BOEENEREN HREESESQER BREHNSERE

SRR SEEIEREREN NEIESRETYE LRNEEGGRMEMN B
[l ﬁ@%i%ﬁﬁﬁ% %Eﬂﬁ%.ﬁ%ﬁ e B
T2 Sl At 5% Y B R B S MM T e M 8 W B IR R LR R R B R DR W B SR
gﬁﬁﬁ@%ﬁﬁﬁﬁﬂﬁgﬁ%=§%%.%?Wﬁ%%%%%%ﬁﬁ%ﬁ@%é
R BT S R I B R R I R R S B B R M R AR R R SR R R e 0 T R
=ttt pek ittt %gﬁﬁﬁﬁéﬁkmﬁﬁﬁﬁﬁiﬁﬁﬁmﬁﬁ
HESERER ERRRFRRIY RESREEERE BRRBHRUEEEE

Fourth digit of Kuten codes

digit50123456789

1st-3rd
840

R 2| 831
ﬁz 832
iE 835
R | 836
7| 837
B [ | 838
% FE | 839

EEXNE BEENSDROE RRNEEEEEE SR jostegid
LHIEREYE ZWNSEEWEERN RGNS %%Eﬁﬁﬁﬁﬂw I 44 T Y
(REEB VLS RERIREE M @EEME%%%% ERMEETEES S0
ITEmMF e MEERREEAN NHRESERNRS REREENREBE LR
SWENEKE CSKESEFHEON AMERERANE SENMIEUEED S
0, e T ) 1 0 5 O 5 O 0 0 0 P B - o M B R
3 S B 5 4 0 B T I 2 T R 0 B R B B S S R S S 4 S B R R K MR R KB
DD S IREMER R IR N G R S R A SR R I I B S S M
T 4t 1 K T 7 R R R B RSB SR R R IR R B I B
RS HERN ERXEFSELN HNRSREEEE BHNEHEREES  EHE

Fourth digit of Kuten codes

digis |0 1 2 3 4 5 6 7 8 9

1st-3rd
787
788
789
790
791
792
793
794
795
796

~
1)
~

798
799
800
801

o
oo
© ©

775
776
777
778
778

< o
~ ©
~ ~

781
782
783
784
785

©
©
~

765
766
767

< ©
© © ©
~~ ~

769
770
771
772
773
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Weather Indicators

Normally Displayed Pollen Level Typhoon

3 Clear (Day) Low Forming
) Clear (Night) & Moderate il Approaching
@ Cloudy 7] High ] Emergency Status
[ Rain Extremely High
& Snow Other Information
Fd Thunder and Lighting Sakura Blossoms Finy Heavy Rain
0% Chance of Rain =Y Budding & Strong Winds
[i84 10% Chance of Rain a Near Full Bloom & Notification
= 20% Chance of Rain Peak Bloom
= 30% Chance of Rain & Past Peak
& 40% Chance of Rain
£ 50% Chance of Rain Autumn Foliage
%3] 60% Chance of Rain No Color
[ 70% Chance of Rain Moderate Color
s 80% Chance of Rain e Peak Color
s 90% Chance of Rain Past Peak
o 100% Chance of Rain
& Later UV Level
V4 Partial & Low

Moderate

7 High

Very High

F xijpuaddy
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Q Menu List

+ Enter menu item numbers for direct menu access. Note that Main Menu theme must be set to Basic.
+ See “Check Style Mode Settings” (P. 14-3) for menu items whose default settings differ according to the model color.

Mail
2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to
Inbox - - — P 5-9
Outbox - - — P 5-12
Draft - - — P 5-23
Compose Message — — — P.5-3
Compose SMS — — — P.5-7
Server Mail Mail List - - P. 5-10,
P.5-20
Server Mail Memory — — P. 5-20
Retrieve New - - —
Templates — — — P.5-19
[tsumono-Mail - - — P 5-6
Mail Setting Custom Mail Address - — P 14-16
Scroll - 1 Line P 14-17
Font Size - Standard
Mail List Disp. - 1 Line+Body (Name)
Start Attachment(auto) - OFF
Header/Signature - Edit Header, Edit Signature: Not Stored, Edit Quotation P 14-16,
Marks:---===--------- , Insert Setting: Selected P 14-17
Mail Box Lock — Inbox, Outbox, Draft, Server Mail: Unlocked P.5-14

b xipuaddy
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Menu List
2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to
Mail Setting Receiving Setting — Operation Preferred P 14-17
Read Out Setting - Select Voice: Female 1, Read Out Received Mail: ON
Emotion/Keyword - Disp. Emotion: ON, Disp. Keyword: OFF P 14-16
S! Mail Settings — Message Download: Auto(All), Delivery Report: OFF
SMS Settings — SMS Report Request: OFF, SMS Validity Period: 3 Days, SMS Input
Character: Japanese(70char.)
Report Spam Setting - stop@meiwaku.softbankmobile.co.jp P 14-17
Check Mail Settings - —
Reset Mail Settings - —
Yahoo!
2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to
Yahoo! Keitai - - — P 6-3
Menu List - - —
Bookmark - - — P 6-9
Saved Pages - - —
History — — — P. 6-3
Enter URL — — —
PC Site Browser — — See “PC Site Browser under Yahoo!"” (P. 15-32). —

F xijpuaddy

15-21



b xipuaddy

2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to
Browser Settings Font Size — Standard P.14-19
Scroll - Single Line
Downloads - Display Images: ON, Play Sounds: ON
Flash Sound Effect — ON
Memory Manager - -
Security — Manufacture Number: ON, Send Referer: ON, Cookie Settings: Enabled
Check Settings - —
Initialized Browser - —
Reset - -
S! Appli
2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to
SI Appli List — — - P97
Settings Sound/Vib Settings - Volume: Level 4, Vibration: ON P 14-24
Backlight Settings - Switch ON/OFF: Link To Phone Set., Blink: ON
Reset — —
Information - - — P 9-7
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Entertainment

Menu List

2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to
S!'Info Ch./Weather What's New - — P 10-3
History — —
Register/Cancel - —
Get Latest Contents — — P.10-6
Settings - S! Information Notif.: ON, Font Size: Standard P. 14-25
Weather Indicator - See "Weather Indicator for S! Info Ch./Weather under Entertainment” -
(P. 15-32)
S! Quick News S! Quick News List - - P.10-2
Settings - See “Settings for S! Quick News under Entertainment” (P. 15-33) -
S! Contents Store — - - P.10-5
Camera
2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to
Photo Mode - - — P 7-5
Movie Mode - - — P 7-7
Voice Mode - - — P 7-10
My Picture - - — P 12-2
Videos - - —
Music
2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to
- - - - P. 9-5
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Menu List

Tools
2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to
Alarm — 44 - P 11-12
Schedule — 45 - P 11-4
Calculator — 85 - P 11-11
Dictionary Enter Word - — P 2-27
Text Reader - - -
Reference History - — P 2-27
Text Memo - 42 — P 11-9
To Do List — 95 - P.11-7
Life History Viewer - - — P 11-2
S! Addressbook Back-up | Start Sync - — P 2-24
Auto Sync Settings — ON/OFF: OFF P.14-12
Sync Log — — P.2-25
Account Details — 0 - P 1-21
Bar Code Reader — - - P 11-14
Text Reader - — — P.11-16
Receive Ir Data — 79 - P.13-3
Play/Erase Msg. - - — P 3-5,
P.3-18
Play/Erase VC Msg. - - — P 3-5
Voice Memo - 43 - P.11-10
Voice Announce - 91 - P.14-10
Forwarding Image - - ON P 14-12
microSD Manager - - — P 12-11
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Menu List

2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to

USIM Operation — — - P 2-23,
P. 5-22

Data Folder

2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to
My Picture - 46 — P 12-2
Melody - 16 —
S! Appli - - —
Ring Songs-Music - - —
Videos — — -
v - - -
Own Data

2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to
Received Calls — 24 - P.3-10
Dialed Calls — — -
Mail Member — 97 - P.5-6
Tomo-Den - - — P 3-12
Common Phrases — 38 - P 2-14
Own Dictionary — 82 — P.2-15
DL Dictionary — — —
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Menu List

TV
2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to
Watch TV — - - P.8-5
Program Guide - - — P 8-6
Booking Program List - - — P 8-10
Timer Recording List - - —
Result Timer Rec — - - P.8-15
TV Link — - - P.8-13
Channel List — - - P 8-12
Channel Settings - - — P 8-3
User Settings Subtitles - ON(Wide:Bottom) P. 14-21
Rec. While Low Battery - ON P 14-22
TV Sound While Closed - ON P 14-21
TV Power Saving - OFF (not set)
Display Light - Constant Light
Data BC Settings - Set Image Disp.: ON, Sound Effect: ON P 14-22
Icon Always Show - ON P 14-21
Check TV Settings — — P 14-22

Reset Channel Setting - —

Reset Storage Area - -

3 5
Reset TV Settings - -

S g

3

8. Phone Book

x

2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to
E — — — — P 2-18
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Menu List

Settings
2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to
Style Mode Setting - - Varies by model color. P 14-3
Incoming Call Ring Volume 50 Phone, Video Call, Mail: Level 4 P. 14-8
Select Ring Tone 13 Phone (Select Ring Tone: Pattern 1, Select Calling Disp.: Flying Type),
Video Call (Select Ring Tone: Pattern 3, Select Calling Disp.: Flying Type),
Mail (Select Ring Tone: You've got mail 1, Select Receiving Disp.: Flying
Type)
Vibrator 54 Phone, Video Call, Mail: OFF P. 14-9
lllumination 89 Set Color (Phone: Color 3, Video Call: Color 5, Mail: Color 10), Set
Pattern: Standard, Missed Info: ON
Manner Mode Set 20 Manner Mode P 14-10
Setting when Opened - Answer Incoming, Display New Mail, Display Missed Call: OFF P 14-9
Disp. Phone Book Image - ON
Answer Setting 58 Any Key Answer
Mail Ring Time 68 ON (Ring Time: 5 Seconds) P. 14-8
Ring Time(sec.) 90 Set Mute Seconds: OFF, Missed Calls Display: Display P. 4-5
Info Notice Setting 65 ON P 14-10
Answering Machine 55 OFF P 3-4
Disp. Call/Receive No. - Varies by model color. P 14-10

F xijpuaddy

15-27



h xipuaddy

Menu List

2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to
Talk Hyper Clear Voice - Low P 14-13
Noise Reduction 76 ON
Quality Alarm 75 No Tone
Reconnect Signal 77 No Tone
lllumination in Talk - OFF
Set Hold Tone - On Hold Tone: Tone 1
Setting when Folded 18 End the Call
Dialing Pause Dial 84 — P 14-12
Sub-address Setting - OFF
Prefix Setting - EBESE (Prefix: 0046010)
Headset SW to Dial - OFF P 14-11
Int'| Dial Assistance - Auto Int’l Call Set.: ON (Country Code: 7, IDD Prefix Code: EBH(S), | P 14-13
Country Code Setting: B (Country Code: 81), IDD Prefix Setting: Ek
F{E (IDD Prefix Code: 0046010)
Video Call Visual Preference - Normal P 3-17
Select Image - On Hold, Holding, Substitute Image, Answering Machine, Preparing, P 14-14
Voice Memo: Pre-installed
Auto Redial as Voice - OFF
Display Setting - Main Display: Other Side
Hands-free Switch - ON
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Menu List

2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to
Display Display Setting 56 Stand-by Display: Varies by model color., Wake-up Display, Dialing: Flying |P. 14-3
Type, Calling (Select Ring Tone: Pattern 1, Select Calling Disp.: Flying
Type), Video Call Dialing: Flying Type, Video Call Calling (Select Ring
Tone: Pattern 3, Select Calling Disp.: Flying Type), Mail Sending: Flying
Type, Mail Receiving (Select Ring Tone: You've got mail 1, Select
Receiving Disp.: Flying Type), Retrieve New, Mail Rec'd Result: Flying Type
Backlight 70 Lighting: ON+Saver (Light Time: 1 Minutes), Charging: Standard, Area: |P. 14-5
LCD+Keys, Brightness: ON+Middle
Display Design 86 Color Theme: Varies by model color., Icon Pattern (Battery Icon, Antenna |P. 14-4
Icon: White), Soft Key: Varies by model color.
Sub-display Setting 93 ON (Disp. Clock Only: OFF, Clock Type: Digital 1, Called, Mail, P 14-8
Connection: ON, Time Signal: ON (60 Minutes), Display Time: 15
Seconds
Font 66 Font Type: Gothic, Thickness: Bold, Character Size: Standard P 14-4
Desktop Icon 63 Theme 1 (S! Quick News List, TV, Quick Search, Bar Code Reader) P 14-6
3D Display Setting - ON
SEEEIR (Language) 15 HAE P 14-5
Original Menu 52 Account Details, Receive Ir Data, Calculator, Schedule, Text Memo, P.14-7
Alarm, Bar Code Reader, Dictionary, My Picture, Secret Mode
Menu Display Set 57 Menu Display: List, Theme: Varies by model color., Memory Focus: OFF
Viewer Settings - Picture P 14-5
Icons 36 — P.1-7
Icons Setting - ON P 14-7
Privacy Angle - OFF P 14-5
Quick Info Setting - Display Sender
Screen Effect — OFF
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Menu List

2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to
Call Time/Charge Call Data 61 — P 3-11
Set Max Cost Limit — Notify Setting: OFF P 14-14
Reset Total 60 — P 3-18
Auto Reset Total Cost - OFF P 14-14
Clock Set Main Time 31 Time Adjustment: Auto (Time Zone: GMT+09 Japan), Summer Time: OFF [ P. 14-2
Set Sub Clock - Display Method: OFF, Summer Time: OFF
Clock Display 39 Display: ON, Size: Big, Color: Varies by model color.
Alarm Setting - Alarm Preferred
Clock Alarm Tone Set - Alarm Tone
Auto Power ON - OFF P 14-3
Auto Power OFF - OFF
Security Function Lock - OFF P 4-3
Keypad Lock - After Closed: OFF, Timer: OFF P 4-4
Emission OFF Mode - NO (not set) P 4-5
Secret Mode 40 OFF (not set) P 4-6
Secret Data Only Mode 41 OFF (not set)
Reject Unknown - Accept P 4-5
Call Setting W/O ID 10 Unknown, Payphone, User Unset: Accept (Select Ring Tone: Same as
Ring Tone, Select Calling Disp.: Same as Display)
Change Security Code 29 9999 P 1-20
PIN Setting - - P 4-2
External Connection USB Mode Setting - Communication Mode P 13-5
Headset Usage Setting 51 Headset+speaker P 14-11
Headset Mic. Setting - Headset Microphone
Auto Answer Setting 94 Phone, Video Call: OFF
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Menu List

2nd-level Menu 3rd-level Menu Menu No. Default Setting Refer to
Connection Settings SMS Center Selection - 819066519300 P 14-18
Certificate - All Certificates: Valid P 6-12
Retrieve NW Info — — P 1-17
Send Location Info — — Confirm P 14-20
Int’l Roaming Set NW Search Mode - Auto P 14-15
Display Operator Name - Display OFF
Optional Services Caller ID Notification 17 Activate/Deactivate: ON P.3-20
Voice Mail/Divert - — P 3-14,
P.3-19
Call Waiting - — P 3-19
Call Barring - — P 3-20
Other Settings Keypad Sound 30 OFF P 14-10
Charge Sound - ON
Battery Level 71 — P 1-21
Side Key Guard - OFF P 1-22
Character Input Set 35 Input Mode: 5-touch, Prediction: ON, T9 Change Mode: T9 Kanji P 14-27
Change Mode, CHG Input Size: Standard, Auto Cursor: OFF
Shortcut-key Setting - ltsumono-Mail
Closed Illum. — ON (Set lllumination: Varies by model color., Set Pattern: Firefly
Reset Settings 23 — P. 14-28
Initialize - —
Software Update - — P 15-4
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Q Menu List

PC Site Browser under Yahoo!

4th-level Menu 5th-level Menu Menu No. Default Setting Refer to
Home - - — P 6-5
Bookmark — - - P 6-9
History — — — P. 6-6
Enter URL — - —
Yahoo! Keitai — - - P 6-3
PC Site Brw. Settings Warning Messages — ON P.14-20
Scroll - Single Line P 14-19
Display Mode Settings - PC Screen: 100%, Small Screen: Standard P 14-20
Downloads - Display Images: ON, Play Sounds: ON P 14-19
Memory Manager - -
Security - Manufacture Number: ON, Send Referer: ON, Cookie Settings: Enabled, |P. 14-19,
Script Settings: ON P 14-20
Check PC Site Brw. Set - - P 14-19
Initialized Browser - —
Reset PC Site Brw. Set - -
Weather Indicator for S! Info Ch./Weather under Entertainment
4th-level Menu 5th-level Menu Menu No. Default Setting Refer to
Weather — — - P.10-3
Manual Update - - — P 10-6
Settings Weather Update - ON P 14-26
Standby Setting - ON
Weather Notif. — ON
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Settings for S! Quick News under Entertainment

Menu List

Refer to

4th-level Menu 5th-level Menu Menu No. Default Setting
Auto Refresh S! Quick News - OFF
General - OFF
Special - OFF
Standby Settings Standby Disp. Set. - ON
Speed Settings - Normal

Unread & Read Set.

Unread & Read

Set Image Disp.

ON

Del. Quick News

P 14-25
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Specifications

IMain Specifications

Model

840N

Dimensions (H x W x D)
(When Closed)

Approx. 107 x50x 15.4 mm
(thickest Part: Approx. 17.7 mm)

Weight

Approx. 104 g

Continuous Standby Time

Approx. 680 hrs

Continuous Talk Time

Voice Call: Approx. 250 min.
Video Call: Approx. 130 min.

Charging Time

Up to approx. 120 min.

Display/ Type
Sub-display

Display: TFT 262,144 colors
Sub-display: Organic EL one color

Size

Display: Approx. 2.9 inches
Sub-display: Approx. 0.77 inches

Pixels

Display: 102,480 pixels
(240 x 427 dots)
Sub-display: 3,744 pixels
(96 x 39 dots)

b xipuaddy

15-34

Camera Imaging device |CMOS
Lens size 1/4.0 inch
Effective pixels  [Approx. 5.1 million pixels
Recording pixels |Approx. 4.9 million pixels
Zoom (digital)  |Stillimage: Up to approx. 3.8 x

Video: Up to approx. 5.5 x
Still images Up to approx. 1,000 files'
still images for |4 to 20 files?
continuous
shooting
Still image file  |JPEG
format
Video recording |Handset: Up to approx. 12 min./
time recording, total 480 min.3
Memory card: Up to approx. 120 min.3

Video file format | MP4

TV Continuous Approx. 310 min.
watching time
Maximum Approx. 600 min.*
recording time

Chaku-Uta® [Storage Capacity |Approx. 80 MB>

and Chaku-

Uta Full®

1 In case the image size is SubQCIF(128 x96) and the image quality is set

to Fine (the file size is 10 KB).
2 Varies depending on the image size.




Specifications £ o

3 Time for recording when recorded in the following conditions:

IHandset Materials

Handset Memory card
Image size SubQCIF (128 x 96) Handset Parts Material/Finish
Image quality Long Dur. Mode |Normal or Long Dur. Mode Rear display panel Acrylic resin, dichroic vapor
File size 2MB Long Time deposition + UV coating
e Normal Decorative ring (around Camera ABS resm,.alummum vapor deposition
- - lens) + UV coating
4 Approximate time when recorded on a 2 GB memory card. Charger terminals (Desktop Holder) | Phosphor bronze, gold plating
5 Shared with images, videos, saved pages, images (captured with TV) and Battery <crews ron chromate
hi il templates. - i i
graphic matl templates compartment | Compartment Stainless alloy, nickel plating
surface
Terminals Titanium copper, gold plating
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IMaximum Number of Storable Items

Maximum
Item Maximum Number | That Can be

Protected
Answering Voice calls 5 (20 sec. each) -
Machine Video calls 2 (20 sec. each) -
Voice Memo 1 (20 sec.) —
Dialed Calls 30 -
Received Calls 30 -
Redial 30 -
Speed Dial 10 (Entry Number -

000-009)

Maximum
Item Maximum Number | That Can be
Protected

Phone Book entries 1,000" -
Schedule Events 500 -

Holidays 100 -

Anniversaries 100 -
To Do List Tasks 100 -
S! Mail/SMS | Received 1,0002343 1,000

messages

Sent messages |400%23% 2002

Draft messages |20° -
Bookmarks [Yahoo! Keitai 100°° -

PC Site Browser | 1006 -
Saved Pages 1002 502
S! Appli 10025 -
still images 1,00024 -
Videos 10026 -
Captured screehshots (TV) 1002 -
Melody files 2002 -
Songs 1002 -
Template (Graphic Mail) 1,0002 5 -

15-36

1 Up to 50 entries can be saved on USIM Card.
2 The actual number that can be saved or protected may be less depending

on the data size.

3 An additional 10 received and sent SMS messages can be saved on USIM

Card.

4 Up to 100 additional messages/files can be saved in Secret Folders.

Ul

Includes data stored by default.

6 Up to 10 additional files can be saved in Secret Folder.




IMemory Card Folders & Files

Specifications

Folder File
DCIM XXXNECDT' Still images captured with Camera and JPEG images copied or moved
from handset
MISC Settings file for DPOF printing
PRIVATE MYFOLDER Mail Drafts Backup data of Draft
Inbox Backup data of Inbox
Sent Messages Backup data of Outbox
Utility Calendar Backup data of Schedule
Contacts Backup data of Phone Book
Memo Backup data of Text Memo
Rights Backup file of content keys
Tasks Backup file of To Do List
My Items Bookmarks Backup file of Bookmarks
Flash(R) Flash® files
Games and More S! Appli files
Music Songs
Pictograms My Pictograms
Pictures Still images
Sounds & Ringtones Melodies
Videos Videos
NE_Folder Other files

-
Ul
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Specifications

Folder File
SD_VIDEO |[MGR_INFO TV Program recording management file
PRGXXXZ TV Program recording files

1 XXX: Three single-byte numbers from 100 to 999
2 XXX: Three single-byte alphanumeric characters (hexadecimal) from 001 to FFF

h xipuaddy
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Number
2-touch Mode .....ccoeveverrceerieeeens 2-15
3D Display Setting .......ccccocevveeeens 14-6
5-touch Mode .....ccocvvvceeecieene 2-11

Access Files .....oocovrveneiieniieieeee
Composite Image
List SEttiNG ..vvvvneeeeiiiiii e
Set Image Disp. ....cccvvvieeeiiiiiiennis 12-14
Access Handset Functions ............... 2-2
Access History .......ccceeeieiiinniene 6-3, 6-6
Delete ..oooovviiiieiiiiie e 6-11
Access the Internet
Access menu list ..., 6-3
From Bookmarks ..... ..6-9

From Data Broadcasts ....
From Entered URL Record
From Scanned Data ...

From TV Links .....

From URL in Text . 5-23
From Web Page ... .6-12
Open New Tab ... .. 6-7
PC Site BIOWSET ....vvvveeeiiiiieeeiiiiieeaanns 6-5
Use Access HiStory ..........ccccceenees 6-3, 6-6
Yahoo! Keitai .......eeevvivereeaiiiiieeeaiins 6-3
Account Details ......coceocerienienennne 1-21
Add Folder
BOOKMArK ..ovveeiiiiiieeiiiiiecce e 6-14

Data Folder .........oevvviiieeiiiiiieeeens 12-9

MESSAGES ...vvvviiiiiiieeeee e 5-22
Adjust Earpiece Volume .......... 3-3, 3-8
After Sales Service ......cccoceevveeenne 15-50
Alarm oo 11-12

Cancel .. 11-13

Edit ..o 11-21
Release All ... L11-21
SEE ettt 11-12

Alarm Activation Operations ..... 11-12
Alarm Notification Operations
Schedule ..

To Do List ....... 11-7
Alarm Setting .....ccocceveiieeicnnenee. 14-2
Answer Calls

Video Calls .ovvvveeiiiiiieieieceeen 3-8

Voice Calls .34
Answer Setting .... 14-9
Answering Machine .......cc.cceeeeieene 3-4

Activate When a Call Arrives ................ 3-4

Delete Messages ................. 3-18

Play Messages . .35

Settings ............ .34
Any Key ANSWEr .......cccevcveveceernnnen. 14-9
Attach to Mail

Bookmark ........cceiiiiiiiii

Delete Attached Files ..

Files woviiiiiiiiiiin,

Shot Still Image/Video
Authentication Password ............. 13-3

Auto Answer Setting .......ccceee.ee.
AUtO CUISOr ...ooccveveiieeieeeeeeeeann
Auto Power On/Off ........ccccueeeee
Auto Redial as Voice .......c..........
Auto Refresh (S! Quick News)
Auto Reset Total Cost ..

Auto Save Set ............

Auto Timer ... .

AULO-SOIt ....ovviiiiiieee e

B

Backlight

Backlight Settings (S! Appli) ..

Bar Code Reader ................ 11-14
Check Scanned Data .. 11-14
Delete Scanned Data .. 11-22

Basic Key Operations

Battery .....cccceoeinees
Installation ..

Bookmarks .......ccooeeenieniinieeees
Access Page
Add Folder ..
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Index

Save Scanned URL ......eeveeviivieeeeennns 11-22
Send by S! Mail ..
Sort Folder .....ooovvviiiiiiiieiieiiiiiiiinn,
C
Calculator .....cccoveceeeiieeceeceee
Call Barring .
Call Forwarding ......ccccoeevvenveneeneenns 3-14
Call Rejection .......ccccevveeeiieeiiciens 3-16
Call Time/Charge .......cccceeeveneeneenns 3-11
Call Waiting ....ccoceeeeeeeeiciceeees 3-19
Call While Abroad . 3-13
Caller ID ..... 3-20
Camera ......... .7-2
AULO Save Set ......coeeiiieiiiiiiiiieees 7-4
Capture Still IMages ........coovvveeerriennn. 7-5
Effect ..ol

Flicker ..........
Memory Info ..
Movie Type Set ...
Quality Setting ...
Record Videos
Settings .....oooiiiiiiiii
Shake Correction
Viewfinders .......ccooeeiiiiiiiiiiiiiis
Capture Still Images ......ccceceeeeuennee. 7-5
Auto Timer .........coeuunns
Continuous Shooting .
Frame .....ccoooviiinn.
Center Access Code

15-40

Certificate ..ccoceveeeveeceeece e 6-12
Chance Capture ........cceceeveerceennenne 7-10
Change

E-mail Address .........cccceeeviiineenans 14-16

Entry Number ..........cccoos 2-29
Font Size (Message Text) ...........ccceunees 5-24
Graphic Mail Effects .........ccccoceeeeeiins 5-19
ICON IMAGE e 2-26
Network Password .............ccccceeeenens 3-20
PINT/PINZ e
Security Code ...
Set To, CCOrBCC vovvveiiiiiiiiiiee e, 5-17
Channel List ....cccoeevvevenriineeenne 14-21
Delete a Channel
Remote Control Numbers ................ 14-21
Save Stations of a Different Area ......... 8-12
Switch ..
Channel Settings .......cccoceveeienieene 8-3
AUTOMALIC ©vveeeeiiiireeeeiiie e e 8-12
Character Stamp ....c.ccceeeevveieenenne 12-7
Charge Battery .. .. 1-13
AC Charger .......coocveeeeeiiieeeeeiiinenn 1-15
Desktop Holder ...........ccccecvveeeeinnns 1-16
Charge Sound ....... ...14-10
Check Battery Level .......cccceceeneee 1-21
Check Mail Settings .......c.cccceu.e. 14-17
Check PC Site Brw. Set ................ 14-19
Check Settings (Yahoo! Keitai) ..14-19
Check TV Settings .....ccccevcevvuenne. 14-22
CHG Input Method ......cccccvveennene 2-11

CHG Input Size ...ccvvvveeeeereeeene 14-27
Clear Learned (Text Entry) .......... 14-27
(@1 Yol SR 14-2
Clock Alarm Tone Set . 14-2

Clock Display ............. .. 14-2
Closed lllumination .14-27
COAES vt 1-20
Center Access COde ....ovvevruirreernnnn.. 1-20
Network Password ...
PINT/PINZ oo
Security Code .....ccooriiiiiiiiiieieeeiee
Compose & Send Messages
Attach Files .......coooieiiiiiiiiiiil 5-5
Compose S! Mail ...ooovveveeiiiiiiieeii 5-3

Compose SMS ...
Delete Receiver ...

Edit oo 5-23
From Phone Book ...... 2-30
From Scanned Data ... 11-22
From Tomo-Den ..........ccovvveeeviinnnennns 3-12
From Web Page ........cccccovveeeiiinnneenns 6-12
Graphic Mail ............... .5-3
Insert Header/Signature . 5-17
Itsumono-Mail ..5-6
Save ...iiieeen. 5-18
SEt PO ovvveeeeiiiiee e 5-18
Specify Mail Member List
RECIPIENTS e
To, Ccor Bcc .
Compose Messages ..........cceo.u. 5-3, 5-7



Continuous Shooting .......cc.cccceueu... 7-9

Cookie Settings (Internet) .......... 14-19
Copy
Between Handset & Memory Card ..... 12-12
EVENT oo 11-19
Phone Book Entries ... 2-23, 2-30
SMS MESSAGES .vvvvvvvineeeeeeieeiiiiinnn 5-22
Text covveeeeieenean 2-14
Customer Service ......... .15-51
Customize Mail Address ............. 14-16
D
Data BC Settings ......ccccccevveinnenne 14-22
Data Broadcasts ........ccccceveveeieenns 8-6
Data Folder ...... L12-2
Add Folder ... .12-9
Change Order of Files ... 12-14

Check File Information .. .
Delete Files .....cooveeeeiiiiiiiiiiiiiiieeeees
Delete Folder .........ccccovviiiiininnnncn.
Edit File Name ....
Edit Folder Name ...
Edit Still Images ..

Edit Videos ...
Memory Info ..

Move Files .....cooveeiiiiiiiiiiiiiiieeie,
Open Files ....cooviiiiiiiiiiieeeei,
Original Animation . .
Playlist (Melody) ........ccuvviiiiiiieneiiinis
Playlist (Vid€0) ...oeeveevveiiiiiieeeeeeeeeen

RINGONE ...oeiiiiiiiiiiee e,
Secret Folders ...
Stand-by Display
Data Transfer Tool .......ccccceeceenene 13-5
Delete All S! Appli

Delete Cache ........ 14-19
Delete Cookies ..... ..14-19
Delete Quick NEeWs .......ccccvveveeeenns 14-25
Delivery Report (S! Mail) ............ 14-16
Desktop Icon Settings .........cccceeeee 14-6
Desktop 1coNs ......ccceverieeieereenieeneen 2-3
Add Icons
Change Icon Image .......cccccevvvvneennnne 2-26
Delete Desktop Icons .............ccccevvn. 2-26
RESET .. 2-26

SHOW/HIAE v 2-26

SOMt e 2-26
Dial

From Dialed Calls ..........ccoovviiiiiiinnnns

From Phone Book ...
From Received Calls .
From Redial ...........
From Scanned Data ...................oeen.

From Tomo-Den .......cooeeiiiiiiiiinnennn.
From Web Page ...
Global Roaming ...

International Calls ................
Phone Number in Message Text
Video Calls ...vvvveiiiiiiiieiiis 327
Voice Calls ..o 3-3

Dial LOCK .eouereeriirierieieieeeee s
Dialed Calls .....ccceveevenereieeenee.
Dictionaries ........cccocceveeverieenennnen.
Disp. Call/Receive No. ......
Disp. Phone Book Image ..
Display Design ............... .
Display Indicators ........cccoeevereeneenns
Display Light (TV) .cccoevevinineene
Display Mode Settings ................
Display Operator Name ..............
Display Setting ........cccceeeene
Display Setting (Video Call)
DL Dictionary ......cccceeveeeeenne .
Delete .ovvvveiiiiieeeeeeii e
Download
MUSIC i
STAPPI oo
St Contents Store .......ccoveeeviiiieiininnns
Templates (Graphic Mail)
Downloads (Internet)

DPOF Setting .....cccccoovvvieniiiincns
Cancel ..o
>
E ]
T
ECO MOdE ...oveveieeieeeeeeeeens 1-22 g
Edit o
Address (Mail Member) ..................... 5-18 X
Alarm Settings ........cccvveeeeiiiiieennnns 11-21
EVENT ©evviieiiieee e 11-19 m—
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Index

File Name (Data Folder) ...................
Folder Name (Bookmark) ...
Folder Name (Data Folder) .
Folder Name (Messages) ...
Folder Name (Templates) ...
Mail Member List Name ...
Own Dictionary ........ccoeveevvieneiennneen.
Phone Book ENtry ..........cccvvvvieneenenn.
Re-entering in T9 Input Mode ... .
Stll IMages .ovvvvieeeeeiiiiiiie
Template (Graphic Mail) ....................
Templates (Common Phrases) ....
TXt o
URL (Bookmark) .........cccveeeviuneerinnnnns
ViIdEOS .t
View/Record Timer Settings .
Edit Still Images ......ccccceeereeiennnen.
Brightness ......ccoevvvviveiiiiieeiiiiieeennn
Change Size .
Character Stamp .....oooovveeviiiieriiees
Correct Backlight .......eiiiiiiiiiiiinni,
Frame ...............
Marker Stamp ...
Refresh Skin Tone ...
Retouch ............
Rotate ....... .
THM @WAY e
Edit Videos ......cccocveiveiencneeeene,
Emission OFF Mode ........ccceceenuene
Emotion/Keyword .........ccccoeeeennen
Emotion-Expressing Mail ................ 5-9

15-42

Font Size (Internet) .........ccuu.......
Font Size (Mail) ....oovvevueereeeienens
Font Size (S! Info Channel) .
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Warranty & After Sales Service

IWarranty Tip

« For information on after sales service, contact your nearest SoftBank

A warranty card is included with 840N. i ) shop or SoftBank Mobile Customer Center, General Information
@ Check that the store name and purchase date sections have been filled (P. 15-51).

correctly.
@ Read the card carefully and store it in a safe place.
@ See the card for the warranty period.

IAfter Sales Service

Refer to “Troubleshooting” (P. 15-6) before submitting your handset

for repair.

If problem:s still persist, contact SoftBank Mobile Customer Center,

Customer Assistance of your area (P. 15-51), or consult with your

nearest SoftBank shop.

Provide us with detailed information of your problems.

@ Repair within the warranty period is carried out in accordance with the
conditions of the warranty.

@ Repair after the warranty period is carried out if possible, and the owner
of handset is responsible for any repair costs.

Note

« SoftBank assumes no responsibility for any damages incurred by you or
third parties for failed calls, etc. due to failure or malfunction of this
product.

Data and settings you saved may be lost or altered as a result of failure or
repair of handset. It is recommended that you keep a backup copy of
important data (e.g. Phone Book entries, image and sound files).
SoftBank assumes no responsibility for any damages due to the loss or
alteration of handset data.

Disassembling or modifying handset may constitute a violation of Radio
Law. Your handset will not be accepted for repairs if it has been modified.
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Customer Service

If you have any questions about SoftBank handsets or services, call General Information. For repairs, call Customer Assistance.

H SoftBank Mobile Customer Center

General Information Customer Assistance
From SoftBank handsets 157 (toll-free) From SoftBank handsets 113 (toll-free)
From landlines 0088-21-2000 (toll-free) From landlines 0088-240-113 (toll-free)
0800-919-0157 (toll-free)

From IP phones, call these numbers.

Eastern Japan 022-380-4380 (toll call) Tokai 052-388-2002 (toll call)
Kansai 06-7669-0180 (toll call) Chugoku, Shikoku, | 1, £e7 4010 (toll call)
Kyushu, Okinawa

B SoftBank Mobile Global Call Center

For assistance (lost/stolen handsets, etc.) from outside Japan, call:
+81-3-5351-3491 (Toll-free from a SoftBank handset)
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